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Introduction 

• Aims 
This book has been written to provide the 
knowledge, understanding and pr:tctical skills that 
you need for the Cambridge !GCSE in Information 
and Communication T echnology. This book, 
together with the accompanying CD and image for 
sc:mning, provides: 
• practice examination questions for the theory 

elements of the course 
• practice tasks which offer guidance on how to 

::mswcr questions for the practkal parts of the 
course 

• activities which allow smdcnts practice in answering 
questions for the practical pam ofdtc course 

• source data fi les for the tasks and activities 
• h ints and tips for the practical papers 
• suggestions for possible teaching methods. 

Altho ugh it has been written with the CIE syllabus 
in mind, it c m also be used as a usefu l refe rence text 
for other practical JCT qualific:i tions at GCSE and 
other equivalent Level 2 courses. 

• Using the book 
The text is in 16 chapters . Although it is possible 
that som e elements of the pr:i.ctical chapters may be 
ex:imincd in the theory question papers, and vice 
versa, the sections for the theory wo rk arc in 
Chapters l -8 and the sections for the practical work 
in Chapters 9-16. 

• Examination questions 
Fo r the d1cory section, there arc examination-style 
questions on the CD , together with model answers, 
all in portable document format (.pdf). For the 
practical section, the examination-style questions 
appear as activities in the book, with the model 
answers on the CD. Two practice examination 
p:ipcrs also appear on the CD. 

• Co lour codes and symbols used 
Throughout the book there arc a number of colours 
and symbols used. Key presses arc shown as < Enter>, 
bur be careful with 0 1apter 15, where html codes are 
also shown in angled brackets, like this < html>. 
Different sections of text are in the following styles. 

Tasks 
Theseareexamlnation-stylequestlonslnthepractlcal 
section (which often include the use of source files 
from the CD for the practical tasks) that are answered 
withlnthechapter.Thetextdemonstratesthe 
techniques used to solve the task and gives some 
example answers. These provide easy-to-follow step.by. 
step Instructions, so that practical skills are developed 
aloogslde the knowledge and undemanding. 

Activities 
These are examination-style questions in the practical 
section, usuallyattheend ofachapter orsectlonfor 
the students to answer. These often include the use of 
source fil es from the CD. Model answers for each 
activity are available In portable document format 
(.pdf) on the CD. 

Exercises 
In the theory section, these a re short exercises for 
the students to complete in order to confirm their 
understanding of the concepts covered in a section 
or chapter. 

Hints 
These give hints, tlps,shortcutsandadvlceon 
examination techniques. 

HTML markup 
All html markup appears in a blue , 
proportionally spaced font . 

Cascading stylesheets 
All cascading stylesheet markup 
appears i n a red propor tionally 
spaced font . 

• Text co lou rs 
Some words or phra.sc:s within the text arc printed 
in red. Definitions o f these renns ean be found in 
mc glo,=y. 

In the pr;ictical section , words th..1 t appear in b lue 
indicate an action or location found within the 
softw.1.rc package, for example 'Sekct the H o me tab! 

In the d:1.t:1.basc sections of the lxlok, words in 
orJ.ngc sho w field names. 
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Words in green show the functions or formulae 
entered into the cell of a spreadsheet, for example a 
cell may contain the function = SUM(B2:B12) . 

• Hardware and software used 
The practical dements of the examinations can be 
undertaken on any hardware platfonn and using any 
appropriate software packages. For the purposes of 
this book, we have needed to choose specific software 
packages, but the fimctionality of many other packages 
is very similar. Many of the skills demonstrated in 
Chapters 9 to 16 are transferable and can be adapted 
for other hardware and software platforms. 

All the tasks and activities within the practical 
chapters have therefore been created using a PC 
platfonn ·with Microsoft Wi"ndon.,,- Vista operating 
system and include the use of Notepad. Independent 
packages used for the practical sections include 
packages from Microsoft Office Pro.fossional Edition 2007, 
including Word, faxel,Access and PowerPoint. lntcmet 
fa:pWYer has been used as the web browser and 
Windows LiJ>e Mail as a web-based email editor. 

For the website authoring section of the book 
(01aptcr 15), all work has lx."Cn produced in hnnl code 
without the use of a WYSIWYG package. Although 
you may have a WYSIWYG package available and may 
wish to allow students to use this, it is imi:ort:ant to 

realise that they arc expected to have knowledge of 
underlying HTML and cascading sryleshect code. All 
hnnl written within this chapter is written in HTML 
version 4.01 strict, and arc W3C validated (although 
the Doctype statements have been removed so as to 

avoid confosing sn1dents). All cascading srylcshects 
usL-d have been W3C validated. 

• Using the source image 
You have been provided with a source image which 
can be scanned when attempting Activity lOb in 
Chapter 10. TI1is can be found at the very end of the 
book, after the index. 

• Using source files 
Source files can be found on the CD and will need 
to be copied onto your local machine or network 

drive in order to use them. Copy them and give 
them read/write access. This is essential to ensure 
that you can use some of the file types included on 
the CD. For example, you cannot create queries or 
reports in Access when working from the CD. The 
CD will contain all source files in a series of sub­
foldcrs, one for each of the practical chapters. 

PC users 
From the Start button,ra:====== ;;--, 
select the Computer ~ ;::-... 
option and locate the (i. 

CD drive, which may be fii 
called drive D: or E:. a-­
For the purposes of this • -­
section, we will assume 1::,-~-•­
that it is called drive E:. .ti-'"'­
If your machine has a •-
~~c7::cr~r~~cap~orth~:: ~ ----. 

instmctions accordingly. ~iriliiii 
Locate the Chapter I 
source files folder, which can be found 
at E:\ Resources\Chapter sou rce files . To 
locate an individual file, such as the image 
SNOWBALL.JPG used in Chapter 10, use the path 
E:\Resources\Chapter source fi les\Chapter 10\ 
Snowball .jpg. 

It may be better to copy the contents 
of this folder into a new folder on your 
local machine or network drive. Open 

~:!\~1~~::: ::~h ~~c;;s~!:/~:~~~ 
save a new copy with an amended filcname. You 
may need to cl1angc the file permissions of these files 
to read/write to enable you work on them; however, 
check with your network administrator before 
attempting to make these cl1anges. 

MAC users 
Double click on the CD icon on the desktop. Use 
Finder to navigate to the location for the new folder, 
then create a new folder (< Applc>+ <Shift> 
+<N>). With Finder, choose the CD and select all 
files (< Apple>+<A> ) and copy them 
( <Apple>+ <C> ). Go to the new folder usingFinrkr 
and paste the files ( <Apple>+<V>). 



Changing the source files to match 
your regional settings 

Before attempting any of these processes, back up all 
source files. TI1e source .csv (comma separated 
value) files supplied on the CD have commas as 
separators between fields and full stops within 
currency values. If your regional settings for these 
values are different to these (for example, if you use 
commas within currency values rather than full stops 
and your software settings require you to use 
semicolons for separators between fields), then the 
source data files will need to be edited for use with 
the regional settings for your software. This process 
may be required to convert the source data files 
before the start of the practical examinations. You 
can do this process in many packages, but the easiest 
(at this level) is Word. Open the .csv file in Woni 
using the Office button and Open . Select the file 
from the list and click on [:::~::::3. This will open 

the file, which will !CXJk similar to this. 

"'1<>N,ohct"'"" tho car?, - 1. Coh<r.frice t""t wo l>wo~t tho ,u 
fo.-• ...-·..- '"'' - ~·11 ••ll thO en fo,- 0 Y•• • . ~•tr• , , O<,o, .... "'"' n­
<'o•ni"9? 
TW.,n,,<..L, , bUd< , Ia000 , 10JOS, ,oos,AJ J<>y ·-10 ••rC<ndiU«>,"J. • 
...,.,,_, ,cioa,s!1.,.., , .,ss., .. ,.200J.>1,c"""!t!on!ng,• 
ToyoLo,-2 ,_..,,or,>l•«rk "'"", ' "°', 1'1<s,,oo,,LootMr 11,a" Mr 
C«>4.lt1on1fl<}, I 

Select the Home tab, then the Editing ~ .,,,.. 
section followed by the Replace icon.- ~""P~" 

Enter a, (comma) into the Find what: ~ s.iec· 
box and a , (semicolon) mto the Replace 

with box, then cl1ck on ~ t 
.... ............ - .. -

~-----~-_______@ 

------a 

Introduction 

Repeat this process, replacing a . (full stop) with 
a , (comma). All the characters will have been 
replaced within the file like this. 

mE1:.·,::--~'~.~:,:-:::,::,o;L~:,~,.~~~ ":::::.. 
TVR;ni=an:Hlocl ;l l!000;203Cl!;10)t;>ll<>v•O•l• .,hcmditionln, ;N 

..,,,,_o;C200;•B""r;4'9:'.;5;":100l\AiJ,eomjtioniJlg'" - •• •·r 
CO<t~i tlooil>g; N 

Save the file with the same file name using the 
Office button and Save. This will ensure that the file 
is saved in .csv fonnat. 
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II 

Types and components of 
computer systems 

In this chapter you w ill learn about: 
• hardware 
• software 
• the main components of a computer system 
• operating systems: 

• graphical user interface (GUI) 
• command line interface {C U) 

• different types of computer systems. 

1 . 1 Hardwa re and softwa re 

Computer systems are now commonplace in every part of our daily life. This chapter 
introduces the basic components that make up these computer systems; most of 
these will be described in much greater depth in later chapters. Comparing books 
with computers is a good analogy: the actual pages and the ink used on the pages 
are equivalent to the hardware used to make up these computers; the words written 
on these pages are equivalent to the software. Without the words, the book is 
useless. Similarly, without software, computers would be of little use to any of us. 

Hardware is a general term for die physical components that make up a computer 
system, for example keyboard, mouse, monitor, processor, cirmit board and so on. 

Software is a general term for die programs that control the computer system. 
Tiiere are two types of software: 
• systems so ftwa re: programs that allow the hardware to run properly, e.g. 

operating systems 
• applicatio n s software: programs tliat allow die user to do specific tasks, e.g. 

spreadsheets. 

1 .2 Main compo ne nts of compute r syste ms 

A typical computer system is made up of hardware and software. Figure 1.1 shows an 
example of a computer system consisting of input devices, output devices and secondary 
storage. These will be discussed in more detail in Chapter 2, but examples include: 
• input d evices: keyboard, mouse 
• output devices: monitor, printer 
• secondary storage d evices: DVD RfW drive, removable hard drive. 

H owever, one part of the computer system has not yet been mentioned. Tiiis is 
shown as the 'Processor and internal memory devices' in the diagram - this consists 
of four key components called the central processing unit (CPU) , internal hard 
disk, random access memory (RAM) and read only memory (ROM ). 



Figure 1.2Typical 
microprocessor 

Types and components of computer systems 

Figure 1.1 Atypicalcomputersystem 

TI1e central processing unit (CPU) is the part of the computer which interprets and 
executes the commands from the computer hardware and software. CPUs used to be 
made up of discrete components and numerous small integrated circuits, which were 
combined together on one or more circuit board/ s. H owever, due to modem 
manufacturing techniques, the term microprocessor is now used instead of CPU. 
This is a single integrated circuit (see Figure 1.2) which is at the heart of most PCs 
and is also found in many household devices and equipment where some control or 
monitoring is needed (e.g. the engine management system in a car). 

The internal hard drive is the computer's main memory; this is where the 
applications software, disk operating system and data files are stored. The main 
advantage of these memories is the fast data transfer/access times and their large 
capacity to store data (this is discussed further in Chapter 3). 

Random access memory (RAM) is an internal chip where data is temi:orarily 
stored when nmning applications. This memory can be written to and read from. 
Since its contents are lost when power to the computer is n1rned off, it is often 
referred to as a 'volatile' or 'temporary' memory. 

Read only memory (ROM) is a memory used to store information that needs to 
be pennanent. It is often used to contain, for example, configuration data for a 
computer system. TI1ese chips cannot be altered and can only be read from (hence 
their name). One of the main advantages is that the information stored on the ROM 
chip is not lost even when power is turned off to the computer. TI1ey are often 
referred to as 'non-volatile' memories. 

It is worth noting that ROM also contains some coding known as the boot file. 
This code tdls the computer what to do when it first starts up; it is often referred to as 
the BIOS (basic input/output system ). When the computer is turned on, the BIOS 
carries out a hardware check to fmd out if all the devices are present and whether they 
are functional. Then it loads the operating system into the RAM. The BIOS stores the 
date, time and system configuration in a non-volatile chip called a CMOS 
(complementary metal oxide semiconductor) , which is usually battery i:owered. 

1 .3 Operating systems 
Reference to operating systems has already been made earlier in this chapter. 

To enable users to communicate with computer systems, special software, known 
as operating systems, have been developed. TI1e general tasks for a typical operating 
system include: 
• controlling the operation of the input, output and backing storage devices 
• supervising the loading, nmning and storage of applications programs 
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• dealing with errors that occur in applications programs 
• maintaining security of the whole computer system 
• maintaining a computer log (which contains details of computer usage) 
• allowing communication between user and the computer system (user interface). 

Computer users need to be able to communicate with the operating system - this is 
called the 'user interface'. There are two main types of user inteifaces: command 
line interfaces (C Lls) and graphical user interfaces (GUis) . 

Command line interfaces 

CLls require a user to type in instrnctions in order to chCXJse options from menus, 
open software etc. 1l1ere are often a number of commands that need to be typed in, 
for example, to save or load a file. The user therefore has to learn a number of 
commands just to carry out basic operations. It is also slow having to key in these 
commands every time an operation has to be carried out. However, the advantage of 
CLI is that the user is in direct communication with the computer and is not 
restricted to a number of pre-determined options. 

For example, Figure 1.3 shows the CLI code required for importing data into a 
table called B. 

1. SQLPrepare(hStmt, 

2. ? ( SQLCHAR * ) "INSERT INTO tableB SELECT * FROM 
tableA", 

3 . ? SQL_NTS) : 
4. ? SQLExecute(hStmt); 

Figure 1.3 Example of CU code 

The above statements show how complex it is just to carry out a fairly 
straightforward operation using CLI. 

Graphical user interfaces 

GUls allow the user to interact with a computer (or MP3 player, gaming device, 
mobile phone, etc.) using pictures or symbols (icons) rather than having to type in a 
number of commands. For example, the whole of the CLI code shown in Figure 1.3 

could have been replaced by a single icon: ~ (table update). Simply selecting this 
icon would automatically execute all of the steps shown in Figure 1.3 without the 
need to type them in each time. 

GUis use various technologies and devices to provide the user inteiface. One of 
the most common is windows icons menu and pointing device (WIMP) which 
was developed for use on personal computers (PCs) . TI1is uses a mouse to control 
a cursor, which then selects icons to open/rnn windows. Each window contains an 
application and modern computer systems allow several windows to be open at the 
same time. In the example shown in Figure 1.4, a number of icons can be seen on 
the left-hand side and on the OOttom right; three windows are open and these are 
shown as grey rectangles at the bottom of the screen. 

A windows manager lCXJks after the interaction between windows, the 
applications and the windowing system (which handles the pointing devices and the 
cursor's position) . 
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Figure 1.4 Atypical GUI 

In recent years, devices such as touch screen phones use post-WIJ\.1P interaction, 
where fingers are in contact with the screen. This allows actions such as pinch ing 
and rotating, which would be difficult to do using a single pointer and device such 

1 .4 Types of computers 
There are many types of computer systems in existence. This section smnmarises 
some of the more common types currently available. 

PC/ desktop computers 
PC/desktop usually refers to a general purpose computer which is made up of 
separate monitor, keyboard, mouse and processor unit (see Figure 1.1). TI1e term 
PC (personal computer) usually refers to computer systems which are IBM­
compatible, thus distinguishing them from, for example, Macintosh systems. 

It is worth making a comparison here with laptop computers: 

Advantages 

• Spare parts and connections tend to be standardised, which usually results in 
low costs. 

• Desktops tend to have a better specification ( e.g. faster processor) for a given 
price (often due to size and constmction constraints in laptops). 

• The large casing allows good dissipation of any heat build-up. 

Di sadva ntages 

• Desktops are not particularly portable since they are made up of separate 
components. 

• All the components need to be hCXJked up by wiring, which can be quite complex 
and clutters up the desk space. 

• Because they are not particularly portable, it is necessary to copy files, etc. when 
you want to do some work elsewhere (e.g. at home). 

• 
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Laptop computers 

Laptop (or notebook) refers to a type of computer where the monitor, keyboard, 
pointing device and processor are all together in one single unit. This makes them 
extremely portable systems. 

The key features you would expect to find in a laptop are: 
• low weight (to aid portability) 
• low power consumption (and also long battery life) 
• a processor that does not generate too much heat (cooling is very important). 

Adva ntages 

• They are very portable, since the monitor, pointing device, keyboard, processor 
and backing store units are all together in one single box. 

• There are no trailing wires, etc. because everything is in one single unit. 
• They can take full advantage of WiFi (see discussion in Chapter 4 ). 
• Since they are portable, they can link into any multimedia system. 

Di sadvantages 

• Since they are portable, they are easy to steal! 
• They have limited battery life so the user may need to carry a heavy adaptor. 
• The keyboards and JXlinting devices can sometimes be awkward to use. 
• Heat dissipation is more difficult due to the structure of the laptop computers. 

Netbooks 
Netbook is a tenn used to describe a computer that can almost fit onto a hand and 
is a smaller version of a laptop. These used to be known as palmtop computers, but 
this tenn now generally applies to much smaller devices which use touch screens and 
often a stylus to key in data (see below). 

Adva ntages 

Netlxx>k computers have many of the features of laptops and therefore have similar 
advantages and disadvantages. 

Di sadvantages 

In addition to the disadvantages listed above for laptops: 
• netlxx>ks don't have optical drives 
• the keyboards are only about 80 per cent the size of laptop keyboards 
• they lack some of the features found in larger machines, principally due to the 

size constraints and to the fact that they are cheaper to purchase. 

Personal digital assistants 

Personal digital assistants (PDAs) are small handheld computers that usually 
come with a touch screen that is activated using a stylus. Data (e.g. text) is entered 
by using a keyboard that appears on the touch screen. Originally, these devices were 
used as personal organisers but their use has expanded somewhat to include new 
generation mobile phones, dat a loggers, satellite navigation systems, etc. Many 
PDAs now have basic database, word-processing and spreadsheet facilities. 
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Adva ntages 

• They can be used anywhere because of their size. 
• They are very lightweight and are more portable than laptop computers. 

Di sadvantages 

• It is difficult to enter text quickly. 
• TI1ey have very limited capabilities due to the software and the operating 

system used. 

Mainframe computers 

Afainfr:une computer is a tem1 used for a large, very powerfu~ computer system. 
The name comes from the days when the individual components were housed in 
large (often room-sized) frames. 

Their main purpose is to run commercial applications, such as banking and 
insurance, where huge amounts of data need to be processed each day. 

The main fearures of main frame computers are as follows. 
• They can have several CPUs. 
• They have very fast processor speeds. 
• They can support multiple operating systems. 
• They have huge amounts of storage capacity. 
• They have huge internal memories (e.g. several hundred Gbyte of RAM). 
• They often operate using time sharing or batch processing (see Chapter 7). 

Advantages 

• Due to the features listed above, they can be used to do very large jobs which 
require large memories and very fast processor time. 

• They are used in time-sharing systems to allow users to be given a time slice of 
the very poweiful facilities afforded by a mainframe system. 

• They are capable of very large number crunching, and so can deal with very 
complex mathematical functions ( e.g. fractals ) which would be very time 
consuming using, for example, a PC. 

Di sadvantages 

• Mainframe computers need to be permanently housed in a large room, so cannot 
be moved around. 

• They are very expensive to operate and maintain. 

II 
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Input and output devices 

In this chapter you will learn about: 
• input devices: 

• the uses of each device 
• the advantages of each device 
• the disadvantages of each device 

• output devices: 
• the uses of each device 
• the advantages of each device 
• the disadvantages of each device 

• control applications and the uses of each device. 

2.1 Input devices 
As the name suggests, input devices are hardware devices that allow data to be input 
into a computer. Many such devices exist, ranging from the more common ones, 
such as the keyboard, through to the more specialist devices, such as barcode 
readers. A number are described in this section. 

Keyboards 
These are the most common input devices and are used to input text, numbers and 
instrnctions into the computer. Most use the QWERTY layout (this name comes 
from the keys on the top row, which spell out 'Q\VERTY') . 

Ergonomic keyboards have also been developed recently. These are designed to 

reduce health-related problems associated with the standard keyboard (e.g. carpal 
tunnel syndrome or repetitive strain injury (RSI) - see Section 6.7). 

Uses 

• Keyboards are used to input data into applications software ( e.g. text into word 
processors, numbers into spreadsheets, etc. ). 

• They arc also used for typing in commands to the computer (e.g. Prnt Scm, 
Ctrl + P to print out, etc.) 

Advantages 

• Keyboards enable fast entry of new text into a document. 
• They are a well-tried technology and a well-known method of entry. 
• Most people find them easy to use. 
• It is easy to do verification checks as data is entered, as it appears on the screen 

simultaneously. 

Di sadvantages 

• Users with limited arm/wrist use can find keyboards hard to use. 
• Entering data using a keyboard is slow when compared to direct data entry 

(e.g. optical mark recognition). 
• Keyboards are fairly large devices that use up valuable desk space. 
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TI1e concept keyboard uses icons or phrases instead of standard letters. These are 
often used in, for example, fast food restaurants, offices and shops, where a single 
key represents an item. For example, the symbol shown in the photo represents 'add 
tax'. ~1e p~rson using the keyboard only needs to toud1 this key to calculate the tax 

Advantages 

• Concept keyboards enable fast data entry, as there is no need to type in whole 
commands. 

• They are waterproof, which is useful in a restaurant environment . 

• r;~:;:1::1~1:~r~i:;:J~~J::~t~:~ ~o:~:t;~
1

~!::t~~~~~tt:!
0

~~ying in 
infonnation which could potentially corrupt the computer system. 

Numeric keypads 

A numeric keypad is used to enter numbers only (although some have a function 
key to allow input of alphabetic characters). 

Uses 

• Numeric keypads arc used in automatic teller machines (ATMs), where 
customers can key in their personal identification number (PIN), an amount of 
money,ctc. 

• Telephones have numeric keypads to allow phone numbers, etc. to be keyed in. 
• Electronic point of sale (EPOS) terminals have numeric keypads in case the 

barcode reader fails to read the barccxle and the number has to be keyed in 
manually by the operator. 

• Chip and PIN devices have numeric keypads for entry of PIN, amount of money, etc. 
• They arc used to enable fast entry of numeric data into a spreadsheet. 

Advantages 

• Numeric keypads are faster than standard keyboards for entry of numeric data. 
• Since many are small devices (e.g. mobile phones), they are very easy to carry 

around. 

Disadvantages 

• They can be difficult to use, due to very small keys. 
• It is difficult to use them for entering text. 
• Sometimes the order of the numbers on the keypad isn't inruitive. 

Mice 
The mouse is an example of a pointing device . A ball is used 
underneath the mouse to detect movement, so by moving the 
mouse around the user can control the position of a pointer on 
the screen. There are usually two buttons, whid1 have different 
functions: very often the left button is used to select something 
by double clicking it and the right button brings up drop-down 
menus (see Figure 2.1 ). 

Many mice also have a scroll button, which speeds up the 
process of moving through a document. Figure2.1 Example 

of a drop-down menu 

II 
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Recent developments have produced the optical mouse (where movement is 
detected by reflected light rather than the position of a moving ball) and the 
cordless mouse (which is an example of a wireless device). The advantage of an 
optical mouse is it has no moving parts and it also doesn't pick up any dirt. This 
makes it more robust and improves its peiformance, since the older type of mouse 
can 'skid' on certain suifaces reducing the control of the pointer. 

Uses 

• Mice can be used for opening, closing and minimising software. 
• They can be used for grouping, moving and deleting files. 
• They are very useful when editing images, for example controlling the size and 

position of a drawing pasted into a document. 
• Mice are used for controlling the position of a pointer on the screen to allow 

selection from a menu or selecting an icon and for scrolling up and down/ left 
to right. 

Advantages 

• It can be faster to select an option using a mouse rather than a keyboard. 
• Mice enable rapid navigation through applications and the internet. 
• Mice are small and so take up linle area. 

Disadvantages 

• People with restricted hand/wrist movement can find it hard to operate a mouse. 
• Mice are easily damaged and the older type of mouse also quickly becomes 

clogged up with dirt. 
• They are difficult to use if there is no flatsuiface readily available (e.g. on an 

aeroplane). 

Touchpads 
Touchpads are used in many laptop computers as a pointing device. The pointer is 
controlled by the user moving their finger on the touchpad and then gently tapping it to 
simulate the left hand button of a mouse (i.e. selection). TI1ey also have buttons under 
the touchpad which sem: the same function as the left and right bunons on a mouse. 

Uses 

The uses of a touchpad are tl1e same as those of a mouse. 

Advantages 

• It can be faster to select an option using a touchpad rather than a keyboard. 
• Touchpads enable rapid navigation through applications and the internet. 
• Since the touchpad is integrated into tl1e laptop computer, there is no need for a 

separate mouse, aiding portability. 
• They can be used even when there are no flat surfaces available. 

Disadvantages 

• People with limited hand/wrist movement find touchpads difficult to use. 
• It can be more difficult to control tl1e pointer when compared with a mouse. 
• They are more difficult to use when doing certain operations such as 'drag and drop'. 
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Trackerballs 
Trackerballs arc similar to a mouse, except that the ball is on the top of the device and 
the user controls the pointer on the screen by rotating die ball with the hand. Some 
trackerballs have two buttons which have the same fimction as the left- and right-hand 
mouse buttons. If they have a third button, this is equivalent to a double click. 

Uses 

• They have die same pointing/cursor control capability as a mouse. 
• They are used in applications wherc the user has a disability (such as RSI). 
• They arc used in a control room envirorunent, wherc it is faster than a mouse to 

navigate through process scrccns and is morc robust dian a mouse. 

Advantages 

• Trackerballs do not need die same fine control as a mouse. 
• People with limited hand/wrist movement find it easier to use than a mouse. 
• The pointer can be positioned more accurately on the screen than with a mouse. 
• They take up less desk space dian mice since they arc stationary. 

Disadvantages 

• Trackcrballs arc not supplied with die computer as standard, so they arc more 
expensive. 

• User may need training since they arc not standard equipment. 

Remote controls 

A remote control is used to control the operation of other devices remotely by 
using infra red signals. Tiie buttons on the keypad arc used to select options (such as 
television stations, sound levels on a hifi, timings on a D VD recorder, etc.). 

Uses 

• Most home entertainment devices such as a television, satellite system, DVD 
player/recorder, hifi systems, etc. have remote controls. 

• Remote controls arc also used to control multimedia systems. 
• They are used in industrial applications to rcmotely control processes, stop and 

startmachincry,etc. 

Advantages 

• Remote controls enable devices to be operated from any distance, which is 
particularly useful for people widi disabilities. 

• Some chemical processes are hazardous, so it is safer to operate equipment from 
a distance. 

Disadvantages 

• People with limited hand/wrist movement can find them hard to use. 
• The signal between the control and the device can be easily blocked. 

II 
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Joysticks 
Joysticks have similar functions to mice and trackerballs. By gripping the stick, a 
pointer on the screen can be controlled and buttons are used to make selections. 
Often they have another button on the top of the stick that is used for gaming 
purfOses, e.g. to fire a weapon. 

Uses 

• Video/computer games are often controlled by joysticks. 
• They are used in simulators (e.g . flight simulators) to mimic acrual controls. 

Advantages 

• It is easier to navigate round a screen using a joystick rather than a keyOOard. 
• Control is in three dimensions. 

Disadvantages 

• It is more difficult to control the on-screen pointer with a joystick than with 
other devices, such as a mouse. 

Touch screens 
With this system the user can choose an option by simply touching the button/ icon 
on the screen. TI1e selection is automatically made without the need for any 
pointing device. 

Uses 

• Touch screens are used for self-service tills, e.g. petrol stations, where the user 
just touches the screen to select the fuel grade and payment method. 

• Touch screens are used where selections are made on screen, for example ATMs, 
point of sale tenninals (e.g. at restaurants), public information systems at 
airports, railway stations, tourist offices. 

• Personal digital assistants (PDAs), mobile phones and satellite navigation systems 
use touch screens. 

• Interactive white OOards used for education are large touch screens. 
• Touch screens are used in computer base training (CBT) where selections are 

made in answering on screen testing. 

Advantages 

• Touch screens enable faster entry of options than using a keyOOard or a mouse. 
• It is very easy to choose options. 
• It is a user friendly method for inputting data, so no training is necessary. 
• Touch screens are tamper proof, preventing people from keying in information 

which could potentially corrupt the computer system ( e.g. at unmanned ticket 
collection kiosks). 

Disadvantages 

• There is a limited number of options available. 
• Using touch screens freguently can lead to health problems ( e.g. straining of arm 

muscles,RSl, etc. ). 
• The screen can get very dirty with constant touching. 
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Magnetic stripe readers 

These are used to read information on the magnetic stripe found, for example, on 
the back of a credit card (see Figure 2.2). The stripe contains useful information, 
such as the account number, sort code, expiry date and start date. 

Uses 

• Credit and debit cards have magnetic stripes that are used by ATMs or EFTPOS 
(electronic funds transfer point of sale) terminals. 

• Security cards for entry to buildings, hotel rooms, etc. use magnetic stripes. 
• Travel systems (e.g. train and underground tickets) use magnetic stripes. 

Adva ntages 

• Data entry is faster compared with keying in using a keyboard or keypad. 
• The system is error free, since no typing is involved. 
• The information held on the magnetic stripe is secure: because it cannot be read 

directly by a person; and, since there is no typing, there is not the risk of 
somelxxly observing your key strokes. 

• They can prevent access to restricted/secure areas. 
• Magnetic stripes are unaffected by oil, water, moisture, etc. 
• There are no moving parts, so they are physically very robust. 

Di sadvantages 

• If the magnetic stripe gets damaged ( e.g. due to exposure to a strong magnetic 
field or excessive use) the data is lost. 

• The card needs to be in close contact witl1 the reader, so magnetic stripe readers 
don't work at a distance. 

• Since tl1e information is not human readable, this can be a disadvantage in some 
applications (e.g. hotel room numbers are not printed on the card, so tl1ere needs 
to be another way of showing the information for the customer). 

Smart card readers 

Smart cards contain cl1ips (see Figure 2.3) and are similar to magnetic stripe cards. 
With these cards the infonnation is stored on tl1e chip (e.g. PIN and personal data). 
The data stored on the chip can be updated (e.g. on loyalty cards). For example, 
certain oil companies use these cards: when a customer buys fuel at a filling station, 
the loyalty card is swiped and 'points' are added to the card; these points can be used 
for air miles, money off next purchases, and so on. The storage capacity of the chip 
is much greater than a magnetic stripe, so more infonnation (such as customer 
details) can be stored. 

Uses 

• Loyalty cards, ID cards and public transport passes use smart cards. 
• Smart cards can be used to track customer/passenger movements ( e.g. on a metro 

system). 
Figure 2.3 The chip • They are used with satellite systems to decode program signals. 
on a smart card • Smart cards are used for electronic passports and driving licences. 

II 



II 

Information and Communication Technology 

Adva ntages 

• Some smart cards (e.g. transport tickets) are used instead of money, reducing the 
need to carry cash. 

• The chip on the card does not need to be in contact with reader, so there is less 
damage compared with a magnetic stripe reader. 

• Data is more secure, since it is easier to copy information on a magnetic stripe 
than it is to copy information on a chip. 

Di sadvantages 

If the card is lost, information stored on the chip could be used in identity theft. 

Chip and PIN readers 
Chip and PIN readers are similar to smart card readers, but are used at EFTPOS 
terminals. The device has a slot into which the card is placed and the chip is read. 
The PIN is entered using the keypad. A small screen is also part of the reader, which 
gives instrnctions to the operator. 

Uses 

• Chip and PIN readers are used where payments are made using cards 
(restaurants, supennarkets, travel agents, etc.). 

Adva ntages 

• Chip and PIN readers provide a more secure payment system than 11X]Uiring a 
signarure or using a magnetic stripe, since the PIN typed in must match up with 
PIN stored on chip. 

• Chip and PIN readers provide a more robust system than magnetic stripe readers, 
since the chip does not need to be in contact with the reader. 

Di sadvantages 

• Since the customer types in the PIN, they need to be careful that it isn't read by 
somelxxly else, thus giving an opportunity for fraud. 

Scanners 
Scanners are used to enter information on hard copy ( e.g. text documents, 
photographs) into a computer. The most common type is the flat bed (as shown 
here) which is made up of a glass panel and lid. TI1e hard copy document or photo is 
scanned by a light source and produces a computer-readable image. 

The subsequent image can then be manipulated using a drawing package. Images 
can also be used with optical character recognition (OCR) software to allow the 
infonnation to used in a word processor, desktop publishing, presentation software, 
etc. Specialist scanners exist which are designed to carry out a specific task, 
e.g. barcodc scanners (discussed later in this section). 

Uses 

• Scanners arc used to scan in documents and convert them into a format for use in 
various software packages. 

• Old and valuable documents and books can be scanned, thus protecting the 
originals from damage through handling and also producing records in case the 
paper copies are lost or destroyed. 

• Non-digital photographs need to be scanned if they are to be stored on computer. 
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Advantages 

• Images can be stored for editing at a later date (paper documents cannot be 
edited unless they are scanned first). 

• Scanners are much faster and more accurate (i.e. no typing errors) than typing in 
doa1ments again. 

• It is fOSSible to recover damaged documents and photographs by scanning them 
and then using appropriate software to produce an acceptable copy. 

Disadvantages 

• The quality can be limited, depending on how good the scanner resolution is. 

Barcode readers 

Barcode readers are used to read infonnation in the fonn of a bar code (illustrated 
in Figure 2.4). The readers are usually in the fonn of a barcode scanner and are 
often built into POS tenninals in supennarkeni. HandJJeld scmmers or wands (as 
shown here) are also very common for reading barcodes if portability is required 
(e.g. if the barcodes are on large or fixed objects). 

Uses 

• Barcode scanners are used in supennarkets and other shops where the goods are 
marked with a barcode; the barcodes are used to give infonnation about the 
product, which enables automatic stock control, itemised billing, etc. to take place. 

• They arc used in libraries, to scan 00th users' library cards and barcodes on 
books, in order to keep track of books on loan. 

• They arc used as a safety fimction in many companies to ensure that electrical 
equipment is checked on a regular basis. Barcodcs arc placed on an item to 
identify it and a database holds all the information related to that barcodc so it is 
possible to interrogate the system as part of a safety audit. 

Advantages 

• Scanning barcodcs is much faster than keying in data manually and fewer 
mistakes are made. 

• \Vhen barcodcs are used as a way of recording data, they can improve safety. 
• Barcodcs enable automatic stock control. 
• Barcodc scanning is a tried and trusted technology. 
• \Vhcn an item price is changed, only the central database needs to be updated. 

There is no need to change the prices individually on each item. 

Disadvantages 

• Barcode scanning is a relatively expensive system to administer since every item in 
the shop needs a barcode and every barcodc needs to be entered on to the central 
database. Also, there is a need to invest in the computer technology together with 
staff training, which can all be very expensive. 

• The system is not fCXJlproof - barcodes can be swapped around on items! 

II 
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OMR devices 
Optical mark recognition (OMR) is a system which can read marks written in pen 
or pencil. The places where the pen or pencil marks can be made are clearly shown 
on the form, for example: 

le-• 2 • • 3 • e 
In this example, a pencil mark has been made between the dots on answer 1. TI1e 
position of the mark is stored in the computer's memory after being read by the 
OMRdevice. 

Uses 

• OMR devices are used to read questionnaires, multiple-choice examination 
papers and many other types of form where responses are registered in the form 
of lines or shaded areas. 

Advantages 

• It is a very fast way of inputting the results of a survey, etc. - the documents are 
fed in automatically and there is no user input. 

• Since there is no typing, it is more accurate than keying in the data. 
• OMR is more accurate than OCR (discussed later in this section). 

Di sadvantages 

• The fonns need to be carefully designed to make sure that the marks/shading are 
correctly positioned to gather accurate information. 

• There can be problems if the forms haven't been filled in correctly and sometimes 
they have to be manually checked before being read by the OMR device - this is 
both time consuming and expensive. 

OCR readers 
Optical character recognition (OCR) is the name given to software that takes 
scanned text and converts it into a computer readable form. The text can then be 
used in various application packages such as word processors, desktop publishers 
and presentation software. 

Uses 

• One of the most recent uses is in the processing of passports and identity cards. 
• OCR is used when scanning in documents so that they can be modified using a 

word processor or desktop publisher package. 

Advantages 

• It is a much faster data entry system than manually keying in data. 
• Since no manual data entry, the number of errors is also reduced. 

Di sadvantages 

• The system still has difficulty reading handwriting. 
• It is still not a very accurate technique. 
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MICR devices 
Magnetic ink character recognition (MICR) is a characters 

system which can read characters printed in a special ink ~~iR by 
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can understand and then stored in a computer file. Figure2.5 Abankcheque 

Uses 

• It is primarily used to process cheques in banking operations. When a cheque is 
presented its value is then printed on the cheque in the special ink. The cheques 
are all gathered together ( either at the end of the day or after some specified 
period) and then read using a batch processing method (see Section 7.9). 

Adva ntages 

• MICR offers greater security than OCR since the printed characters cannot 
be altered. 

• There is no manual input, thus errors are reduced. 
• Even if somebody writes over the magnetic ink characters ( e.g. with a signamre) 

they can still be read. 

Di sadvantages 

• Only certain characters can be read and the number of different characters is 
very limited. 

• It is a more expensive method than other methods used in direct data entry. 

Digital cameras 
Digital cameras are rapidly replacing traditional, film-based cameras. Once 
photographs are stored in memory, they are easily transferred to a computer using a 
uni\'ersal serial bus (USB) connection (see Figure 2.6). Once saved, the images 
can be manipulated (e.g. cropped, re-sized, contrast altered, etc.). 

Uses 

• Digital cameras produce photographs for transfer to a computer directly or to 

print out by connecting directly to a printer. 
• Many digital cameras also allow short video clips to be produced. 
• Photographs can be uploaded directly into applications software such as word 

processors, desk.top publishers, etc. 

Adva ntages 

• It is easier to produce better quality photographs than with a traditional camera. 
• It is easier and faster to upload photographs to a computer rather than having to 

scan in hard copies when using traditional metlmds. 
• There is no need to develop film and print out photographs any more - this saves 

money and is also environmentally more acceptable (saves paper and no longer 
need the chemicals used in developing the films ). 

• It is easy just to delete an image from memory if it is not satisfactory and take the 
photograph again. 

• The memory cards can store several hundred photographs. A traditional camera 
was limited by tl1e number of photographs that could be taken on a roll of film. Ill 
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Disadvantages 

• The camera user needs to be computer literate to use the cameras properly; also 
the transferring, storing and manipulating of the images via a computer requires 
some understanding of how computers work. 

• There is some artistry lost since clever software now corrects errors in the 
photographs ( e.g. incorrect exposure, removal of red eye, etc. ). 

• The resolution is not yet as good as traditional cameras, although this is 
improving all the time. 111c quality of photographs depends on the number of 
pixels (many cameras now off"cr more than 10 mega pixels per image), quality of 
lens, etc. 

• Images often need to be compressed to reduce the amount of memory used 
(a single image can use more than 2 Mbyrcs of memory, for example). 

• It is possible to fill up computer memory very quickly with several photographs of 
the same subject in an attempt to find the 'perfect' snap shot. 

Webcams 
Webc:uns arc similar to digital video cameras; however, they arc connected directly 
to the computer (through a USB port) and they do not have a memory. The 
infonnation tl1at tl1c wcbcam picks up is transmitted directly to the computer. Many 
computer systems now have wcbcams built into the top of their monitors as 
standard equipment. 

Uses 

• \Vhilc chatting onlinc, many people use wcbcams as a more personal way of 
having a conversation. 

• They arc used to enable video conferencing to take place (discussed in Chapter 4). 

Advantages 

• Wcbcams can be left on constantly, only being activated as required . 
• They allow people to keep in contact with each otl1cr without the need to travc~ 

so they arc particularly useful for elderly or disabled people. 

Disadvantages 

• Wcbcams have very limited fcamrcs and the picture is often of poor quality. 
• They need to be connected to the computer, although tl1is is less of an issue with 

laptop computers when the wcbcam is built into the monitor lid. 

Microphones 
Microphones can be connected directly to a computer. Sounds can be inputtcd and 
then manipulated. 111c input sound is converted to an analogue signal and tl1cn 
converted into a digital signal. 111c computer's sound card usually docs this 
automatically (i.e. it acts as an analogue to digital converter (ADC) . 
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Uses 

• Microphones are used to input speech/ sounds to be used in various applications, 
e.g. presentations, sampling (in films, music, etc.) , special effects (films ). 

• They are used in voice recognition software, which can have a number of 
purposes, for example: 
• conversion of speech into text that can be used in, for example, a word processor 
• recognition of commands ( e.g. some cars now have voice-activated systems to 

switch on the lights, rum up the radio volume, etc. ). 

Adva ntages 

• It is faster to read in text than to type it in using a keyboard. 
• Using special software, it is possible to manipulate sound in real time rather than 

working on a recording done at some earlier stage. 
• If used in a voice activation system, this has the advantage of improving safety 

since, for example, car drivers don't need to take their hands off the wheel to 

operate a switch or alter the radio station etc. 

Di sadvantages 

• Sound files can use up a lot of computer memory. 
• Voice recognition software isn't as accurate as typing in manually (for example, 

the software can't distinguish the difference between 'their' and 'there'). 

Sensors 
This section deals with analogue sensors. A sensor is a device which inputs data to 
a computer, where the data is a measurement of some physical quantity which is 
continuously changing (e.g. temperature, light, moisture, etc.). These physical 
quantities are analogue in narure. Since computers only understand digital data 
(i.e. ls and Os), the information from the sensors needs to be convened into a digital 
form. This is done using an analogue to digital converter (ADC). 

Uses 

Sensors are used in monitoring and control applications - the type of sensor depends 
on the application (see Table 2.1 ). \Vhen monitoring, the data sent to the computer 
is often transferred directly to a spreadsheet package ( e.g. taking measurements in a 
scientific experiment, measuring atmospheric pollution, etc.). 

Temperature 

Pressure 

Light 

Sound 

Humidity/moisture 

pH 

Automatic washing machines, central heating systems, 
automatic greenhouses, ovens 

Burglar alarm systems, washing machines, robotics, 
environmental monitoring 

Automatic greenhouses, automatic doors, burglar alarm systems, 
street lighting control 

Burglar alarm systems, monitoring liquid and powder flow in pipes 

Automatic greenhouses, environmental monitoring, factories 
where moisture levels are crucial (e.g. manufacture of 
microchips, paint spraying) 

Automatic greenhouses, chemical processes, environmental 
monitoring 

Table 2.1 Applications of different types of sensors II 
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Advantages 

• Readings taken using sensors are generally more accurate that those taken by 
human operators. 

• Readings are continuous, so there is no break in the monitoring. 
• Because it is a continuous process, any necessary action (control system) or 

warning (monitoring system) will be initiated immediately. 
• The system can be automatic, removing the need for human intervention. This is 

particularly important if the process is hazardous or needs precise 
control/monitoring. 

Disadvantages 

• Faulty sensors can give spurious results (e.g. if the sensors on the rear bumper of 
a car which monitor for obstacles become dirty, they may either not identify an 
obstacle or give a continuous alarm). 

Graphics tablets 
A graphics tablet is used with a stylu s to produce frediand drawings for example. 
The images produced can then be stored in a file on a computer. 

Uses 

• Graphics tablets are used to produce drawings, computer graphics, etc. 
• In countries where characters are complex (e.g. China, Japan), they are used as a 

fom1 of input since it is faster than typing in the characters using a keyboard. 
• They are used in computer aided design (CAD) work. 

Advantages 

• It is possible to modify drawings before they are input. 
• They offer a very accurate method of drawing, which is better than using a mouse 

ortrackerball. 

Disadvantages 

• They are more expensive than other pointing devices, such as a mouse. 

Light pens 
Light pens contain sensors that send signals to a computer whenever light changes 
arc detected. At the moment, the devices only work with cathode ray tube (CRT) 
monitors (see Section 2.1 ) because they rely on the screen image being built up row 
by row by an electron beam. The screen is refreshed SO times every second, so the 
computer is able to detennine the pen's position by noting exactly when the light 
pen detected the electron beam passing its tip. Systems to operate with thin film 
transistor (TFT) monitors are still at the development stage. 

Uses 

• Light pens are used for selecting objects on CRT screens. 
• They are also used for drawing on screen (e.g. with CAD packages). 
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Advantages 

• Light pens are more accurate than touch screens. 
• They are small, so can be used where space is an issue. 
• They are easy to use. 

Disadvantages 

• There are problems with lag when drawing on screen. 
• At the moment, they only work with CRT monitors. 
• They are not very accurate when drawing. 

2.2 Output devices 
As the name suggests, output devices are hardware devices that allow data to be 
output from a computer. Some devices hold the data temporarily (such as a printer) 
whereas other devices produce pennanent output in the form of a hard copy (such 
as a printer producing output on paper). There is a third type of output device 
which is used to control processes in conjunction with sensor input devices. These 
are covered separately in Section 1.3. 

CRT monitors 
CRT monitors are the least expensive type of monitor, although they are becoming 
increasingly rare as TFT monitors are now taking over. They come in various sizes. 
TI1ey use an electron gun to fire against a phosphor screen, which creates a picture 
that is made up of tiny dots. Each dot is coloured red, green or blue - the intensity 
of each coloured dot makes up the vast range of colours interpreted by the eye. 

Uses 

• CRT monitors are used as the primary output device for computers so the user 
can see immediately what they are typing in. 

• They are used with light pens, for example to allow designs to be created on screen. 

Advantages 

• CRT monitors still produce a higher quality image than TFT monitors. 
• The angle of viewing is still better than with a TFr monitor. 
• They work with light pens in computer-aided design and computer-aided 

manufacturing (CAD/CAM) applications. 

Disadvantages 

• CRT monitors tend to be rather heavy and are a weight hazard if not supported 
properly. 

• They nm very hot and can cause fires if left unattended ( especially as they get older). 
• They consume considerably more power than the modern TFr monitors. 
• They can flicker, which can lead to headaches and eyesight problems with 

prolonged use. 

II 
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• TFT monitors 

TFf monitors are taking over from CRT monitors as the main output device. One 
of the reasons for the rapid development of laptop computers can be attributed to 
the advancements made in TIT technology. The screen is made up of thousands of 
tiny pixels, which are made up of transistors controlled by a microprocessor. Each 
pixel has three transistors, coloured red, green or blue; the intensity of each governs 
the effective colour of the pixel seen by the eye. 

Uses 

• TFf monitors are used as the primary output device for computers so the user 
can sec immediately what they are typing in. 

• They are an integral part of laptop computers. 

Adva ntages 

• TFf monitors are lightweight, so do not pose the same risks as CRT monitors. 
• They produce less glare than CRT monitors and also emit less radiation. 
• They consume much less power and do not generate as much heat as a CRT 

monitor. 

Di sadvantages 

• The angle of viewing a TIT monitor is fairly critical, with the image appearing 
unclear when viewed slightly from the side. TI1is can be an issue if several people 
arc looking at a screen at the same time. 

• The definition is sometimes not as good as CRT monitors. 
• TFf monitors cannot yet be used with light pens, so these monitors cannot be 

used in CAD iflighr pens are used to create and edit drawings. 

Laser printers 

Laser printers produce very high-gualiry hard copy output. 111c print rate per page 
is very guick if a large number of pages are being printed. They rely on large buffer 
memories, where the data for the whole document is stored before the pages can be 
printed out. 

Uses 

• Laser printers are used where noise levels need to be kept low (e.g. in an office). 
• They are the best option for fast high quality high volume printing. 

Adva ntages 

• Printing is fast for high volumes. If only a few pages are to be printed they are 
little faster than inkjct printers. 

• They can handle very large print jobs. 
• The gualiry is consistently high. 
• Toner cartridges last for a long time, so laser printers can be a cost effective 

option, particularly if colour outputs arc not required. 



Input and output devices 

Disadvantages 
• Laser printers are expensive to buy. 
• They are only really fast if several copies are being made. 
• Colour laser printers tend to be expensive to run, since four cartridges (three 

colours plus black) are needed as well as diffoser kits, etc. 
• They produce ozone and volatile organic compounds because of their method of 

printing and type of toner/ink used. These have been linked to health hazards in 
the office. 

lnkjet printers 
lnkjet printer s are used to produce good quality hard copies. Although the quality is 
not quite as good as that from bser printers, it is far better than that from dot matrix 

1 •••• ~ printers. Unlike laser printers, inkjet printers do not have large buffers, so printing is 
done a bit at a time. This is why printing is sometimes paused, since the whole page 
can't be stored in the buffer and it has to wait for the computer to send more data. 

• 

Uses 
• lnkjet printers are used where low output volumes are required. 
• Ifhigh-quality printing is required for single pages (or only a small print job) 

then these printers are ideal, for example they are very good at producing photo 
quality printouts. 

• 3D inkjet printers are now being used in industry to produce prototypes (see below). 

Adva ntages 
• The output is of high quality. 
• lnkjet printers are cheaper to buy than laser printers. 
• They are very lightweight and have a small footprint (i.e. take up little space). 
• They do not produce ozone and volatile organic compounds, unlike laser printers. 

Disadvantages 
• The output is slow if several copies needed, as there is little buffer capacity to 

store the pages. 
• The ink cartridges run out too quickly to be used for large print jobs. 
• Printing can 'smudge' if the user is not careful. 
e Inkjet printers can be expensive to run if they are used a lot, since original ink 

cartridges are expensive. 

3D inkjet p rinters 
These are a new type of printer that produce solid 3D models using modified inkjet 
technology. In this technology, known as 'tomography', thin layers of fine powder 
(plaster, resin and starch) are bonded together as a 3D model is slowly built up 
(each layer is only about 0.25mm thick). Figure 2.7 shows some items produced on 
a 3 D inkj et printer - these are known as prototypes . 

Figure 2.7 A prototype produced on a 3D inkjet printer II 
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Uses 

• Inkjet printers are used to produce prototypes which acn1ally work from CAD 
packages, photograph images, stored drawings, etc. 

• Scale models are produced in colour before the real thing is manufactured. 
• The ultimate objective is to produce organic objects (such as replacement human 

organs) using this layering technology. 

Advantages 

• 3D inkjet printers save a lot of money, since making prototypes by other 
methods is very time consuming and expensive. 

• Physical scale models are produced with working parts, which gives a better idea 
ofhow the end product will look. 

• The powders used can often be ground up and re-used. 

Disadvantages 

• 3D inkjet printers are expensive to buy. 
• They are slow at producing their output. 
• The end product can sometimes be a little rough and often needs further work to 

be done on it. 

Dot matrix printers 

Dot matrix printers are a type of impact printer, where a printhead (made up ofa 
matrix of pins) presses against an inked ribbon. They tend to be slow, noisy and the 
output is not good quality. They are still useful, however, where multi-part or 
continuous stationery ( e.g. long reams of perforated paper) is being used. 

Uses 

• They can be used in noisy environments (e.g. garage workshops) and in 
applications where print quality is not very important. 

Advantages 

• Dot matrix printers can be used in environments which would be a problem for 
laser or ink jet printers ( e.g. dusty, dirty or moist atmospheres). 

• Carlx:m copies or multi-part outputs can be produced. 
• They are very cheap to nm and maintain. 
• They are easy to use if continuous stationery is required (e.g. long print jobs such 

as wages slips). 

Disadvantages 

• They are very noisy and so not gcxxl in an office environment. 
• They cost more than an ink.jct printer to buy. 
• They arc very slow and the printing is of poor quality. 
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Plotters 
Plotters (also known as graph plotters) are devices that produce hard copies, but 
operate in a different way to printers. They are not limited to normal printer paper 
size and are capable of producing highly accurate, very large drawings and posters. 
The most common types are pen plotters (which use coloured pens to draw), 
electrostatic (similar method to laser printers) and inkjet plotters. With pen plotters 
the coloured pens are controlled by a computer and the paper can move backwards 
and forwards to allow accurate shapes to be drawn. 

Uses 

• Plotters are used to produce large drawings (e.g. blueprints of buildings, 
factories, etc.) and are often used with CAD applications. 

• They are used to produce large pictures for use on billboards or giant posters. 
They can also print on plastic-coated paper. 

• If the pens are replaced with cutting tools, it is also possible to make large signs. 

Adva ntages 

• They can produce huge printouts. 
• The print guality is extremely high. 

Di sadvantages 

• They are slow in operation. 
• They are expensive, both to buy and to maintain. 

Speakers 
Speakers can be connected directly to a computer or are built into the monitor or 
casing (as in a laptop computer). Digital data from the computer is converted into 
analogue form, using a digital to analogue converter (DAC). The signal is then 
amplified through the speakers. 

Uses 

• Speakers are used to output sound from multimedia presentations. 
• They are used in home entertaimnent centres. 
• They can help blind people (together with speech generation software) through 

audio output of text on the screen. 
• They are used to play downloaded sound files. 

Multimedia projectors 

Multimedia projectors receive signals that can be either analogue or digital, 
although most modem projectors only work with digital inputs. TI1e signal source is 
usually from a computer, television or DVD player. The image from the source is 
magnified and projected onto a large screen. TI1e devices usually work with a remote 
contra~ but can also use vim1al mouse technology which actually becomes a cordless 
PC mouse with the same features as a mouse. It is then possible to direct the 
computer presentation without being tied to the computer. Another feature of the 
virtual mouse is the laser pointer. Most multimedia projectors take input from 
various types of video fonnat such as NTSC, PAL or SECAM. 

II 
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Uses 

• Multimedia projectors are used for training presentations (to allow the whole 
audience to see the images from a computer). 

• TI1ey are also used for advertising presentations (large images showing product 
features of, for example, a new car, can be shown at exhibitions, shopping 
malls,etc. ). 

• Home cinema systems (projecting the images from a DVD or television) use 
multimedia projectors. 

Adva ntages 

• They enable many people to see a presentation rather than all of them crowding 
round a small computer screen. 

• They avoid the need for several networked computers. For example, when 
looking at a video clip on an internet site, everylxxly can see the video on the 
large screen rather than logging on to a number of computers. 

Di sadvantages 

• Images can sometimes be fuzzy. 
• Multimedia projectors are expensive to buy. 
• Setting up projectors can be a little difficult. 

2.3 Contro l devices 
Control devices are anotl1er type of output device. They are used to control 
processes in conjunction witl1 sensor input devices. TI1is section gives an overview of 
actuators and the devices that they operate, but the use of sensors and actuators are 
covered in more depth in Section 7.7. 

Actuators 
Actuators are transducers and are used to take signals from a computer and 
convert them into some form of motion, for example operating motors, pumps, 
switcl1es and valves. As part of tl1e control process, digital signals are sent from the 
computer to an actuator to operate a device. Usually, conversion of the digital signal 
to analogue is required first (using a DAC). 

Motors 
The motor is rurned on or off by tl1e actuator. 

Uses 

• Motors are used in many domestic appliances, such as automatic washing 
machines (to make tl1e drnm rotate), cookers (to switch on fans ), water pumps in 
central heating systems and automatic greenhouses to open windows and switch 
on fans. 

• In industry, they are used to control roOOt anns. 
• In computers, they operate fans, disk drives and DVD drives. 



Buzzers 

TI1e buzzers are switched on or off by the actuator. 

Uses 
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• Buzzers are used in cookers and microwave ovens to tell the operator when the 
cooking process is complete. 

• They are used in burglar alarm systems to warn if intruders are present. 

Lights 

TI1e acn1ator is connected to the switch that turns the lights on or off. 

Uses 

• They are used for security lights. 
• Lights are used in greenhouses to control the lighting conditions. 

Heaters 

Actuators are connected to switches which run1 the heater on or off. 

Uses 

• H eaters are used in automatic washing machines, cookers and central heating 
systems. 

• H eaters are used in automatic greenhouses to control the temperature. 
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In this chapter you will learn about: 
• back-up storage 
• why it is necessary to back up data and files 
• the types of access used by the backing stores 
• the types of internal and external backing storage devices: 

• magnetic 
• optical 
• solid state. 

3 .1 Backing up da ta 
The first two sections in this chapter consider the need for backing up data and the 
different ways of storing and accessing data. Section 3.3 then discusses many forms 
of backing storage and compares the advantages and disadvantages of each type. 
The comparative performance and main uses for each type of store are also discussed 
in some depth. 

Whal is backing up of data? 
Backing up refers to the copying of files and data to a different medium (disk., tape, 
flash drive, etc. ) in case of a problem with the main storage device. Backing up files 
and data on a regular basis is seen as good computing practice and many computer 
systems can be set to back up files automatically on a regular basis. 

The backups are often stored in a different place to the main storage. This is in 
case of fire or some other situation which could lead to irretrievable loss of key data 
and files. 

Why back up data? 
There are various reasons why backups are made. Some of the more common 
reasons are considered below: 
• D ata could be lost due to failure of the original storage device. 1l1is could be due 

to hardware failure (e.g. head crash on a hard drive unit), problems caused by 
files being over-written accidentally ( or otherwise) or possible corrnption of files 
(e.g. caused by power surges). 

• H ackers could be responsible for the corn.iption or even loss of data. This may 
not be their intention (they may only want to gain access to the infonnation for 
other purposes, e.g. to find personal infonnation such as bank account details). 
H owever, the very act ofhacking into files could cause problems such as 
corrnption or data loss. 

• Backups arc also made in case the files need to be used elsewhere. The original 
files arc then protected against possible corrnption or loss. 

H owever, backups do not necessarily guard against the effect of a virns. The virns 
could attach itself to the files which could mean that the backups were also affected. 
If the computer was 'cleaned' of the virns and then the backup files were re-loaded 
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there would remain the risk that the same vims could infect the computer system 
again. The best protection is not to get a vims in the first place (discussed in 
Chapter6). 

3.2 Types of access 
TI1e way data is stored and read by different backing storage devices varies 
considerably. This section briefly describes the two main methods of accessing data. 

Serial access 
With this system, to access data it is necessary to start at the beginning and then 
access each piece of data in tum until the required information is found. 

It is primarily used on magnetic tape systems and is a very slow fonn of access. It 
is used in applications where speed of access or 
where the order in which the data is accessed is 
not important, for example in utility billing, 
clearing bank cheques or producing pay slips. 

vVhen a magnetic tape needs updating, an 
additional tape is required so that the old 
infonnation can be merged with the new data 
(itself often on another tape, but the new data 
could be stored in various ways) to produce the Figure 3.1 Updating the data on a 
updated tape (see Figure 3.1). magnetic tape 

Direct access 
TI1is method is used with magnetic disks and with optical media (such as CDs and 
DVDs). TI1e computer uses a key field to calculate where data has been stored. It is 
then able to access the data directly from the calculated position. Consequently, 
access is much faster than with serial access. 

It is used in applications where access speed is vital (e.g. in real-time process 
control systems such as controlling a chemical plant or online systems such as 
booking air tickets or automatic stock control). 

vVhen updating media which uses direct access, the new data is written to the 
next available location and its position is calculated using the built-in algorithm. 

3.3 Backing storage media 
Dating back to the development of the personal computer, all computer systems 
have come equipped with some form of backing storage. \Vhen a user types data 
into a computer, the infonnation is stored temporarily on the RMI - however, this 
infonnation would be lost as soon as the computer was rurned off. Backing storage 
devices ensure that data is stored pennanently and can be used at a later date. 1l1is 
section will be considering various types of backing storage and the media used. 

Backing storage devices are either internal or external (i.e. plug-in devices) to the 
computer, and are one of three types: 
• magnetic 
• optical 
• solid state. 

II 
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Fixed hard disk 
Fixed hard disk drives are available on all computers and are the main method used 
for data storage. On a PC this is usually a fixed hard disk with read/write heads 
allowing data to be written to or read from the disk smface. The disk surface is 
coated in a magnetic film which allows data to be stored by altering the magnetic 
properties to represent binary l s or 0s (the fundamental units of computer 
memories). TI1e hard drive disks usually store the disk operating system (DOS) 
and other important software and files. Applications software (e.g. spreadsheets and 
word processors) need a hard drive to allow them to quickly retrieve and save data. 

Uses 

• Fixed hard drives are used to store the operating system and working data. 
• They are used for storing applications software that needs fast retrieval and 

storage of data. 
• Real-time systems (e.g. roOOts, control of a chemical plant) and online systems 

(e.g. booking airline tickets, automatic stock control (using EPOS)) used fixed 
hard drives. 

• They are used in file servers for computer networks. 

Adva ntages 

• They have a very fast data transfer rate and fast access times to data. 
• They have very large memory capacities. 

Di sadvantages 

• TI1ey can be fairly easily damaged (e.g. if the correct shut-down procedure on a 
laptop computer has not been correctly carried out and the computer is then moved). 

• They lack portabiliry unless a portable hard disk drive is used (see next sub-section). 

Portable hard disk drives 
These devices work in much the same way as fixed hard disk drives but are usually 
connected to the computer via a universal serial bus (USB) port and can be 
disconnected and used on different computers. TI1e disks are generally capable of 
storing more data than the equivalent optical disk (CD, DVD and so on). 

Uses 

• Portable hard disks can be used as back-up systems to prevent loss of data. 
• They can be used to transfer data, files and software between computers. 

Adva ntages 

• The data access time and data transfer rate is very fast. 
• They have large memory capacities. 
• They can be used as a method of transferring information between computers. 

Di sadvantages 

• k with fixed drives, a portable hard disk can be easily damaged if the user 
accidentally drops it or does not shut it down correctly after use. 
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Floppy disk drives 
Floppy disks are still used on some computer systems. They consist of a thin disk of 
plastic which is housed in a plastic case with a window where the disk can be 
accessed. As the disk rotates, a read/write head is used to add or read data stored on 
the smface. 

Uses 

• 1l1ey are still used where small files need to be transferred/stored 
(e.g. word-processed documents). 

• Some older computer systems still make use of this method of storage. 

Advantages 

• Using a CD to store a small file (e.g. a word-processed document) is often 
regarded as wasteful - especially ifCD-R is used. 

• It is a very simple technology. Floppy disk drives are also extremely low cost 
items to buy. 

Disadvantages 

• Floppy disks have a very low memory capacity when compared to CD/DVDs, 
for example. 

• Very few modern computers have floppy disk drives. 
• The data transfer rate is slow compared to more modern data storage devices. 
• Floppy disks are not very robust. 

Magnetic tapes 
A m agnetic tape is a very thin strip of plastic which is coated in a magnetic layer. 
They are read and written to by a read/write head. The data is stored in magnetic areas 
which represent l s and Os. Data is written to and read from the tape in sequence 

tei1:
1
:h~:~~1~r DC~e,X j:~:ec~;;~;~ ~i ~rda~d;a;t~b~t:~ ~~o~~l~~ 

necessary to read E, D and C first before getting to the reguired record. 1l1is is known 
as serial access. 1l1is type of storage is useless in a real-time or online application (due 
to the very slow access speeds) and is best suited to offiine or batch processing. 

Uses 

• Magnetic tapes are used in applications where batch processing is used, for 
example in clearing bank chegues, utility billing (gas, electricity, water) and 
producing pay slips. In these applications, there is no need for any specific 
processing order and speed of data access is not important). 

• They are used as a back-up media since all the data needs to be stored. 

Advantages 

• They are generally less expensive than the eguivalent-capacity hard disk. 
• It is a very robust technology. 
• The data transfer rate is fast. 

II 
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Disadvantages 

• Access time is very slow. 
• When updating, another tape is needed (i.e. original tape + tape with the 

changes produces an up:lated tape). 

Optical storage media 

Optical storage devices, such as CD and DVD, all use optical (i.e. light) read/write 
methods, unlike tapes and floppy/hard drive disks which are magnetic media. A laser 
beam is used to write to and read from the optical media. 

The CDs and DVDs are manufacn1rcd either from a single polycarbonate disk or 
from two polycarbonate disks bonded together. A very thin layer of metal or organic 
dye is used as the recording media. The big advantage of these storage media is that 
they are portable and can store large data files (e.g. films, music or multimedia files) 
which would be too large for a floppy disk. 

CD-ROM and DVD-ROM 

CD-ROMs and DVD-ROMs are read only memory (ROM), which means they 
cannot be written over and can only be read. 1l1c data is stored as a series of pits 
(equivalent to a binary value of 1) and lands (equivalent to the binary value ofO) in 
the metallic optical layer. The pits are formed by a laser beam etching the surface at 
the manufacturing stage. Only a single track exists which spirals out from the centre 
of the disk. 

The pits and lands are read by a low-powered laser beam which follows the data 
stream and reads from the centre outwards in a spiral. The light reflects differently 
off a pit than it does off a land and this is interpreted as ls and Os (i.e. data) - hence 
the term digital media. 

Uses 

• CD-ROMs are used by manufacturers to store music files and software, 
computer games and rcti:rcncc software (such as an encyclopcdia). 

• DVD-ROMs have much larger storage capacity than CD-ROMs and arc used to 
store films. They are now increasingly used to store computer data and ever-more 
sophisticated computer and arcade games. 

Adva ntages 

• They hold far more data tl1an floppy disks, so one CD/ DVD could replace several 
floppy disks in some applications. 

• They are less expensive tl1an hard disk drive systems. 

Di sadvantages 

• The data transfer rate and data access time arc slower than for hard disks. 

CD-Rand DVD-R 

The letter 'R' here means tl1c disk is recordable once only and then it becomes a 
CD-ROM or DVD-ROM. These use a thin layer of an organic dye as the recording 
media; DVDs also use an additional silver alloy or gold reflector. A laser beam 
produces heated spots and unheated spots. On reading the disk, a laser beam is 
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capable of distinguishing between the two types of spots and effectively reads the 
data stream from the centre outwards in a spiral action. This data is then interpreted 
as ls and Os. 

Uses 

• They are used for home recordings of music (CD-Rs) and films (DVD-Rs). 
• They are used to store data to be kept for later use or to be transferred to another 

computer. 
• They arc used in applications where it is necessary to prevent the deletion or 

over-writing of important data). 

Adva ntages 

• CD-Rs and DVD-Rs are cheaper than RW disks. 
• Once burned (and finali sed ), they are like ROM disks. 

Di sadvantages 

• They can only be recorded once, so if an error occurs then the disk has to be 
thrown away. 

e Not all CD/ DVD players can read CD-R/DVD-R. 

CD-RW and DVD-RW 
The 'R \V' means that these disks are a re-writable media and can be written over 
several times. Unlike CD-R/DVD-R, they don't become ROMs. The recording 
layer uses a special phase-changing metal alloy. The alloy can switch between 
crystalline and amorphous (non-crystalline) phases, thus changing its reflectivity to 

light, depending on the laser beam power. Spots are produced which can be read by 
a laser and then interpreted as ls and Os . The system allows data to be written, 
erased and re-written many times. 

Uses 

• CD-RWs and DVD-RWs are used to record radio and television programmes, 
but can be recorded over time and time again. 

• They arc used in closed circuit television (CCIV) systems. 

Advantages 

• CD-RWs and DVD-RWs can be re-used many times. 
• They can use different file formats each time they are used. 
• The R W format is not as wasteful as the R format since files or data can be added 

at a later stage. 

Di sadvantages 

• CD-RWs and DVD-RWs can be relatively expensive media. 
• It is JX)Ssible to accidentally overwrite data. 

DVD-RAM 

DVD -RAM is a recent addition to the optical media group. Unlike other CD and 
DVD formats, DVD-RAM.shave several discrete concentric tracks rather than a 
single spiral track. This gives them the advantage that writing and reading can occur 
at the same time. This makes it possible to watch an already recorded television 
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programme at the same time as a different 
programme is being recorded. DVD-RAMs can be 
written to many times. 

Figure 3.2 compares the single spiral track 
found on nonnal CDs and DVDs with the discrete • •• single tracks found on a DVD-RAM.. Figure 3.2 a Spiral tracks on a 

The recording layer is made from a similar normal CD or DVD b Discrete tracks 
phase-changing material to that used in R W on a DVD-RAM 
technology. When writing, a laser heats the phase-
changing alloy on the disk to alxmt S00-700°C, changing the reflective properties 
from shiny to dull (i.e. pits). If the disk needs to be erased, a laser heats the smface 
to alxmt 200°C to return the disk to its original shiny state. A low power laser is 
used to read the written marks on the smface. The shiny and dull (pits) marks 
represent data to a computer where they are interpreted. 

Uses 

• DVD-RM1s are used in recording devices such as satellite receivers to allow 
simultaneous recording and playback. 

• They are used in camcorders to store films. 

Adva ntages 

• DVD-RM1s have a long life - minimum life is estimated to be 30 years. 
• It is possible to do a re-write operation over 100,000 times, compared with the 

RW fonnat which only allows alxmt 1,000 re-writes. 
• Writing on DVD-RAM.sis very reliable, as they have in-built verification 

software to ensure the accuracy of the data. 
• Access is very fast if the files are fairly small. 
• There is no need to finalise the disk. 
• They have a very large capacity (about 10 Gbyte if double-sided fonnat is used). 
• They offer the ability to read data at the same time as data is being written. 

Di sadvantages 

• DVD-RM1s are not as compatible as R or RW fonnat, as many systems will not 
recognise their fonnat. 

• They are relatively expensive, costing alxmt 4times as much as a DVD-RW disk. 

Blu -ray disks 
Blu-ray d isks have the largest capacity of all the optical media available and go up 
to 100 Gbyte (at the present time). The laser beam used is at the blue/violet end of 
the spectrum, rather than red which is the colour of the lasers used in other optical 
media. Consequently, the light used has a shorter wavelength, allowing more data to 
be stored/read on the disk. 

Uses 

• Blu-ray disks are used in home video consoles. 
• They are used for storing and playing back films: 1 high-definition film of two 

hours duration uses 25 Gbyte of memory. 
• PCs can use this technology for data storage or backing up hard drives. 
• Camcorders can use this media (in cartridge form) to store film footage. 
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Adva ntages 

• They have a very large storage capacity, and so are ideal for storing high 
definition films. 

• The data transfer rate is very fast. 
• The data access speed is also greater than with other optical media. 

Di sadvantages 

• The disks are relatively expensive . 
• At the time of writing, blu-ray systems still have encryption problems (which are 

used to stop piracy) when used to store video. 

Solid state backing store 
Solid state technology is being developed to the fX)int where solid state drives will 
soon replace hard disk drives in laptop computers. This is due to their inherent 
thinness, their much faster data a=ss time and the fact that they are extremely robust. 

They are similar to magnetic and optical media in that data is still stored as ls 
and Os. However, instead of changing the magnetic properties on the thin film 
smface of a rotating disk, these solid state systems control the movement of 
electrons within a microchip. The ls and Os are stored in millions of miniature 
transistors within the microchip: if the transistor conducts a current, this is 
equivalent to a 1, otherwise it is a 0. 

They consequently have no moving parts, consume much less power and are 
extremely robust. 

They are used primarily as removable storage devices and are collectively known 
as flash memory. The most common examples are memory sticks/ pen drives and 
memory cards. 

Memory sticks/ pen drives 
Memory sticks/pen drives can store several Gbytes of data and use the solid state 
technology described above. They are usually connected to a computer through the 
USB port and power to operate them is drawn from the host computer. They are 
extremely small and very portable. Most operating systems recognise these storage 
media, which means that no additional software is needed to operate them. 

Some expensive software increasingly use these storage methods (sometimes 
referred to as portable flash drives) as a form of security. They plug into the 
computer using the USB port and are known as dongles. TI1e software installed on 
a computer sends out a request (in encrypted form ) to the dongle asking for an 
encrypted validation key. Tirns a person trying to commit software piracy would 
have to crack the code on the dongle first before they could use the software. Some 
systems go one stage further and have key bits of software stored on the dongle in 
encrypted fonn. The software looks for these pieces of encrypted code to enable it to 
nm. This gives an added security benefit to the software. 

Uses 

• Memory sticks and pen drives are used for transporting files between computers 
or as a back-up store. 

• They are used as a security device - a dongle - to prevent software piracy. 

II 



II 

Information and Communication Technology 

Adva ntages 

• They are very compact and portable media. 
• They are very robust. 

Di sadvantages 

• It is not possible to write protect the data and files. 
• Their small physical size means that they are easy to lose. 

Flash memory cards 

These are a form of electrically erasable programmable read on! y memory 
(EEPROM) and are another example of solid state memories. 

Uses 

• Flash memory cards are used to store photos on digital cameras. 
• Mobile phones use them as memory cards. 
• They are used in J\.IP3 players to store music files. 
• They are used as a back-up store in handheld computer devices. 

Advantages 

• Flash memory cards are very compact, so they can be easily removed and used in 
another device or used for transferring photos directly to a computer or printer. 

• Since they are solid state memories, they are very robust. 

Di sadvantages 

• They are expensive per Gbyte of memory when compared to hard drive disks. 
• They have a finite life in terms of the number of times they can be read from or 

wrinento. 
• They have a lower storage capacity than hard disks. 
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In this chapter you will learn about: 
• types of networks: 

• ring, bus, star and tree 
• local area networks {LANs), wide area networks (WANs) and wireless LANs 

(WLANs) 
• network devices - modems, hubs and switches, routers and bridges 
• the internet - web browsers and internet services providers (ISPs) 
• intranets 
• network security- user IDs, passwords, encryption and authentication techniques 
• communications - fax. email, video conferencing and voice over internet 

protocol {VOiP). 

4.1 Introductio n 

Most computer systems are now connected together in some way to form what is 
known as a network. This ranges from the basic school/home network of only a few 
computers (often set up to share resources such as printers or software) to large 
nenvorks such as the internet which effectively allows any computer connected to it 
to communicate with any other computer similarly connected. 

This chapter considers the type.s of networks that exist and the many features that 
are available because of networking. 

4.2 C ommon types of network 

Most networks are controlled by the use of servers. There are different types of 
servers,forexample: 
• file servers, which allow users to save and load data/files 
• applications servers, which deal with the distribution of applications software to 

each computer 
• printer ser vers, which ensure printing from devices on the network is done in a 

queue, for example 
• p roxy servers, which are used as a buffer between W ANs (discussed at the end 

of this section) and LANs (discussed in Section 4.3 ). 

This section will now describe a number of different types of networks. 

Local area networks 

A local area nenvork (LAN) is usually within one building or certainly not over a 
large geographical area. A typical LAN will consist of a number of computers and 
devices (e.g. printers) which will be connected to hubs or switches . One of the hubs 
or switches will usually be com1ected to a router and modem (usually broadband) 
to allow the LAN to connect to the internet; in doing so it then becomes part of a 
wide area network (WAN). 
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There are advantages of networking computers together using LANs: 
• the sharing of resources (such as expensive peripherals and applications software) 
• communication between users 
• a network administrator to control and monitor all aspects of the network 

(e.g. changing passwords, monitoring internet use and so on) . 

H owever, there are also disadvantages: 
• easier spread of virnses throughout the whole network 
• the development of printer queues, which can be frnstrating 
• slower access to external networks, such as the inten1et 
• increased security risk when compared to stand-alone computers 
• the fact that if the main server breaks down, in most cases the network will no 

longer function. 

There are four common types of LAN network topologies : ring, bus, star and tree 
networks. 

Ring networks 

Ring networks, shown in Figure 4.1, are 0 
becoming less popular. Every computer in the 
network is connected in a ring, including the server. 
Data is transmitted around the ring and each 
computer only removes the data which is relevant _ 
to it. This allows each computer to send and receive 
data since they all have a unique 
identification/ address. 

Advantages Figure 4.1 A ring network 

• Ring networks work well under heavy loading. 
• It is possible to create very large networks using this topology. 

Disadvantages 

• If there is a fault in the wiring between two computers then the whole network 
will fail. 

• Adding a new device or computer to the network can be difficult since it has to 
be placed between two existing devices. 

Bus networks 

In a bus nenvork, illustrated in Figure 4.2, each computer or device is connected to 
a common central line. Data travels along this central line until it reaches the 
computer or device that requires it. The ends of the line have terminators to prevent, 
for example., signal bounce., which would cause data interference. 

Figure4.2 A bus network 
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Adva ntages 

• It is easy to add a new computer or device to the network. 
• If one device or computer fails, it does not affect the rest of the network. 
• This type of network doesn't need a hub or a switch and also reguires less cabling 

than, for example, a star network. It therefore also saves on costs. 

Di sadvantages 

• It is difficult to isolate any fault on the network. 
• If the central line has a fault then the whole network fails. 
• This is becoming an increasingly outdated topology for network design. 
• Its performance worsens noticeably as more and more devices/ computers arc added. 

Star networks ~ 
With a star network, shown in Figure 4.3, each 
computer or device is connected via a central 
hub or switch. Data is sent to the hub which 
then sends out data along every cable to every Hul>'lwltch 

computer or device (no checking is done to see 
where the data should be sent). 

Advantages 

• ! ~~: :~;;~s ~~
1
:~:c;e~~ils, then the rest Figure 4.3 A star network 

• Problems on the network are easy to identify and work can be carried out on a 
faulty device without affecting the rest of the network. 

• It is easy to expand the network. 

Di sadvantages 

• If the central hub breaks down, the whole network crashes. 

Tree network 

A tree network has a central line (just like a bus network) connecting together a 
series of star networks, as shown in Figure 4.4. TI1e server is also connected to this 
central line. Because of its flexibility, and the fact that it has the advantages of 00th 
bus and star networks, this topology is becoming increasingly popular. 

The advantages and disadvantages are the same as for bus and star networks. 

Figu re 4.4 A tree network 
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Wireless LANs (WLANs) 

WLANs are similar to LANs but there are no wires or cables. In other words, they 
provide wireless network communications over fairly short distances (a few metres) 
using radio or infrared signals instead of cables. 

Devices, known as access points (APs) , are connected into the wired network at 
fixed locations (sec Figure 4.5 ). Because of the limited range, most commercial 
WIANs (e.g. on a college campus or at an airport) need several APs to permit 
unintem.ipted wireless communications. The APs use either spread spectrum 
technology (which is a wideband radio frequency with a range of about 30 to 
50 metres) or infrared but this has a very short range (i.e. about 1 to 2 metres) and 
is easily blocked, so is of limited use. 

Figure 4.5 A network connect ing WLANs 

The AP receives and transmits data between the \¥LAN and the wired network 
strncn1re. End users access the WLAN through WLAN adapters, which are built 
into the devices or are plug-in modules. 

Advantages 

• All computers can access the same services and resources ( e.g. printers, scanners, 
internet access from anywhere within range of the APs ). 

• There is no cabling to individual computers and devices so safety is improved. 
• The system is more flexible , since users can move their laptops from their desks. 
• Adding new computers and devices is very easy (all that is required is a WLAN 

adapter, provided the device is within range of an AP) and costs are reduced since 
no extra cabling is needed. 

Di sadvantages 

• Security is a big issue since anyone with a WLAN-enabled laptop computer can 
access a network if it can pick up a signal. It is therefore necessary to adopt 
complex data encryption techniques. 

• There may be problems of interference which can affect the signal. 
• The data transfer rate is slower than in a wired LAN. 

Wifi 

WiFi refers to any system where it is possible to connect to a network or to a single 
computer through wireless communications, for example: 
• on the WLAN described above 
• PDAs and other handheld devices 
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• laptop computers which are WiFi enabled 
• peripheral devices such as printers, keyOOards and mouse which can interface 

with the single computer when fitted with WiFi adapters. 

WiFi systems rely on some form of AP, which uses radio frequency technology to 
enable the device to receive and send signals. 

Note that WiFi is not short for wireless fidelity (a common misconception! ). 
Rather, it is the trademark name for any pnxl.uct which is based on the IEEE 
802.11 standard. 

WiFi hotspots are places where you can access WiFi (free or paid). They exist in 
public places such as airports, hotels and internet cafCS. It is possible to logon to free 
WiFi hotspots unless they are protected by passwords. Software exists which can be 
loaded onto a laptop computer which then searches for non-protected WiFi systems. 
The practice of driving around in a car looking for these unsecured WiFi hotspots is 
known as war driving and poses a security risk to any unsecured WiFi system. 

Blueloolh 
Bluetooth is an example of wireless personal area nenvorking (\VPAN ) 
technology. Spread spectrnm transmission (radio waves) is used to provide wireless 
links between mobile phones, computers and other handheld devices and allow 
connection to the inten1et. 

With this system, it is possible to create a small home network, for example, to 
allow communication between any PDA., mobile phone, computer, media player 
and printer. TI1e range is, however, quite small (aOOut 10 metres). Examples of its 
use include the transfer of photographs from a digital camera to a mobile phone or 
the transfer of phone details to a computer. It bd1aves like a mini-LAN. 

Wide area networks 

A wide area nenvork (WAN) is basically formed by a number ofIANs being 
connected together through either a router or a modem. Some companies will set up 
private WANs (usually by way of fibre optic cabling or telephone wires restricted to 
company use only). TI1is is expensive but comes with the advantage of much 
enhanced security. It is more common to use an internet service provider (ISP) for 
connections to the internet and communicate via this network system. 

The following additional hardware is needed for a WAN: routers, modems and 
prm1' servers (described in Section 4.3 ). 

4.3 Network devices 

Modems 

I 
Modem means modulator demodulator and is a device which converts a computer's 
digital signal (i.e. modulates it) into an analogue signal for transmission over an 
existing telephone line. It also does the reverse process, in that it converts analogue 
signals from a telephone line into digital signals (demodulates) to enable the computer 
to process the data. (Section 5.5 discusses digital and analogue data in more detail. ) 

Modems are used to allow computers to connect to networks (e.g the internet) 
over long distances using existing telephone networks. 
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Dial-up modems operate at transmission speeds of about 60 kilobits per second, 
which is quite slow by today's standards. (TI1ese are discussed in more detail in 
Section 4.4.) However, modem broadband or asymmetric digital subscriber line 
(ADS L) modems operate at 11,000 kilobits per second (or higher). The term 
'asymmetric' means that the modem is faster at downloading (getting) data than it 
is uploading ( sending) data. 

Although the ADSL modems sti.11 use the existing: telephone network, unlike dial-up 
modems they do not tie up the line while accessing the intemet, so the land-line 
tdeplxme can still be used at the same time. Furthermore, they can always be 'on' so 
internet access can be available 24 hours a day. ADSL modems can allow telephone 
conversations and internet traffic to occur at the same time because of the wide 
bandwidth signal used: the higher frequencies are used to cany the internet signals, so 
they do not interfere with normal telephone traffic. Cable modems also exist which allow 
cable television providers to oflC:r internet access as well as =iving television signals. 

Network hubs 
Network hubs are hardware devices that can have a number of devices/ computers 
connected to them. Its main task is to take any data received via one of the ports and 
then send out this data from all of the ports. Each computer/device will receive the 
data, whether it is relevant or not. 

Switches 
Switches are similar to hubs but are more efficient in the way they distribute data. 
A hub learns which devices are connected to which ports. Each device has a media 
access control (MAC) address which identifies it uniquely. Data packets sent to 

the switch will have a mac address giving the source and receiving device. If a device 
X is always sending the switch data via port 4 then it learns that X must be 
connected to that port; any data packet which is intended for X only is then sent 
through port 4 and not through any of the others. This means that the network 
traffic only goes to where it is needed and so a switch is more efficient than a hub, 
especially when the network is very busy. 

Bridges 
Bridges are devices that connect one LAN to another LAN that uses the same 
protocol (the mles that determine the format and transmission of data). They decide 
whether a message from a user is going to another user on the same LAN or to a user 
on a different LAN. The bridge examines each message and passes on those known to 

be on the same LAN and forwards messages meant for a user on a different LAN. 
In networks that use bridges, workstation addresses are not specific to their 

location and therefore messages are actually sent out to every workstation on the 
network. H owever, only the target workstation accepts this message. Networks 
using bridges are interconnected LANs since sending out every message to every 
workstation would flcxxl. a large network with unnecessary traffic. 

Routers 
Since large companies often have more than one network there are occasions when 
the computers in one network want to communicate with the computers in one of 
the other networks. Routers arc often used to connect the LANs together and also 
connect them to the internet. 
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Routers inspect the data packages sent to it from any computer on any of the 
networks connected to it. Since every computer on the same network has the same first 
pan of an internet protocol (IP) address, the router is able to send the data package 
to the appropriate switch and it will then be delivered using the mac destination address 
in the data packet. If this mac address doesn't match any device on the network it passes 
on to another switch on the same nenvork until the device is found. 

HTTP proxy servers 

This is a special type ofsen'Crthatacts as a bufter between a WAN (usually the intemct) 
and a LAN. The sen'Cr passes on the senrice requests to the internet and then passes 
back the requested pages. It therefore retrieves web pages and passes them on to the 
computer that made the request. Any page retrieved from the internet is stored on the 
senrer, which means that when a difterent computer requests the same page it is available 
immediately thus considerably speeding up the browsing process. 

4 .4 Th e inte rnet 
TI1e internet is a worldwide collection of networks which allows a subscriber to send 
and receive emails, chat (using text or voice) or browse the world wide web. 

TI1e world wide web (WWW or web) is the part of the internet which the user 
can access by way of a web browser ( e.g. Microsoft Internet Explorer). A web browser 
is software that allows the user to display and interact \\-':ith pages and files from the web. 

Websites 

TI1e web is made up of millions of these websites (e.g. www.hoddereducation.com) 
and millions of web pages (e.g. H odder Education front page, shown in Figure 4 .6). 
Web pages arc documents on a computer screen which may consist of text, pictures, 
sounds, animation or video (i.e. multimedia). A website consists of many of these 
pages linked together. 

..... _,_,_,.. ···--·--

Figu re4.6 Exampleofawebpage 
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The website shows these hyperlinks to allow users to navigate between web pages. 
These hyperlinks are often shown as blue underlined text or sometimes a small hand 
appears .i, under a picn1re or under some text indicating the link to another page or 
website. 1l1e user clicks on these hyperlinks using a mouse (or other pointing 
device) to move to another page. 

Web browsers use uniform resource locations (URI.s) to retrieve files. URLs are 
a standard way of locating a resource on the internet; they are usually a set of four 
numbers, e.g. 194.106.220.19. H owever, as this can be difficult to remember, an 
alphanumeric form is usually used whicl1 has the format: 

protocol://site address/ path/filename 

where: 
• protocol is usually http 
• site address consists of: host computer name, domain name, domain type and 

(very often) the country code: 
• computer name is usually www 
• domain name is the name of the website 
• domain type is commonly one of the following: .com, .erg, .co, .net, .gov 
• examples of country code include .uk, .us, .de, .cy 

• path is the web page 
• filename is the item on the webpage. 

Thus, a full URL could be http: /Jwww.urlexamples.co.cy/ pagcs/examplel 

Accessing the internet 

~; t~!::/~:i;7i;i:::t re:~:~:7;;:g~::s to ; •• ; "':'. ~i ':, ~ - • 
with an ISP, an account is set up and they are given 
login details, which include a username and a 
password. The user co1mects to the intemet via the 
user account which also allows the provider to monitor --­
usage. Most ISPs also provide an email account (sec 
Figure 4.7 for an example of an email page). 

Emails are an dcctronic way of sending documents 
( etc.) from one computer to another. TI1ey allow 
attachments, which can be word-processed 
documents, spreadsheets, data files, music files, movie Figure 4.7 Example of an email 

files, etc. An email address contains two parts: page 

examplcl@yahoo.co.uk OR example2@yahoo.com 

The first part is the user name e.g. example I or example2 and the second part is@ 
followed by host name e.g. @yahoo.co.uk or @yahoo.corn. 
Emails are discussed in more depth in Chapter 9. 

TI1cre are three common ways of accessing the internet oflC:red by senrice providers: 
• dial-up internet access 
• cable internet access 
• digital subscriber line (DSL) (broadband) internet access. 
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TI1ese were discussed in Section 4.3 as part of modems and are summarised in 
Table4.l. 

Dial-up internet access 
(dial-up modem) 

This is the slowest type of connection (about 60 kbps). 

The user connects to the internet via the telephone line by 
dialling one of the numbers supplied by the ISP. They are 
thereforenotonallthetime; ISPcontractsareusuallyfora 
number of hours per month of internet access time and 
additionalchargesareincurredifthisisexceeded. 

A big disadvantage isthatthetelephonelineistied up while 
a dial up modem is in operation. 

Cable internet access (cable Local cable television operators give a user access to the 
modem) internet through their own cable networks using a cable 

network modem. 

Internet access via DSL The fastest download speeds can be obtained by using DSL 
(broadband modem) broadband connections (at least 11,000kbps). This is often 

offered with wireless interface which requires an AP and a 
router. ISPs usually have a download/upload limit (e.g. 20 
Gbyte of data) as part of the contact. This is not a problem 
unless the user is often downloading music or movie files 
which can quickly use up the memory allocation. 

Broadband has the advantage of always being on, since it 
doesn'ttieupthetelephone line. 

Thefasttransferrateallowssystemssuchas volceover lP 
(VOiP) and online chat rooms to be used effectively. 

Table 4. 1 Methods of accessing the internet 

4.5 lntra nets 
Many companies use an intranet as well as the internet. The simple definition of an 
intranet is 'a computer network based on internet technology that is designed to 

meet the internal needs for sharing information within a single 
organisation/ company'. TI1ere are number of reasons for doing this. 
• It is safer since there is less chance of external hacking or viruses. 
• It is JX)Ssible to prevent employees from accessing unwanted websites. 
• Companies can ensure that the infonnation available is specific to their needs. 
• It is easier to send outsensitii,e messages that will remain only within the company. 

It is now worth comparing the internet with intranets: 
• The term 'internet' comes from the phrase inten1ational network. 
• The term 'intranet' comes from the phrase internal restricted access network. 
• An intranet is used to give local information relevant to the company whereas the 

internet covers topics of global interest. 
• It is JX)Ssible to block out certain internet sites using an intranet. TI1is is much 

more difficult to do from the internet. 
• An intranet reguires password entry and can only be accessed from agreed 

points, whereas the internet can be accessed from anywhere provided the user 
has an ISP account. 
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• An intranet is behind a firewall, which gives some protection against hackers 
(unauthorised users), vimses and so on. This is much more difficult to do with 
inten1et access since it is more open on an inten1ational scale. 

• Information used in intranets is usually stored on local servers, which makes it 
more secure from outside agencies. 

4.6 N etwork security 

The security problems when using networks such as the internet are well 
documented. There are various security threats to networks and there are many 
equally varied ways of combating the threat. Many of these issues are discussed in 
Chapter 6 but this section will concentrate on four areas: 
• userID 
• password 
• encryption 
• authentication techniques. 

User IDs 

\Vhen logging on to any network system, a user will be asked to type in a user ID. 
This assigns the user privileges once the logon procedure is successful. For example, 
on a network, top level privilege would be for an administrator, who is able to set 
passwords, delete files from the server, etc., whilst a user privilege may only allow 
access to their own work area. 

Passwords 
After keying in the user ID, the user will then be requested to type in their 
password. This should be a combination of letters and numbers which would be 
difficult for somebody else to guess. \Vhcn the password is typed in it often shows 
on the screen as ~ • • • • • ~ ·• so nobody overlooking can sec what the user has typed 
in. If the user's password doesn't match up with the user ID then access will be 
denied. Many systems ask for the password to be typed in twice as a verification 
check (check on input errors). To help protect the system, users arc only allowed to 
type in their password a finite number of times - three times is usually the maximum 
number of tries allowed before the system locks the user out. After that, the user will 
be unable to logon until the system administrator has re-set their password. 

\Vhen using some internet websites, if a user forgets their password they can 
request the password to be sent to their email address. The password is never shown 
on the computer screen for reasons of security. 

Encryption 
Encryption is the converting of data into a code by scrambling it or encoding it. 
This is done by employing encryption software (or an encryption key). Since the 
data is all jumbled up it appears meaningless to a hacker or anyone who illegally 
accesses the data. It should be stressed that this technique doer not prevent illegal 
access, it only makes the data useless to somebody if they don' t have the necessary 
decryption software (or decryption key). It is used to protect sensitive data (such as 
a person's banking details). 
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TI1e system works like this: 
• A user writes a message and the computer sending this message uses an 

encryption key to encode the data. For example, the message 'THIS IS AN 
EXAMPLE' (sent on 15 April) is encoded to <43Kr Kr T7 W04887W'. 

• At the other end, the receiving computer has a decryption key which it uses to 

decode the message. Note that the date when the message was sent is important 
since this formed part of the encryption algorithm . 

Encryption keys are much more complex than the one above, in order to prevent 
computers being used to crack the code. Very sophisticated algorithms are used 
which make the codes almost unbreakable. 

Authentication techniques 
As shown aOOve, there are many ways in which a computer user can prove who they are. 
TI1is is called authentication, and a type of authentication is used in the banking 
example that follows. Most systems adopt the following authentication logic: 
• something you know - e.g. PIN/ password 
• something belonging to you - e.g. your bank card 
• something unique to you - e.g. your fingerprints. 

At least two of these are needed at the moment when a user has to prove who they 
are. For example, the following banking example uses: 
• something you know - surname, reference number, PIN, date last logged on 
• something belonging to you - card put into card reader to produce the 8-digit code. 

In furnre, the third fearnre will be introduced (such as a fingerprint scanner attached 
to a computer to uniquely identify the user). 

~---

Figure4.8 The authentication process 

Banking example 

A user belongs to H &S Bank. H e wants to check the starns 
ofhis account online. H e logs onto the H &S Bank website 
using his ISP. Figure 4.8 illustrates a sophisticated set of 
steps taken to prevent unauthorised access. 

Only once each page has been successfully navigated will the 
user have access to his bank account. The last stage is a final 
check to see if the customer's account has been illegally 
accessed - if they hadn't logged into the website on 15 April 
at 17:45 then this would trigger a sea.irity check into the 
customer's account. Note that the last web page makes use of 
what are called radio buttons. 
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4.7 Commun ication m eth ods 

Many methods of communication using networks exist. These include fax, email, 
video conferencing and VOIP. 

Fax 

The term fax is short for the word 'facsimile'. With this system, documents are 
scanned electronically and converted into a bit map image ( a bit is a binary digit and 
is a 1 or a 0 ). This is then transmitted as a series of electrical signals through the 
telephone network. The receiving fax machine converts this electronic image and 
prints it out on paper. 

It is also possible to generate fax signals from a computer to allow files and 
documents to be sent to a fax machine - this saves printing out the document first 
and then passing it through a fax machine. Fax/modem software in the computer 
converts the image into a fonn recognised by a fax machine. H owever, this is not as 
efficient as the email system where the electronic copy is sent and is then stored 
electronically thus permitting the document to be edited, for example. 

Email 

This is an electronic method for sending text and attachments from one computer to 

another over a network (see Section 4.4 for further details). 
The advantages of using email include: 

• the speed of sending and receiving replies using the email system 
• the low cost, since stamps, paper and envelopes are not needed 
• not needing to leave home to send the mail. 

Disadvantages include: 
• the possibility of virns threats and hacking 
• the need for the email address to be completely correct 
• the inability to send bulky objects via emails. 

Video conferencing 

1b.is is a method of communication bc..·1:ween people at two separate locations 
(e.g. in different countries). TI1is is done in real time and makes use of a LAN, if 
internal, or through a WAN, e.g. the internet, if national or international. The 
system works in real time and uses additional hardware such as webcams, large 
monitors/television screens, microphones and speakers. 

The system also uses special software such as: 
• CODEC, whicl1 converts and compresses analogue data into digital data to send 

down digital lines 
• eclm cancellation software, which allows talking in real time and syncl1ronises 

communications. 

Delegates at one end speak into a microphone and look at a webcam. The other 
delegates can see them and hear them using large monitors and speakers. 

There are potential problems with these systems sucl1 as time lag (the time it 
takes for the signal to reach its destination, which can be difficult when trying to 

have a conversation since there seems to be a delay). Also, sound quality and picrure 
quality can be poor unless expensive hard\vare and software is used. 
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However, these systems are becoming increasingly popular as the cost of 
travelling increases and the risk of terrorist attacks becomes higher. One large 
company, which reduced travelling from Europe to USA and used video 
conferencing wherever possible to discuss product development:, claims to have 
saved several million US dollars over a 12-month period. The savings were due to 

reduced travelling (mostly air fares) and to reduced overnight accommodation. Since 
little or no travelling is involved meetings can be held at short notice, but time 
differences between countries can become an issue. 

VOiP 

Voice over intemet protocol (VOiP) is a method used to talk to people using the 
intemet. VOiP converts sound (picked up by the computer microphone or special 
VOiP telephone plugged into tl1e USE i:ort of the computer) into discrete digital 
packets whid1 can be sent to their destination via the internet. One of the big advantages 
is that it is eitl1er free (if tl1e talking is done computer to computer, i.e. 00th computers 
have VOiP telephones or use their built-in/plugged-in microphones and speakers) or at 
a local rate to anywhere in the world (when VOiP is used to communicate with a 
mobile or land line telephone rather than another computer). 

To work in real time this system requires a broadband ISP. The main problems 
are usually sound quality (echo and 'weird sounds' are OOtl1 common faults). 
Security is also a main concern with VOiP, as it is witl1 other internet tedmologies. 
The most prominent security issues over VOiP are: 
• identity and service theft 
• viruses and malware (malicious software) 
• spamming (sending junk mail) 
• phishing attacks (the act of sending an email to a user falsely claiming to be an 

established legitimate enterprise in an attempt to scam tl1e user into surrendering 
private infonnation tl1at will be used for identity theft). 
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Data types 

In this chapter you will learn about: 
• types of data - Boolean, text, alphanumeric, numeric and date 
• data structures - files, records, fields and primary keys 
• relational databases - tables, primary keys and foreign keys 
• analogue data - the need for analogue to digital converters {ADC) 
• digital data - the need for digital to analogue converters {DAC). 

5 .1 Introduction 

Data can exist in many forms, and so there are various defined types of data that 
computers use. All the data that is stored on computers is digital, but lots of types 
of data in the real world involve physical measurements of continuously varying 
data. TI1ese need to be converted into digital data for storage and manipulation on 
a computer. 

Data frequently needs to be stored in a logical sequence to allow access and/or 
searching to be done at some later stage. One of the most common methods of data 
storage is the use of databases. 

5.2 Types of data 
There are several data types found in most computer systems: 
• logical/Boolean 
• alphanumeric/ text 
• numeric 
• date. 

Logical/Boolean data 
Boolean data (or logic data type) can have only two values: true or false . This 
works if there are only two possible responses to a question or situation, i.e. (Yes or 
No), (frue or False) or (1 or 0). 

This is made most use of when carrying out a search in a database or on the 
internet. In these cases, logical operators are used which are based on trne 
(i.e. binary 1) or false (i.e. binary 0) logic. 
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The AND operator 

Consider the list of seven students in Table 5.1. 

Male 1.6 

Male 1.7 

Female 1.5 

Female 1.7 

Male 1.4 

Female 1.6 

Male 1.5 

Table5.1 Asmalldatabase 

SupJX)se we now make the search: 

(Sex= Male) AND (H eight (m ) > 1.6) 

Table 5.2 shows the logic stams for each part of the search query. There is only one 
match where the search condition is tnie for (Sex= Male) AND true for 
(H eight (m) > 1.6 ): name B. 

Female False 1.7 True 

Male True 1.4 False 

Female False 1.6 False 

Male True 1.5 False 

Table 5.2 Logic status for search query (Sex= Male) AND (Height (m) > 1.6) 

Note that the logic operator called AND looks for the siniation where something is 
true in both groups. For example, consider two groups X and Y where X = {l , 2, 3, 4} 
and Y = {3, 4, 5, 6}. The statement XAND Ywould be equal to {3, 4} since iris true 
that 3 and 4 are the only items which are common (i.e. tme) to 00th groups (sec 
Table 5.3). 

II 



II 

Information and Communication Technology 

[ True I False 

I True ! False 

True 

True 

I False I True 

! False I True 

Table 5.3 Logic status for statement X ANDY 

In the student database only example B contains items which are true (common) to 
both groups (i.e Male and 1.7m). 

The OR operator 
Now consider a different search: 

(Sex= Female) OR (Height (m ) < 1.6) 

This gives the logic status shown in Table 5.4. There are five matches where the 
search condition is true for (Sex= Female) OR true for (H eight (m) < 1.6) : 
names C, D, E, F and G. 

I Male I False 11., I False 

I Male I False 11.1 I False 

Female True 1.5 T= 

Female True 1.7 False 

Male False 1.4 r,~ 

Female True 1.6 False 

Male False 1.5 T= 

Table 5.4 Logic status for search query (Sex= Female) OR (Height (m) < 1.6) 

Note that the logic operator called OR kx:,k.s for the situation where something is true 
ineitl1er group. For example, consider two groups X and Y where X = {l , 2, 3, 4} 
and Y = {3, 4, 5, 6}. The statement XOR Y would be egual to {l , 2, 3, 4, 5, 6} since 
it is tme that all six numbers occur in either group (see Table 5.5). 
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False 

False 

Truo 

True 

False Truo 

False Truo 

Table 5.5 Logic status for statement XOR Y 

In the student database example, C, D, E, F and G contain items which arc trne in 
either group. 

Alphanumeric and text data 

Looking at a standard keyboard, you see the letters A to Z, the digits O to 9 and 
other characters such as : @ & £ ) } etc. The letters A to Z are referred to as text 
and the letters A to Zplus the digits Oto 9 are referred to as alphanumeric (some 
definitions also include the remaining keyboard characters such as @ & £ ) } as part 
of the alphanumeric cl1aracter set). 

For example, the password 'MARQUES' contains letters only and is therefore 
text. H owever, the password 'MIKE62' contains letters and numbers and is 
therefore alphanumeric. A person's name would always be text but their addre.ss, 
which could contain letters and numbers, would be alphanumeric. 

Numeric data 
Numeric data can be in two forms: integer (whole numbers) or real (containing 
decimals). For example, 3416 is an integer, but 34.16 is real. 

Examples of integers include the number of floors in a hotel, the number of 
smdents in a class or the number of wheels on a car. Examples of real numbers 
include tetnperan1res, price of an item in a shop or a person's height in metres. 
Numeric data also includes zero (0) and negative numbers sucl1 as - 45 16 (integer) 
or - 30.26 (real). 

Date data 
Date can be written in many forms, for example: 
• dd/mm/yyyy (dd = day, mm= month and yy/yyyy = year), e.g. 19/08/2009 
• dd/mm/yy, e.g. 19/08/09 
• dd.mm.yy, e.g. 19.08.09 
• yyyy-mm-dd, e.g. 2009-08- 19. 

All of the aOOve examples use a number form of the month, but it can also be 
written as the full word or the three-letter abbreviation: 
• dd mmmm yyyy, e.g. 19 August 2009 
• dd-mmm-yyyy, e.g. 19-Aug-2009. 

All the aOOve are accepted as date in most application packages (such as spreadsheets 
and databases) where the format is particularly important due to data manipulation 
(e.g. sorting) or searching. 
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5.3 Data structures 

Data is often stored in files, which consist of 
records, which in rum consist of fields , as 
illustrated in Figure 5 .1. 

For example, a company may have set up a 
file to include information about their 
employees in the following format: 

Figure5.1Structureofadatafile 

reference number/name/date started/department 

Figure 5.2 shows a possible structure for the file COMPANY EMPLOYEE FILE. 
The infonnation is held in one file with five records and four fields per record. In 
this example, the first field (the reference number) is known as the key fie ld or 
primary key. Each primary key is unique and is used to locate a record in a file 
during a search operation. 

Record 1 1416 J.Smith 30/0512003 Sales 

r Record2 1417 K. Shah 11/02/1989 Manager 

Record 3 1431 R.Marques 15/10/2001 Finance FILE 

Record4 1452 T. Rodriguez 27/09/1995 Sales 

l Record 5 1461 V.Schultz 09/12/2005 Graduate 

field field field field 

Figure 5.2 The file 'COMPANY EMPLOYEE FILE' 

Also note the data types for each field: 

reference number numeric data (integer) 

date date format (dd/mm/yyyy) 

department 

In reality, COMPANY EMPLOYEE FILE would be much larger, containing all the 
records for all the company's employees. TI1is type of file is often referred to as a flat 
file structure. 

5.4 Databases 
A database is a collection of information which is strnctured in some way to permit 
manipulation and searching of data. 

Why are databases used? 
• They promote data consistency. \Vhen data is updated on a database it is up to 

date for any application which uses the database. 
• Data duplication is reduced to a minimum since only one copy of each data item 

needs to be kept. 
• It is relatively easy to expand the database if some new application is being 

considered. 



• Security of data is easier to monitor and maintain. 
Data access can be controlled by database front 
ends ; the acrual database will be ' invisible' to all 
users except the database administrator (see 
Figure 5.3 ). 

Early databases were examples of flat file structures, as 
described in Section 5.3 and illustrated by the 
COMPANY EMPLOYEE FILE. The way the data is 
organised makes it difficult to search for a specific piece 
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of information or to create reports which only contain Figure 5.3 User access to data 
certain information (fields ) from each of the records. contained in a database 

Relational databases 

R elational databases were first intnxluced in 1970 following the work of F. F. 
Codd, a researcher at IBM. 

Relational databases consist of a number of separate tables which are related ( a 
table is made up of rows and columns in much the same way as a spreadsheet is 
structured). Each table contains a primary (key) field that is also a field in at least 
one other table. It is possible to combine data from different tables to pnxluce a 
report which only contains the required information. 

Relational databases do not need to repeat data, which is one of the problems of 
flat file strucn1re (in the example that follows, three flat files would be needed 
containing repeated fields of key data since there would be no links connecting each 
file ). Information is stored in separate tables only connected by the primary (key) 
field. Other advantages of relational databases include: 
• faster data retrieval (because oflinks between tables) 
• easy expansion of the database by adding extra data or new tables 
• the need to change data in only one table - all other references to this data will 

then also be up to date, resulting in what is known as data integrity . 

Tables can also contain foreign keys that relate tables in the database to one 
another. A foreign key in one table is a primary key in another. 

We will now look at an example that shows the strucn1re of tables in a relational 
database. In this example, there are three connected tables. It is important to note 
that in commercial databases there will be several tables connected together. 1l1e 
examples shown here contain only two or three and are being used to show the 
principle of relational databases. 

Example 

A garage sells cars and keeps a database of sales, customers and servicing, as shown 
in Figure 5.4 overleaf. 

The primary (key) field is Cu number and the column is shaded red). 
1l1e foreign key fields are I m ·oke number and Engine ID and these are 

shaded green. 
Information from all three tables is linked together so, for example, if a car 

service was due then by typing in CJ.r number the customer's details and servicing 
details are brought up on the screen. This means information can be sent to the 
customer as a reminder. Once the service is carried out, the servicing table will be 
updated which means all other references to it will also be up to date. 

To help you understand these complex structures, go through the following 
exercise, which contains a flat data strucrure and a relational database. 
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Llnk th,ough 
th• p,lmory 

~:;,~ 

FigureS.4 Threere latedtables inarelational database for a garage 

Exercise Sa 
Example1 
Table5.6showsaflatdatastructure. 

Mr J.Bloggs 

MsR. Spacek 

MrN. Choudry 

18,000 

25,000 

19,000 

40,000 

25,000 

Table 5.6 Flat file structure for data on employees in a company 

a How many records are there in this section of the database? 
b How many fields are there in each record? 
c Whichfieldcontains: 

i numericdataonly 
ii textdataonly 
iii alphanumericdataonly? 

d Whatfieldistheprimarykey? 
e lnwhichfieldhasthedatabasebeensorted? 
f If the database was sorted in descending order on salary, using the 

new order of data in the sorted database? 

Legal 

... only, whatwouldbethe 
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Example2 
The database shown in Table 5.7 contains two linked tables. The database is being used to keep a record of which 
customers have borrowed CDs from the music lending library. 

CD stock table 

77779287727 Seasons End Marillion 1989 10 

99969313424 Kingdom of Rust D=s 2009 

24354273506 Let It Go Nada Surf 2002 11 

94639624829 Our Love to Admire Interpol 2007 

02498669105 The Invitation Thirteen Senses 2004 12 

45099625627 Seal Seal 1994 10 

Table 5.7 Tables of data relating to CDs borrowed from a library 

Customer borrowing table 

M10411 MrK. Sahz 415003455 02498669105 1511012009 

M21516 MrD. Silva 841133222 77779287727 14/1012009 

F18113 MrA.Adak 614555211 45099625627 14/1012009 

M20004 MrR. Choudhury 416888210 24354273506 12/1012009 

F16117 Msl.Smith 416219000 94639624829 11/1012009 

F50316 MrM. Egodi 841567228 99969313424 10/1012009 

a How many records are there in the CD stock table? 
b How many fields are there in each record in the Customer borrowing table? 
c Whattypeofdatabaseisbeingusedhere? 
d What is the primary key in the CD stock table? 
e Whichfieldisaforeignkey? 
f Whatdatatypewouldyouuseinthe field? 
g Whatdatatypeshavebeenusedinalltheotherfields? 

5.5 Ana logue and digita l da ta 
As we have already learnt from earlier chapters, computers work with digital data, 
which is defined as discrete, fixed values in a given range. 

However, in the real world, physical measurements (i.e. data) are not digital but 
are continuously variable, producing an infinite number of values within a given 
range. For example, length, weight, temperature, pressure, etc. can take any value, 
depending on the accuracy to which they are measured. These values are measured 
by an analogue de\'ice which represents physical measurement on a continuous 
analogue scale, as illustrated in Figure 5.5. The speedometer represents speed by 
showing the position of a pointer on a dial, while the thermometer represents 
temperature by the height of the liquid column. 
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Thedataisknownas analoguedata. • 
Most control and monitoring ~ 

applications use devices called sensors 
to measure these physica~ analogue 
quantities. Examples of sensors and 
their use in monitoring and control 
applications are discussed in Chapter 7. 

However, computers can only Figure 5.5 Examples of analogue devices 
understand and manipulate digital data. 
Analogue data would not make any sense to the computer and may even cause some 
damage. To enable data in analogue form ( often the input from a sensor) to be 
processed by a computer, it needs to be changed into a digital fonn. This is done using 
an analogue to digital converter (ADC) . 

Alternatively, if the computer is being used to control a device, such as a motor 
or a valve, the device may need to be controlled by continuously variable voltages. 
There would be no use sending out a digital signal. I t would first need to be 
changed into an analogue signal, requiring another device, known as a digital to 
analogue converter (DAC). 

Example of a control system 

111is example shows why there is a need to convert analogue to digital and also 
digital to analogue as part of control system involving a computer: 

Figure 5 .6 shows a computer being used to control a furnace heated by burning 
gas supplied from a gas source (the amount of gas is controlled by a valve which can 
have an infinite number of positions). 

Figure 5.6 Control system fora furnace 

TOfflpe<otUf4 
voluentof<d 
~ .. 

A sensor is used to measure tcmpcrarure in the furnace and it sends readings in 
analogue form (small electric currents/voltages) . This data is converted into digital 
by an ADC and is fed to a computer, which compares the input tempcramre with 
the required tcmpcrah1re stored on a file. If any action is needed (furnace 
tcmpcrarurc is too low or too high) then a digital signal is sent out from the 
computer. This signal is converted into an electric current/voltage (i.e. analogue) so 
that the valve can be regulated (i.e. opened or closed to control the gas supply and 
hence the furnace temperature). 
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In this chapter you will learn about: 
• software copyright rules 
• viruses and hacking: 

• definitions 
• ways of protecting the system 

• the effects of ICT on society: 
• employment 
• social impact 
• online shopping and banking 
• policing of the internet 
• use of microprocessors in household appliances 

• information from the internet: 
• reliability of data 
• risks of undesirable websites 
• security {including phishing, pharming and spam) 

• internet developments, e.g. biogs, wikis and social networking 
• health and safety issues. 

6.1 Introductio n 

The use of lCT has affected our everyday lives in many ways. These range from the 
effects of ICf on society in general, such as the changes in types and styles of 
employment, to the convenience that it offers the individual, through services such 
as online shopping and banking. H owever, in addition to providing new 
opportunities, ICf has introduced its own problem, such as issues relating to 

copyright, security of 00th companies and individuals, and health and safety. This 
chapter discusses many of these effects. 

6.2 Software co pyright 
Software is protected by copyright laws in much the same way as music CDs, film 
DVDs and articles from magazines and books are protected. 

\¥hen software is supplied on CD or DVD there are certain rules that must be 
obeyed. 
• It is not legal to make a software copy and then sell it or give it away to a friend 

or colleague. 
• Software cannot be used on a network or used in multiple computers unless a 

licence has been acquired to allow this to happen. 
• It is not legal to use coding from the copyright software in your own software 

and then pass this software on or sell it as your own without the permission of 
the copyright holders. 

• Renting out a software package without permission to do so is illegal. 
• It is illegal to use the name of copyrighted software on other software without 

agreement to do so. 
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Software piracy (illegal copies of software) is a big issue amongst software 
companies. They take many steps to stop the illegal copying of software and to stop 
illegal copies being used once they have been sold. TI1e following list shows a 
number of ways in which software is protected, both by making the installer agree 
to certain conditions and also by methods which require the original software to be 
present for it to work. 
• When software is being installed, the user will be asked to key in a unique 

reference number (a string of letters and numbers) which was supplied with the 
original copy of the software. 

• The user will be asked to click 'OK' or 'I agree' to the licence agreement before 
the software continues to install. 

• The original software packaging often comes with a sticker informing the 
purchaser that it is illegal to make copies of the software; the label is often in the 
form of a hologram, which indicates that this is a genuine copy. 

• Some software will only nm if the CD-ROM or DVD-ROM is actually in the 
drive. This stops illegal multiple use and network use of the software. 

• Some software will only nm if a dongle is plugged into one of the USE ports 
(dongles were discussed in Section 3.3). 

6.3 Viruses and hacking 
A virus is a program that replicates (copies) itself and is designed to cause hann to a 
computer system. It often causes damage by attaching itself to files, leading to one 
or more of the following effects: 
• causing the computer to crash (i.e. to stop functioning normally, lock up or stop 

responding to other software) 
• loss of files - sometimes system files are lost which leads to a computer 

malfunction 
• corrnption of the data stored on files. 

Virnses infect computers through email attaclunents and through illegal software or 
downloading of files from the internet that are infected. TI1e following list shows 
ways of protecting systems against virnses. 
• Use up-to-date anti-virus software. This detects virnses and then removes or 

quarantines (i.e. isolates) any file/attachment which has been infected. 
• Do not allow illegal software to be loaded onto a computer and do not use any 

CD/DVD in the computer which comes from an unknown source. 
• Only download software and files from the internet if they are from a reputable site. 
e Use firewalls (discussed below) on networks to protect against virnses. 

Note that backing up files on a regular basis does not necessarily guarantee the 
prevention of virnses spreading. If a file is already infected and it is then backed 
up, when the file is re-loaded into the 'deaned' computer the virns may actually be 
re-installed! 

Hacking is the act of gaining access to a computer system or network without 
legal authorisation. Although some hackers do this as a form of intellectual 
challenge, many do it with the sole intention of causing harm (e.g. editing/deleting 
files, installing hannful software, executing files in a user's directory or even 
committing fraud ). 

Some large companies actually employ hackers to test out their security systems. 
Although the only foolproof way of stopping a networked computer from being 
hacked into is to disconnect it from the internet, this is clearly not a practical or 
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desirable solution. Similarly, the only certain way to prevent a stand-alone computer 
from being hacked into is to keep it in a locked room when not in use; again, this is 
not always practical. 

However, there are a number of ways to minimise the risk of hacking: 
• use of firewa lls: these are used on networked computers. They provide a detailed 

log of incoming and outgoing traflic and can control this traffic. TI1ey are able to 
stop malicious traffic getting to a user's computer and can also prevent a 
computer connecting to unwanted sites and from sending personal data to other 
computers and sites without authorisation 

• use of robust passwords (i.e. difficult passwords to guess) and user IDs to 
prevent illegal access to a computer or internet site. 

Whilst encryption makes files unreadable if accessed illegally, it does notpm,mt 
illegal access (hacking) in the first place. It therefore would not prevent a hacker 
carrying out many of the hannful actions described in this section. 

6.4 Effects of ICT on society 

One moral issue that has emerged from the development oflCT is the social divide 
created by computer technology and ICT. This is often referred to as the ' haves and 
have-nots' - those people who have the necessary ICT skills or money to purchase 
and use computer equipment will gain benefit from the new technology; those who 
are not able to access this new technology are left even further behind leading to this 
social divide. 

ICT has affected many aspects of society. This section is going to look at just a 
few of these: 
• the impact on employment 
• the development of online shopping and banking 
• policing of the internet 
• the use of microprocessors in household appliances. 

Impact on employment 

TI1e introduction ofICT has led to unemployment in many areas such as: 
• manufacturing, where robots have taken over many tasks (e.g. paint spraying in a 

car factory) 
• computer-controlled warehouses, which are automatic and require no personnel 

to be present 
• labour-intensive work (e.g. in the printing industry, checking football pools, 

filing, etc.). 

However, it is also trne that some new jobs have been created with the introduction 
ofICT. These include writing software, maintenance of robots and other JCT 
equipment and work connected with internet sites (setting sites up, maintaining 
them, etc.). 

The overall work- related effects on people can be summarised as follows: 
• the need to be re-trained because of the introduction of new technology, e.g. how 

to operate or maintain the new macl1inery which is being introduced to do the 
work previously done by a person 

• a cleaner working environment where robots have taken over many of the 'dirty' 
manual tasks 
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• dc-skilling of the workforce, as jobs where high skills were needed in the past arc 
now done by computer systems (e.g. the use of DTP software in the printing 
industry, CAD software in producing engineering drawings, etc.) 

• a safer working environment ( e.g. fewer people working in noisy factories ) 
• fewer manual tasks, since tasks such as heavy lifting arc now done by robots. 

Companies have also gained from the introduction of ICT systems. For example: 
• there is no need to employ as many people to do the tasks, thus reducing 

labour costs 
• robots do not take holidays, get sick or take coffee breaks, resulting in higher 

productivity 
• whilst the quality is not necessarily better, there is greater consistency in the 

products made (e.g. every car coming off a production line will be identical). 

Impact of using ICT for online shopping and banking 
The development of onlinc shopping and banking has led to changes in the type of 
employment in shops and banks. Fewer staff arc now needed in traditional shops 
and banks, but new staff arc needed to provide the onlinc services ( e.g. packing and 
sending out orders, courier services, and so on). AI, the amount of online shopping 
and banking increases, the impact on society begins to gain in significance. (The 
applications arc covered in more depth in Chapter 7; th.is section will deal primarily 
with the impact ofICT.) 

Online shopping and banking means that more and more people arc staying at 
home to buy goods and services, manage their bank accounts and lxx>k holidays, etc. 
This would all be done using a computer connected to the internet and some form 
of electronic payment (usually a credit or debit card). The following notes give a 
comprehensive list of the benefits and drawbacks of using the internet to carry out 
many of these tasks. 

Adva ntages 

• There is no longer a need to travel into the town centre thus reducing costs 
(money for fuel, bus fares, etc.) and time spent shopping. It also helps to reduce 
town centre congestion and pollution. 

• Users now have access to a worldwide market and can thus look for products that 
arc cheaper. This is less expensive and less time consuming than having to shop 
around by the more conventional methods. They also have access to a much 
wider choice of goods. 

• Disabled and elderly people can now get access to shops and banks without the 
need to leave home. This helps to keep them part of society since they can now 
do all the things taken for granted by able-bodied people. 

• Because it is onlinc, shopping and banking can be done at any time on any day of 
the week - this is termed 24/7. This is particularly helpful to people who work, 
since shops/banks would nonnally be closed when they finished work. 

• People can spend more time doing other things. For example, going shopping to 
the supermarket probably took up a lot of time; by doing this onlinc people arc 
now free to do more leisure activities, for example. 
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Disadvantages 

• There is the possibility of isolation and lack of socialisation if people stay at home 
to do all their shopping and banking. 

• There are possible health risks associated with onlinc shopping and banking 
(discussed in Section 6.7). 

• Security issues (e.g.) are a major concern. These include: 
• hacking, stealing credit card details, etc. (discussed in Section 6.3 ) 
• vimscs and other malware (e.g. phishing, pharming:, etc., discussed in Section 6.5) 
• fraudulent websites (discussed in Section 6.5). 

• It is necessary to have a computer and to pay for line rental to take part in onlinc 
shopping and banking. Also the telephone line will be tied up if the user docs not 
have a broadband connection. 

• Unlike high strcc..'t shopping, it is not possible to see ( or try on) the goods first 
before buying them. TI1e goods also take several days to arrive. 

• There is a risk of lack of exercise if people do all their shopping and banking at 
the computer. 

• High street shops and banks are closing because of the increase in mlline 
shopping: and banking and this is leading to 'ghost towns' forming. 

Effects on companies due to the spread of on line shopping and banking 

TI1e discussion al:ove focused on the effects of lCT on people. H owever, companies 
and other organisations have also been affected by the growth of ICT and online 
shopping and banking. 
• Companies can save costs since fewer staff arc required and they do not need as 

many shops and banks in high streets to deal with potential customers. 
• Because the internet is global, the potential customer base is increased. 
• There will be some new costs, however, because of the need to re-train staff and 

the need to employ more staff in despatch departments. 
• There are also costs due to the setting up and maintaining of websites to enable 

online shopping and banking. 
• Since there is very little or no customer-employee interaction, this could lead to a 

drop in customer loyalty, whicl1 could result in loss of customers. This could also 
be brought about by the lack of personal service associated with online shopping 
and banking. 

Should the internet be policed? 
This is a question which has raged for many years. Currently, the internet has no 
controlling body to ensure that it conforms to certain standards. TI1ere are many 
arguments in favour of control and as many arguments against. 

Arguments in favour of some form of control 

• It would prevent illegal material being posted on websites (e.g. racist/ prejudiced 
material, pornographic matter, material promoting terrorist activities, etc.). 

• People find it much easier to discover information which can have serious 
consequences (e.g. how to be a hacker, how to make OOtnbs, etc.). Although 
most of this can be found in books, it is much easier to find the information 
using a search engine. 
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• It would prevent children and other vulnerable groups being subjected to 
undesirable websites. 

• Since anyone can produce a website, there is no guarantee of the accuracy of 
information. Some form of control could reduce the amount of incorrect 
information being published. 

Argu me nts aga inst some fo rm o f co ntro l 

• Material published on the websites is already available from other sources. 
• It would be very expensive to 'police' all websites and users would have to pick 

up the bill. 
• It would be difficult to enforce rnles and regulations on a global scale. 
• It can be argued that policing would go against freedom of information. 
• Many topics and comments i:osted on websites are already illegal and laws 

currently exist to deal with the perpetrators. 

Micro processor-co ntro ll e d devices in the ho me 

Many common household devices are now fitted with microprocessors to control a 
large number of their functions. The devices fall into two categories: 
• labour-saving devices, which include automatic washing macl1ines, microwave 

ovens, ovens, and dishwashers 
• other housdmld devices, such as television sets, hifis, fridge/ freezers and central 

heating systems - these are not labour saving, but they do have microprocessors 
to control many of their functions. 

Tables 6.1 and 6.2 give the advantages and disadvantages of both types of devices. 

• They lead to more leisure time since 
the devices can be programmed to 
do the tasks. 

• People have more time to go out 
andsocialise,andcangooutwhen 
they want to. 

• They are becoming very 
sophisticated and can make use of 
embedded web technology. 

• They can lead to unhealthy diets 
(e.g. TVdinners). 

• Peoplecantendtobecomelazy, 
sincetheyrelyonthesedevices. 

Table 6.1 Advantages and disadvantages of microprocessor-controlled labour-saving devices 



Advantages 

• Theysaveenergy,sincetheycan 
switch off automatically. 

• It is easier to program the devices 
todoataskratherthan having to 
settimings,dates,etc. manually. 
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Disadvantages 

• Theyleadtoamorewasteful 
society: devices are thrown away if 
theelectronicsfail,sincetheyare 
not economic to repair. 

• They can be more complex to 
operateforpeoplewhoarenot 
technology literate. 

• Leaving devices on standby (such as 
televisions) leads to a waste of 

Table 6.2 Advantages and disadvantages of other microprocessor-controlled devices 

6.5 Informatio n from th e internet 

The social and general impact of using the internet or devices which rely on 
microprocessors have been discussed in earlier sections. This section will now look at 
the quality of information found on the internet when using a search engines. TI1ere 
are four main aspects to consider: 
• reliability of information 
• undesirability of certain websites 
• securityissues 
• other internet issues. 

Reliability of information 

• Information is more likely to be up to date than in books, since websites can be 
updated very quickly. 

• It is much easier to get information from websites, as search engines quickly link 
key words together and find information that matches the criteria. 

e There is a vast amount of infonnation on the internet, which is easier to locate 
than using the indices in several books. 

• However, information on the internet may be incorrect, inaccurate or even biased 
since it does not go through any checking process. 

• There is a risk of information overload even if search engines are used properly. It 
is possible to get thousands of hits, which may make it difficult to find the 
infonnation relevant to the user's search. 

Undesirability of certa in websites 

• TI1cre is always the risk of finding undesirable websites (as discussed in Section 6.4). 
• There is also a risk of doubtful websites which are not genuine and could lead to 

a number of problems such as undesirable web links, secu rity risks, etc. 
• Security risks are a very large problem and arc discussed in the following section. 
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Security issues 
The risk of virnses and hacking has already been discussed in Section 6.3. The use of 
passwords, user IDs, encryption, firewalls and other software protection was also 
discussed in Section 6.3. H owever, there are other security risks (not necessarily as a 
result of viruses or hacking) associated with connecting to the internet. 1l1ese 
security risks are now discussed in some depth. 

Phishing 

Phishing is a fraudulent operation involving the use of emails. The creator sends out 
a legitimate-looking email, hoping to gather personal and financial information from 
the recipient of the email. To make it more realistic (and therefore even more 
dangerous! ) the message will appear to have come from some legitimate source 
(such as a famous bank). As soon as an unsuspecting user clicks on the link they are 
sent to a spoof website where they will be asked for personal information including 
credit card details, PINs, etc. which could lead to identity theft. 

Many ISPs now attempt to filter out phishing emails, but users should always be 
aware that a risk still exists and should be suspicious of any emails requesting 
unsolicited personal details. 

Pharming 

Pharming is a scam in which malicious code is installed on a computer hard disk or 
a server. 1bis code has the ability to misdirect users to fraudulent websites, usually 
without their knowledge or consent. 

\Vhereas phishing requires an email to be sent out to every person who has been 
targeted., pharming docs not require emails to be sent out to everybody and can 
therefore target a much larger group of people much more easily. Also, no conscious 
action needs to necessarily be made by the user (such as opening an email), which 
means the user will probably have no idea at all that have been targeted. Basically, 
pharming works like this: 

A hacker/pharmer will first infect the user's computer with a virns, either by 
sending an email or by installing software on their computer when they first visit 
their website. It could also be installed as part of something the user chooses to 
install from a website (so the user doesn't necessarily have to open an email to 
become infected). Once infected., the vims would send the user to a fake website that 
looks almost identical to the one they really wanted to visit. Consequently, personal 
infonnation from the user's computer can picked up by the pharmcrjhacker. 

Certain anti-spyware, anti-virns software or anti-pharming software can be used 
to identify this code and correct the corrnption. 

Spam 

Spam is electronic junk mail and is a type of advertising from a company sent out to a 
target mailing list. It is usually harmless but it can clog up the networks, slowing them 
down, or fill up a user's mail OOx. It is therefore more of a nuisance than a security risk. 

Many ISPs are good at filtering out spam. In fact, some are so efficient that it is 
often necessary to put legitimate email addresses into a contacts list/address book to 
ensure that wanted emails are not filtered out by mistake. 
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Spywa re 

Spyware is software that gathers user infonnation through their network connections 
without them being aware that this is happening. Once spyware is installed, it 
monitors all key presses and transmits the information back to the person who sent 
out the spyware. This software also has the ability to install other spyware software, 
read cookies and even change the default home page or web browser. Anti-spyware 
can be used to search out this software and correct the com1ption. 

Other internet issues 

Although the following item is not regarded as a security threat, it can be a 
considerable nuisance to an internet user and is included here for completeness. 

Cookies 

Cookies are small files sent to a user's computer via their web browser when they 
visit certain websites. They store information about the users and this data is 
accessed eacl1 time they visit the website. For example: 
• they remember who the user is and send messages such as 'Welcome Daniel' each 

time they log onto the website 
• they recognise a user's buying preferences; e.g. if a user buys CDs, pop ups 

(adverts) related to their buying habits will appear on the user's screen eacl1 time 
they visit the website. 

Without cookies, the web server would have no way of knowing that the user had 
visited the website before. 

6 .6 Internet developments 

The internet has changed out of all recognition since it first started, and continues to 
develop. This section considers some of the most recent developments in the way 
the internet is used. 

Web 2.0 refers to a second generation of internet dt..-vdopment and design. This 
has led to a development of new web-based communication, applications and hosted 
servers. For example, the following will be considered in more detail in this section: 
• biogs 
• wikis 
• digital media sharing websites 
• social networking sites 
• folksonomies. 

Biogs 

Biogs (which is an abbreviation for web logs) are personal internet journals where the 
writer (or blogger) will type in their observations on some topic (e.g. a political view) 
or even provide links to certain relevant websites. No training is needed to do this. 

Biogs tend to range from minor projects where people just gossip about some 
topic (such as the peiformance of an actor in a recent film) through to important 
subjects such as politics, advertising products or raising awareness of a certain key 
event taking place. H owever, comments made are ,wt immune from the law and 
bloggers can still be prosecuted for making offensive statements about people! 
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Wik is 
The word Wiki' comes from a H awaiian word meaning 'fast'. Wikis are software 
allowing users to easily create and edit web pages using any web browser. A wiki will 
support hyperlinks and has very simple syntax (language mlcs) for creating pages. 
They have often been described as \veb pages with an edit button'. Anyone can use 
wikis, which means that the content should always be treated with some caution. One 
of the most common examples of a wiki is the 01Uine encyclopedia Wikipedia. 

Digital media sharing websites 

Digital media sharing websites allow users to upload video clips and other media 
to an internet website. The video host, for example, will then store the video on a 
server and show the user the different types of code which can be used to enable 
them to view the video clip. 

This development is becoming increasingly popular since most users don't have 
unlimited web space. One of the most common examples of this is YouTube. 

Social networking sites 

Social nenvorking sites focus on building online communities of users who share 
the same interests and activities. They enable young people, in particular, to share 
photos of themselves, show people their favourite videos and music, what they like 
to do in their spare time, what they like to eat, etc. 

Common examples include Facebook and Myspace, where users can join free of 
charge and interact with other people. It is possible to add friends and i:ost messages 011 
a bulletin/message board and up:iate personal profiles to notify friends about themseh'eS. 

These are rapidly becoming the modem way of interacting socially and they allow 
young people, in particular, to communicate across the world and share their 
interests and views with many people. 

Folksonomies 

Folksonomies are closely related to tagging and literally mean 'management of people'. 
Tagging is a type of social bookmarking where a user can tag any web page with words 
that describe its contents. Anyone can view web pages corresponding to a specific tag. 
In folksonomies, the visual representati011 is a tag cloud - this is a seguence of words of 
different sizes that represent popular rags by showing them in a larger frnn size. One of 
the most common examples is Flickr. 

6.7 Hea lth and safety issues 
There are many health and safety problems associated with regular use of computer 
systems. 

H ealth and safety regulations advise that all computer systems have a minimum of 
tiltable and anti-glare screens, adjustable chairs and foot supports, suitable lighting, 
uncluttered work stations, and recommend freguent breaks and eye tests. 



Back and neck 
problems/strain 

Repetitive strain injury 
(RSl) - damageto 
fingers and wrists 

Eyestrain(causedby 
staring at a computer 
screentoolongorbad 
lighting in the room) 

Headaches 
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Although health and safety are closely related, they are very different subjects. 
Health issues are related to how to stop people becoming ill or affected by daily 
contact with computers. Safety is more concerned with the dangers whicl1 could lead 
to serious injury or even loss of life. TI1ey are discussed in separate sections below to 

help clarify the main differences. 

Health aspects 
Table 6.3 highlights a number of health issues, together with possible solutions to 

either minimise the risk or eliminate it altogether. 

• use fully adjustable chairs to give the correct posture 

• usefootreststoreducepostureproblems 

• usescreensthatcanbetiltedtoensuretheneck isatthecorrectangle 

• ensure correct posture is maintained (i.e. correct angle of arms to the 
keyboard and mouse, for example) 

• make proper use of a wrist rest when using a mouse or a keyboard 

• take regular breaks and do some exercise 

• use ergonomic keyboards 

• use voice-activated software if the user is prone to problems when using 
mouse and keyboard 

• ensure that there is no screen flicker, since this can lead to eye problems 

• change to LCD screens w here flicker is less of a problem than with CRT screens 

• take regular breaks and try focusing on a point which is some distance away 

• make use of anti-glare screens if lighting in the room is a problem or use 
window blinds to reduce strong sunlight 

• haveeyestestedregularly - middle-visionglassesshould be prescribed if the 
userhasapersistentproblemsuchaseyestrain,dryeyes, headaches.etc.) 

• use an anti -glare screen or use window blinds to cut out light reflections -
bad lightingcancausesquintingand leadtoheadaches,etc. 

• take regular breaks and do some exercise 

• have eyes tested regularly and use middle-vision glasses if necessary 

Ozoneirritation(dry 
skin, respiratory 
problems, etc.) - thisis 
caused by laser printers 
in an office area 

• ensure proper ventilation to remove the ozone gas as quickly as possible 

• house laser printers in a designated printer room 

• change to other types of printer if necessary (e.g. inkjet printers) 

Table 6.3 Health risks and proposed solutions 
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Safety aspects 
Table 6.4 gives a number of safety issues, together with possible solutions to 
eliminate or minimise the risk. 

Safety hazard Ways of ehm1nat1ng or m1n1m1sing hazard 

Electrocution • use of a residualcircuitbreaker(RCB) 

• check insulation on wires regularly 

• do not allow drinks near computers 

• check equipment regularly 

Trailing wires (trip hazard) • use cable ducts to make the wires safe 

• cover wires and/or have them neatly tucked away 
(under desks, etc.) 

• try and use wireless connections wherever possible, 
thus eliminating cables altogether 

Heavy equipment falling • use strong desk and tables to support heavy 

Fire risk 

hardware 

• use large desks and tables so that hardware isn't too 
closetotheedgewhereitcanfall off 

• have a fullytestedC02/dryfireextinguishernearby 
(not water extinguishers!) 

• don't cover equipment vents, which can cause 
equipment to overheat 

• make sure hardware is fully maintained 

• ensure good ventilation in the room, again to stop 
overheating of hardware 

• do not overload sockets with too many items 

• change to low voltage hardware wherever possible 
(e.g. replace CRT monitors with LCD monitors) 

Table6.4 Safety hazards and proposed solutions 
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I this chapter you will learn about: 
communication systems 
satellite and mobile phone network communications 
data handling applications 
modelling applications 
batch processing and online systems 
control and monitoring applications 
robotics 
batch processing applications 
automatic stock control systems (use of barcodes) 
online booking systems 
banking applications 
library systems 
expert systems. 

7.1 Introduction 

This chapter koks at how ICT is used in everyday life and discusses the many 
advantages and drawbacks of using computer systems to replace or enhance 
applications which were previously paper or manually based. 

7.2 Communications applications 

There are several communication applications that make use of ICf technology. 
These fall into two categories: methods of communication and ways of 
communicating information. 

Methods of communication include: 
• video conferencing 
• voice over internet protocol (VOiP) systems 
• emails. 

TI1ese were discussed in Section 4.7, and so are not considered any further here. 
There are a large number of ways of communicating information. The five 

considered here arc: 
• multimedia presentations 
• printing flyers and posters 
• use of websites 
• music production 
• cartoon animations. 
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Multimedia presentations 

Presentations using animation, video and sound/music are generally much more 
interesting than a presentation done on slides or paper. 

The presentations are produced using one of the many software packages on the 
market and then used with a multimedia projector so that the whole audience is able 
to see the presentation. Some of the advantages of this type of presentation include: 
• the use of sound and animation/video effects 
• interactivefhyperlinks built into the presentation 
• the fact that it is more likely to hold the audience's attention. 

Some of the disadvantages include: 
• the need to have special equipment, which can be expensive 
• sometimes the requirement for internet access within the presentation, if the user 

wishes to access files (e.g. music or video) from websites or up-to-date 
information (e.g. weather reports) which needs a live connection. 

Paper-based presentations 

It is always possible to produce presentations in a hardcopy format rather than the 
system described above. This has the following advantages: 
• Disabled people do not have to go to the venue to see the presentation. 
• It is possible to print it out in Braille for the benefit of blind people. 
• The recipient can read the presentation at any time they want. 
• The recipients have a pennanent copy, which they can refer to at any time they want. 

There arc, however, disadvantages: 
• The presentation needs to be distributed in some way. 
• There are no special effects (sound, video, animation). 
• There are printing costs (paper, ink, etc. ). 

Flyers and posters 
Flyers and posters can be produced very easily using one of the many software 
packages available, most commonly word processors and desktop publishers 
(DTP). Usually, the flyer or poster will have photos which have been taken specially 
or have been downloaded from the internet. The following sequence is fairly typical 
ofhow such a document would be produced on a computer system: 
e A word processor or D11' application is opened. 
• The user creates frames, boxes and text boxes. 
• If necessary, photos are taken, using a camera. 
• The images are uploaded from the camera, loaded from a CD/DVD, scanned 

from hard-copy photos or downloaded from the internet. 
• The photos are saved to a file. 
• The photos are imported or copied and pasted into the document. 
• The photos are edited and text t}pcd in or imi:orted from a file and then put into 

the required style. 

Websites 

Rather than producing flyers and posters by printing them out, it is i:ossible to use 
websites for advertising and communication. There are a number of advantages and 
disadvantages of using this teclmique. 
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Advantages include: 
• the ability to add sound/video/animation 
• links to other websites/hyperlinks 
• the use of hot spots 
• buttons to navigate/move around the website 
• hit counters to see who has visited the websites. 

Disadvantages include: 
• the fact that websites can be hacked into and modified or viruses introduced 
• the need for a computer and internet connection 
• its lack of p:>rtabiliry compared with a paper-based system 
• the need to maintain the website once it is set up. 

Music production 

The generation of music and the production of music scores can now be done by 
computer systems with the appropriate software, for example: 
• music samplers and mixers allow the original tracks that were recorded in the 

studio to be modified in any way that the pnxl.ucer wants 
• electronic instruments (like guitars and organs) can play back through electronic 

effects machines 
• synthesisers combine simple wave fonns to produce complex music creations 
• electronic organs can mimic any other instrument 
• music scores can be generated from the music itself using software 
• software can automatically correct music notes in a score 
• there is no need to understand music notation to write a music score 
• music notes are automatically printed out in the correct format. 

Cartoon animations 

Animation can be produced using computer hardware and sofnvare. With 30 
animation, objects are designed on a computer and a 3 0 skeleton produced. 111e 
parts of the skeleton are moved by the animator using key frames (these frames 
define the start point and end point to give a smooth animation effect). The 
difference in the appearance of the skeleton in these key frames is automatically 
calculated by the software and is known as tweening or morphing. The final stage 
is to make a realistic image by a technique known as rendering. 

7.3 Satellite and mobile network commun ications 

This section considers three applications which make use of satellite technology 
and/ or mobile phone network teclmology: 
• mobile phone networks 
• embedded web teclmology (EWf) 
• global positioning satellite systems (G PS). 

Mobile phone networks 

Mobile phones communicate by using towers inside many cells networked together 
to cover large areas, illustrated in Figure 7.1. TI1e towers allow the transmission of 
data throughout the mobile phone network. 
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Each tower transmits within its own 

cell. If you are driving a car and get to rj"\. ::~:?;J~~,: 
the edge of a cell the mobile phone ~ pt,o,,o co,«-

signal starts to weaken. This is 
recognised by the network and the Figure 7.1 A network of mobile phone cells 

mobile phone then picks up the signal in 
one of the adjacent cells. If a person is making a call or sending a text to somebody 
in a different country then satellite technology is used to enable the communication 
to take place. 

Mobile phone technology can now be used by computers. A plug-in device 
(using one of the available USB fOrts ) allows the computer to connect to the mobile 
phone network, which then allows access to the internet. This service is usually 
provided through a monthly contract which gives a download limit. 

Embedded web technology 
Embedded web technology (EWT ) is a relatively new development that uses the 
internet in real time to control or interact with a device in the home or a device 
which is part of an industrial application. The device must contain an embedded 
microprocessor for this system to work. 

The device can be controlled by an authorised user from a computer anywhere on 
a network or from a web-enabled mobile phone. 

Consider the scenario of an oven equipped with an embedded processor. An 
authorised person can use their web-enabled mobile phone, for example, to send 
instructions to control the oven remotely (e.g. switch it on at a given time, set the 
timings and set the temperature) from their office before setting off for home. Any 
device with an embedded microprocessor can be controlled in this way; examples 
include a DVD recorder, a washing machine, a central heating system or even a 
scientific experiment in some remote location (e.g. in outer space or under the sea). 

Global positioning satellite (GPS) systems 
Global positioning satellite (GPS) systems are 
used to determine the exact location of a number 
of modes of transport ( e.g. airplanes, cars, ships, 
etc.). Cars usually refer to GPS as satellite 
navigation systems (sat navs). 

Satellites surrounding the Earth transmit 
signals to the surface. Computers installed in the 
mode of transport receive and interpret these 
signals. Knowing their position on the Earth 
depends on very accurate timing - atomic clocks 
are used in the satellites which are accurate to 
within a fraction of a second per day. Each satellite 
transmits data indicating its position and time. Figure 7.2 Calculation of position 
The computer on board the mode of transport using satellites 

calculates its exact position based on the 
information from at least three satellites, illustrated in Figure 7.2. 

In cars, the on-board computer contains pre-stored road maps. With these sat nav 
systems the car's exact location, based on satellite positioning, can be shown on the 
map and the driver can also be given verbal instrnctions such as: 'After 100 metres, 
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the car's position in relation to the road ~ , 
network (see Figure 7.3 ). ~ 

Advantages Al2lS b octlocoHanofthom 

• ;~;e;::;sd:i:il:~rt~~~~~oc~:~tlt :~~~:~ 7 .3 Car position shown on a sat nav 

far safer. 
• It removes errors, as it can wan1 drivers about one way streets, street closures, etc. 
• TI1e system can warn the driver about the location of speed cameras, again aiding 

safety. 
• TI1e system can estimate the time of arrival. 
• It is also possible to program in the fastest route, a route to avoid towns, etc. 
• TI1e system can give useful information such as the location of petrol stations. 

Disadvantages 

• If the maps are not kept up to date, they can give incorrect instrnctions. 
• Unless the system is sophisticated, road closures, due to accidents or road works, 

can cause problems. 
• Loss of satellite signals can cause problems. 
• If an incorrect start point or end point is keyed in, the system will give incorrect 

information. 

7.4 Data han d ling applications 

AO ao c® oo 10 
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Figure7.4 Methods 
of filling in 
questionnaires 

A number of applications make use of simple data handling technigues, such as: 
• surveys 
• tuck shop (i.e. schCXJl sweet shop) records 
• clubs and society records 
• record keeping (e.g. a book shop). 

Surveys 

Suppose a small business is interested in finding out information about the buying 
habits of a number of customers. Questionnaires or surveys will be either handed 
out to people or posted on a website to allow them to be filled in onlinc. Paper 
questionnaires will be filled in either by shading in circles, ticking in boxes or 
connecting two points to select the correct response (see Figure 7.4). 

Online questionnaires would tend to use the first option (using radio buttons) 
since this is a quick and easy method for gathering data. 

Paper surveys are then scanned in using optical mark recognition (OMR) or 
optical character recognition (OCR) methods and the information is transferred to a 
database. TI1e advantages of doing this rather than checking each one by hand are that: 
• it is faster to get results 
• therearefewererrors 
• it is easier to do a statistical analysis 
• it is less expensive to carry out, since it needs fewer people. 

Online questionnaires have the added advantage that no data preparation is needed, 
as the results are sent directly to a database for analysis. 

II 
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Tuck shop records 

An example of the use of spreadsheets to keep school nick shop accounts is given in 
Section 7 .5 . Simple financial applications such as these use spreadsheets to keep a 
record of prices and takings. The advantage is that it is much easier to vary different 
parameters to show how to optimise profits or to see why a loss is being made. The 
system can be programmed (using macros) to automatically warn of any problems. 

Club and society records 

Clubs and societies need to keep records of their membership. The information held 
typically includes payment details, contact details (phone number, address), 
interests, etc. A simple database is often used to hold all this information, making it 
unnecessary to keep paper records. Consequently, if a particular item of interest 
(e.g. a talk on Fl motor racing) comes up then the computer system can quickly 
scan all the records on file and find out who would be interested in this topic. The 
organisation can then automatically contact the member by email or, using mail 
merging, send out a letter and flyer. 

It is also easy to check on membership subscriptions and send out reminders. 
This all saves having manual records on paper, which take time to search, can be 
easily lost, can have some details missing. It is also less expensive ( cost of paper, 
filing, etc. ) and saves on space in the office area. 

It is worth noting that data stored by the club/society may be of a personal narure 
and must therefore obey the rules of a data protection act. 

A typica l data protection ad 

The puqx:,se of a data protection act is to protect the rights of the individual about 
whom data is obtained, stored and processed (i.e. collection, use, disclosure, 
destmction and holding of data). Any sucl1 act applies to both computerised and 
paper records. 

Any data protection act is based on eight simple principles: 
l D ata must be fairly and lawfully processed. 

2 D ata can only be processed for the stated purpose. 

3 Data must be adequate, relevant and not excessive. 

4 Data must be accurate. 

5 D ata must not be kept longer than necessary. 

6 D ata must be processed in accordance with the data subject's rights. 

7 Data must be kept secure. 

8 Data must not be transferred to another country unless they too have ade<:]uate 
protection. 

Failure to abide by these simple mles can lead to a fine and/or imprisonment to 
anyone who holds data about individuals. 

There are general guidelines about how to stop data being obtained unlawfully: 
• Don't leave personal information lying around on a desk when not being used. 
• Lock. all filing cabinets at the end of the day or when an office is unmanned for 

any length of time. 
• Do not leave data on a monitor if unattended or log off from a computer system 

if it is to be unattended for a time. 
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• Protect passwords and don't give them out to anylxxly else. 
• Change passwords regularly and select passwords which are difficult to 'crack'. 
• Make sure anything in a fax/email is not of a sensitive nature (ask yourself the 

question: 'Would I write that on a post card?') 

All of the above arc in addition to the number of safeguards discussed throughout 
this book (such as ways to prevent hacking, phishing, pharming, etc. ). 

Record keeping 
To evaluate the advantages of using a computer system for record keeping, we will 
consider the case of a small bookshop. This shop keeps files on the books in stock 
and on their customer base. Using a simple database it would be easy to keep this 
information in electronic form. TI1is would make it easy to contact customers if a 
particular book was just published or to check on their buying habits. If a customer 
came into the shop it would also be far easier to search for a particular book (based 
on title, author or ISBN). No paper records would need to be kept which would 
lead to the following advantages to the shop: 
• Less llX)m would used up in tl1c shop since no paper record would need to be kept. 
• It would be quicker and easier to find details of a particular book or find out 

whether or not it was in stock. 
• The system would be less expensive, since it wouldn't be necessary to employ 

somelxxly to do all the filing and searching. 
• There would be fewer errors since no manual checking of paper files would be done. 

There are some disadvantages of the system: 
• The shop would need to buy a computer and software to nm the system. 
• It would take a lot of time and effort to transfer all the paper files to the database. 

7.5 Modelling applica tions 

A simulation is the creation of a model of a real system in order to study the 
behaviour of tl1e system. TI1e model is computer generated and is based on 
matl1ematicalrepresentations. 

The idea is to try and find out what mechanisms control how a system behaves 
and consequently predict the bd1aviour of tl1e system in tl1e future and also see if it 
is i:ossible to influence this fumre behaviour. 

Computer models have the advantage that they save money, can help find a 
solution more quickly and can be considerably safer (discussed further below). There 
are many examples of simulations, ranging from simple spreadsheet representations 
through to complex flight simulators. This section gives two examples: a model for 
showing a shop's profit/loss and a traffic light simulation. 

Tuck shop model 
This example uses a spreadsheet to do the modelling. It models tl1e school tuck shop 
mentioned in Section 7.4. The numbers in the spreadsheet model are shown in 
Figure 7.5, with Figure 7.6 showing the formulae that produce these numbers. 
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Figure7 .7 A 
junction controlled 
by traffic lights 
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Figure7.5 Resultsinthespreadsheetmodelforatuckshop 

Figure7.6 Expressionsinthespreadsheetmodelforatuckshop 

Thus, by varying the values in column C or in column F it would be possible to 

model the shop's profit or loss. This is a very simple model but it shows the 
principal of using spreadsheets to carry out any type of modelling that can be 
represented in a mathematical form. 

Traffic light simulation 
To demonstrate a more complex simulation, the following scenario has been chosen: 
a set of traffic lights are to be modelled at a ¥-junction, as shown in Figure 7.7. 

In this simulation it is necessary to consider: 
• how and what data net"Cls to be collected 
• how the simulation is carried out 
• how the system would work in real life. 

Data coll ectio n 
Since the success (or failure) of a simulation model depends on how realistic it is, 
data needs to be collected by watching traflic for a long period of time at the 
¥-junction. This is best done by using induction loop sensors which count the 
number of vehicles at each junction. Manual data collection is possible but is prone 
to errors and is difficult to do over an IS-hour period per day, for example. The 
following data is an indication of what would need to be collected: 
• the number of vehicles passing the junction in all directions 
• the time of day for the vehicle count 
• how many vehicles build up at the junction at different times of the day 
• how vd1icle movements change at weekends, bank holidays, etc. 
• how long it takes a vd1icle to clear the junction 
• how long it takes the slowest vehicle to pass through the junction 
• the movements made by vehicles ( e.g. left turns, right turns, filtering, etc. ) 
• additional environmental factors, such as whether there are pedestrian 

crossings nearby. 
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Carrying o ut the sim ul a tion 

Data from the above list is entered into the computer and the simulation nm. The 
results of the simulation are compared with actual traffic flow from a number of data 
sets. Once the designers arc satisfied that it simulates the real situation accurately, 
then different scenarios can be tried out. For example: 
• vary the timing of the lights and see how the traffic flow is affected 
• build up the number of vehicles stopped at part of the junction and then change 

the timing of the lights to see how the traffic flow is affected 
• increase or decrease traffic flow in all directions 
• how emergency vd1icles affect traffic flow at different times of the day. 

Using the sim ula tio n 

This simulation can then be used to optimise the flow of traffic through the junction 
on an ongoing basis. 
• Sensors in the road gather data and count the number of vehicles at the junction. 
• This data is sent to a control box or to a computer. It may need to be converted 

first into a form understood by the computer. 
• The gathered data is compared to data stored in the system. The stored data is 

based on model/simulation predictions which were used to optimise the traffic flow. 
• The control box or computer 'decides' what action needs to be taken. 
• Signals arc sent out to the traffic lights to cl1ange their timing if necessary. 

Why simulations are used 
• They arc less expensive than having to build the real thing (e.g. a bridge). 
• On many occasions it is sater to run a simulation - some real situations arc 

hazardous (e.g. chemical processes). 
• With simulations, various scenarios can be tried out in advance. 
• It is nearly impossible to try out some tasks in real life because of the high risk 

involved or the remoteness ( e.g. in outer space, under the sea, in nuclear reactors, 
crash tcstingcars,etc.). 

• It is often faster to do a simulation than the real thing. Some applications could 
take years before a result was known (e.g. climate cliange calculations, population 
growth, etc. ). 

TI1erc arc some limitations to using simulations: 
• They arc only as good as the data used and the mathematical algorithms 

representing the real-life situations. They therefore have a limited use in some 
very complex applications (e.g. simulating a nuclear process). 

• They can be very expensive to set up and often require specialist software to be 
written. 

• They frequently require very fast processors/computer systems (which can be 
expensive) to do the necessary 'number cnmching'; many simulations are made 
up of complex mathematical functions and use several thousand data sets. 

II 
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Exercise 7a 
Here is a list of five simulations/models and a list of five reasons why models are carried out. Try 
and match the five simulations to the best reason why that simulation would be done. 

Pilot training Cost of building the real thing is too expensive 

Environmental modelling Some situations are too dangerous to humans 

Simulati ng bridge loading Take too long to get results back from real thing 

Nudear reactor model It is almost impossible to do the tasks for real 

Space exploration Easier/safertomakechangestoamodel 

7.6 Types of processing 

There are three basic types of processing: 
• batch processing 
• real-time (transaction) or online processing 
• real-time process control. 

Batch processing 

With batch processing, a number of tasks (jobs) are all collected together over a set 
period of time. The jobs are then loaded into a computer system (known as a job 
queue) and processed all at once (in a batch). Once the batch processing starts, no 
user interaction is needed. TI1is type of processing can only be done where there are 
no timing constraints, i.e. files don't need to be updated immediately or a response 
from the computer is not needed straight away. 

A big advantage of batch processing is that the jobs can be processed when the 
computer system is less busy ( e.g. overnight), so the use of resources is being 
optimised. Areas where batch processing is used include billing systems 
(e.g. electricity, gas, water and telephone), payroll systems and processing of bank 
cheques. Section 7.9 considers batcl1 processing applications in more detail. 

Real-time (transaction) processing 

Real-time (transaction) processing is an example of online processing. When 
booking seats on a flight or at the theatre, for example, this type of online processing 
is required. The response to a query needs to be very fast in order to prevent 'double 
booking' and seats need to be marked as 'unavailable' immediately the booking is 
confirmed. (Booking applications are covered in more detail in Section 7. 11.) 

Examples of the use of this type of processing include flight bookings, cinema and 
theatre bookings and use of an automatic teller machine (ATM) when getting money. 

Real-time process control 

Although this is still an example of online processing, it is very different to real­
time (transaction) processing. This system usually involves sensors and feedback 
loops ( e.g. monitoring and control applications - these are covered in more detail in 
Section 7.7). 
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In real-time (transaction) processing, files are updated in real time (e.g. booking 
flights ) but in real-time process control, physical quantities (such as a temperature) 
are continually monitored and the input is processed sufficiently quickly to influence 
the input source. 

7.7 Contro l app lica tions 
This section is split into two parts: rurtle graphics and the use of sensors to control 
or monitor applications. 

Turtle graphics 
This is based on tl1e computer language called LOGO and is now usually known as 
turtle graphics. It is essentially tl1e control of the movement of a 'turtle' on a 
computer screen by a number of key instmctions which can be typed in. TI1e most 
common commands are given in Table 7.1. Thus, to draw the shape shown in bold 
in Figure 7.8, the instructions listed in Table 7.2 need to be carried out. Note that 
there are two possible sequences of instructions, which will both draw tl1c same 
shape - tl1e second option makes use of'Rcpcat' instmctions and so is more efficient 
in its coding. 

FORWARD x Move x cm forward 

BACKWARD x Move x cm backward 

LEFT d Turn leftthrough d degrees 

· ~ ···· :·····1····· 1 · 
,oo 

RIGHT d Turn rightthrough d degrees 

REPEAT n Repeat next set of instructions n times 

ENDREPEAT Finish the repeat loop 

PEN UP Lift the pen up 

PEN DOWN Lowerthepen 

Figure 7.8 Shape to be drawn by the turtle Table 7.1 Common turtle graphics commands 

Pendown Forward40 Pen down Pendown 

Left90 Left90 Left90 Forward20 

Forward40 Pendown Repeat3 Repeat3 

Right90 Forward 20 Forward40 Right90 

Forward40 Right90 Right90 Forward40 

Right90 Forward40 Endrepeat End repeat 

Forward40 Right90 Forward20 

Right90 Forward40 Pen up 

Forward20 Right90 Left90 

Pen up Forward40 Forward40 

Left90 Left90 

Table 7.2 lnstructionstodrawtheshape inFigure7 .8 
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Applications using sensors 
There is a difference between monituring and controlling an application using a 
computer and sensors. In both cases, sensors arc used to send data to a computer 
where the data is processed - it is what happens next where the differences occur: 
In monitoring, the computer simply reviews the data from the sensors 
(by comparing it to data stored in memory) and updates its files and/or gives a 
warning signal if the values arc outside given parameters. No clmnges to tlJe process are 
mnde during monitoring. 

In control applications, the computer again reviews the data from the sensors 
(by comparing it to data stored in memory). But if the values arc outside the given 
parameters it tnkes action to try and get the values wit/Jin acceptable ranges. It does this 
by sending signals to devices controlling the process (such as motors, valves, etc.). 
For example, if the temperature in a greenhouse is tCXJ high, it might send a signal to 
a motor to open a window until the temperature is within acceptable parameters; 
once the temperature dropped to acceptable values, the computer would instmct the 
motor to close the window again. 

There arc many examples of monitoring and control applications. 

Monitoring: 
• monitoring a patient's vital signs in a hospital 
• monitoring a scientific experiment in a laboratory 
• a burglar alann system 
• environmental monitoring (e.g. oxygen levels in a river). 

Control: 
• controlling a chemical process 
• controlling a nuclear reactor 
• controlling a greenhouse cnviromnent 
• controlling a central heating system 
• controlling a set of traffic lights. 

Remember also that it was stressed in Section 5.5 that the analogue data from the 
sensors needs to be converted into digital data using an analogue to digital 
converter (ADC) so that the computer can understand and process the data from 
the sensors. If the computer sends signals to motors, valves, etc. then this data also 
needs to be converted to analogue using a digital to analogue converter (DAC) so 
that the computer can effectively control these devices. 

We will now consider a number of monitoring and control applications. There 
arc so many examples to chCXJsc from that it is important that you understand the 
principle behind each process so that this can be adapted to suit other examples. 

Monitoring example: monitoring a patient's vital signs in a hospital 

• Sensors read key vital signs (sucl1 as pulse/heart rate, tcmpcrarurc, blood 
pressure, respiration, etc.). 

• The data from the sensors is converted into digital using an ADC. 
• The data is stored in the computer's memory. 
• The computer compares the data from the sensors with the values stored in its 

memory. 
• The results arc output on a screen in the form of graphs and/or digital read-outs. 
• An alarm is activated if any of the data is outside acceptable parameters. 
• The system continues to monitor the patient until the computer is rurned off. 
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Monitoring example: measuring oxygen levels in a river (environmental 
monitoring) 

The monitoring system and the positions of the sensors arc shown in Figure 7.9. 

Figu re 7.9 A monitoring system for measuring 
oxygen levels in a river 

• Sensors read data from the river ( oxygen levels and acidity levels using a pH 
sensor). 

• The data from the sensors is converted into digital using an ADC. 
• The computer stores the received data. 
• The oxygen levels and acidity levels arc compared to the historical data stored in 

memory and they arc also compared to alarm levels stored in memory. 
• One of two things will now happen: either the data is transferred to a CD/ DVD 

or to a memory stick and taken away for analysis later or the computer is 
connected into a mobile phone network and transmits the data back 
automatically to the monitoring station. 

Advantages of using computers and sensors for monitoring 

• The computer will not forget to take readings. 
• The computer's response time is much faster, which is particularly important in 

the patient monitoring example. 
• Doctors, nurses, scientists, etc. can all get on with other tasks while the 

monitoring is done automatically. 
• Computers give 24 hours cover every day (i.e. 24/ 7). 
• The readings will tend to be more accurate. 
• Readings can be taken more frequently if they arc done by a computer and sensors. 
• It could also be safer if whatever is being monitored may have potential hazards 

(e.g. children falling into the river whilst attempting to take readings). 

Control example: a greenhouse environment 

Five different sensors could be used to control a greenhouse environment: humidity, 
moisn1rc, temperarnre, pH and light sensors. The system is shown in Figure 7. 10. 

Because of tl1e number of sensors, this is clearly quite a complex problem. I.et us 
consider tl1e humidity sensor only. 1l1is sends a signal to an ADC which then sends 
a digital signal to tl1e computer. This compares the input with stored values and 
decides what action needs to be taken (follow tl1e orange lines in Figure 7.10). If 
humidity is too high, the computer sends a signal to a DAC to operate the motors 
to open windows tlms reducing the humidity. Ifit is too low, the computer sends a 
signal to open valves to spray water into the air (follow the green lines in Figure 
7.10 overleaf). This continues as long as the system is switched on. The process is 
similarforallfivesensors. 
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Figure7.1 0 The control system fora greenhouse 

Control example: che mi cal process 

A certain chemical process only works if the temperamre is above 70°C and the pH 
(acidity) level is less than 3.5. Sensors are used as part of the control system. A 
heater is used to wann the reactor and valves are used to add acid when necessary to 

maintain the acidity. The following description shows how the sensors and 
computer are used to control this process. 
• Temperature and pH sensors read data from the chemical process. 
• This data is converted to digital using an ADC. 
• The computer compares the incoming data with ' ideal' data stored in memory: 

• If the temperamre is too low, a signal is sent to switch on the heaters. 
• If the temperamre is too high, a signal is sent to switch off the heaters. 
• If the temperamre is within an acceptable range, no action is taken. 
• If the pH is too high, a signal is sent to open a valve and acid is added. 
e If the pH is too low, a signal is sent to close this valve. 
• If the pH is within an acceptable range, no action is taken. 
• TI1e computer signals will be changed into analogue signals using a DAC so 

that it can control the heaters and valves. 
• This continues as long as the computer system is activated. 

Adva ntages of using se nsors and compute r syste ms to contro l processes 

The advantages given earlier for monitoring systems also apply to control systems. 
H owever, there are a number of additional advantages: 
• The response time if some parameter is out of range is mucl1 faster. 
• This is safer, as some processes are potentially dangerous if they go wrong-the 

computer can control the process in a more accurate way, ensuring that the 
conditions are always correct. 

• If a process is dangerous, it is better to control it from a distance. 
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7.8 Robotics 
RoOOts are used in many areas of manufacruring, from heavy work right through to 
delicate operations. Examples include paint spraying of car bodies, welding 
bodywork on cars, manufacruring of microchips, manufacturing electrical goods and 
automatic warehouses. 

Control of robots is either through embedded microprocessors (see Section 7.3) 
or linked to a computer system. Programming of the rolx>t to do a task is generally 
done in one of two ways: 
• The rolx>t is programmed with a sequence of instrnctions which allow it to carry 

out a series of tasks (e.g. spraying a car body with paint). 
• Alternatively, a human operator manually carries out a series of tasks and how 

each task is done is relayed back to the robot (embedded processor) or 
controlling computer. TI1e sequence of instrnctions is remembered so that the 
rolx>t can automatically carry out each task identically each time ( e.g. assembling 
parrs ina television). 

RoOOts are often equipped with sensors so they can gather important infonnation 
alx>ut their surroundings. Sensors also prevent them from doing 'stupid things', such 
as stopping a rolx>t spraying a car if no car is present, or stopping the spraying 
operation if the supply of paint has nm out, etc. 

Robots are very good at repetitive tasks. However, if there are many different 
tasks (e.g. making specialist glassware for some scientific work) then it is often 
better to still use human operators. 

Advantages 

• Robots can work in enviromnents harmful to human operators. 
• They can work non-stop (24/7). 
• They are less expensive in the long term. Although they are expensive to buy 

initially, they don't need wages. 
• Productivity is higher, since thc..-y do not need holidays, are not ii~ etc. 
• There is greater consistency - every car coming off a production line is identical. 
• They can do boring, repetitive tasks, leaving humans free to do other more 

skilled work. 

Disadvantages 

• Robots find it difficult to do 'unusual' tasks ( e.g. one-off glassware for a chemical 
company). 

• They replace skilled labour, leading to unemployment. 
• Since rolx>ts do many of the tasks once done by humans, there is a risk of de-skilling. 
• Because robots are independent of the skills base, factories can be moved 

anywhere in the world, again causing unemployment. 

II 
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7.9 Batch processing app lications 
There are several applications that make use of batch processing, the most common 
ones being payroll, billing (electricity, gas, water and telephone) and cheque processing. 

Payroll 
At the end of each pay period (usually weekly or monthly) a company needs to pay 
its employees. Payroll systems are used to calculate wages and print out pay slips. 
• The inputs are: employee details from file (e.g. rate of pay, tax code, bank 

details), number ofhours worked (often obtained from a timesheet), any 
overtime working, holidays, etc. 

• The processing done is calculation of: gross pay, any deductions (tax, national 
insurance), net pay, etc. 

• The outputs are: printed pay slips, up:lating of the employee file, transfer to 
Bankers Automated Clearing Senrice (BACS) if wages paid into a bank account, etc. 

Figure 7.11 The stages in batch processing 

Billing systems 

TI1is is nm as a batch system, where all the 
timesheets, etc. are gathered together before the 
payroll calculations are done in one go ( often over 
night). Since there is no need for any further input, 
nor is it urgent to get the output (unlike in, for 
example, a l:ooking system), batch processing works 
efficiently. The process is shown in Figure 7.11. 

Because companies send out their bill/ invoices on a pre-determined date, all the 
information is gathered together and then processed in one go (batch). Consider an 
electricity billing system: 
• The inputs are: customer details (address), charge per kW (unit) of power, 

previous readings, IK"W readings taken from the electricity meter, bank account 
details (if using direct debit), etc. 

• The processing done is calculation of: number of units of electricity used 
(i.e. new reading minus old reading), customer's cost (i.e. units used times charge 
per unit), monthly payments made (if using direct debit), outstanding amount 
owed or carried over to next bill, etc. 

• The outputs are: bill showing all the details, updating of customer file, 
production of reguest for payment if not done through direct debit, etc. 

The diagram of this process is very similar to that shown in Figure 7.11 for the 
payroll system. 

7.10 Automatic stock contro l system 
Automatic stock control systems rely on the use of barcodes . 

Barcodes now appear on most products sold in shops. They allow quick 
identification of product details once the barcode has been scanned by a barcode 
reader. Supermarkets, in particular, use electronic point of sale (EPOS) terminals, 
which incorporate a barcode reader that scans the barccxle, retrieve the price of the 
article and relay information back to the computer system allowing it to up:late its files. 



Figure7.12 An 
example of a 
barcode 
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Barcodes are made up of alternating dark and light line.s of varying thick.ne.ss, as 
shown in Figure 7. 12. A number underneath the barcode usually consists of four 
parts: country ccxle, manufacturer's code, product code and a check digit. The 
check digit is a form of validation which is used to make sure no errors occurred 
during the reading of the barcode. 

The check digit can be calculated in a number of ways. The method discussed 
here works for ccxles which contain 11 digits. 

Consider the following code: 

1 3 5 7 9 11 odd digit positions 

is 1 o 4 3 1 1 2 o 1 71 
8 10 even digit positions 

l Add together the digits in the odd positions and multiply the sum by 3: 
5+ 0 +3+ 1 +0+7= 16 
16 X 3 = 48 

2 Add together the digits in the even positions: 
1 +4+ 1 +2+ 1 =9 

3 Add the two results together: 48 + 9 = 57 

4 To find the check digit, calculate what needs to be added to 57 to make the next 
multiple of 10 i.e. 60. Tims, the check digit is 3. 

H encethefinalcodeis 5 l 04 3 l 120 1 7 3. 
Every time the barcode is read, this calculation is performed to ensure that it has 

been scanned correctly. 
Barcodes are used in the following applications: 

• library OOOk systems (see Section 7. 13) 
• administration systems (e.g. in hospitals) 
• passport and ID card systems 
• some burglar alarm systems 
• equipment checking systems (safety records on maintenance of equipment) 
• automatic stock control systems (de.scribed in tl1is section). 

The following de.scription is a detailed account of how barcode.s are used to control 
stock levels automatically in a supermarket. Otl1er retailers use similar systems witl1 
only minor difference.s. 
• Barcodes are attached to all the items sold by the supermarket. 
• Each barcode is associated witl1 a stock file, which contains details such as price.s, 

stock levels, product de.scriptions. The barcode acts as the primary key in the file. 
• A customer takes their trolley/basket to the EPOS terminal once they have 

completed their shopping. 
• The barcode on ead1 item is sca1med at tl1e EPOS. 
• If the barcode cannot be read, then the EPOS operator has to key in tl1e number 

manually. 
• The barcode is searched for on the stock file record by record until a match is found. 
• The appropriate record is accessed. 
• The price of the item is sent back to the EPOS, together witl1 a prcxluct description. 
• The stock level for the item is found in the record and is reduced by 1. 
• The new stock level is written back to the file. 
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• If the stock level of the item is less than or equal to the re-order/minimum stock 
level then the computer automatically orders a batch of items from the suppliers. 
(Supplier information would be found on another file called the order file or 
supplier file - the barcode would be the link between the two files.) 

• Once goods have been ordered, a flag is assigned to this item in the file to 
indicate an order has been placed; this now prevents re-order action being 
triggered erery time this item is scanned before the new stock arrives. 

• The aOOve procedure is repeated until all the items in the customer's 
basket/ trolley have been scanned. 

• \Vhen all the items have been scanned, the customer is given an itemised bill 
showing a list (with prices) of everything they have OOught. 

• The computer updates the files containing the daily takings. 
• If the customer has a loyalcy card, the system will also automatically update their 

points total. 
• \Vhen new goods arrive, the barcodes on the cartons will be used to update the 

stock files. Also, any flags associated with these goods will be removed so that the 
stock checks can start to be made again. 

Some newer supermarkets now allow customers to scan their own items at special 
checkouts. Tiiese basically work in the same way as the normal EPOS tenninals. 

7.11 Online booking systems 
Online booking systems rely on the abilicy to update files immediately, thus preventing 
double booking, which could happen if die system response time was slow. Booking 
systems are used for transport (flights, trains and buses), cinemas and theatres. 

We will consider the dieatre booking system to describe how this system works. 
With this example, we have assumed diat die customer has already logged on to the 
theatre booking website. 
• The customer clicks on the peiformance they wish to see. 
• They enter die date and time of the peiformance and the required number of seats. 
• A seating display at the dieatre is dien shown on die screen and the user clicks on 

where they would like to sit. 
• The database is then searched to check the availabilicy of die selected seats. If the 

seating plan is shown on screen, diis step is not required. 
e If die seats are available, die scat numbers are shown together widi the total price. 
• If the customer is happy widi diis, diey select 'confirm' on the screen. 
• The seats are now temporarily set at 'no longer available'. 
• The customer then enters their personal details or indicates that they are a returning 

customer (in which case the website being used will already have their details). 
• They select a payment method and make the payment. 
• The theatre seats are then booked in the customer's name. 
• The final details are shown on the screen, together widi a reference number (in 

case dicre are any customer queries later on). 
e An email is sent to die customer which they print out as their proof of purchase. 

In some cases, this also acts as dieir printed ticket when they go to the theatre -
an e-ticket. 

• The database is updated with the transaction. 
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Booking seats at the cinema is very similar. 
However, booking flights is slightly more 
complex since it involves choosing airports, etc. 
Figure 7.13 shows an example of an online 
webpage for choosing flights. 
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7.12 Ba nking app lications 
The use of computer technology has 
revolutionised how we do our banking 
transactions, for example: 

.,._ ..... @- o-.... o-
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• internet banking ( discussed in Chapter 6) 
• the use of automated teller machines (ATMs) Figure 7.1 3 An onlineflight booking 
• chip and PIN technology. system 

Automated teller machines (ATMs) 
Automated teller machines (ATMs) are places where customers can get cash (or 
carry out certain other banking activities such as order a statement) using their credit 
or debit card. Table 7.3 summarises the process. 

Customer puts card into ATM . 

PIN is entered using the keypad. 

A number of options are given : 
• change PIN 
• top up mobile 
• seebalance 
• get money. 

Thecustomerselectsthecashoption. 
A number of cash amounts are shown. 

The customer accepts one of the options 
ortypesinadifferentamount. 

Thecustomerisaskediftheywanta 
receipt. 

The card is returned. 

Money is dispensed. 

• Contact is made with bank's computer. 

• PIN ischeckedtoseeifit is correct. 
• Card ischeckedtoseeifit is valid. 

• The customer's account is accessed to see 
iftheyhavesufficientfunds. 

• ltischeckedtoseeiftheyare 
withdrawing more than their daily limit. 

• Transaction is OK. 

• Customer's account is updated. 

Table 7.3 Process for withdrawing cash from an ATM 

Although A TMS are very convenient for customers, they do have a few disadvantages: 
• They arc often in places where theft can take place unnoticed. 
• 'Fake' A TMs can be set up to gather information about the card and retain the card. 
• Some banks charge customers for the use of ATM.s. 
• Someone else could sec the PIN being entered and could use this to commit 

fraud at a later date ( also known as 'shoulder surfing'). 
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Figure7 .14 A chip 
and PIN card 

Chip and PIN 
Many cn:dit cards an: equipped with a chip as well as a magnetic stripe (see Figure 7. 14) 
- this contains key information such as the PIN. 

This system is designed to enhance security since it is better than relying only on 
a signarure. When paying for items using a chip and PIN card, a form of electronic 
funds transfer (EFf) takes place. In this example, a customer pays for a meal in a 
restaurant using a chip and PIN card: 
• The waiter inserts the card into the chip and PIN reader. 
• The restaurant's bank contacts the customer's bank. 
• The card is checked to see if it is valid ( expiry date, whether stolen card, etc.). 
• If the card is stolen or expired then the transaction is terminated. 
• The customer enters the PIN using a keypad. 
• The PIN is read from the chip on the card and is compared to the one just keyed in. 
• If they are the same, then the transaction can proceed. 
• If they are different, the transaction is terminated. 
• A check is then made on whether they have enough funds. 
• If there are not enough funds available, then the transaction is terminated. 

Otherwise, the transaction is authorised. 
• An authorisation code is sent to the restaurant. 
• The price of the meal is deducted from the customer's account. 
• The same amount of money is credited to the restaurant's bank account. 
• A receipt is produced as proof of purchase. 

Exercise 7b 
Indicate which of the following tasks is batch processing or onl ine (both types). 

Producing a monthly payroll 

Processing bank cheques at the end of the month 

Using an ATM to obtain cash 

Bookingseatsforatrainjourney 

Monitoring a patient in an intensive care unit 

Manualstocktakingsystemdoneattheendofeachday 

Welding of a car body using a robot 

A satellite navigation system 

Producing and updating a dictionary or encyclopedia 

Printing out mobile phone bills at the end ofthe month 

GettingpricesofitemsatanEPOSterminalina 
supermarket 
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7 .13 Li brary systems 
Many library systems are computer controlled. TI1ey usually involve the use of 
barco(les on the books being borrowed and on the borrower's library card (see 
Figure 7.15 ). 

... IIJ[(ll~ll.111 

11111111!1111111111111 
11m Mr,<,.N. otllcr -

m:ztD H.15Llbrory -
b} .... , ... _..., ...... .,. ... __ 

Figure 7.1 5 Barcodes on a) a library book and b) a library card 

• The following describes a computerised library system based on barcodes. 
• TI1ere are two files: 

• Book file (this contains a number of records made up of the following fields ) : 

Barco de Book title 
Name of 
author 

Date 
published 

Number of Date due 
books back 

• Borrower's file (this contains a number of records made up of the following 
fields ): 

Borrower's number Borrower's name Borrower's details 
Barcodeofbook 
borrowed 

• \¥hen a borrower takes out a book, the lx>ok's barcode is scanned. The book 
details are then found on the book file. 

• TI1e borrower's library card barcode is then scanned for the borrower's unique 
number. The book file is linked to the borrower's file and both files are updated 
to indicate which book has been OOrrowed and when it is due back. 

• On a daily basis, the borrower's file is interrogated by the computer to see 
which books are overdue for return: 
• The computer reads a record from the book file. 
• It compares the date due back with the current date. 
• If the date due back is less than (or equal to) the current date (i.e. earlier 

date) . 
• ... using the barcode number of the book .. 
• ... the book file is linked to the borrower's file .. 
• ... and the corresponding record is read from the OOrrower's file. 
• TI1e customer details are then found and a letter or email is automatically sent out. 
• The next record in the book file is then read .. 
• ... until the whole file has been checked. 

II 
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7.14 Expe rt syste ms 
TI1ese systems have been developed to mimic the expertise and knowledge of an 
expert in a particular field. Examples include: 
• diagnosing a person's illness 
• diagnostics (finding faults in a car engine, finding faults on a circuit OOard, etc.) 
• prospecting for oil and minerals 

• tax and financial calculations ~ 
• chess games ,,_ lnforo,,c• K-todgo 

• 1dennficat1on of plants, ammals and -.c. <nglno booo 

chemical compounds 
• road scheduling for delivery vehicles Ki:'..odto 
A basic expert system JS made up of a number 
of elements, illustrated in Figure 7. 16. Figure7.1 6 Elementsofanexpertsystem 

How to set up an expert system 

• Experts in the field are interviewed to find out what is needed in the expert 
system. 

• Data is then collected from these experts. 
• A kno wledge base (defined below) is designed and then created. 
• The m les base (defined below) is designed and created. 
• An infe rence engine (defined below) is designed and created. 
• The input screen and output format are also designed and created - this is 

known as the user interface. 
• The expert system is tested against known conditions and scenarios. 
• It is also checked to see if it meets the original specification. 
• Experts are interviewed alxmt how effective it is before the expert system gcx:s 

out on general release. 

Advantages 

• Expert systems provide consistent answers. 
• They never 'forget' to answer a question when determining the logic. 
• Using expert systems reduces the time taken to solve a problem. 
• A less skilled work force is needed, which gives the potential of saving money, 

but also allows areas of the world access to expertise which they could not 
normally afford. 

Disadvantages 

• They tend to lack common sense in some of the decision-making processes. 
• Errors in the knowledge base can lead to incorrect decisions being made. 
• It can be expensive to set up in the first place. 
• Considerable training is necessary to ensure the system is used correctly by the 

operators. 
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Example of a n expe rt system: oil prospecting 

• An interactive user screen appears. 
• Questions are asked about geological profiles. 
• Answers to the guestions and information aOOut the geological profiles are typed in. 
• The inference engine searches the knowledge base using the rules base. 
• Thesystcm: 

• suggests the probability of finding oil as an output 
• indicates the probable depth of deposits 
• makes predictions about geological deposits aOOve the soil 
• produces contour maps showing concentration of minerals, rocks, oil, etc. 

Definitions of knowledge base, inference engine and 
ru les base 

Kn owledge base 

This is a database designed to allow the complex storage and retrieval n:guirements of a 
computerised knowledge-based management system (in supfX)rt of an expert system). 

Infe re nce e ngine 

This is software that attempts to derive answers from the knowledge base using a 
form of reasoning. It is how expert systems appear to use human-like reasoning 
when accessing information from the knowledge base in an effort to find a 
conclusion to a given problem. The inference engine is a type of reasoning engine. 

Rules base 

This is made up of a series of'inference rules' (e.g. IF the country is in South 
America AND the language used is Pom1guese 11--IEN the country must be Brazil). 
These inference mlcs are used by the inference engine to draw conclusions. TI1ey 
closely follow human-like n:asoning. 

II 
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In this chapter you w ill learn about systems analysis and design, specifically: 
• the analysis stage 
• the design stage: 

• validation 
• verification 

• the development stage 
• the testing stage 
• the implementation stage, particularly changeover methods 
• documentation 

• user documentation 
• technical documentation 

• evaluation. 

8.1 Introduction 
A systems analysis team is often brought in to review an 
existing system and suggest a number of improvements. The 
existing method used may be either a manual paper-based 
system or a computer-based operation that is no longer 
regarded as adequate for the task. 

There are many stages in systems analysis, as shown in 
Figure 8.1. These are covered in Sections 8.2 to 8.7. 

8.2 Analysis stage 
The basic steps in the analysis stage can be summarised as 
follows: 

l fact finding/collecting data from the current system 

Figure8.1 The stages in 
systems analysis 

2 description of the current system - establishing the inputs, outputs and 
processing being done 

3 identification of the problems with the current system 

4 agreeing the objectives with the customer 

5 identifying and agreeing the customer's requirements 

6 interpreting the customer's requirements 

7 producing a cost-benefit analysis 

8 producing a data flow diagram. 

Stages 2 to 7 are sometimes referred to as the feasibility study and this can be 
further broken down as shown in Figure 8.2. 
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Figure8.2 Stagesinafeasibilitystudy 

Let us now consider the first item in the analysis stage - fact finding. There are four 
common methods used in fact finding, which have been summarised in Table 8. 1 
overleaf. The methods are: observation, questionnaires, interviews and looking at 
existing paperwork. 

8.3 Design stage 
Once the analysis has taken place and the systems analyst has some idea of the scale of 
the problem and what needs to be done, the next stage is to design the key parts of the 
recommended system. A list of tasks is summarised here., but is by no means exhaustive: 
• designing data capture forms/ input forms 
• designing screen layouts 
• designing output fonns and reports 
• producing systems flowcharts and/or pseudo code 
• selecting and designing validation rnles that need to be used 
• selecting the most appropriate data verification methods 
• designing and agreeing the file strnctures and tables 
• selecting and designing the hardware requirements 
• selecting and designing the software requirements 
• producing algorithms or program flowcharts 
• designing a testing strategy/ plan. 

We will now consider in more depth two of these tasks: verification and validation . 

Verification 
Verification is a way of preventing errors when data is copied from one medium to 

another ( e.g. from paper to disk/CD). There are two common ways that verification 
checks are carried out: 
• Double entry: in this method, data is entered twice, using two different people. 

1l1e computer compares the two entries, either after data entry or during the data 
entry process, and identifies any differences. 

• Visual check: this is the cht·clcing for errors by comparing entered data on the 
screen with the data in the original document (this is nut the same as proof reading). 

Validation 
Validation is a process where data is checked to see ifit satisfies certain criteria when 
input into a computer, for example to see if the data falls within accepted 
OOundaries. A number of validation techniques exist and Table 8.2 highlights some 
of the more common ones used when writing computer software. II 
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Range check 

Length check 

Checkswhetherdataiswithin 
given/acceptable values. 

Checksiftheinputdatacontainsthe 
required number of characters. 

Systems analysis and design 

Aperson'sageshouldbeintherange>O 
but < 150. 

lfafieldneedssixdigitstheninputtinga 
five- or seven-digit number, for example, 
shouldcauseanerrormessage. 

Character/type check Checks that the input data does not contain A person's name should not contain any 
invalid characters. numbers but a person's height should only 

contain digits. 

FormaUpicture check Checks that data is in a specific format. Date should be in the form dd/mm/yyyy. 

Limit check Similar to range check except that only one Input data must be> 10. 
of the limits(boundaries)ischecked. 

Presence check 

Consistency check 

Check digit 

Checks if data is actually present and has not In an electronic form, a person's telephone 
been missed out. number may be a required field and if no 

data ispresentthisshouldgiverisetoan 
error message. 

Checks if fields correspond (tie up)with each If 'Mr' has been typed into a field called t it le 
other. then the gender field must contain either 

'M'or'Male'. 

Looks at an extra digit which is calculated Check digits can identify three types of 
from the digits of a number and then put on error: 
the end of the number (see example in • if two digits have been inverted during 
Section7.10). input,e.g. 13597insteadof 13579 

• an incorrect digit entered twice, 
e.g . 13559typedininsteadof 13579 

• adigitmissedoutaltogether, e.g. 1359 
typed in instead of 13579. 

Table 8.2 Common validation methods 

8.4 Development and testin g 

Once the design stage is completed, it is then necessary to create the system and fully 
test it. This section considers some of the development stages and testing strategies 
which are often adopted by systems analysts. 

Development stages 

If the system contains files (e.g. a database) then the file structure needs to be 
finalised at this stage ( e.g. what type of data is being stored in each field, length of 
each field, which field will be the key field, how the data files will be linked, etc. ). 
Once the file structure has been determined, it is then created and fully tested to 

make sure it is robust when the system actually goes live. 
Since it is imi:ortant that the correct data is stored in files, there are certain 

techniques that need to be adopted to make sure the data i:opulating the file/s and 
database/s is at least of the right rype and that it conforms to certain rules. Validation 
routines and verification methods (discussed in Section 8.3 ) are used to ensure this 
happens. Again, these routines have to be fully tested to ensure they do trap 
unwanted data but also to make sure any data transferred from a paper-based system 
to an electronic system has been done accurately. 

II 
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Any system being devdoped will have some fonn of user inteiface. The types of 
hardware were chosen in the design stage. H ow these are used to inteiface with the 
final system now needs to be identified, for example how the screens (and any other 
input devices) will be used to collect the data and the way the output will be 
presented. If specialist hardware is needed ( e.g. for people with disabilities), then it 
will be necessary to finalise how these devices are used with the system when it is 
implemented. TI1is will be followed by thorough testing to ensure the user screens are 
user friendly and that the correct output is associated with the inputs to the system. 

Testing strategies 
Testing of each module needs to be done to ensure each one functions correctly on 
its own. Once the development of each module is completed, the whole system 
needs to be tested (i.e. all modules functioning together). Even though each 
individual module may work satisfactorily, when they are all put together there may 
be data clashes, incompatibility and memory issues, etc. 

All of this may lead to a need to improve the input and output methods, file and 
database strnctures, validation and verification methods, etc. Then the system will 
need to be fully tested again. It is a very time-consuming process but the system has 
to be as peifect as possible before it goes live. 

Testing will use many different types of data, which will fall into one of three 
categories: normal, extreme or abno!Tilal. I.et us suppose one of the fields in a 
database is the date and this must be in the fo!Til dd/ mm/yyyy, where each element 
of the date must be numeric: 
• Normal: this is data which is acceptable/valid and has an expected (known) 

outcome, e.g. the month can be any whole number in the range l to 12. 
• Extreme: this is data at the limits of acceptability/validity, e.g. the month can be 

either of the two end values i.e. 1 or 12. 
• Abnormal : this is data outside the limits of acceptability/validity and should be 

rejected or cause an error message. For example, all the following values are not 
allowed as inputs for the month: 
• negative numbers (e.g. - 1, - 15) 
• any value greater than 12 (e.g. 32, 45) 
• letters or other non-numeric data (e.g. July) 
• non-integer values (e.g. 3.5, 10.75). 

8.5 Implementatio n 

Once the system is fully tested, the 
next stage is to fully implement it. 
Some of the stages in this process 
are shown in Figure 8.3. 

We will now consider 
changeover to the new system in 
more depth. As indicated in Figure 
8.3, there are four common methods 
used for changing over from the old 
system to the new system. Each one 
has advantages and disadvantages, 
shown in Table 8.3, which need to 
be weighed up before the most 
appropriate method is chosen for a 
particular application. 

1 T,olnrtoffontho..-,ynom 1 
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Figure8.3 The implementation stage 
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Direct 

Parallel 

Pilot 

Phased 

Table 8.4 compares the costs, input requirements and risk of failure for all four 
changeover methods. 

Medium 

Medium Medium 

Medium Medium Medium 

• Low if successful, otherwise very high amount of input needed 

Table 8.4 Comparison of the four changeover methods 

8.6 D ocum entatio n 

Once the new system is fully developed, a considerable amount of documentation 
needs to be pn:xl.uced a) for the end user, and b) for people who may need to modify 
or develop the system further at some later stage. 1l1ere is some overlap between the 
two types of documentation, but the basic requirements are shown below. 

User documentation 

User documentation is designed to help users to learn how to use the software or 
system. This can consist of any of the following: 
• the puri:ose of the system/program/software package 
• how to log in/log out 
• how to load/run the software 
• how to save files 
• how to do a search 
• how to sort data 
• how to do printouts 
• how to add, delete or amend records 
• screen layouts (input) 
• print layouts ( output) 
• hardware requirements 
• software requirements 
• sample runs (with test data and results) 
• error handling/meaning of errors 
• troubleshooting guide/help lines/FAQs 
• rutorials. 

Technical documentation 

T echnical documentation is designed to help programmers and analysts who need 
to make improvements to the system or repair/maintain the system. TI1is can consist 
of any of the following: 
• purpose of the system/program/software 
• program listing/coding 
• programming language used 
• flowchart/ algorithm 
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• input fonnats 
• hardware requirements 
• software requirements 
• minimum memory reguirements 
• known bugs in the system 
• list of variables used (and their meaning/description) 
• file strnctures 
• sample rnns (with test data and results) 
• output fonnats 
• validation rnles 
• meaning of error messages. 

8.7 Eva luation 
Once a system is up and nmning it is necessary to do some evaluation and carry out 
any maintenance, if necessary. The following is a list of some of the things 
considered when evaluating how well the new system has worked. This can 
ultimately lead back to a re-design of part of the system if there is strong evidence to 

suggest that changes need be made. If you kok back to Figure 8. 1 in Section 8. 1, 
you will see that the evaluation stage feeds back into the design stage. To evaluate 
the system, the analyst will: 
• compare the final solution with the original reguirement 
• identif)r any limitations in the system 
• identify any necessary improvements that need to be made 
• evaluate the user's responses to using the new system 
• compare test results from the new system with results from the old system 
• compare the performance of the new system with the performance of the old system 
e observe users performing set tasks, comparing old with new 
• measure the time taken to complete tasks, comparing old with new 
• interview users to gather responses alxmt how well the new system works 
• give out questimmaires to gather responses about the ease of use of the new system. 

Some results from the evaluation may require changes to either hardware or software. 
H ardware may need to be updated because: 
• of feedback from end users 
• new hardware comes on the market, making change necessary 
• there are changes within the company which reguire new devices to be added or 

updated. 

Software may need to be updated because: 
• of feedback from end users 
• changes to the company strncture or how the company works may need 

modifications to the software 
• changes in legislation may need modifications to the software. 

II 



This page intentionally left blank 



Part 2 

I 

Now ex1,erimen1 

workln~ wllh PowerPolnt 
Is Inn 

r:i--... ·­
ICI--.... 

11--
1::, ....................... ~-·~-



II 

Communication 

9.1 

Hint 
Your email system 
will be protected 
by a password . 
Make sure that you 
keep your 
password secure. 

I this chapter you will learn how to: 
open your mailbox 
organise your mail 
use email etiquette 
send an email 
send a file as an email attachment 
receive an email 
receive and save a file as an email attachment 
reply to an email 
forward an email 
copy an email to another mail recipient 
manage your email contact lists 
locate and download information from the internet 
use the internet to locate information on a specified website 
use the internet to search for information using a search engine. 

or this chapter you will need this source file from the CD: 
• STYLE1.CS5 

Using ema il 
Email is shon for 'electronic mail' and is a method of sending text-based messages 
from one computer to another or using mobile phones. Email is usually received 
instantaneously by the recipient's mail provider and frequently waits there until tl1c 
user accesses tl1cir mailbox. Some mail providers will allow users to have their 
messages forwarded to tl1cir mobile phones. All mailOOxes have a storage limit and it 
can be very easy to fill your mailOOx. If this happens, you will not be able to receive 
the messages sent to you. 

To use email you must have a mailbox with an email address. These can be web 
based like Windows Lin Mail or use an internally hosted mailbox, which is common 
in many schools. For this chapter, I have created a new email account with Windows 
LiveMaU. Although I will use tl1is for the exercises in tl1is chapter, most of the skills 
arc transferable to otl1cr email editors and the underlying structures arc the same. 

9.2 Opening you r mailbox 

Hint 
If this icon does not 
appear,selectthe 
Start button, 
followed by All 
Programs and 
W indows Live Mail. 

To open your mailbox, go to the Wtndoll's 
taskbar, usually found along the bottom 
of tl1c screen. Select the icon for Windows 
Live MaU (it looks like a white envelope) 
and click the left mouse button on this icon 
to open the email editor. 

@ --..-.-.... ,.,, 

/!,···---,-" 
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Your email editor will open and look similar to this. You may need to enter your 
email address and password in some systems. i 

·•;::.:-;:_ ~-
: u_....... II 

' "" H<,t...,ln('I"'......_..._ 
l,a•-1 ·­lii' s...~~ . ...... _. 
e o-.... m< 

9.3 Organising your mail 

Hint 
If the menu bar 
is not visible, click 
on the New button, 
and select Folder 
from the 
pull-down list. 

At the moment the mailbox is empty, but it will soon fill with a flood of messages. 
These will need organising into logical groups. You need to decide on the groups 
you want and then create and name folders to match these groups. 

Task 9a 
Create new folders in your email editor called 'IGCSE ICT' 
and'Friends'. 

Select your email account by clicking on your email 
address in the left column of the email editor. 

Select the File menu, followed by Folder, then 
Cmte now 7doc ... lik, ,his. 

• Quicl< view< 

II 
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9.4 Email etiquette 
When using email, use these basic mle:s to help you to gain respect of other online users: 
• Do not type using all capital letters - this is read as shouting in an email. 
• Do not leave the subject line blank. 
• Do not use coloured text and backgrounds. TI1ese are more difficult to read and 

can take up a lot of space in an email inbox. 
• When sending a number of people the same email use 'bee' rather than 'cc' as it 

protects their email addresses from being passed on and reduces the chance of 
them getting junk mail. 

• Do not forward chain letters and similar types of email as these can take up 
valuable space in an email inbox. 

• Do not give out any personal details like phone numbers, passwords, bank 
account details, etc. in emails. 

• Email communication is private. In most countries, you are likely to be breaking 
the law if you post the content of an email to you in a public place without the 
sender's permission. 

• Compress or zip email attachments where possible before sending them. This will 
allow larger documents or other files to be sent guickly and take up less storage 
space in the inbox. 
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9.5 Sending an emai l 

Hint 
If the Cc and Bee: 
o ptions cannot be 
seen, click on Show 
Cc& Bee to get 
these boxes 

Task 9b 
Send an email message to David Watson. Use the email address 
david.w.watson@hotmail .com and let him know that some of the source files for Chapter 15 
of the book are almost complete. Copy this message to a user with the email address 
a .n.other@hoddereducation.co.uk and send a blind carbon copy to 
best.book@hoddereducation.co.uk. 

Make the subject line for the email '0417 IGCSE text book' 

Open your email edito r and access your ~::::'3iEJ5E:!:!!· ···· 
mailOOx, using your =::~,i~l ,~dd;=;_rn~,:.:d---1JJ•llllll/llllmlllm•• password. Click on N :_w to create a 
new email message. ~ i;r, Quid:view5 

This opens the New Message ., un,eode-moil 

window. Enter the email address of the li:i un,e.>dlromcontarn 

person that you wish to send the email §I Unreodleeds 

to in the To : box. In this case the 
message will be sent to David Watson. 

I 

I] H<c 
~~~~~~~~~~~~ 

Make sure that you type the address accurately, carefully ch ecking spelling and 
punch1ation. One error in your typing will mean that the message will not be sent to 

the correct person. TI1is person will not be aware that you have ever sent them a 
message. If you h ave contacts that you email often, add them to your contacts list 
(sometimes called an address book), and select them from there. This reduces the 
chance of errors when typing the email address. Clicking the left mouse button on 
the [IJ lo: icon opens the contacts list. 

If you wish to send a copy of the message to another person, add their name to 
the Cc : (carlx m copy) OOx. Again, if the person's name is already in your contacts 
list, use the [IJ Cc icon to find and add their em ail address. For this task, a copy of 
the message w ill be sent to a.n.other@hoddereducation.co.uk so include this address 
in the carbon copy OOx. 
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You can also copy the message to another person using Bee (blind carbon copy). 
None of the people receiving the message will be aware that a copy ofit has been 
sent to anyone in the Bee : box. It also prevents the email address that was used for 
the blind carbon copy being passed to other people. For this task a blind carbon 
copy is to be sent to best.book@hoddereducation.co.uk, so include this address in 

- the Bee: box. 
TI1e subject line of a message lets the person receiving the email know what the 

message is about. This will allow them to read the most urgent messages first. Add 
the subject line '0417 !GCSE text book' in the Subject : box. -----~ 

Enter the content of the message in the main message box. Remember to use a 
greeting at the start of the message and a salutation at the end. 

When you have checked your \ 
email to make sure that there are W:>•°"""'="'c•c'•-;:_;:=~~~ :""'="'"""""""""J 
no errors, click on Send . The email fto 1'"' - - ,._. 

1- - 1,o1p 

will then be sent to the mailbox of I 
Bee: boxes. ~ - ~· ~- ~ -.-.-: ~.-----
each person in the To :, Cc: and ~ --- '-

- ~-ooooj,--------~ c..._JW 
Activity 9a .,.. ,.,.. .. ~ - .. .. -..., . A ""'" · +11 · • , -
Sendanemailtoyourteacherwith 
thesubjectline'email' . Copythisto " 
twootherpeopleinyourclass, ::,-;:;;;· "'·•"' .. "" " .. """'" ·.....,, •....,....,, .. I""' .,., 
informing them that you can now 
sendthemmessagesusingemail. 
Yourtutorwillsendyouareply, 
which will set you another task. 

9.6 Receiving an email 

Click on the In box for your email account. Any emails received will appear in this 
window. In this example, the new email message has been received and can be seen 

- here. New (unopened) messages appear in bold in this centre column of the window. 
Double clicking the left mouse button on the message will open it in a new 

window and will look similar to this. 

,._ 
II Dsort> 
lio' <-•·-. Jtn, ...... 
i'.r Ddtlt,Mt""' 

ltoQanll;, 

t-,--=------,--- -----~ '~'----- - ~~c-1 
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To reply to the message click on Reply, or to reply so that all the people placed in 
the To: box and Cc : OOx in the original message can sec the reply click on Reply all. 

them toyouinlhenextfewdays. 

If you wish to send this message to another person without adding to the conten 
use Forward. 

Using the Reply or Reply all options allows you to add your text to the message, 
but send the original message as well. You may notice that the email addresses of the 
people who were blind carOOn copied into this message are not visible to the other 
people receiving the message, unlike those who were carbon copied. 
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9.7 Manag ing your contacts 

You can add a contact to your 
address book when they send you an 
email message. k you can see there 

;o::; ~~~:~!~i:~dct~ :1:1~~: ~ dd ~: <'';:.....=·-=·--~,"'-=--~ 
to contacts hyperlink to open the ,....,., --- ...... ,...... 
Add.1Contact wmdow - w ... ,....._,~L__ ___J 

Some of the dcta>ls have been L ·-
automancally filled m from the email ~ 
you were sent Complete any other 
personal details that you Wish to 

mclude on the forms You can 
1 

mclude more contact details usmg 
the tabs down the left side When 
you have completed the form, this r-; ............ _, .. ..,.,"""'' 
person can be added to your list of ...,,._, 'r+rn 1- .. -...r~ 
contacts by chckmg on ,...,,......,.,1 

Your contacts list can be managed by selecting the Tools menu in Wina'owsLi1,e 
Mail, and clicking on Contacts ... . This will open the Contacts window. 

,ll cm«, ...... ,..., 

i. si-..-,-,<t­
.. .... ,. .. _s,"' 

New contacts can be added, existing contact details edited and contacts deleted from 
this window. You can also organise your contacts into groups. You can use these groups 
to send a single email to all of the people in a group at the same time by selecting the 
group name rather than contact name. You can create multiple groups and contacts can 
belong to more than one group. Groups can be deleted by right mouse clicking on the 
group name then selecting Delete Category from the drop-doW11 menu. Deleting a 
group does not delete the contacts in it and removing a contact from a group does not 
delete the contact from your address book. Your contact details can be shared with 
others using this system, but this is IK>t recommended. 

Activity 9b 
Add the email addresses and other contact details of two of your friends to your contact list. 
Check that these contact details work by sending them a test email. Reply to messages sent by 
yourfriendslettingthemknowthatthedetailsarecorrect. 
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Send an email message to David Watson and a copy to a.n.other@hoddereducation.co.uk 
with the file STYLE 1.CSS (from the CD) attached to the message. Make the subject line for 
theemail'Firststylesheet'. 

Prepare the email for 
sending as you did in 
Task 9.2. Enter the em ail 
addresses, subject line and 
the body of the message. -

1 ; u~~T! t :!~a~::g;his.~ : : 
Click on Attach to start , _ _ ,....,._ .. .,. _ ,m, __ ,,._,,__ 

the process of attaching the ~ 
file to the message. This 1--------------1 
o pens the Open file 
window. 

Select the file to be _ , .,1,1: •• ·~'"°"'~"i'C~li"'·i-~~~~~ji~ii~ sent before clicking on 

""" This will add the file 
as an attachment to the 
message. TI1is process 
can be repeated to 

attach multiple files to a 
message. \Vhen you 
have checked the 
message and it is ready 
to be sent, click on 

Send. I 

[IJ 1~-....--­
W cc , .,,......,--,., 

'ii ~- --"'' 

. ( 00\UolP• otl .. _ ..... 
"' ""'""­·c-· .. Ch.plc,11 ll 

i2.:.~'.!!..---
0 "r'<-'."'"' 
i:. ,tylol_.,.i, 

, ...... 1~·1 

.. . ..,..,.., li! I..,... :,, • • ..,......., . A""" · .,, ., . M • U A • 

-
Activity9c 
Read the reply that your teacher sent you after Activity 9a. Reply to this email, sending them 
thedocumentthattheyhaveaskedforwithyournotesinit. 

1111 



Information and Communication Technology 

9.9 Receiving and saving a fil e us ing ema il 

Hint 
Email attachments 
canbeusedtosend 
viruses. Do not 
open an 
attachment unless 
you are expecting it 
and know and trust 
the sender. 

Click on the lnbox for your email account. All messages that you have received will 
appear in this window. In this example, a new email message has been received. The 
paperclip shows that the message has an attachment. Open this message by double 
clicking the left mouse button on the sender's name. TI1e message will look similar 
to this. 

·-· •.. .. .... _ ......... ,, -.. ... 

~

To open the attachment, double click the left mouse button on the attachment name 
Then chck on IP> m the Mali Attachment wmdow 

If you prefer to save the file, right 
mouse click on the attachment name 

lt;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;;====:jj to f~ :a~;:rs-i1;:
1
~:~:Save as ... 

(Save all ... is usefol for multiple files), which opens the Save Attachment As window. 
Chocise the filename and the folder location for the file, then click on 
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9.10 Using the internet 
The internet is a wide area network, made from a number of individual computers 
and networks linked together to fonn one large network. It is worldwide and can be 
accessed by anyone with an internet connection. Anyone can add infonnation to or 
have a server on the internet. This means that some infonnation on the internet is 
incorrect, biased or unreliable, although other information is reliable and factual. 

TI1ere are two ways of locating information from the internet. The first is by 
accessing sites that you know about using their URL. The second method is finding 
the infonnation that you are looking for, but you do not know where to look. This 
method involves using a search engine. 

9.11 Opening a website from a URL 

~O~O~·~·~· ~~~· -~~~~~~~~~~::========~ ~ ~~,~~;'~:ra:~~,l:~:

11

i: the 11: unique address given to any 
[i',fj...,;; ____ _..c',.-~-~--"'11 document found on the 

internet. The URL contains 
11 '!!!!!11!1!111!!!1iiii:imii;ii!iii[~ two parts: the first is the type Ill of protocol being used (e.g. 

http: //) and the second is the 
name of the computer (e.g. 
www.cie.org.uk). There may 
be a third part which gives the 
pathway within this computer. 

Open your web browser and 

b----d~==~-_:.:::.;~ ~; ~;,~Rt ;[et~ds~:s~hat 

bar, followed by the <Enter> key. In this case the address added is for the 
homepage of the CIE website. 

If you know the URL for a page within the website, you can type the full 
entry into the browser to get to a particular page. For example if you wanted the 
0417 page within this site you would enter this URL: http://www.cie.org.uk/ 
qualifications/ academic/middlesec/ igcse/subject?assdef_id=969 to obtain this page 
ofthewebsite. 

To avoid having to retype long 
URL; like this, use the Add to 
Favorites icon to store this URL , :'i. e . ;;;; . e. ,-o , .... . • 
in your browser. To open your / l[-""""""----=='""-:::-=----=:--------:-=:--""'11 
stored favourites, use the 
Favorites icon. 

3 ::,:v.:.~tr::!t"~~-·:.:~ I · _,,c'"""""' ·:..-" 
-...-11a<11m-..-..m&D>u. 

,... ~ ,,_,...,.,., """' " ' "' " '- o,w,~u, --·- -·- ·-- ......... ............ _..,,. ~ 

1111 
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9.12 Using a search engine 

A search engine is useful if you do not know the URL of a website or if you want 
information and do not know where to look. There are many search engines that 
appear to use different methods, but the underlying function of all search engines is 
the same. They take the words that you enter as a search string and look up in their 
database of webpages those that appear to match your search string. The more 
detail that you put into your search string the more likely the search engine is to find 
the results rou require. 

Task 9d 
Search the Internet for information on 'learn to scuba dive' in your country in preparation 
forascubadivingtriptotheRed Sea. 

Open a webpage with a search engine. In this case you are going to use the URL 
www.google.com. As this has been entered into the browser, this has been re-routed 
to a local version of the website hosted in the UK. 

To search for a topic enter the search string in this box. 

GoogJ~· 
J t..o,,o-.i, ji,Jp.r......,l .. "v ,J --

s...a.1,. w ...... i e _ . .... ~U< 

fl '"""'"'l'~~o. 

Your choice of search string is very important. If you type only the words 'scuba 
dive' then click on j C.. Soorcl l. the search engine will find these results. You can see 
that the search engine has found eleven and a half million possible webpages. 

3ctbo<llvh:i ,™~·"'""'~ ........... ...... _ ...... -~ ......... . 
_._.....,. ..... M ... . ....... ... 1,1 .......... , 
_,, __ [ __ 
.. ......... ................... ,.. 
PN.on,,w, 1 h,Wr>t11~,·1o 01.o '" hn 
~ ...... __ _ -........ -.-~-··"" 

-'"'---· ...... ,.., ............... 
""'"""""' AD-.w-"--'"""'· _ __....,...,,.. 
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To improve the search you can select the pages from the UK radio button (this 
may vary depending upon your location). 111is would make sure that only local sites 
arc included in the search results. Changing the search string to include 'learn to 
scuba dive' will also reduce the number of web pages found. -----~ 

These two stages have reduced the number of fX)Ssiblc webpages to just over 
thirty thousand. 

Google "'"'"" : "'" _ . . ...... .., 

~~~!:'~=-~ .. 
LHIR.lit.C)u.....i.,_ul, P"1 ......... "-'*•'""' ,...,, _,,_ _o... t.,-, 

~X,.,';;•mTh<,On~P""' 

The results of this search appear on the page. 
Most search engines will show sponson."1:! links as the first few results of the search. 

These arc websites that have paid money to have their web pages at the top of the 
rcsults, in the hope that this will bring them more customers. These arc not always the 
best links to use. Some search engines will tell you that this has happened like this. 

This seard1 could be refined further by adding the name of the local town or 
city in the search string. A better way to refine your searches is to use the advanced 
search option available in many search engines. 

1111 
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Hint 
Spelling errors in 
search strings are 
the most common 
reason for search 
errors. To help 
solve these 
problems,enterthe 
search string into 
your word 
processor, check 
thespelling,then 
cutandpastethe 
search string into 
your web browser. 

Selecting this will take you to the Advanced Search window . . a:-----

Google ---

•· ~ · l;J oii - .;) - · 0 - · · 

If an exact phrase needs including in the search, like 'Red Sea', place this text here. 
This would find any websites relating to the phrase 'Red Sea' but not find either 

the word 'Red' or the word 'Sea' on their own. 
If there arc words that you need to have one OR another included in the search these 

can be placed here. 
If there arc other words that you want excluding from the search place these here. 
All of these options could be used to find the site or sites that you require. Look 

carefully at the URLs and brief descriptions of cacl1 site to help you decide which 
site or sites might be more suitable for you. 

Search engines can also be used in a website to search only within that site. These 
arc sometimes used in the practical examinations. If you need to use one of these, 
take care to enter meaningful search strings, taken directly from the infonnation in 
the question paper. Each search engine works in a different manner and instrnctions 
on saving and downloading arc always given. 
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I this chapter you w ill learn how to: 
enter data from an existing file 
key in and edit text 
import images from a variety of sources 
place and manipulate images 
set the page size and orientation 
set page margins 
use headers and footers 
set page, section and column breaks 
use columns 
set font styles and sizes 
emphasise text 
use lists 
use tables 
align text 
set line spacing 
correct errors. 

or this chapter you will need these source files from the CD: 
• ACTIVITY3.RTF • TEXT3.RTF 
• SNOWBALL.JPG • TEXT4.RTF 
• TABLE1 .CSV • TEXTS.RTF 
• TABLE2.CSV • TEXT6.RTF 
• TEXT1 .RTF • TEXT7.RTF 
• TEXT2.RTF • TREES.JPG 

You will also need this source image for scanning: 
• SNOWANGEL 

You will find this image at the end of the book, on page 300. 

10.1 Gene ric fil e types 
TI1e practical examinations will ask you to open and edit data that is supplied to you 
in the examination. These files will be saved in a file fonnat that can be opened in 
suitable software on all types of computer. For the examinations you must be able to 

open documents from generic file types and understand their features and 
limitations. G:)lnmon generic files include: 
• comma separated values: these files have a .csv file extension. This file type takes 

data in the form of tables (that could be used with a spreadsheet or database) and 
saves it in text format, separating data items with commas 

• text: these files have a .txt file extension. A text file is not formatted and can be 
opened in any word processor 

• rich text format : these files have a .rtf file extension. 1bis is a text file type that 
saves some of the formatting within the text. 
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10.2 Entering data from existi ng fil es 

Hint 
If you have to 
combine more than 
onefile(sometimes 
with different file 
types),openeach 
file as anew 
document.then 
copy and paste 
from one document 
to another. This 
method can reduce 
any problems that 
could occur with 
embedded objects. 

Task IOa 
Open the file TEXTl .RTF and insert the file TABLEl .GV as a table within the document. 
Change the document heading to 'Winter weather forces schools to close'. 
Save the document as Ch_lO_Task_lOa in your word processor's normal format. 

You can use a variety of text and f::'e:c------------,;"'1 

~:::~~:!:~;:l:t1!~i;:t 00 = = ~-----._.,,.,.,_,,.....~-~ i 
document. These include .doc 
(Micrvseft Word doa.1ments), • 1......, 

.docx (also Word documents), 11. -

.rtf and .txt formats. Open • """"' 

~ ·--· ·~ 
I .......... ~--

Woni. To open a document, 
select the O ffice button •; ::._ 

~eth:Ut~~:~=:;f C!a :.::~ ...... 
on Open to obtain Iii ~ ~=~ 
this window. , -...,ai 
Changeth~ ·:,'::," · • -----..i 

thatcanlxop::,~T~~n;::: ~:=.-.. 
drop-down menu. If you are ~~nw.-. 
unsure of the file type and :::.',':;.... 
wish to see all the available :::i.=:-.- ,--. 
files in a folder select All Files. You can now sec a list of all the \;'0::"':!!!-.. .. 
available files, including the file TEXTl. To open this file, click the $:'r"" .. 
left mouse button on the filcnamc, followed by . -. , -•• 

Use the O ffi ce button and Save As ... to save this document with the filcna.mc 
Ch 10 Task 10a as a Word doa1mcnt, rather than in rich text fonnat. 

Nm~ ape;;: the file TABLEl.CSV as a new Word document. An alternative to 

copying and pasting the table into the document would be to place the .csv file 
in the document as an embedded object. This is really useful if you wanted to 

update the table within another package like a spreadsheet, but is not as useful in 
the practical examinations 
where it is unlikely that you 
will have time to keep up:lati.ng 

~=;e~:beddcd into a ~ / ~.::~;A~,/ '~ l::~;:n·li ... ~~~ ,:;_ 
111c file TABLEl.CSV 

looks like this when it has been 
opened in lVord.- --~•11 

Now you need to edit it, to 

rum the comma separated 
values into a table and copy it 
into the file that you recently 
saved. Highlight all the text 
and then select the Insert tab. 
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.. Because the text is 

to r::,:~::~::.~rtr::~t [i.)µ°~:c-=~:;;;;,,;;~:::::= """~ 
to create the table. If Word has 
not offered you the correct 
values for rows and columns 
because the .csv file contains 
both commas and carriage 
returns, then the table may need 
editing by either removing blank 
rows and/or columns. In this 
example, it has created an extra 
column to the right. 

To remove this column, first 

click the left mouse button in a J~§§:~;~~~~~~~ cell in the right-hand column. 
This removes the highlighting 
from the table. In the same 

button for Delete 
entire column followed by ~ . 

Copy this table and paste it 
in place of the text <Place 
table bere> in the 
document that you saved as 
Ch 10 Task 10a. TI1is task is 
co1tlim~ed inl:he next section. 
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10.3 Keying in text 
To change the document 
heading, highlight the existing 
heading and overtype this with 
the new heading. Although this 
seems one of the easiest tasks in 
the practical examinations, it is 
one where a significant number 
of students fail to check their 
data entry. You will need to be 
one hundred per cent accurate 
with all d ata entry, including 
the use of capital and lower case 
letters. The document should 
now look like this. 

Save the changes to this 
document. 

10.4 Editing text 

Task I Ob 
Open the file Ch_lO_Task_lOa. 

·---- ............... .,.,,.. 
_,.,, . .,._:;..:;.., ..... -o.;:.,.~ .;,,'"'',,,-: ... : ... . ... - · 

::~-:'.: ;:," .= :;::.:-:: .:;:. . .:..:.. :;::;:;..," ... ,·· -.. : 

. 
. m 
.. · 

. . . 
. 

, ., • . ...., • .._ ..... - . , . ..-. •• . • ._,_. . • ~ . - n , • . ,.~._~, .. 

~1•M.' .. .-.. --~·7 ·-·:-.:::.":"-~.':."'~ 

:.··. ·.:.!"·~ . .is'.::;.,:".,.;-..... .:::,;;;,;.h~ .... 

Move the last sentence in the document so that it becomes the last sentence in the first 
paragraph. 
Add a new subtitle 'School closures' just above the table, and add this short paragraph: 
The dramatic change in the weather has meant that a number of areas are experiencing 
transport problems. This means that many schools across the country have been closed.' 
betweenthesubtitleandthetable. 
In the third paragraph change the word 'was' to 'is', and add the word 'has' between 
'Counties' and'reported'. 
Save the document as Ch_l O_Task_lOb in your word processor's normal format . 

There are a number o f techniques that could be used to move the last sentence to the 
end of the first paragraph. These include cut and paste, copy and paste then delete 
the o riginal and drag and drop. It is recommended that you learn and practise all of 
these methods. 

All three methods rt:quire you to highlight the correct section of text. A useful tip 
(especially if you are right-handed) is to highlight from the end of the text back to the 
beginning rather than the other way around. Highli lt the text like this. 



Hint 
Draganddropiseasy 
'When both positions 
areonthescreenat 
thesametime,but 
harder'Whenyou 
need to scroll through 
the document before 
dropping. 
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You can now choose your method from: 
1. Cut and paste 

Right mouse click within the highlighted area to get the drop-down menu, then 
select Cut. TI1is removes the sentence and places it in the windows clipboard. 
Move the cursor to the end of the first paragraph and right mouse click to obtain 
the drop-down menu again. This time select Paste. 

2 Copy, paste and delete 
Right mouse click within the highlighted area to get the drop-down menu, then 
select Copy. This copies the sentence to the clipboard but does not remove it. 
Move the cursor to the end of the first paragraph and right mouse click to obtain 
the drop-down menu and select Paste. Move back to the original sentence, 
highlight it and press the <Delete> key on the keyboard. Although this method 
takes longer than methOO 1, it does not remove the original sentence until the 
end of the process, so if you accidentally lose the sentence from the clipboard the 
original is still present. 

3 Drag and drop 
Click the left mouse button in the highlighted area and hold this down, moving 
the cursor to the end of the first paragraph. Release the left mouse button at that 
point and you will drop all of the highlighted text there. 

Whichever method you have used, make sure that the character spacing between the 
sentences and the line spacing betwet,1 paragraphs matches the rest of the document. 
In the practical examinations you are likely to be penalised for any inconsistencies. 

To add the subtitle, move the cursor to the end of the first paragraph and press 
the <Enter> key twice. (Ibis will keep tl1e same paragraph spacing as the rest of tl1e 
document). Now type the 
text 'School closures' 
followed by the < Enter> 
key. Type the new 
paragraph. Go back and 
check for data entry errors 
and the consistency of 
spacing. Correct any errors. 

To change tl1e word 
<was' to 'is', locate the word 
and highlight it. Type in tl1e 
word 'is' and it will replace 
the original. To insert the 
word 'has', place the cursor 
between tl1e words 
'Counties' and 'reported'. 
Ensure that tl1erc is a single 
space on each side of the 
cursor before you type the 

word 'has'. ~..;;;"'".;.t:;~~.:.;! :;'::'~;:;~.;!:";!;.;.!~~.':···---· 

d::~·f1.1:=:i:~:1~ :--: ::£~; ···_; ·~ :·;.~~--.:~ 
look like this.-----~-~·-=· -~-~.~--~-~-~=:Ji~iiiiir!=i 
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Hint 
To import images 
from a scanner or 
digitalcamera,the 
hardware device 
must have been 
installed on the 
computer first or 
the device will not 
work. 

Activity IOa 
1 Open the f ile TEXT2.RTF and insert the file TABLE2.CSV as a table within the document 

after the paragraph that ends 'This table shows the number of schools closed in some of 
the local authorities:' . 

2 Change the document heading to 'Snow brings disruption to Britain'. 
3 MC1.'ethelastparagraphinthedocumentsothatitbecomesthefirstparagraph. 
4 Add the text 'Heavy snowfalls were reported to the north of London. London was also affected 

but not to the same extent as the disruption that had been caused the week before.' as a new 
paragraph immediately before the paragraph that starts 'Flights were suspended ... '. 

5 lnthelastparagraphchangetheword'weird'to'unusual'andaddtheword'national' 
between 'many' and 'newspapers'. 

6 Saveandprintthisdocument. 

10.5 Importing images 

Images for the practical examination can be imported from clip art, a digital source 
like a scanner or digital camera, a file supplied to you , or an image from a website. 

Task IOc 
Open the file Ch_10_Task_ 10b. 
Add a suitable image from clip art, from a scanner, from a digital camera and from the file 
SNOWBALL.JPG. 

Importing an image from clip art 

To import an image from clip art, select the !'§~;,1111!1 .. •••••~ 

Ins;~t: 1r~~~i:e
0

~ 11~e~ ~a~~t~~~~ ~ q ~-;. 4 
of the document. AI; there are thousands of clip- .._ . ::;. ~ ·~ 
art images available in some packages it is r::,,';=--=; 
sensible to search for images of a type to see what 
is available. In this case the article is about snow, --------===----' 
so you can add this as your search string in the 

- Search for : OOx. In the Search in : box, cH.oose from the drop­
down list where you wish to search for the images : it could be on 
the local machine or via a web search. This may also depend 
upon the network settings of your system. Local searches will 

: ~:~~~;; ! :~ea~~u!S,n~t~
0

~~:!h:~ei~ ~,: ;~,~~~ ::;~ ea =~~ .. ~.~ 
r=C"""'==..--;--:i long time depending upon your network Ill ~ l'l 

-11 :.:~.., , crnmcction speeds. You must also define 
I~~ the type of resource that you wish to 
-~" include. This is found in the Results ~ ~.I! 

I~- r;i should be: OOx which opens a drop-down ~ ~ 
menu. In this case you want clip art, so 
e11sure that only this tick OOx is selected. 1$1 ll'itll 
Click 011 ~ . i1lllJ ~ 
th~1_, _~ _, u_k,_ o_f_, h_, _" _" _ch_m_ ,_Y_loo_ k_ l_ik_, ~ II~ ~ . 

Move your cursor to the ei1d of the ~ i=:=J 
docume11t and double click the left mouse 
button on the image you want to place on 
the page. You will manipulate this image 
later in thecl1apter. 
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Importing an image using a scanner 

Images cm be scanned and added to yom dip-,n oollection. ~ I !Cl I- I i 
Select the Insert tab and click on the Clip Art icon to open the ~ ~ • 
Clip Art pane. Click on the Organize clips ... icon. _ :ii _..,.. 

TI1is opens the Microsoft Clip Organizer window. Select ·.- °"'"'"'orna-
the File menu, followed by Add Clips to Organizer, then .., _,. __ 
From Scanner or Camera ... 

This will open the Insert Picture from Scanner or Camera window. Select the 
seamier in the Device box and click on ~ . Scan the image - \ 
the instrnctions for this will vary depending upon the scanner software. 

•·--• - ""- I ,--

1-----~ 

- - . 
CfipArt 

SNrchl',;,r: 

F?5El 

TI1e image you have 
sca1mcd will be added to the 
images stored on the local 
machine and can be obtained 
from the Clip Art pane. 
Remove the search string 
from the Search for : box. In 

_____ .. ~ 

~~---~ ~ ~:; da~~1 t:=t s~:l~~~~:~;~; s-i~ ~~~ 
th . " M CII . A~~ 

eI:~::~ ;:i,ltJ' sh:u~:~:';/ : D SOOnds 

box, tick the boxes for Clip Art 
and Photographs . \Vhen these options have been selected 
click on ~ . The scanned image, plus any others 

====c_~ J,stored locally, will appear like this. 
Double click the left mouse bunon on the scanned image 

to place it on the page. 

Importing an image using a digital camera 

You can impon an image from a digital camera in one of two 
ways. Both methods require you to attl.ch the digital camera to 

Iii Orwm<b.. the PC, rum on the camera and, if required, select the PC setting 
°it ~.,..,Ofl'u:>-h on the camera. All cameras are slightly different in this respect. 
f,j) n,o l\:r hb,._ The first metlmd is similar to using the scanner, and adds 

~----~ :1e:!:r~:,~:a~:: ~%~ f-~-;;;.;;;_;;;::~:;::-= :_.i,~ 
an images stored on the local macl1ine. As for tl1e -..,,. __ ~ ------- 1 

scanner, select the Clip Art pane, tl1e Organize ·: 1 
clips .. . icon, then File, Add Clips to Orgam:y"' 
and From Scanner or Camera .. .. Choose the 
camera from tl1e available options like this. t:::::::::::::=::::::::;;:::'J a 
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Click on the [ 1:1- - ..J button to open the Get Pictures from .. . window. 
Depending upon your camera, you may need to find the correct folder. When you 
have found this you will see all the pictures available on the camera. Click the left 
mouse button to select an image or use the left mouse button and <Shift> or 
<Ctrl> keys to select multiple images. When you have chosen the images that you 
want, click on ~ . TI1is image will now be available as clip art, like the image 
scanned earlier in this section. 

The second method is to attach the digital camera to the PC and click on the 
St rt button, followed by Computer. 

This opens the Computer window and 
allows you to browse the available storage 
devices. Select the Removable Disk 
option (it may have the camera name 
here). Copy the image file and paste it 
into the word-processed document. 

Importing an image 
provided for the task 
Select the Insert tab, followed by - -+-----+.' 

Picture . This opens the Insert Picture -----------~ 
window. Browse through the folders •-- . _ 
and files until you locate the file 00 .~,=.-=,,~. ="-~"'+"•.IL'~ , 

sNg~~~~i:~~-u,-,-;-bu_n_o_u_m_, - t(l•Ell•=-1• ~-· _l _l _liii,.llliiiiiiii .. l 
this file followed by the ~ : ::;--' i...-1 ~.":"" 
button. This will insert the image w .......... 
into the document. Save the 
document with a new filename. 

You will notice that the images 
have just been placed at the end of 
the document. These will now need 
manipulating so that they become a 
part of the document, rather than 
just appended to the end. 



10.6 Res izi ng images 

Task I Od 
OpenthefileCh_lO_Task_lOc. 

Document production 

Resize the image SNOWBALL.JPG to 8 centimetres high and maintain its aspect ratio. Place 
thisatthetoprightofthefirstparagraph. 
Resize the clip-art image to 2.8 centimetres high and 2 centimetres wide. Place this image at 
the top left of the second paragraph. Ensure that the text wraps around both of these 
images. 
Place the scanned image to the right of the table, aligned to the right margin. Resize this 
image if needed. 
Place the image from the digital camera to the bottom left of the page. Crop the image to 
remove the top 25 per cent of it. Ensure that all the text and images fit on a single page. 

Find the image SNOWBALL.JPG in your 
document. To obtain a drop-down menu , 
right click with the mouse o n this image. 
From this menu select the Siz.e ... o ption. 
1bis opens the Size window. 

The task instrncts you to resize the 
image maintaining its aspect ratio. This 
means to keep the height and width in the 
same proportions as the original image, 
usually to ensure that you do not disto rt it. 
To do this, ensure that the two tick boxes 
related to the aspect ratio are both selected . 

~ r,_,dU,c ~ 

~ lOO<n,tetn,>o 

~ !!.rl.11"< «> <><9",0l<f<M•""' 

l•!b E:::::I!I T°"· E:::];] 
'-'If,!: ~ ··"= ~ .......... ... 
"""'~ 23.Sl"" Wdt., ,,.,.. .,. 

~ 

Change the H eig h t : of the image to 
8 centimetres and click on ~ . 

Use a similar method to resize the 
clip-art image to 2.8 centimetres high by 
2 centimetres wide. Select the clip-art 
image and open the Siz.e window for that 
image. In this case different lengths and 
widths have been specified, but you have 

"=========' =-=='j not been instrncted to crop the image. 

II 



Information and Communication Technology 

Hint 
If evidence of an 
image size or the 
aspect ratio is 
required fora 
practical 
examination.you 
can usescreenshot 
evidence of this 
window. 

This means that you will probably 
distort the image from its original 
proportions. To do this, ensure 
that both of the aspect ratio tick 
boxes have their ticks removed. 

Use the Height: box to change 
this setting to 2.8 centimetres and 
the Width: box to 2 centimetres. 

TI1is will change the 
proportions of the image from 

mis,\.. 

.. 

~ t: 7. 62cmWld!h: 7. 62 cm 

~ 

Notice how the second image is slightly thi1mer but the same height. This task is 
continued in the next section. 

10.7 Wrapping text around images 
Task 10d requires you to place the resized SNOWBALL.JPG image at the top right 
of the first paragraph. A question like this would expect you to align the image to 
the margins and to the top of the paragraph, and there is a further instrnction to 
warp the text around the image. It is often wise to set the text wrapping first, then 
place the image. To set the text wrapping of the image, right click with the mouse 
on this image. From the drop-down menu., select the Text Wrapping option. 

You get a sub-menu with the layout options. Useful ones include: 

1. In Line with Text 
This places the image as an in-line graphic and is treated as a text character within 
a line of text. It will move with the text surrounding it if new text is inserted or 
deleted. 

2 Square 
TI1is places the image on the page and the text wraps (flows ) around it. Use 
More Layout Options ... to specify the type of wrapping that you require. 

3 Tight 
This places the image on the page and the text wraps (flows ) around it, like 
Square, but you cannot control the distance of the text from the image for the 
top and bottom settings, although you can to the left and right, using More 
Layout Options ... 

4 Behind Text 
TI1is places the image behind the text. It can be used to set a background image 
in a document. 
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5 In Front of Text 
TI1is places an image over the top of the text. 

6 Top and Bottom 
TI1is places the image with the text above and below the image, but not wrapped 
to the side. 

7 More Layout Options 
TI1is can be used to give more options to the selected layout types above. For 
example: if a Square layout is selected you can specify where you wish to flow the 
text around the image and the distance of the text from the image on each side. 
This option also allows you to 
control the positioning of the image 
on the page. 

menu. 
To move and place the image, c 1 

and hold the left mouse button on the 
image and drag it to the top right 
comer of the first paragraph. When 
you have roughly placed this image, ,ii , ,, .... ._ 

right click on the image again. Select i! ,.,_.,. 

the Text Wrapping option, followed ~ ::,-..c.-.. 
by More Layout Opti~:"'~--~·, ,~o~g~ct~,h~,:'..__J/~~~~=~§:~~~ Advanced Layout window. Click on the 
Picture Position tab. ·~===~ ----~ 
'"P~~:~eforar~~:~1:aag:!nra~~::ry~~~v~i~~ " - ~ ......... ~I 

.:,· " .... ~- ~J ~ 
the text to the right margin, in the ,. .. ..,.. .. ~ 
Horizontal section, first select the .-.- c::::::=li:1-.. r--i::J 
Alignment radio button and then set the 
image Right aligned relative to the Margin . ~=-~,? :::· i:;::;;_] 

• r- fil ....... r ..... i;;;i 
" .... ~- ~,r ~ "--~ .. --.. ~ --c::::=:.it1-- F--:3 ·- =-·~ o-- u:::::i:il- ~ ..B --· =,..-. ,- 3 ·--11'1 .._.~ ...... 

.-.. ......... , c::::=::id, ...... ., r- ;J 

= = 
To align the image to the top line of 
the paragraph, in the Vertical section, select 
the Alignment radio button and then 
To relative to the Line. To set the 
position, click on l!!_. Check that this has 
worked correctly. If not, this is usually due 
to the image being placed with tCXJ little 
precision when it was dragged and dropped. 

~ ~ Try dragging and dropping the image again 
,,_ _ ____ _ __ _, and repeat the process. 
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Repeat both procedures for the clip-art image, wrapping the text using Tight, 
and placing the image with a Horizontal alignment of Left relative to the Margin 
and a Vertical alignment of Top relative to the Line. 

To place the scanned image to the right of the table, aligned to the right margin, 
follow the same procedures as above, set the wrapping and align the image with the 
right margin. The image is still too large for the space; no size has been specified, 
but it needs resizing without changing its aspect ratio. Use the drag handle in the 
comer to resize the image ( do not use the drag handles in the middle, as they will 
affect the aspect ratio). 

pl•y ,~ t ho """"• • •""""-'lli•<J, .... "1 
,v-o ,o•d<iN<l,_...i.on, p«>®<i~g • -

The resizing has been completed so that the 
paragraph below the scanned image does not have 
to wrap around it. This has been done to ensure 
that the final instruction within this task to 
'Ensure that all the text and images fit on a single 
page' can be completed. 

The image from the digital camera may need to 
be rotated before it can be placed on the page or 
resized. Click the left mouse button on the image 
to select it. You will notice a rotate handle as well 
as the drag handles used to resize the previous 
image. Hold down the Shift key, then click and 
hold the rotate handle and drag it in a clockwise 
direction (like the arrow). When the image has 
rotated through 90 degrees (so that it is upright) 
let go of the mouse button. 
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The rotated image will need resizing ,-------------, 
to fit the available space. It is 
recommended that you resize the 
image to a smaller size than required 
at this stage. 1l1is image should have 
the text wrapping set to Tight, and 
placed with a Horizontal aligmnent 
of Left relative to the Margin and a 
Vertical alignment of Bottom 
relative to the Bottom Margin. 
Then resize the image to fit the 
available space. The page should 
look like this. This task is 
continued in the next sectio n. 

10.8 Cro pping imag es 

Activity I Ob 

To crop the image from the digital 
camera, click the left mouse button 
on the image, then on the Format 
tab (which should have the text 
Pictu re Tools d isplayed above it) at 
the top of the window. From the 
Size section of this tool bar click on 

the Crop icon. -;ilic;;;;;;i;;;:;j;::i!lll•• l!.!!• ••••••1111! 1l1is will change the drag handles 
used to resize the picture to crop 
handles, which are used to cut off a 
portion of the image. Drag the top 
handle down so that approximatdy 
the top 25 per cent (a quarter) of the 
picn1re has been removed. To resize 
the image again, you must click your 
left mouse button back on the text, 
then on the image, so that the crop 
tool has been removed and use the 
drag handles to resize the image. 

OU Ht19nt 11 .. , cm· J 

1 Open the file saved in Activity 10a. Add the image TREESJPG 
(fromtheCD)androtateitthrough 180degrees. Resizeitto 
7centimetreswide,maintainingitsaspectratio.Placeitatthe 
topleftofthefirstparagraph. Ensurethatthetextwraps 
around this image. 

2 Scan the image SNOWANGEL. Place and resize this image at the start of the second paragraph, so that it left and right 
aligns with the text wrapped around the first image like this: 

3 C~p th, top aod bottom of th, SNOWANGEL ;mag, so that th, chUd ;, w;th;o 5 mUUmotm of th, ! ~! 
edge of the image. L::::::::J 

4 Add an image of a car or train from clip art and place this at the bottom of page 1 so that it moves 
thetableontopage2. 

5 Add a suitable image from a digital camera of a car, t rain or snow and place this in an appropriate 
place on page 2. 

6 Save and print this document. 
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10.9 Formattin g pages 

In the practical examinations, you may be presented with doa1mcnts with different 
page layouts and g iven instrnctions to reformat them. Do not assume that a 
document is already set as specified. If it is in text (. txt) fonnat, it will use the default 
settings of your word processor. If it is opened in rich text format (.rtf) or was saved 
as a W ord document, it will keep the settings used to save the fil e. 

Task I Oe 
OpenthefilesavedinTask 10b. 
Change the page size to AS and the orientation to landscape. Set the top and bottom 
margins to 3 centimetres and the left and right margins to 3.5 centimetres. 
Save the file with a new name and print the document. 

··- EJ-- . . ' 
.... !:?.... . 

I .... ,--s 
= = 

To set the top and bottom margms to 

3 centimetres, select the Margins section, 
then either; highlight the text within the 
Top: and Bottom: boxes and type in the new 
values, o r use the scroll handles to change the 
values in each of the boxes. 

Change the left and right margins to 3.5 
centimetres using a similar method in the 

I L":::'"-=-"='-=='""b-----+ Left: and Right: boxes. Click on --;i""". 
~ c:::K:J ~ 
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If the document is to be part o f a OOund lx>ok, a gutter may be needed. TI1is is an 
area outside the margins that is used to bind the lx>ok together. If you need to use a 
gutter, this can also be set in the same way using the Margins sectio n of the window. 
The gutter can be placed to the left or top o f the page, depending upon the type of 
binding to be used. Save the document. 

10.10 Using headers and looters 
A header is the area of a document between the to p of the page and the top margin. 
A footer is the area of a doa1mcnt between the bottom of the page and the bottom 
margin. You can insert text o r graphics into headers and footers. This might include 
the author's name, the document's filcnamc, page numbering, or even a company 
logo . H eaders and footers can be found in many printed documents, including those 
that have been word processed or desktop published, and in presentatio ns, reports 
from spreadsheets and databases and in webpages . 

Task IOf 
Open the file saved in Task 10e. 
Place your name in the centre of the header. Place the date and time on the left, an 
automated page number in the centre and the filename on the right in the footer. 
Save the file with a new name. 

To use the document 
header or footer select the 
Insert tab. In the Header 

& Footer sectio n click 01•;, _!)C:...:::Jii~==~f==--=:;-----,]I 
the Header icon. This ~ 
offers a range of built in 
header styles; simple Blank 
settings are all that should 
be required for the 
practical examinations. If 
you select the Blank 
(Three Columns) option, 
this will allow you to put 
text o n the left, in the 
centre and on the right 
within the header. This 
moves the cursor into the 
header and changes the 

toolbar to g ive you options ~=,~~;;-~~~~~~~'!! 
for the header, like changing the 

positio n ofthc hcadcrn~~i,~,i~v,'.'''.'.0 ~ 1f:1~~~:~i~t.l ~ I 
the edge of the page. -

For Task lOf you are instructed 
to place your name in the centre of 
the header. Move the cursor over the 
centre placeholdcr that says [Ty pe 
TextJ and type in your name. 
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Hint 
If you are not sure 
whether a carriage 
return exists in the 
text, header or 
footer,selectthe 
Home tab on the 
toolbar,thenthe 
Show/Hide • icon. 
Carriage returns 
will appear in the 
dcxumentas E!i 

Your text will replace the placeholder. For this task you were not instructed to place 
anything in the left or right placeholders. These must be deleted or you may be 
penalised in the examination. Select each placeholder in rum and press the 
<Delete> key. TI1e header should now look similar to this. 

El"!l=l!!!l!!lllllll!ll!!!l!!!:!11111!1111111111111!!!""'"".i~ ·'! foo~~, s~~ ~~/~1:lr!~ the 
Go To Footer icon. 
Although this takes you r;:::::..s~iiiiiiii;;;;;;:;;i:i.ii~ iiii;iiiil!::;2,~ into the footer, it neither 
sets up the placeholders nor 
correctly i:ositions the tab 
stops for the centre and 
right aligned text. Whilst 
thisworksfinefora 

standard document, if you have changed the margin settings of a document, as in 
Task lOe, the tab stops do not align with the margins as shown here. You can see in 
this example that the centre tab stop is not set to 7 centimetres which would be the 
centre of this page with these margin settings. 

To set up the page footer, click on the Footer icon on the 
Header & Footer section of the toolbar and then the Blank 
(TI1ree Columns) option. This will allow you to set all three 
areas of the footer. 

In Task lOf you are instructed to place the date and time on 
the left in the footer. Click the left mouse button on the left 
placdmlder to highlight it. Then click on the Date & T ime icon 
on the toolbar. '-'-=="=='==-

This will open the Date and Time window. In 
this task, the format of the date and time has not 
been specified so you can select either of the 
options that shows 00th the date and the time. 
Click the left mouse button on the format that 

!:"'~'=======;;JI~~ auto;:a~e:e;ga~s1:1i:::~;~: !'.:;: :~ 
the footer. Click the left mouse button 
on the centre placeholder, then click on 
the Page Number icon from the 
toolbar. This gives you a drop-down 
menu, from which you need to select the 
option for Current Position. Select the 
format for the page 
numbering; again, in 
this task the format of "-------~=-· __ = _ _, the numbering has not 
been specified so you 

can select whichever option you choose. Check carefully that the 
automated page numbering has not placed an extra carriage return 
into the footer; ifit has remove this using the <+-Backspace> key. 

illl .... _ 
,J ..... .. _ 11--... ,] ,..,H,N>,_ 11 ---~ :;i. ., ___ _ 



You were also instrncted to place the document's 
filename on the right in the footer. Click the left 
mouse button o n the right placcholder, then click 

Document production 

on the Quick Parts icon on the toolbar. ---.i...:==-- t;;t; 
This will allow you to select a number of 

automated functions, most of which are beyond 
the scope of this book. Select Field ... to open the 

Field 
_ .._ ..... r .... ..- window. In the Field names : box, scroll r :' -= ----~y~~§:E1:: .. 

required select the Add path to 
filename tick box before clicking on i:L. 

_._ 1l1e completed footer should look similar 
to this. 

To exit from the header or footer back 
into the document, either click o n the 

_ .. ,..,. .. -.......... Close Header and Footer icon, o r -
~ double click the left mouse button on the 

body text of the document. Save the 
document. 

·- -
§!. !'.. ;-S.,... ~ <>O~Nl-&bm'-> ~~ (b~ 

-·· N-.,. -

: i?.'-
·1= ........ '.'.'.":" ... . 

Activity IOc 
Open the file ACTIVITY3.RTF. Change the page size to A4 and the orientation to portrait. 
Set all the margins to 4 centimetres and remove the gutter. Place the date on the left, the 
filename in the centre and the time on the right in the header. Place your name on the left 
and an automated page number on the right in the footer. Ensure that the header and 
footer are 2 centimetres from the top and bottom of the page respectively. Save and print 
the document. 

10.11 Wid ows a nd orpha ns 
If you start a paragraph of text on one page but there is not enough room on the 
page to get the last line typed in, the single line of text which appears at the top of 
the next page is called a widow. Similarly, sometimes you start a paragraph at the 
bottom of a page but you can only type in one line before the rest of the text goes 
onto the next page. 1l1e first line of the paragraph at the bottom of the page is called 

1111 
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an orphan. These should be avoided when producing a document and you are likely 
to be penalised if you include these in any submission for the practical examinations. 
They can be manually avoided by inserting a Page 
Break, which does not show the reader that you 
have forced the page break at this JX)int. For mo re 
information o n breaks, refer to Section 10.12. 

You can set up Word to automatically avoid 

;~~~ea~~;Ji~:~~~ : e~~:~~esele~ ~;_;;~:::,:::, :::::::::::~::: : 

Paragraph section click on the expan~ r<1 ,-~_:S:iiiii• ,.....i:, 
icon to open the Paragraph window. _..... - -

N ow select the Line and Page Breaklj.-,--
tab so that the window koks like this. To L,,-., .. .,..,!, 
get Word to automatically avoid widows ~=~"::':' 
and orphans, select the Widow/Orphan -~ 
control tick OOx and click on - . ~:..w.,.....,.-..-. 

~ l!o'I· ~ 

10.12 Using page, section and (§--"''"'~ 
column breaks 

Breaks can be used within a document to 

force text o nto a new page or into the 
next column (if columns are being used), 
or to define areas with different layout, I I 
for example where part o f a document is - .---------
fo rmatted in landscape orientatio n and ~ - - -- - -- -·· -

~:art~;n~:i::~~· !~r:7~:l:~~Ct~ U SC ~ ~ ~ ~ 
these effects: 

1 Page break 
This forces the text o nto the start of a new page, leaving white space at the end of 
the pn.·vious page. It is particularly useful for removing widows and orphans from 
yourdoaunent, although Word can be set up to do this for you (sec Sectio n 10.11). 

2 Column break 
TI1is fo rces the text into the top of the next available column, which may be o n the 
same page o r may be on the next page. 

3 Section break 
A section break is used to split areas of a document with different layouts. There are 
two types of section break: one forces a page break as well as the change in layout 
and the other is a continuous break, that allows different layouts on the same page. 

Task IOg 
Open the file saved in Task 10f. 
Add the tut 'Winter wonderland or woe' as a new title at the start of the document. Keep 
the two titles on the first page of the document. Set the orientation of the first page to 
portrait and the rest of the document to landscape. Set all of the body text except the table 
into two columns, with a 2 centimetre spacing and vertical line between the columns. 
Savethefilewithanewname. 



Hint 
If you select the 
Home tab on the 
Toolbarandclick 
on the Show/Hide 
icon, the section 
break will be visible 
like this: 

Document production 

~!~\r; !:~ :~~e~1~\ext ••••••••••••••• 

'Winter wonderland or 
woe' to the start of the 
document as a new title. 

pla~:l~e~et~~~1:tto the t l~====-t--1 
break needs to be 
inserted. This will be just 
beforethetext'On 
Monday .. .'. Because this 
break will be the 
separator between two 
different types of layout 
(page 1 being portrait 
and page 2 onwards 
being landscape), a 
section break for a new 
page needs inserting 
rather than just a page 
break. To do this, select 
the Page Layout tab and 
click on the Breaks icon. 

LJ .§1 

"""""" lndicolelhotthe lexllollowinglhe<0lumn 
breokwillbtginin l he nexlcolumn 

Ja! Wr­
Se~rolele>laroundobject,on w eb 
~ge~such><caplionlextfrombodylext. 

-·­ln<erl • <eclionbreak • nd,t>rtlhenew 
<eclionon t t,e next~oe. -ln<erl a<eclionbrN k~nd<l>rllhe new 
<eclionon t t,e~me~ge. 

-·­ln<erl a <eclionbre•k•nd,t>rtlhenew 
<eclionon t t,enexte .. n-nw1bered~ge. 

-·­ln<erl•<eclionbre• k • nd,t>rtlhenew 
<eclionon t t,e nextodd-nuri>ered~ge. 

This drop-down list will appear. Select the Section Break option for the 
Next Page. 

As the document is currently in landscape orientation, move the cursor to page 1, 
the section that needs to be changed to portrait orientation. TI1en select the Page 
Layout tab again, followed by the Orientation icon and click on Portrait. You will 
notice that the word processor has only changed the orientation of this page 
(because you inserted the section break) and that all of the header and fc:x:,tcr settings 
have been automatically amended for the new layout of this page. This task is 
continued in the next section. 

••~<ce•·-•<••• ,. .... . - ....... . ... . ,, .... , 
' ---,-----

10.13 Using columns 
Columns can be used to give a layout similar to that found in a newspaper and you 
may be required to fonnat a document, or part of a document into a number of 
columns. If you arc going to have different column settings for diflerent parts of the 
document, you must decide where you are going to split the document into the 
different sections. This infonnation is often given to you in the examination questions. 

For Task 10g you need to add two more section breaks to the document, so that 
the lxxly text and the table can have different layouts. These section breaks need to be 
at the start and end of the table. Because the text and table do not need to be on 
different pages you need to set these as continuous section breaks. Move the cursor to 
the place where you want each break inserted (i.e. before and after the table), then in 
the Page I..tyout tab click on the Breaks icon, followed by the Section Breaks option 

II 
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Hint 
If you have just 
formatted the first 
section like this, 
moving the cursor 
into the final 
paragraph and 
pressing<Ctrl>and 
<Y>willrepeat 
your last action. 
This is much quicker 
thanrepeatingthis 
process. 

Hint 
Column breaks can 
be inserted to force 
text into the next 
column using the 
Pagelayout tab, 
the Breaks icon in 
the PageSetup 
section, followed 
by the Column 
option. 

option at the OOttom of the drop-down list. 
1bis opens the Columns window. 01angc the 

~::ets from One!column to Two. 

-· - · - 1-1 = = 
Place a tick in the Line benveen OOx to ~ ~ 

the vertical line. Change the Spaciiimicg,'1ro~m";;,~i"""b,b---~:;;;;,;;;:;~ 
default value to 2 centimetres. Make sure that the Apply to: OOx contains a reference 
to the Selected sections before clicking on ~ - Move the cursor into the paragraph 
after the table and repeat this process for the final section of the document. Save the 
completed document, which will look like this. 

Activity I Od 
Open the file saved in Activity 10c. 
Change the body text of only the first page so that it is set in two columns with a 
1 centimetre spacing and a vertical line between the columns. 
Save the file with a new fllename. 
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Activity IOe 
Open the file saved in Activity 10d. 
Change the page margins to 2 centimetres and the alignment of the header and footer to fit 
the margins. Ensure that the header and footer are 1 centimetre from the top and bottom of 
each page. 
Add a new title 'Arctic blast grips the United Kingdom' at the start of the document. Place 
the two titles on a single portrait page with a single column. All other text should be on 
landscape pages, in three columns with 1.5 centimetre column spacing. 
Save the file with a new filename. 

10.14 Font styles and sizes 
Text can be changed to have different font faces, colours and sizes and can have a 
number of enhancements added. These are useful fo r making text stand out. Font 
faces are grouped into two main categories: serif fonts and sans serif fonts. These 
are not the name of the font face, but are the generic categories that describe the 
properties of the fo nt. A serif font koks like this: This is serif font and a sans serif 
font looks like this: This is a sans serif font. The wo rd 'serif' describes the sho rt 
strokes at the end of individual letters. Sans serif fo nts do not have these short 
strokes. If you are asked to set text into a sans serif font, you mu st find any font in 
your word processor that does not have these serif strokes. 

Serif fonts are often used in newspapers and books as they are easier to read than 
sans serif fonts. It would be appropriate to use sans serif fonts for emphasis of text or 
for titles or sub-titles. It is not sensible to use more than two different font faces on 
any page. You can use other enhancem ents to make text stand out, as can be seen 
later in this chapter. 

Font sizes are measured in points. TI1ere are 72 points to an inch (which is ju st 
over 2.5 centimetres) . If you are asked to produce text of an appropriate size, for 
most adults 10 points is appropriate as body text, but older readers may prefer 12 
point. An ything above 14 point is generally unsuitable as lxxly text for adults, but 
may be ideal for children. In stories for children learning to read ( aged 4 to 6 ) it 
may be appropriate to use a 20 or 24 point font size to make it easier to make out 
the letter shapes. Different fo nt sizes would also be appropriate as body text for the 
partially sighted. 

T wo fonts can be the same size but appear to be different heights. Fo r example, 
all of these fonts arc 11 points high: Goudy, Comic Sans,~~ Sbt., lffllllCl, 
T ekton and Arial. The height of the font is measured using the measurement from 
the top of the letter with the tallest ascender (often the letter 'h'), to the bottom of 
the one with the longest descender (often the letter 'p'). 

Task I Oh 
Open the file saved in Task 10g. 
Set all of the text on the first page to an 18 point sans serif font . Make the sub-heading a 
13 point sans serif font and the body text a 13 point serif font. 
Savethefilewithanewfilename. 
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Hint 
A document may 
containatable(like 
thisone)ora 
database extract. 
Make sure that 
these are formatted 
with the same font 
faceandsizeasthe 
body text of the 
document. 

-.-• ..... 

Ho"'l - klrca "fR•'-"' R'1'1ffl<tt Maoiing, OpenthefilesavedinTask 

~ i C~ COWH<- • IM • A" A• ~ ;1~ :::dtl~~~~!~~:;~. t1~: 
~Copy 

,.,,. a I u . ... • , • ' ~ .=_~ L the H ome tab, then tl1e 
· J Fo,-hlnl., ~· = -~ Font section. Use tl1e drop-

The list of available fonts will look similar to tl1is, 
showing the currently selected font in the box., the most 
recently used fonts below and a full list of all tl1e fonts 
below; many more are available using the scroll bar. 

For tl1is task you need an 18 point sans serif font to 

use as tl1e title for a document, so chcose an appropriate 
font such as Aria l Black. Use the drop-down list box 
for tl1e point size. Select 18 if it is available, or type this 
size into tl1e box. 

B I 11 · - x, x• No • ~ - .L\, · 

down list to show a list of 
available fonts. 

To set all the body text to a 13 point serif font, highlight 0 Mob• G"''"'-'P•0 8old 

all of the body text (including tl1e table) and the sub· ::~~oni 
heading, tl1en, using the method shown above, change 'I- AL&UJAJ" 

the font size to 13. Setting the font size for 00th the 
body text and the sub-heading, and then changing the 
font face of the sub-heading, will be quicker than doing 
each section individually. Select an appropriate serif font 
such as Times New Roman; as tl1is is body text do not 
choose one that is complex and difficult to read. 

,.,,, .. .. ,. .... ~ ... . 

To set the sub-heading into a sans serif font (it is already 13 point), highlight the 
text 'School closures' and select the same font face that you used on page 1, in this 
case Arial Black. Save the completed document, which will look like this. 

l• I -- --· - - - - ~ · 

Activity IOf 
Open the file saved in Activity 10e. Set all of the text on the first page to a 24 point sans 
serif font . Make the body text, headers and footers an appropriate 11 point serif font . 
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10.15 Em phasising text 
Text can be emphasised in many ways. These include using colour, emOOldening 
(making the text bold), underlining or italicising the text. AI, you have seen from this 
book, different colours can be used to symbolise different things: any red text in this 
book is a reference to the glossary, blue text in this cl1apter tells you what to select in 
your work, etc. Background colours can also be used to give different meaning. In this 
book, for example, activities are always shown with a pale red background and tasks 
always shown on a blue background. 

T ask IOi 
Open the file saved in Task 10h. 
Make the text Winter wonderland or woe' red. Make the name of each airport in the text 
stand out by highlighting it in cyan. 
Make all of the text in the top row of the table an italic font . Make the words 'snowmen' 
and 'snowangels' bold. Underline the sub-heading. 
Set all of the text on the first page to an 18 point sans serif font . Make the sub-heading a 
13 pointsansseriffontandthebodytexta 13 point serif font. 
Savethefilewithanewname. 

O pen the file saved in Task 10h and highlight the text W inter wonderland o r woe'. 
Select the Home tab, the Font section and then the drop-down arrow fo r the Font 
Colour icon. 

This opens the initial colour palette. Select the 
- - ~ "V colour you need from the cho ices g iven; for this 

task the red colour is specified. If the colour that 
• I 1l • IN x, x' A.o · .., • • you need is not shown, click o n the More 

________ .,. f"olors ... option. 

= ~----~ ,,-- To highlight eacl1 aiq,ort in the text, move the 
cursor to the highlight tool in the Font section and select 
the drop-down arrow. From the drop-down colour 
palette for the highlighter pen, use the left mouse button 

to se~: ;:1~::o::v,::,;:-h,::m::-0::-u::sc- ---=.,,::-.,6.'~. _ lle_ lle_ ,11~ 1 

: ~::: : ~:re~t t: ~~:1~~~ t: i~ • • • 

~ "'T,~=-1 :~n~~~~~r;~~gt~:~~:~s~~eti;is • • • • • 

aiq,orts. When you have • • • • 
- - - ---~ finished., go back to the drop-

~ i;:i~;l~~~~:.alen c for the highlighter and select Stop J • ~t:::~IIOhtlng 
To italicise the top row of the table, highlight 

the top row of the table. Select the Home tab, the 
Font section and click on the Italic icon.---+-"'~j .. ,.,. 

To emOOlden (make bold) the words 'snowmen' e I 1l • .. " • ,.. Ao · -'Y · A · 
and 'snow angels', highlight the three words (if you t ""' . 
hold down the <Ctrl> key whilst highlighting, -
you can select these words at the same time) . __J 

Select the Home tab, the Font section and then the Bold icon. 
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Hint 
The countries you 
will need are 
England, Ireland, 
Scotland and 
Wales.Selectthe 
Home tab, Edit ing 
and then the Find 
icon to help you 
findallofthese 
words in the 
document. 

Hint 
Use the Format 
Painterwithcare,it 
copies paragraph 
formatting as well 
as font formatting. 
Forexample,ifthe 
area copied from is 
partofabulleted 
list.when the 
format is applied, 
the new text also 
becomesabulleted 
listinthesamestyle. 

To underscore (underline) the sub-heading, highlight the text 'School closures'. 
Select the Home tab, the Font section and click on the Underline icon. Save the 
file. 

Activity I Og 
Open the file saved in Activity 10f. 
Make all the text on page 1 green. Make the words United Kingdom on page 1 bold, italic 
and underlined. Make the name of each country in the text stand out by highlighting it in 
green. Save the file with a new name. 

Using format painter 
If you need to copy the formatting from one part of a document and apply it to 

another, for example if you have just set some text red and emboldened and want to 
copy that formatting onto another area of text you can use the fonnat painter. Place 
the cursor within the text you wish to copy the formatting from and click the left 
mouse button. Select the Home tab, the C lipboard section and click on the Format 
Painter icon. Move the cursor to the text that you wish to format, if it is a single 
word then click the left mouse button anywhere within that word. If the area is 
more than one word, highlight the new text and the formatting from the original 
text will be applied to this text. 

10.16 Using lists 
There are two types oflist that could be used in the practical examinations: bulleted 
lists and numbered (or sometimes lettered) lists. Bulleted lists contain a bullet point 
( cl1aracter) at the start of each line to show that it is a new item in a list of other 
similar items. 

Task IOj 
Open the file TEXT3 .RTF and place your name on the right in the header in a 14 point serif 
font. Placethefilename inthecentreofthefooter. 
Change the twelve items listed into a bulleted list. Use a bullet of your choice. Make sure 
thatthisbulletedlistisindented byatleast3centimetres. 
Savethefilewithanewname. 

Open the file and create the header and footer as Review View Add-ln i 

described earlier. To add bullet points to a list, 
highlight all of the text to be added, in this case....--,"1 :;:: • }::; • ·~ · i:tf "ftr:.l1!JL ~ 
~~r:; ~:;l~t::;!~~:~ ~;~c:~~nt:;a;~,~ :t~1. Iii: • :II • l~ I~ · - · 
This will place bullet points next to each of the Paragraph r.. 
list items. To choose the type of bullets used, 
select the drop-down handle instead of the icon. 
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[::,;;;;;;::======--i,-~s,~lect the type of bullet point that you require 
from the ullet Librar y. In this case, you can 
choose any symOOl like the ./. The bulleted list will 
look like this. ---------~ 

Notice how 
1 

~~: ~~~l~t:1d:1:cd .... 
automatically in from the left 
margin, although not by at least 
3 centimetres. To indent it 
further, you need to change the 
paragraph setting on the rnler. 

If the rnler cannot be seen at 
the top of the page, click on the 
View R uler icon on the right 
aOOve the scroll bar. This will 

Topics•cove re d•so•far•in•chapter•1011 

Whllststudyfngehap~r·10,i-haveieamli'1ow-to:t 

.,-,enter,datafrom-enexistf\gfile11 
"'+keyin ·andediMext-1 
.,-+importfflagnfroma ·variel)lolsource;1J 
.,-+placeandmanipulateimages1] 
./+set'lhepagesize·and-or11ntationf 
"'+~etpagemargins11 
.,-+useheade1S11ndfooters,r 
./+setpage,seclion-endeclu1TV1breaks1l 
./+useeclumnst 
./,seHontstyl11s11nd-sizes1l 
"'--errl)hasizingte:l\1 
.,-+UHl~t;1J 

dispby thernleratthetopofthe ~--------~ 
page. ( Sec Section 10.19 for more information on the mler. ) 

Highlight all of the bulletcd list. On the rnler, click the left mouse 
button on the rectangle (not the triangle) and hold it down whilst 
dragging the handle to the right. Make sure that both handles are 
more than 3 centimetres to the right of the margin. TI1e finished rnler 
should look like this. 
\ The bulleted list will now be indented like this. Save the file . 

Toplcs •covered·so-f11r·ln·chopter+10,r 

Whilshtudyingchapler-10,l·heve leamlhowto:11 

"'-enlerdatafrom-an11xislingfile1l 
...--key1n·andedil·text1 
./-importimagesfrom11·varietyof'SOurces1l 
...-- place-andmanipu!ateimag11s1l 
...- - setthe-pe.ge:~ize·ond-orienltl tionf 
"'- setpagsmargfls11 
./-useheaderatrndfooterst 
.,-- Sillpags ,section -aod=lumnbreakst 
"-useeclumns'I 
"'-setfonhtyle:nnchizes11 
.,--empha~zing;c;ix!f 
" - usefis!$1l 

Ill 
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Task IOk 
OpenthefilesavedinTasklOj . 
Change the bulleted list into a numbered list us ing roman numerals. 
Savethefilewithanewfilename. 

Open the file and highlight the enti re bulleted 
list . Select the Home tab, the Parag raph section Review 
and click on the Numbering icon. ~ 

item~ i~:! t':t~~~rso~:;
0
~;:~~~~~ list ;; • t= • ·~ · ;' t, l!!.Jt~ 

select the drop-down handle instead of the icon. Ill= • ,m • ll!§·]I~ • ~ • 
frot~~::;: r~~rli~~~~t; ~~:! :~~ ;~l~l require Partor•Ph ~ 
can choose the roman numerals as that was 
specified in the task . Save the file. 

Make sure that, if the bullcted list 
contains short items that would make up 
the end of a sentence, it has a colon before 
the list, each list item starts with a lower 
case character and o nly the last item in the 
list has a full stop. 

W ord will try to place capitals on each 
list item, bur this is not correct as each one 
is not a new sentence. You must adjust 
these to get a list looking like this. 

Forbreakfastl had : / 

• cereal 

• toast 

• ! cupoftea. 
When it wos lunchtime 

Activity I Oh 

GB. 8) 2.-- 2)--

3.-- 3)--

~BB) B.-- b)-­

C.-- o)--

B. , __ 
3.--

Qrfin, Nrw Numbn Fonnal-

Open the file TEXT4.RTF and place your name on the left, today's date in the centre and the 
filename on the right in the header. Make the blue text into a bulleted list. using a bullet of 
your choice. Make sure that this bulleted list is indented by at least 2 centimetres. Make the 
green text into a numbered list, using numbers followed by a bracket. Make the red text 
into a bulleted sub-list, indented from the numbered list using different bullet points. 
Change the colour of all the text to black. 
Savethefilewithanewname. 
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10.17 Usin g tables 

Activity IOi 

Task IOI 
Open the file that you saved in Task 10i. Add 
to the end of the document the following 
text as a new paragraph: 
'Temperatures recorded at one weather 
station in Ross-on-Wye during the week 
read:' . 
Below this add the table shown opposite: 
Save the file with a new filename. 

Tables of data may need inserting into your word-processed documents. You have 
already inserted a table from a .csv file in Task 10a. 

Open the file that you saved in Task lOi and add the text as a new paragraph to 
the end of the document. 

r.::=:--::===r-- This will open the Insert 
T able drop-down menu. Move 
the cursor over the grid until it 
highlights the three columns and 
eight rows that you need, like this. 

Click the left mouse button in 
the last highlightt"CI cell of the grid 
and this will insert a 3 by 8 table 
into your document. Add the text 
from the task into this table. You 

D ,,....,_, _ _ 

~-- D•--
:!. can move the cursor into the next ~ l2<.,.,_ 
~ ~,<1\l'ft-11 .. 1 cdl by pressing the <Tab> key. If ~ ::s,,·::~: 

~
0
~-~·----~ r~:~1~~~ ::~: :;~~=: ~l:;oe!~t U ~ 1• ... • 

last cdl of the table and press the <Tab> key to create a new row. If you need lots of 
new rows, hold down the <Tab> key. 

Create a new document with 
thetitle'Skillstopractiseusing 
tables' . Create this table, below 
the title. 

Rightdkk 

Rightdkl 

Alignment Lefl,right,centre, fullyjuitified 

Tnp,c'1nlfe,bottom 

Colou,,shading 

Break,,,uo<1page 

Textw,apping 
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T ask IOm 
Open the file TEXTS.RTF and place your name on the right in the header. 
Delete the second column and the 'Martial arts' row. Insert a new third column 
with this data. 
Insert a new row between the 'Dance workshop' and 'Discover Scuba' with 
this data . 

Merge cells 2 and 3 in the top row and cells 4 and 5 in the top row. 
Save the file . 

Open the file TEXTS.RTF and place your name on the right 
in the header. To delete the second column, move the cursor 
to any cell in this column and click the right mouse button, to 

get the drop-down menu like this. - -----~ 

" .. 
Select Delete Cells .. . , which will open the Delete Cells i. ._,.c ... . 

window. Select the radio button fo r Delete entire column U "'""~ ... , ... ..,.._ 

and click on ~ . 

Repeat this method to delete the 
'Martial arts' row. Right mouse click 
in any cell in this row and select 
Delete Cells ... . This time select the 
radio button for Delete entire row 
before clicking on ci""". 

@~~i~ 
O strft <m !,I> 
0 0dote "'1ft[OW 

\>:i 0doll0"'1tn~ 

~~ 

To insert a new third column, i ,,,,. 

right click the mouse in any cell in the S•PI 

~~::dm: 1~~~~~~~: t:i;~t;h~:p- ~ : .: : 

Insert Columns to the Right.~ ==~.,~:· 
will insert the column. Enter the text O 1o, • .,,.,,. ~ <Mo., 

shown in the task into the cells. lln 1q1 D1r«u.,._ 

Use a similar method to insert the 
new row. Click the right mouse 
button in any cell in the 'Dance 
workshop' row. Select Insert, then 
Insert Rows Below. TI1is will insert 
the new row. Enter the text shown in A '0 "1 "'-

the task into the cells. 

ll6•~o,--.. 
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x 1>01>vlo1;,,n Y o?Vlotion To merge cells 2 and 3 in the top 
r-~------,~~cc__---ct-~~'--.-c----c-1 row, highlight both these cdls and 

r;;"=. cc::~,,-,™~"~",-+=:~0~~~"~"=",+'~'~~'~"0~"'c.i, ~"~•~c: then click the right mouse button on 
~ ~~--'--i~,,~ -+-~ ,-t--~,,ct-----c-1

19 
one of the highlighted cells to get the 

r~~
0
~,
0

~~ ~'"~' ---1~----t- =t--~-+----'"--1
18 

drop-down menu. Select Merge 

r"'=''~•~oc~"""~'----t~ ----t- cc+--,-~1~ ~:~d ~oet::tn~:t ::t: =~ :: 
r"'="~·=-=''"°=''----j~----t- --+--+----"'j3 you have just merged. The completed 
r'='"~~='=""="''------'~-,---+--'-+-------"-' table should look like this. Save the 
'-''"~·=0 '~--+'- -+-~+--_._, _ _,_, file. 

C,,r11mlcpalntln1 O 

Act;,;ty lOj ~ Open the file that you saved in Activity 10i. 
DeletethetoprC1Wandsecondcolumnof 
the table. 
Insert a ne.v raw above the raw containing 
the word 'Format'. Insert the te:ct 'Columns' in Horizontal 

~~\~~~f!~~~~:~~.I~ VRrtkal 

In column 1, merge the cells containing 
'Insert', Delete' and'Format'withtheblank 
cellsbelC1Wthem.lncolumn2,mergethe 
cells containing 'Cells' and 'Gridlines' with 

iJiil Jljt<goCtlls 

ll 1!.1111loflandShading ... 

l[{l TqtDimtion.... 

the blank cells belCIW them. In column 3, merge the cell 
containing 'Alignment' with the blank cell below it. 
Save the file with a new name. 

Tables can be formatted so that they can be aligned left, right or centrally between the 
margins . Text can be wrapped around the table or not as required. These feamres are 
found in the table properties: click the right mouse button in the cell of the table, then 
select Table Properties ... and the Table tab within the Table Properties window. 
The table alig:mnent can be selected in the Alignment section and text wrapping 
around the table can be switcl1ed on or off in the Text wrapping section. 

Cells can be formatted 
so that the contents can be aligned both 
horizontally and vertically within the cell. 
H orizontal alignment can be set and 
cl1anged by highlighting the relevant cells, 
selecting the Home tab and the Paragraph 
section and using the aligmnent icons within 
that section. See Section 10.18 for more 
details. 

l'.Jiiu= • I 
'""""'"'- lii:::::.ill-•n.[-·::::El 

~[!J~r----oo 
00]~ =, 

= = 
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T ask IOn 
OpenthefilethatyousavedinTasklOm. 
Right align all of the cells containing numbers in the second column . Centre align all of the 
cellsinthetoptworows. 
Set the background colour of all cells in the top two rows to yellow. Ensure that there is no 
text wrapped within the cells of the table. Vertically align all data to the top of each cell. 
Remove the gridlines from any unused cells. 
Savethefilewithanewname. 

To right align the numbers in x pOll u lotion Yopulotio n 

the second column, highlight --b- First Second fi rst choice Choice 

these cells, then select the Align f-';"~.~~::1eg;ry~m;;:,.,;:.,.:jj~;J:'=~""'""ir9 
Text Right ~ icon in the l{ointbo lti ni 3!1 
Paragraph section under the f-'.,:"""",,""""-«'---, - 1*= /----i-f-- -3- ':-1 
Home tab. Repeat this method f-''"""-"'"""'""""""""'-~ = /---''~' f-- ---'t- ~ 
to centre align the cells in the top f-'°'~"~~~-~,,~''';":::ooto~ ;!==t' ~=it=~ 
two rows: highlight these cells f-: 
and click on the Center icon 

in the Paragraph section. While 
these cells in the top two rows are 

;!~~~1
::,~!e::h~:=:-d:~ :

1li:~!a;;::;~ra1
~i11g ~ -~~---~ 

tool. Select the yellow colour from the palette, which Theme CokiB 

will set the background colour for these cells. 
To ensure that there is no text wrapped within the 

cells of the table, the column widths o f the table need 
adjusting to fit the text within them. Make sure no 
cell within the table is selected before placing the 
cursor over the gridline between the cells. This cursor 
will change to appear like this. Without moving the 
mouse, double click the left mouse button. Repeat 
this for each column that needs resizing. Make sure 
that the completed table does not fit outside the 
margins o f the page. TI1is will be 
penalised in the practical examinations. 

NoColor 

i!) ,MoreColon ... 
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To vertically align all data to the top of 
each cell, highlight all the cells that require 
this. Right mouse click in the table, select 
Table Properties .. . , and select the Cell tab. 

r-li'l'c5T'7"f~- -----,-Select the option for Top and click on --;.. 
To remove the gridlines from the unused 

cell in the top left comer, right mouse click 
in that cell of the table and choose Borders 
and Shading ... from the drop-down menu 
to open the Borders and Shading window. 
Select the Borders tab. 

Click the left mouse button on eacl1 of 
the lines that you wish to remove and in the 
Apply to: section select the option for Cell 

~= 
-";,-- =--·""'----'-"I 

I 

~ _J ._ __________ __. 11~----~=.r= 

from the drop-down list, before clicking on ~ - Remember to remove the yellow 
background from this cell, using the method shown earlier in this section. 

Sometimes, when text wrapping is present, a table row and its contents will be split 
between two different pages (or columns). To make sure that this does not happen, 
highlight the entire table, right mouse click and select Table Properties .. . , then the 
Row tab. Remove the tick from the Allow rows to break across pages tick OOx and 
click on ~ . 

Activity IOk 
Open the file that you saved in Activity 10j. Right align all the cells in the first column. Left align 
allothercellsinthetable. Setthebackgroundcolourofallcellsinthefirstcolumntolightgrey. 
Ensurethatthereisnotextwrappedwithinthecellsofthetable. Verticallyalignalldatatothe 
middle of each cell . Remove the gridlines from any unused cells. Save the file with a new name. 

10.18 Text a lignment 
Text can be aligned in four basic ways. It can be aligned : 
• to the left margin with a ragged right margin whicl1 is called left aligned 
• to the centre of the page, which is called centre aligned 
• to the right margin, which is called right aligned 
• to 00th margins which is called fully justified. 
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As you saw in Section 10. 17 the text is aligned by selecting the text and then 
using the using the alignment icons. These icons are found in in the Paragraph 
section under the Home tab. 

lie ••• 

---------- / ' --Left Centre Right Fully 
aligned aligned aligned justified 

Activity IOI 
Open the file TEXT6.RTF and place your name in the centre of the header. Make only the title a 
36pointsansseriffontthatiscentrealignedandfitsinasingle,fullwidthcolumn. Movethe 
third paragraph so that it becomes the last paragraph. Fully justify the body text. Centre align 
the second paragraph. Leftalignthethirdparagraph. Right align the fourth paragraph. Make 
the first word 'grf'!W' in the story 16 points high, the second 'grw/ 20 points and the third 'grwl 
24points. Savethefilewithanf'!Wname. 

10.19 Line spacing f.11pftuls N 
Different line spacing can be used to present 
different page layouts. The most commonly used 
layouts arc single line spacing, 1.5 line spacing and 
double !me spacmg To change the !me spacmg ma I 
paragraph, select the Home tab, and look m the 
Paragraph section to find the Lme spacing icon 
Select tlus icon to open this drop-down menu 

~~;~~~~:~~~:,a:~:;h{l:t;;:::~:~ :::n;::r~,::~raph 
Options ... to open the Paragraph window, which 
gives you more options. 

To change the line spacing, select 
tl1e Line spacing: drop-down menu. 
This will allow you to define an exact 
number of lines, which is very useful 
for title pages, where lines may be 
spaced out, perhaps needing to be five 
or six lines apart. 

Ensuring that line spacing on a page 
is consistent is just as important as 
setting the line spacing. It is ofi:cn wise 
to select all text and adjust tl1c line 
spacing togetl1cr. If you move, copy, 
insert or delete text from your 
document, always check tl1at the line 
spacing is correct afi:er you have made 
any change. Each paragraph and 
heading can have the spacing before and 
afi:cr it set using the same Paragraph 
window. This is set in the Spacing 
section, where tl1e space before and 
afi:cr any paragraph (a title is counted as 
a paragraph) can be edited. 

,= Add SpM, NtN Paragraph 



Activity I Om 
Openthefilethatyousaved in Activity 101. 
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Make the first paragraphsinglelinespacing,thesecond paragraph 1.5 linespacingandthe 
third paragraph double line spacing. Do not change the line spacing in the rest of the 
document. 
Settheheadingspacingto 12spacesbeforeand24spacesafterthe paragraph. 
Save the file with a new name. 

Paragraphs can be fonnatted with different settings for the first line of a 
paragraph and the other lines in a paragraph. These settings are all changed on the 
ruler, which looks like this. 

\ 

On the left side of the mlcr are two settings for the left margin. The top triangle 
adjusts the first line of the paragraph, the lxmom triangle aligns the rest of the 
paragraph, and the rectangle below moves the whole paragraph. 

T ask I Oo 
Open the file TEXT7.RTF and place your name on the left in the header. 
Setthefirstlineofthefirstparagraphasindentedtext, indented by2.5centimetres. Indent 
the whole of the second paragraph by 2.5 centimetres. Set the fourth and fifth paragraphs 
as hanging paragraphs with a 2.5 centimetre tab. In the fifth paragraph make the text 
'Good Use' a sub-heading. 
Save the file with a new filename. 

Open the file and place your name in the header. Click the left mouse button in the 
first paragraph. Drag the top triangle to the right by 2.5 centimetres, like this. 

!~ 
To indent the whole of the second paragraph, click in that paragraph and then 

drag the small rectangle across to the right by 2.5 centi~ this. 

I r;i , 

Highlight 00th the fourth and fifth paragraphs and drag the OOttom triangle to 
the right by 2.5 centimetres, like this., 

l'l':"r;i:r."", ,11"'"""'!'"'"'"'!"'""'! 

To make the text 'Good Use' a sub-heading, remove the full stop and space at the 
end of it and replace it with the <Tab> key. 
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Activity IOn 
Open the file that you saved in Activity 10g. Add thetext'History item 1' as a new line to the start 
ofthedocument. Formatthistextinthesamestyleastherestofthepage. Changethetitle 
Weatherupdate'to'February2009'. Setallofthetextonthefirstpagetobespaced51ines 
apart and all other text in the document to be single line spacing with no spacing before each 
paragraphand24pointspacingaftereachparagraph. lndentfirstlineofeachparagraphonthe 
second page by 5 millimetres. Save the file with a new name. 

10.20 Correcting errors 

You will need to spell check all word-processed documents before 
submitting them for assessment. Select the Review tab and in the 
Proofing section click on the Spelling and Grammar icon. The spelling 
and grammar check starts automatically. Any words or phrases found in a 
document that are not in the dictionary will be flagged as an error. Do 
not worry about the differences in 
spelling that can occur with 
dictionaries from different regions, 
forexample'centre'and'center'; 

::::i:~~~~~s'.1~~~ e!'a~:~f;~:t~I; ~~: _Jµ,,,,..,....,.,"""""'"""'"'""";L_j 
been flagged as an error, but was 
put into the text intentionally. Be 
careful not to change the spelling of 
names, especially for, companies, 
people or places. Each time an error 
is flagged, read it carefully and ~ 
decide whether to change or ignore 
the spelling, using the buttons in the window. 

It is important that you also read through all of the work and make sure that the 
text or data that you have typed is 100 per cent correct. A large number of marks 
can be lost in practical examinations through careless checking of your data entry. 
Check that your documents have consistency in all areas, not only fonts and styles, 
but also in line spacing and paragraph spacing. It is very easy to follow the 
instructions on a question paper, for example to remove a page break., only to find 
that you have an extra carriage return later, which will lose the consistency marks 
awarded for the doa1ment. If you have inserted section breaks or page breaks, make 
sure that there are no blank pages. 

Part of the proofreading and error correction will be to check for widows and 
orphans. Even though you may have applied automatic widow and orphan control, 
it is always good practice to check that these have been removed . It is i:ossible that 
you did not apply it to every paragraph. Make sure that other objects, like bulleted 
or numbered lists, tables, graphs and database or spreadsheet extracts are not split 
over two pages. Again, inserting appropriate breaks should avoid these problems. 



Data manipulation 

In this chapter you w ill learn how to: 
• understand database structures 
• create a database from an existing data file 
• define database structures 
• enter different forms of data into a database 
• search for subsets of data 
• produce a report 
• export data and reports for use within another package 
• use formulae within a database 
• sort data within a database. 

For this chapter you will need these source files from the CD: 
• CARS.CSV 
• STATIONERY.CSV 

11.1 Understa nding data base structures 

Traditional flat-file databases store data using a system of files, records and fields: 
• A field is a single item of data like a forename or date of birth. Each field has a 

fieldname, which is used to identify it within the database. Each field contains 
one type of data, for example numbers, text, or a date. 

• A record is a collection of fields, for example all the infonnation about one 
person or one item. TI1esc may contain different data types. 

• A file (in database tcnns) is an organised collection of records, usually where all 
the records arc organised so that they can be stored together. 

You will be using Microsoft Access, which is part of the Microsoft Office suite. Access 
stores its data in the fonn of tables, which arc organised by rows and columns. Two 
or more of these tables can be joined together bccauscAccess is a relational database, 
rather than a flat file database, but this is lx.'Yond the scope of the practical section of 
this book. Each row in a table contains a record. Each column in the table represents 
a field and each cell in that column has the same, pre-defined field type. 

Field types 

When you create a new database you will set each field a field type. The field type 
will tcllAccess how to store and manipulate the data for each field. You will usually 
decide what field type should be used for each field. TI1erc arc a number of field 
types that you can use and different packages may have different names for these. 
The list below shows the generic names for these field types (these will probably be 
used in the examination questions), but depending upon the package used, you may 
have different names. For example, inAccess an alphanumeric field is called a text 
field. The three main types of field arc alphanumeric, numeric and Boolean: 
• Alphanumeric data can store alpha characters (text) or numeric data (numbers) 

that will not be used for calculations. I.nAccess this is called a text field. 
• A numeric field type (as the name suggests) is used to store numeric values that 

may be used for calculations. This docs not include numeric data like telephone 

Ill 
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numbers which should be stored in an alphanumeric field type. InAccro- this is 
called a number field . There are different types of numeric field including : 
• integer fields, which store whole numbers . InAccess you can select an integer 

field or a long integer field. It is wise to use a long integer field if it is going to 
contain three or more digits 

e decimal formats, which will allow a large number of decimal places, or a 
specified restricted number, if this is set in the creation of the field p roperties 
when the database is set up 

• currency values, which allow currency formatting to be added to the display. 
These include currency symbols and regional sym bols. The database does not 
store these as this would use up valuable storage space 

• date and time formats, which store a date and/or time as a number. 

• A Boolean (or logical) field type is used to store data in a Yes/No (or True/ False, 
0/ 1) format . 

There are other field types as we!~ like a mem o type but these are not available in all 
pack.ages, so will not be in the practical examinations. As stated above, you will be using 
Access.Microseft Excel is not suitable for database tasks as you can not define field types. 

Task I la 
You work for a small garage called 'Dodgy Dave's Motors'. This garage sells used cars. Using 
a suitable database package, import the file CARS.CSV. Assign the following data types to 
the fields. 
Who manufactured the car? Text 
Model Text 
Colour Text 
Price that we bought the car for NumeridCurrency/2 decimal places 
Price that we will sell the car for NumeridCurrency/2 decimal places 
Year Numeric/Integer 
Extras Text 
Does the car need deaning? Boolean/Logical 
Some fieldnames are inappropriate. Create appropriate and meaningful fieldnames for 
those fields. You may add another field as a primary key field if your software requires this. 
Save your database. 

It is important to make sure that you use the fieldnames exactly as given in the 
guestion paper, unless you are asked to provide appropriate and meaningful 
fieldnames. In this task you are asked for appropriate and meaningful fieldnames, so 
start by looking at the detailed descriptions given instead of the fieldnames, or even 
examine the data to work out what info rmation the fields contains. 

For this task, the descriptions help you to work out meaningful fieldnames. TI1ese 
should always be short enough to allow printouts to fit easily onto as few pages as 
possible. The first example is \Vlm m.1nufo~wred the cad; this could be shortened 
to Ma11ufactt1rer o r even Make. Make is short, meaningfu l and appropriate, so use 
that. The Price that we bought chc car for could be changed to Purchase Price, 
Pun:hase, P Price, P _Price o r just PPrlce. Although A cero- will allow any of these, 
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do not use fieldnames with spaces in, as they may cause problems if you try to do 
more complex operations with the database. You could use any of the other three 
options, as all would be acceptable. For this task, use PPti(e. Similarly, the next 
field can be called SPrice. For the final field, Doe~ the car need ck:ming), simply 
using the fieldname Clean could give the wrong idea, as it could mean 'Does the car 
need deaning?' or 'ls the car dean?'. In this case you can use Valet as the fieldname 
to avoid confusion. It is sensible to plan this and make the changes in the.csv file, 
before importing the data intoAccess. 

Open the.csv file in Excel. Move into the relevant cells and type in the new 
fieldnames. Check the spelling carefully before re-saving the data file. Save it with 
the filename carsl.csv so you do not lose the original data file. Task lla is continued 
in the next section. 

. _ .. ___ , ___ .. __ 
::.:::::-.:---.:..--"':'" .. "':.".:.':~-.:""...:: ... ---·-
....... -~ .. -·---_.,_. __ .. _, .. _ .. _______ .,.,_ 

separated ,from the next by 
a comma. This icon opens the Get 
External Data window like this. 

Use the :.M!!!!!!:=..l button to find 
the file CARS1.CSV and ensure 
that the top radio button is 
selected. This will ensure that the 
data is saved in a new data table. 

L---------===::..J Click on ~-
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Hint 
A large number of 
students perform 
poorly on these 
questions in 
examinations 
because they select 
the bottom option 
to link the database 
todataheldina 
spreadsheet. 

The Import Text [,!•:;;-;;_;,.~~=~==~====:.• !!I 
;~~~r1t!!:: will 1---··--··--.. ----
(the comma is the -~,- _ , ,,,. 

separated value (.csv:r•- --·-.... --­
files are delimited files 1:------·----.... ...-
delimiter ), select the ' ......... = .. , ........ >< ....... ~ .... ,. ... :'"''" , ._,., . .,....... l:J ~.~;;:r;·,'.E::· , -··· .. ·····-: -··:-· .. ·,·-· .. ·:~·:;;:.~; ... _ .. . 
~~:r~:~1~~~~ :st~1re, ~:,.,::;;:~;;::;;;;:;:·;;;;;:; _);?··:~:~· ...... ................ . 
selected using the radio .LI 

buttons (unless you ~ ~ eew ~ 
have changed the.csv ~~~~~;;:=:=::=:;:::::;::;::;;;;;; 
file so that it uses semi· ~ 

colons as delimiters) . ----.... :t-----.... -·-· .. --
Examine the first row .,.... .. _ __ ""' 
o f the data and decide ,..,. - • r;- c'- _. 

::;~~:~:: ~;~names f'-.---
that you need or if it nJ..c--,;,,---,..c----,.""''""~""··=· .. -..·"'·""'' ---" ;-l--, 
conmins the first row ·~· ~~- , .. , :~~: ••• , ... : · :::· :: ~::=..::~· ......... : :J 

o fdam.lfthe firstrow .:' .'"" ~. ;.":: ::;: ::': :.:= ::::~" ,.:;:::,.~::_; :~:~i::~ rt: :~:~~n;..:, ,;;-· ~. "' ~::· ~ :::: ~ .:.~:;;:= ~ .. , .. '"""" 

~:::!1::J\:!)~. As ~ . §: ;t::: §. ~\[. ffi ':E::: .,, ...... ,. 
you tick this box the 
first row changes from 
this, tot&is. 

-

rr r rnr~-J •. 

- ~ - .···- - . ··'- ·- ·-• .etol1 c c blook 665 <SS OOO lo~ lihcdo 

oyoc• ellC!I «l u'" ,.,. oo, c CO<l<llt.lcU~o Alloy """"" 
od1 hct 5'95 1s,s 001 e.,t,.,,l Lochro Lutlle r 5eot o 

rcodo, lln i lYor U SO lOOS 007 ·r c ond>.<icucg 

,., oopcc «<a 2SOO , 2s. OOO c otc~ l Loche~ koc ~ cc & oto 

ov.,,hoH tn !tt r ·, loot OS> 3'0 00, ·cCcod.lt.lod.c• 

or<l oeott rthne ,..,, ! a> 003 ll<>!IWl>tt..L O 
ul>oro. oq• ""I i hor OO S ,., 00 3 rCcod.lhc , .,c ; lilo~""-lo 

Hnlt lio rkhl u 095 OO S oo, rCood>.hc , .fr.; 

:: ::'C: ,:;• ~:o ~~:• ::: •~ten 1.ocmo lie coo1>.trn111 ~ 
~ ~ 



Hint 
The icon in the 
Views tabwilllet 
you change 
between Datasheet 
and Design View. 
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Click on .Ad;-.--4, to open the Import - ~ IF-~-,--:,-:---::------il 

Sp~:~t~~~: 7i~1
:~~~ldnames and data types ._,,_ ·==1 ::: -~ ~ 

match those specified in the task. In this case the ':_-.-.--~-~ •i ~ 
PPrice, SPrke and Valet fields are not correct. - .,_. 

TI1e PP.ice and SPrke fields need changing to == CJ D ~===­
numeric (currency) fields and the V,llet field 
needs changing to a Boolean (Yes/No) field. 

To change the l'PrY:e field into a numeric 
field with a currency sub-type, click on the Data 
Type cell for this field and use the drop-down 
list to select the Currency field type. Repeat 
this process for the SPrlcc field. 

For the Vnlet field, use the drop-down list to 
change the Text field type into a Yes/ No field type. 
\Vhen all of these cl1anges have been made, click on 
~. Select ---;;;:- twice. In the next screen, ensure I -"="'-"!"'!!"- 1=-:....!u..J 
that the radio button for Let Access add primary 
key is selected - this adds a new field called ID to 

the table and A=ss will use this as the primary key 
field. Click on ~ and in the Import to Table: 
box, enter tb]Cars. TI1is is a meaningful table name, 
as 'tbl' shows you that it 
is a table and the 'Cars' 
gives relevance to the 
data. Click on ~ to 

import the data and on 
~ to close the 
wizard. Double click on 
tb!Cars to display the 
table like this. ----+ii 

Changes to the field types or other properties, can be 
changed from the Home tab. In the Views section, 
click on the Design View icon. 

The task instructed you to set the 
PPric.e field to 2 decimal places. You 
can cl1eck this by clicking the left 
mouse button in the Price field and 
viewin the number of D cimal 
Places inthe General tabatthe 
bottom of the window. 
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Hint 
If you need 
percentage values, 
set an integer or 
long integer field 
type and select 
Percentage from 
the Format drop­
downmenuforthis 
field . 

or~~ ~ :;~~sr1:~ ~:~a~~~~~~ ~~~a~~~idIX 1;":.ma fi:.:r;;:~t:::;::::;:::::;:;:::::;:;:::::;3~~ 

tir~1~:~~1t:;~::1 
::p~;~:::;~;:~7;:~~e 'lri,-~,,,~ ... =~~'- -;~~;;;~ 

Yes/No option. Save the database for later use. I l'~::'v, ... , 
iy""""_i..,RU• 

r.:.~:. 
Activity I l a 
You work for a shop selling office supplies called 'Easy as ABC'. Using a suitable database 
package, import the file STATIONERY.CSV. Assign the following data types to the fields . 

Code 
Typeofproducttobesold 
Description of the product to be sold 
Quantityofitemsineach pack 
Colour 
Sales Price 
Purchase Price 
Discount 

Numeric/Integer 

'"' ''" Numeric/Integer 

''" NumeridCurrency/2 decimal places 
NumeridCurrency/2 decimal places 
Boolean/Logical 

Some fieldnames are inappropriate. Create appropriate and meaningful fieldnames for 
those fields . Use the Code field as your primary key field . Save your database. 

11.3 Ente rin g data 

Task I l b 
Open the file that you saved at the end of Task 1 la . 
Addthisnewcartothedatabase. 

Make Model Colour PPrice SPrice Year Extras Valet 

Ford Escort Silver 4350 5285 2002 Alarm Central Locking Y 
Alloy Wheels 

D ata would normally be entered into a da tabase using a fonn, ~.::-~. !.111!11111•• 
but in tl1e practical examinations it is probably better to use the 
table to enter new data. 

Open the database saved in T ask l l a. D ouble click the left I• 

m ouse button o n the table nam e to open the table in 

Da~ ; '~e:~e~ :~:: tl1::;,,:;, l;--:l tl,,:,c:-;,:;:ol~urm=~:m:r."fu:ii:lly:-;v;;;sihib;;;l,,-;, ;;;lick:;;-;:;:tl,:;:, - ~ '.;.,,,,.,....;;;.,II 
left mouse button on the sm all white triangle to highlight tl1e 
entire datashect. Move tl1e cu rsor between two 
fiddnames until it looks like this and tl1cn double 

..-:=- ~ -------click. 1l1is will adjust tl1e display widths oftl1e 
• columns. Scroll down the list of cars until you reach 
'" the entry w ith a star next to it which will allow you to =~-""-

add a New car at the bottom. 

• '~;;::::::;;::=;:::::;;:::;a;;;;::::;;_ ,m;;::;;:• _= __ ,_::::;;:;::,-==,. :::;;;:;: = 



Data manipulation 

Click the cursor in the Make cell for the new car and add 'Ford'. The new ID 
number will automatically appear in the I O field, as you set this field as an 
AutoNumber type. Move the cursor and enter the Model, Colour, Yc=ar and Extras 
in the same way. You can always use copy and paste for some data. For example, if 
you need to make sure the spelling of Escort is correct, copy and paste it from 
record 67 above. For the PPrice and SPricc fields, enter only the numbers (and 
decimal point if this is required). Do not attempt to enter any other characters like 
the currency symbol. As you press the <Enter> key after adding the pricesAccess 
will set the data into currency format. The Valet field will automatically default to 
No. Move into this field and enter Yes in this cell. k you enter each item of data 
Access will automatically save it. 

Check your data entry carefully using visual verification. This is when you 
compare the original data on paper (in this case, in Task llb) with the data that you 
have entered into the computer. Any data entry error in a database may cause you 
errors when you try to use the database to search or sort. Save the database. 

Task I le 
OpenthefilethatyousavedattheendofTask 11b. 
Add a new field to the database called PDate. Add the purchase date of 30 September 2009 
for the next record . 

Open the database and open the table 
tblCars in Design View. Move to the empty 
row below the V~let field and enter the 

Datasheet View. Move the cursor into the 

-

PDate field for the new record (the Silver Ford Escort) and use the Calendar icon 
to select the correct date. 

-··"""'"""'"'"""""'""'"t ,.,.,,i..,,,c-,,.i ..... ,.,.,.,.,,._, 

Ill 
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Activity I l b 
~e file saved in Activity 1 la . Add these three items of stationery to the database. 

Code Type Description Quantity Colour SPrice PPrice Discount 

44282 Lever Arch File Laminated Lever 1 Red 57.22 28.96 N 
Arch Files 

44283 Lever Arch File Laminated Lever 1 
Arch Files 

47478 SpineLabel Eastlight Spine 100 
Lables 

11 .4 Pe rfo rming sea rches 

Yellow 57.22 28.96 N 

30 13.86 Y 

In Access you can search for data using a Query. TI1is will allow you to select a 
subset of the data stored in your table. Each query is created and saved and can be 
used again later. Even if new data is added to the table, when you open a query 
again it will select the subset from all the data, including the new data. 

Task I Id 
Open the file that you saved at the end of Task 11c. 
A customer would like a car made by Fore!. Find the customer a list of all the cars in the 
garage made by Ford. 

~:1:~~~\~a~~::~:~~:~~u~:;~~:t!:t:~de~;i!:~~;l~;~ l~u do ~ ~ _], 

Create tab and find the Other section on the right. Click on the ~~ = t.u."0 

Query Wizard icon.-----------~ 
This is the easiest way of performing a search and opens the _ 

New Query window. Select the Simple Q uery W izard and click on ~. 

mJ: ~:;esl ~f ~1e~ ~~~,1:~~~~ \~~~~::_w''._---l:~"5:::::::1--C:==:::::i 
selected in the Tables/Queries OOx. As this is 
your first query this is the only option in this 
box, but each time you create a new query it 
will be shown here. If you select a previous 
query rather than the table, you are likely to 
get incorrect results. 

For Task l ld, it would be appropriate to 
show the customer all the fields except the lD 

field, the price that the garage bought the car ~~~~~~£~~~~ 
for (the PPrke field ) and the date the garage 
purchased the car (the PDate field ). Move all 
of the fields into the query using the double 
arrow key. 

Select the lD field, the PPrke field and the 
PD;1te field in tum and click on the single ~ ...1,---
arrow to remove them from the selection. 
When you have got only the required fields, 
click ~ . Select ~ again. 



Data manipulation 

Enter a name for the query. TI1is query 
may be turned into a report at some point 
and the name you give the query may become 
the title for the report. You may therefore 
wish to add your name to the query name. 

Select the radio button for Modif)' the 
query design before clicking on ~. 

This opens the query in Design View. 
Datasheet View can be seen by selecting the 
drop-down list under the View icon. 
H owever, at the moment the query will still 

-· .. -·-·--. ___ .. _____ _ 

contain all of the records as we have not yet performed the search. 
To perfo rm the query, move the cursor into the Criteria: row of the Mak£ field 

and type Ford . You do not need to use speech marks, as A ccess will put these in for 
you. This will extract o nly the cars made by Fo rci. 

Now select the Datasheet View to see the results o f the query. The number of 
records can be seen at the bottom of the window in this view. TI1ere should be 25 
Ford cars in the query. Save the query. 

Task I l e 
OpenthefilethatyousavedattheendofTask 11d. 
The manager would like to see all the details of all the Fords that need valeting. 

~I 
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Hint 
This is called an 
AND Query, 
because the Make 
hastobeFordAND 
the Valet. field has 
to be Yes. 

Create the query in a similar way to the one forTasklld. Select all the fields and 
when you Modify the query design, enter Ford in the Criteria: row of the Make 
column and Yes in the same Criteria : row for the Valet column. 1l1e selection will lm~i:t~ wl~ :;:~m:th,~slcanch -- -·· -~ -·· -~ '"'· -· """' -

cn~ .J f: II !fl IP.: 11 II. ,., II • 

• il • 

Task I If 
Open the file that you saved at the end of Task l le. 
The manager would like to see all the details of all the cars made by Ford orVauxhall . 

Create the query in a similar way to the one for Taskl l e. In the Simple Query 
Wizard window, make sure that the table name has been selected in the 
Tables/Queries box. If you select one of the previous queries rather than the table, 
you are likely to get incorrect results. 

Select all the fields and when you Modify 
thequerydesign,enter FordorVauxhall in~-(11)1 -~ -

:~:=ec~;~;;~; ~ ~rk~1~s1~ ~/~~:\~~ J; '"'"" . c::~~-r ---
found using this search. "" 

Task I I i' 
Open the file that you saved at the end of Task 1 lf. 
The Sales Manager would like to see all the details of all the cars in stock not made by Ford. 

Create the query in a similar way to the one for 
Taskllf. Select all the fields and when you 
Modify the query design, enter Not Ford in 
the Criteria : row of the Make column. The 
selection will look like this and 43 cars will be 
found using this search. 

Task I lh 
Open the file that you saved at the end of Task 1 lg. 

. T i~-.:::. -·· . -· . 
c ... , . • ..... f«, 

The manager would like to see all the details of all the cars that have alloy wheels. 

By examining the data in the database you can see that the text 'Alloy \¥heels' could 
appear in the Extras field. It may not be the only extra that a car has, there could be 
other extras listed before it or after it within the field. 

To find all the cars with this extra you must create the query in a similar way as 
forTaskllg. Select all the fields and when you Modify the query design, enter 
.. Alloy Wheels·• in the Criteria : row of the Extr,u column. The stars tellAccess that 



Hint 
To search for 
something that isat 
the start of the 
data, use Text*, for 
example Bl* inthe 
Colour field will 
find all the cars 
with the first 
Col0lJf B1ueor 
Black.but would 
not find colours like 
Light Blue. Placing 
thestaratthestart 
of a search string 
will only find those 
things ending with 
the search string. 

Data manipulation 

you are performing a wildcard search. The ~ ,.,.. 1,.Ml PD•~ f"'"'"<l 

selection will look like this and 35 cars will be ';': '"""" tlllU" _,., 

found using this search. .!:',: ....... ?J-.,,,~ , 

Task I Ii 
Open the file that you saved at the end of Task 1 lh. 
The Sales Manager would like to see details of all the cars in stock for sale for less than or 
equalto£4125. 

C reate the query in a similar way as for 
Taskl l g. Be careful not to use any symbols like 
< or £ in the query name. Select all the fields 
and when you Modify the query design, enter 
<=4125 in the Criteria: row of the SPrice column. The selection will look like this 
and 18 cars will be found using this search. 

Similar mathematical formulae can be used , with < for less than, > for greater 
than, > = for greater than o r equal to and = for equals. These mathematical 
formulae cannot be used for queries involving text field s, but can be used for any 
numeric, date o r time fields. 

Activity I l e 
Open the file saved inActivity11c. 

Search the database to find the following information for your manager. For each search 
showallthefieldsinthetable. 

1 Findallthebluestationeryitems. 
2 Findalltheblueorblackstationeryitems. 
3 Findalltheitemswherethecolourisnotblue. 
4 Findallthereditemswherethediscountisyes. 
5 Find all the items where the type contains the word 'file'. 
6 Find all the items where the description contains the word 'file'. 
7 Find all items with a quantity of less than or equal to 10. 
8 FindallitemswherethequantityislO. 
9 Findallitemswithaquantityofgreaterthanl . 

10 Find all items with a quantity of greater than or equal to 10. 
11 Findallitemswherethesalespriceislessthan£10. 

11.5 Producing reports 
TI1e wo rd ' report' can be quite confusing . A dictionary definition is 'a document that 
gives i.nfonnation about an investigation o r a piece of research' . For the practical 
examinations a report has this generic meaning: 'a doa1ment that gives informatio n'. 
This is often confused with a report created inAccess. TI1e report created inAccess 
will often be the most suitable report for a task, but sometimes it may be better to 

produce a report in a word processor, copying and pasting informatio n into a 
document. For each task, you will need to decide which method is the most suitable. 
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Hint 
You must create 
the query first and 
thenbase the 
report upon the 
query. 

T ask I l j 
Open the database that you saved at the end of Task 1 li. 
Produce a report which: 

• shows all the cars made by Ford 
• displaysonlythe and fieldswithinthewidthof 

a landscape page 
• has your name on the left in the header of each page 
• has a title 'All Ford cars in stock' centre aligned at the top of the first page 
• has a subtitle 'request for Mr David Watson' right aligned at the top of the first page. 

Open the database saved in Task l li. Select the Create tab and ;1 .-. 
find the Reports section. Click on the Report Wizard icon to-...._~ o ......_ ._ -
open the Report Wizard window. 1--...:..~ """""""''::;: 

In the Tables/Queries box you need to 

sdect the correct guery. For this task, the 
report will be based upon the guery to select 
only the Forcls (you creatti:l this guery in 
T asklld). Use the arrow buttons to move the 
corn."Ct fields from the Available Fields: into 
the Selected Fields: OOx like this, then click 
on ,., .. , . Grouping is not needed at !GCSE 
level, so click on ~ again. For this task, 
you are not asked to sort the report (which 

will be covered b ter in the chcn_"!' P"'.":J')~, ~~ d~ick'._.J-"4~;ii;iiiiiiiiiiiii~~~ 
on ~ again to get this. -

The task told you to select a single landscape '"""' .__ 
page. Thcpageorientationischosenusing~~ 
Orientation radio buttons. Sdect Landsdoe. Use ( I - .::---- • ::. · 0 
the Layout section to c CXJse ow t e page w1 
laid out; in this case a tabular format has been 
sdected. Click on ~ . 

Choose the style for your report and click on 
~ - Change the rei:ort name, so that it is 'All 
Fo rd cars in stock' (which is the title from the 
task). k you still need to add the subtitle and 
ensure that the layout is correct, select the Modify 
the report's design radio button and click on 
~ . TI1e design view of the report will look 

similar to this. 



Data manipulation 

Each section of the report is shown with a light blue bar. The top section is the 
Report Header . Anything that you place in this section appears only once at the 
start of the document. Anything that you place in the Page Header is shown at the 
top of each page, in this case the fieldnatnes. Similarly, information in the Page 
Footer is shown at the bottom of each page. The Report Foo ter appears at the very 
end of a report, although in this example the Report Footer is empty (it is not 
shown in white) and therefore will not be shown in this document. TI1e Detail 
section is the most important, as this single row is where the data is shown for each 
car. This single row will appear as many rows (as many as there are Ford cars in the 
database) and display the details of each record. 

The task tells you to place your name on the left in the header of each page. Move 
the cursor to the top of the light blue bar showing the Detail row; click.on this so 
that the cursor changes into an arrow. Hold the left mouse button down and drag 
the top of the detail row down about 5 millimetres. Select all of the controls 
(objects) in the Page Header by dragging (and holding) the left mouse button. 

::~ :~eo::::?,'~~~

7
•;
1

:r;ro~ls~i!!!!i'i· 'i"i"i'i"i"i' i"i'i";·;· ;· ·;·; .. ;·;· ·;· 5 millimetres, so that they 
look like this. 

The Design tab should 
already be selected. Find 

:t:~~:l:~:'~~::~:::~:..d _...:;; .. :c::,;;::;;;,,;,_'.'.'"'i~ 
Drag a new control -------~- ------.. 

into the Page Header and ~I!!!!!!!:·:··:··:·:·:·:··:·:·:· i type your name into this ·-
control. In this example,~ 
when rou move the cursor 
out of the control and 
click anywhere else on the rei:ort it does not show the text clearly. This label needs 
editing so that the text is visible and it is left aligned. Select the control and use the 
tools in the Font section of the Design tab to set the font t 
colour to white and the aligrunent to left. --- ~ ';"; M ,. J<.i 

To see what the report will look like at any time, fin~ • • I~ 
the Views section of the Design tab and select the _ _, __ 

Report View. Use this section to change back to the Design View at any time. 
The title 'All Ford cars in stock' needs to be centre aligned. Click on the control 

containing this label, and use the drag handle to stretch the control to 

28.2 centimetres (almost the edge of the page). If you stretch the control further to 

the right it will add !"i !!I!!!!!!!!!!! another page width to the ; 
final printout, wasting · 
paper when it is printed 
and no longer fitting to a single page wide. Once the control fits the page width, 
then centre align the label using the Center icon. ~ 

To add the subtitle, drag the light blue bar for the Page '""; ~ ,. 
Header down about 5 millimetres. Add a new label, the "'." 1 

foll width of the page, in the Report Header, just below ,._ 
the title. Type tl1e text 'request for Mr David Watson' into tl1is control. Set the font 
colour to white as before and right align this subtitle using the Align Text Right 
icon. The design view of tl1e report looks like this. 
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Activity I Id 
Open the database that you saved at the end of Activity 1 l c. Produce a report which: 

• displays all the data in the table within the width of a landscape page 
• hasyournameontherightintheheaderofeachpage 
• has a title 'All stationery in stock' centre aligned at the top of the fi rst page 
• has a subtitle 'request for the manager' right aligned at the top of the first page. 

Task Il k 
Open the database that you saved at the end of Task llj . 
Produce a report which: 

• displays all the data for all the cars with alloy wheels within the width of a portrait page 
• has your name in the report header followed by 'Cars with alloy wheels' . 

Open the database saved in Task llj. Select the Create tab and in the Reports 
section click on the Report \Vizard icon. In the Report Wizard window, select the 
query fo r alloy wheels (that you created in T askllh) in the Tables/Queries box. AI, 
the task says 'display all the data', use the arrow buttons to move all the fields from 
Available Fields : to the Selected Fields : OOx. Go through the wizard as you did for 
the previous task, making sure that you set the page Orientation to Portrait. vVhen 
the wizard has finished, the report is created and looks similar to this. 

G1<1 1<11116 uwl A lc;v\/', ltc~, 
You can see thatAccess 

has attempted to make all 
the fields fit across the 
page, but this has not 
been successful as not all 
of the data is fully visible. 



Data manipulation 

You can see that the control for the label in the Page Header has also been 
stretched. Use the View icon to change back to Report View to see the effect that 
this has tnade to the report. The left column now displays all of the figures 
(including the top row). 

G ahari,_,rownAl loyiNhees 

To make more space available for widening some fields, you will need to reduce 
the width of other fields. The J\fake field has taken more of the page width than it 
needs. Use the drag handle on the right of this field to shrink the field. Use the 
Report View to make sure that all of data is visible (you will need to scroll down 
through all the data), but space is 
not wasted. Repeat this for the 
Model and Colour fields. Stretch 

At the moment, ignore the Extras field, as this is the longest field. Stretch the Valet 
and PD;ttt fields so diat all the data and labels fit within die width of die page. Make 
sure all the data and labels are fully visible. The data and labels may be different widdis 

to those shown here, depl'ld!ing:o~n~~l!IIIIIIIII 
the formats chosen for each field. Now 
stretch the Extras field until the 
PDatc control just reaches the edge of 
the page but no further. 

Change to Report View and 
the report appears like this. You 
can see that all of the Extr.n, still 

do not fit within the space. fl 
In Design View, move into 

the Detail Row and drag the 
bottom handle of the control for 
the Extrns field down so that die 
control becomes exactly twice as high. 

Change to Report View and I 
:;tut~:: ~i:: ~~:as~:::1!a~~tt ~----t;;~ =::::':~ ".:::~::;:'::';:~--.;...'~ 
likediis. 

""'" ,unoo--""---"' 
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Hint 
The Discount field 
can appear as 
Yes/No, True/False 
or as a tick box. All 
of these would be 
correct for this 
question. 

Hint 
If you need to 
export the report 
without any 
formatting.select 
the Text File option. 

Activity I l e 
Open the database that you saved at the end of Activity 1 ld . 

Produce a report which: 

• displays all the data for all the items where the quantity is greater than or equal to 10 
withinthewidthofaportraitpage 

• hasyournameintheheaderofeach page 
• has a title 'Quantity >=10' centre aligned at the top of the first page. 

Exporting data 
Sometimes whole reports, queries or the data within them need exporting into 
other packages to be manipulated as part of a report for someone, or to create a 
graph or chart. 

Task 11 1 
Export the report saved in Task 1 lk into rich text format so it can be included in a word­
processed document. 

~----­~---.. -,, ___ _ ,, ____ _ 
In the Navigation pane, find the report that 
you saved in Task l lk and right click the 
mouse button on the report name to get the 
drop-down menu. 

Select the option to Export. TI1is will open ----r- -~""'"-- '-~ .. --§:_.. •~ ----~:-~~~~::~:, ~~;!;;~ ':;~d F~!~~1~: w. 

• :;-- j ::;:.- Click on the ~ button to select a 
: '"' : .... folder to save the document into. In the 
: ::-.._ : ::-...= practical examinations you will need to use 
" .,.._ : this file for another task, so select the tick box 

for Open the destination file after the 
export operation is complete, then click on 

~ · The exported file will appear. Close the Export - RTF File window. 

Task I I m 
Export all the details of all the cars with alloy wheels into a format that can be used to 
produce a graph. 

The best package within the Office suite for creating graphs is Excel. You have just 
exported the report on all the details of the can; with alloy wheels into.rtf format. 
However, if you try to export the report into Excel you will not be able to do so, as 
the report holds its title and formatting as well as the data. Instead, you need to 

export the query for 'alloy wheels' rather than the report. 



Hint 
If you need to 
export the data 
into.csvformat 
(comma separated 
values), Export it 
first intofxce/, then 
save it in.csvformat 
from Excel. 

Data manipulation 

~~~j~~;;iiiiiit Right mouse dick on the query name, 
then select Export, followed by Excel :-::=::.,t[: ::,_ from the drop-down menus to open the 

~ ~~~~~ ¥= ·.it~ ~ri:rt ilia~1x~e;o~:~~: 1:: ~::~~:~:~ 
• ---- : :, i :._-:_ the tick box for Export data with 

:r __ " _ _ formatting and layout, and the tick OOx 
for Open the destination file after the 

Activity llf 

• -·---- export operation is complete . Click on 
~ . Close the Export - Excel 
Spreadsheet window. 

Export the report saved in Activity 1 lg into: 

• richtextformat 
• a format that can be used to produce a graph 
• a comma separated value format. 

Hiding data in a report 

There are times when information in a report needs to be hidden in some way. In 
real applications a single report would be created for more than one task, and some 
data would be hidden. TI1is process is often done automatically using a created 
report and a programming language. Although that is beyond the scope of this 
COOk, the ability to hide fields within a report is useful. An example of this is when 
an invoice would be produced for a customer, and the same document is used as a 
delivery note, so that it shows the details of the items ordered but the costs are 
hidden. lnAcce.ss this can be done in one of two ways, the first is to make a control 
invisible; the second is to use a background colour that matches the text colour. 

Task I In 
OpenthereportcreatedinTask 11k. 
Hide all the labels and data for the Valet and PDate fields from the report. Hide the PPrice 
data(but not the title) by setting a black background. 

Before starting this task it is wise to back up the report that 
you created in Task l lk. In the Navigation pane, right 
mouse click on the report name and select Copy. Move the 
cursor onto the whitespace in the Navigation pane and 
right mouse click again. 
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Select Paste from the drop-down menu, renaming the report if required. Open the 
report in Design View. Right mouse click on any of the field controls and select 
Properties from the bottom of the drop-down menu to open the Property Sheet pane. 

:9 .._ .... ,_ .. _ ~- -·-­~·--.... -~·---.. ·--· 

Select the four controls for the Valet and 
PDate fields (two for the labels and two for the 
data). These can be selected together by holding 
down the <Shift> key and clicking the left 

~~:e s~~::~1b~nh:;~7i;:t~~e 1~;;1~r;~~ in turnc:_. -----

In the Property Sheet pane, select the 
Format tab. Many of the options in the 
Property Sheet have small drop-down menus, 
which you can use to select pre-defined options; the arrow for the drop-down menu 
appears when you click in the cell. Use the drop-down list in the Visible section to 

select No, which will hide these controls. 
To set a black background for the PPtice data, in the Detail row of the report 

select the control for PPrioc. Move the cursor into the Property Sheet pane, 
selecting the Format tab. Find the Back Colar section and use the g icon to select 
the colour palette. 



Hint 
If you wish to 
change the display 
formats of any 
field,thiscanalso 
be done in the 
Property Sheet 
pane using the 
Format tab. 
However it is better 
to set the 
formattingforthe 
fields in the Design 
View of the table, 
as changing the 
display properties 
will not change the 
waythatthedatais 
stored and this 
could lead to errors 
iffieldsareusedfor 
calculations. 

Data manipulation 

Select the black colour rather than the white background. You will notice that the 
colour code for this control has changed from # FFFFFF to #000000. You will 
learn more alxmt this in Section 15.7. Change from Design View into Report 
View to see the changes. Save the changes to the report design. Close the report. 

~-­:11 ,---- Gran.im tl"O W' I\IIOi Wheel~ 

"' -"-····-­:11 --·-·oo­"' ...._ .. _,_,._, ' ' :11 ---........ "' ..,._ .. _...., ____ " -,, ___ ,_ -,, .. ----- --·--., .. _, ___ --,, •. ... ,~---
Activity I lg 
Open the report created in Activity 11 e. 

Hide the label and data for the field in the report and hide only the data in the 
field by setting a black background. 

Producing labels 

You may be required to produce other fonns of output from your database, for 
example producing labels to advertise a product or address labels for mailing letters 

Task I l o 
Open the file that you saved at the end of Task 11n. 
Find all the cars with a sale price of less than £4000 and for these cars produce labels which: 

• have a page orientation of portrait 
• fit two side by side on the page 
• have a 16 point centre aligned heading 'Special Offer' at the top of each label 
• show only the fields and , sorted into make and 

model order 
• have your name at the bottom right of each label. 
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Design a new query to extract 
only the cars with a sale price 
of less than £4000, selecting 
only the l\fake, Model, 
Colour, SPrlo;, Year and 
Extras fields from the table as 
you step through the Simple 
Query Wizard. When you 
have selected these cars close 
the query and click the left 
mouse button on the query so 
that it is highlighted like this. 

Re~::~ ~:t~ ~: !~dt:t::~ ~~: Labels i,-::;-~:::::111• ••••==::::::i 
icon. This opens the Label Wizard. 
Select any label format that contains two 
labels across the page; in this case, use 
the C2244 labels as they arc slightly 
deeper than tl1e C2166 labels ( and it is 
therefore easier to fit all tl1c data and 
labels onto each label). Click on ~ · 

The next screen asks for the font size 
and colour of the text on the label. Leave 
thissettoa smallsize (itiseasierto 
enlarge tl1is later if neeckd., than to reduce 
it), like 8 points high. Click on ~ -

T ype tl1c text 'Special Offer' in tl1c 
grey area as the top row of the label. 
Press <Enter> to move down to the 
second row. Eacl1 field needs moving 
onto the label - use the right arrow to 
move each field into tl1e label, pressing 
<Enter> after each one to create a new 
row. You can type labels for each row if 
you wish to do so. When all of the fields 
have been moved across, add a final row 
witl1 your name, then click on~· 

Move the ltfake, then Model fields 
across into the right to sort the labels 
by make and model as specified in the 
task, tl1enclickon !.JE.!...J. 

Give tl1e labels an appropriate name 
and select tl1e radio button for Modify 
the label design. Click on ~-
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field has been given more space, so that 
all the data should be visible. This will 
need checking when the labels are 
produced, and edited again if necessary. 
Your name at the bottom of the label 
should also be right aligned. 

Check the labels' layout using the orpce button followed by Print and/ 
Print Preview. Save the labels. 

Activity I lh 
Open the database that you saved at the end of Activity 1 lg. 

Find all the items where the discount is Yes and the sale price more than £30. For these cars 
produce labels which: 

• have a page orientation of portrait and fit two side by side on the page 
• have a 20 point right aligned heading 'Discount Offers' at the top of each label 
• show only the fields , , , and , sorted into ascending order 
• have your name centre aligned at the bottom of each label. 

11 .6 Using formulae in queries 

You are sometimes asked to peiform calculations at run time. This could be done in 
one of two ways. The first method is by creating a calculated field , so that each 
record has a calculation performed on it and the results are stored in a query. TI1e 
other method is to calculate on all ( or a selection of) the records, for example to add 
(sum) the data from a number of records. 

Task I I p 
Open the file saved in Task 1 lo. 
Produce a new report from all the data which: 

• contains a new field called which is calculated at run time. This field will subtract 
thepurchasepricefromthesaleprice 

• has the field formatted to currency with 2 decimal places 
• contains a new field called to calculate the percentage profit for each car at run 

time. Thisfieldwilldividetheprofitbythesaleprice 
• has the Percent field formatted as a percentage value with no decimal places. 

To create a field that is calculated at nm time, you must first open a query. For this 
task, the query will not be used to search for data, but be used to perform the 
calculation. Select the Create tab, then click on the Query \Vizard icon and in the 
New Query window select the Simple Query Wizard. In the Tables/ Queries box 
select the table tblcars as the source of the data. Select all fields using the double 
arrow key. Click on ~ twice, name the query Profit calculation, select the radio 
button for Modify the query design, then click on t--, . 
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In the design view of the queiy, use the bottom scroll 
bar to scroll to the right and find the first blank field 
like this. 

Move the cursor into the Field row for the first 
blank field. Enter the name (Profit) that you wish to 
give this calculated field followed by a colon. The 
colon tellsAccess that the next section is a 
calculation. Within the calculation, you must place 
square brackets [] around each fieldname so that 

'="--:=--:--:----/ --"1] Ac~:/:!::st t1;:ud~:e!~~ns~~~:~c;~:1~~:~se 

price from the sale price. The finished calculation will 
appear like this. 

In the Views section select tl1e Datasheet View. 
Calculate the profit for three or four cars by hand or 
using a calculator, and compare with tl1e results in =======aa.,==..:;t:..11.._IOJ the queiy to check that you have entered tl1e formula 
correctly. 

Hint 
Use+foraddition, 
-for subtraction,* 
for multiply and/ 
for divide. 

TI1e formatting of tl1e calculated field will be performed in the 
report. The task requires you to create a second calculated field so it 
would be sensible to include tl1e new field now and complete tl1e 
formatting later. 

To create a new field Profit fSPrictJ,{PPrictJ Pmtnt [ProlitJJ!SPrictJ 

called Puceot,followthe ~ 
same procedure, this time ~ 
adding a formula to divide 
the profit by the sale price. 
Again, check the calculations with a calculator to ensure that you have not made an 
error entering the fonnula. Save and close the queiy. 

Create a new report using tl1e Report Wizard as shown in Section 11.5. In the 
Tables/Queries box select tl1e profit calculation query as the source of the data. 

Select all fields using the double arrow key. Click on ~ tl1rec times before 
selecting a page Orientation of Landscape. Click on ~ twice more naming the 
reJX>rt Profit calculation. Select the radio button for Modify the report's design, 
then click on ~ . 

Move to the Detail row of the reJX>rt and right mouse click on the control for 
tl1e Profit data. Select Properties from the drop-down menu to display tl1e 
Property Sheet pane. 

Select the Format tab 

C. ~ ..• ~. ~ ..• ~ .. ~ .• ~.~ .• ~.~•~•i•·~· ~--~~:;;:[;:,.:;, .. =:;;---1 for this control, and use ~ the drop-down menu for 

-

1r·"'-~-ili-~-~-a -.....,,,I the Format option to 

:'":'_-=J~iiiiii~;;f ::ra:U~~;i::'click on 
V "'-"' the View icon to go into 

"''"'..,.. ;'"-~~.,--· ~~: = :~/;~;~is 
.. __ --· field is correct and 

contains 2 decimal places. 
In this example it does. 
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Repeat this process for the Percent field, left mouse clicking on the control for 
Percent in the Detail row of the report. For this field select the Percent fonnatting 
style from the drop-down list. Again, go into Report View to check that the 
fonnatting for this field is correct and contains O decimal places. In this example, the 
data is displayed in with percentage fonnatting but has 2 decimal places. 

Click on the View icon to return to Design View. Right click the mouse button 

~~~~~~~;;;;:=;;:--~, on the Percent control in the ~, "' , ,. , " , .,. , . ==-•"' " Detail row. Find the Decimal 
i..,P laces option and select 0 

... 
'·- """ - .,..,,, ,. from the drop-down list. 
Z,';:,___h"<~ ::::,""' /, Gointo ReportView to 
:;: ~ '!;:-ll,;• ;;;.:_:~1 check that the fonnatting for 

-
1 

:_- -

1

~ thisfieldisnowcorrectand 

~~!~~L ~:~ - ~ ;~:1~1~t ~:~:1iel!a~i~J;;is ~ ..... ,..,.. 1 -, 

,_~_·•_ '·-~

1··_~"'- ,ldF~~.?- ~~ ~~~dlaa~:s~:gft~y~:i~~~~ata 

::;::;-- - :; Adjust these before saving the 

~~~--• ;:..._'!,';,., - ~:...., completed report. 

Activity I Ii 
Open the file saved in Activity 1 lh. Produce a new report from all the data which: 

• contains a new field called which is calculated at run time. This field will subtract 
thepurchasepricefromthesaleprice 

• contains a new field called P to calculate the percentage profit for each car at run 
time. Thisfieldwilldividetheprofitbythesaleprice 

• contains a new field called . This field will divide the profit by the quantity 
• has the and fields formatted to currency with 2 decimal places 
• has the field formatted as a percentage value with 1 decimal place. 

11.7 Using formulae in reports 

Other calculations may be needed on the data selected. TI1ese include calculating the 
sum (total), average, maximum or minimum values of selected data, or counting the 
number of items present in the selected data. All of these functions can be produced 
within a report inAccess. 

Task I lq 
Open the file saved in Task 1 l p. 
Produce a new report from all the data which: 

• displays at the bottom of the report the total profit if all the cars were sold 
• displays at the bottom of the report the maximum, minimum and average profit values 
• displays the number of cars in this report. 

You can use the report from Task llp to help you with this task. Close this report 
(ifit is open) and right mouse click on it once in the Navigation pane so that you 
get the drop-down menu . Select Copy, then Paste a new version into the pane with 
a name that relates to Task llq. Open this report in Design View. 
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Click the lefi: mouse button on the OOttom edge of the Report Footer and drag 
this down about 2 centimetres, so that this fcxJter is now visible. Select the Design tab 
and then click on the Text Box icon from Controls section. Move down into the 

@ u_= _- ::::..:;:~,Cc:_::"-"'- "-::::.:."'-": :;:..::~ :;:-;;?::::;.:....= -- _- _- - -~1 ! i:r;e ~:::: and 

• " E · lffl,'" itJ j ,:~ci ~6~t ~ :~ ,a l.l button and drag to 
._: __ ~- - ~ •"II·~" ' .i. ·~ :.- -=:."::':i ~::=;~1:':;1;:l, in 

· ~ ~:-=-~ • • • • directly below the 
PrnRt column. This 
positioning is 
important as this 
control will be used to 
calculate the total 
profit for the data in 
this report. 

If the Property 
Sheet pane is not 

showing, right click tl1e mouse button on the text box that you have just created, tl1en 
select Properties from tl1e drop-down menu. In the Property Sheet, select the 
All tab, find the Control Source row and type the fonnula = SUM([Profit]) into 
tl1is row. The Pro erty Sheet will change to this. 

The round brackets arc part of tl1e SUM function, tl1e square brackets tell Access 
that this is a field (in this case tl1e Profit field calculated at run time). Format this 
control as Currency and set it to 2 decimal places. -------~ 
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Move the cursor into the label for this text box and type in the Caption 'Total 
profit'. This can be entered in the label or in the Property Sheet pane using the 
Caption row like this. 

Change to the R eport View and make sure that the control is in the correct place 
and appears to give the right answer (it is not too large or too small). 

Rather than repeating this process four more times, it will be quicker to copy and 
paste these controls and edit each one to give the required results. Use the lasso tool 
to highlight both the Text Box and its Label. Click the right mouse button and 
select Copy, then click the right mouse button on the background in the Report 
Footer and use <Shift> and <Insert> to paste the copies of these controls. Using 
<Shift> and <Insert> pastes the new controls directly under the existing ones and 
you do not need to reorganise the controls. It also extends tl1e bottom of the Report 
Footer as needed. If you right mouse click and use Paste from tl1e drop-down 
menu, this pastes the controls in the top left-hand corner of the Report Footer and 
you then have to drag and position each set of controls. Repeat <Shift> and 
< Insert> until you have five sets of controls like this. 
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In the last four controls containing labels, 
change the Captions to 'Maximum profit', 

---ji,.;;;;.;;;;;;jiict+-f'l;;;;;.,joiiilt---t 'Minimum profit', 'Average profit' and 
'Number of cars'. Select the second Text Box 

----l:::=l:::l!:t:::4--':3:=r:"t---+ (for the maximum profit) and change the 

---lf.c=.F.,'7,=F'rt--9,,!"'M"'lll',E<,tt---+ ~:::~: : e7~~:1~;~~~e~ : :~:,\~~f!t· 

L 
so that it becomes = MIN ([Profit]) and for 

the average profit so that it becomes = AVG ([Profit]). In the final control to count the 
number of cars, change the formula so that it becomes = COUNT([Profit]) . 1l1e 
controls should look like this. 

Hint 
If you are using 
screenshotevidence 
of calculated 
controls, make sure 
that each control is 
wide enough to 
show all of the 
formulae in full.If 
you do not show all 
the formulae, 
markswillnotbe 
awarded. 

In the Property Sheet pane fo r the final Text Box, change the format back from 
Currency to a Standard number. Set this control to O decimal places. Check the 
layout and calculations in Report View. The completed calculations look like this. 
,_,,, ., ,,.. u .

70000 
.... / save the report. . 

Total profit t86,9io.oo 

u , ,7l u 

Aetivity llj 

If you need to show evidence of the 
formulae that you used for the practical 
examinations, use screcnshot evidence of 
the calculated controls. 

Open the file saved in Activity 1 li. Produce a new report from all the data which: 

• displays at the bottom of the report the maximum and minimum percentage profit for all 
the items in stock 

• displays at the bottom of the report the average profit per item 
• displays the number of items in stock 
• uses appropriate formatting for all data. 

11.8 Sorting data 
Although A ccess has the ability to sort your data in both tables and gucrics, it is 
easier to save the sorting until the data is produced in an A ccess report. 

Task I lr 
Open the database that you saved at the end of Task llq. Produce a report which: 

• displays all the data for the cars made by Ford or Vauxhall 
• fits within the width of a single page 
• is sorted into ascending order of make and model. then into descending order of sales 

price 
• has your name in the report header fol lowed by 'Ford orVauxhall'. 



You created the query in Task ll f. To 
produce this report, select the Create tab 
and click on the Report \Vizard icon. In the 
Tables/Queries box select the Fo rd or 
Vauxhall query. Select all fields using the 
double arrow key and then click on ~ 
twice to obtain this view. 

Use the drop-down lists to select the 
~hke field , then the Model field and finally 
the SPrke field. Fo r the SPrice field , click 
on ~ to the right of this field and it will 
toggle (change) to ~ . When these field 
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have been set as shown, click on ~ · Set the Orientation to Landscape and nm 
through the final stages of the wizard, g iving this report a suitable name. This 
process is the same for other data types such as dates. 

Activity Ilk 
Open the file saved in Activity 1 lj. Produce a new report from all the data which: 

• displays all the blue or black items 
e fitswithinthewidthofasinglepage 
• is sorted into ascending order of colour and type and then into descending order of 

description 
• has your name in the report header followed by 'Black or blue items'. 
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In this chapter you w ill learn how to: 
• create an integrated document 
• combine text and database extracts 
• combine text and graphs or charts 
• produce evidence of your methods 
• ensure the consistency of display 
• use precision framing. 

For this chapter you will need these files from the CD: 
• MEMO.RTF • LETTER.RTF 

For this chapter you will also need your worked copies of: 
• Task 11e • Activity 10h 
• Task 11q • Activity 10i 
• Activity 1 Oa • Activity 1 Oj 
• Activity 1 Ob • Activity 1 Ok 
• Activity 1 De • Activity 101 
• Activity 1 Od • Activity 1 Orn 
• Activity 1 De • Activity 1 On 
• Activity 10f • Activity11c 
• Activity 1 Og • Activity 11 k 

12.1 What is a n inte grated docume nt ? 
In the examination you may be asked to create a document that contains text and 
other objects. TI1ese may include: 
• images including screenshots of your work 
• data taken from a database or spreadsheet 
• graphs or charts 
• short pieces of hunl 
• cascading srylesheets. 

If you are asked to create a document, select your word processor, in this case 
Microsoft Word. Sometimes the word report is used instead of document, as mentioned 
in Section 11.5. This means 'a document that gives information'. It does not mean a 
report created inMicroseftAccess (although there are rimes when it might be 
appropriate to use this) and will usually mean a report created using a word processor. 

12.2 Impo rting objects 
In Chapter 10 you learnt how to import and edit text from a file, clip art and images 
from a variety of different sources. Many of these skills will be needed in any 
integrated document that you produce. 



Hint 
Keyboardshortcuts: 
You can use<Ctrl> 
and <C>tocopyto 
the clipboard and 
<Ct rl>and<V>to 
paste the current 
contents of the 
clipboard. 

Integration 

To import text from a website, open the webpage in a web browser, in this case 
Interna F.xpl-Orer, and highlight the text that you wish to use. Right dick the mouse 
within this highlighted text and select Copy from the drop-down menu. Move into 
the word processor and right dick the mouse in the position you want to place the 
copied text. Select Paste from the drop-down menu . 

The same method is used to copy an image into your document from a webpage. 
H owever, note that in most countries, copyright laws mean that it is illegal to copy 
any text or image from a website without the permission of the owner of the 
copyright. For the practical examinations, copyright of the material on the websites 
that you will be asked to use will be owned by CIE, or permission to use the 
material for the examination will have been obtained by CIE. 

12.3 Showing evidence of your methods 

Hint 
Makesurethatthe 
image you have 
captured can be 
seenclearlybythe 
examiner. 

In the practical examinations, you may need to show the examiners how you answered 
the question. Using a series of screenshots is the quickest and easiest way of doing 
this. A screcnshot is where you 'capn1re' an image of what is displayed on the screen at 
the time. TI1is is copied and stored temporarily in the clipboard of the computer and 
can be pasted into a document. As well as using these basic tools provided within the 
Windows environment, there are other ways of doing this. TI1ere are a number of 
packages available that will produce screenshots, some of which are available as 
freeware. If you are already know how to use one of these packages, using them may 
save time in the practical examination. Because there are so many different packages 
available and each works in a different way, they are not covered in this bcok. 

To take a screenshot and capture an image of everything that is displayed on the 
screen at any time press the <Prt Ser> (or <Print Screen> ) key on your keyboard. 
If you have more than one window open and wish to caprure only the current 
window hold down the <Alt> key and press <Prt Ser>. Paste the contents of your 
clipboard into the word processor and edit the image (cropping and/or resizing, as 
described in Sections 10.7 and 10.8) to show only the sections that you require. 

12.4 Showing evidence from Access 

You have already produced queries, ref0115 and calmlated controls in Access in Chapter 
11, but it is not always easy to produce the evidence of this for the practical examinations. 
If you have created a report containing a tick OOx, always print this din.-crly from the 
report or use scn."enshot evidence. If you try to export a rqx:,n containing tick OOxes in 
rich text format for example, the tick OOxes will IXJt be included in the t"Xported 
document. If you use screenshots and the evidence is in more than a single screen, make 
sure that you take a number of screenshots showing all of the evidence. 

Task Ila 
Open the file saved in Task llq. 
Show evidence of the formula and formatting used for the calculated controls for the 
'Average profit' and 'Number of cars' within the report. 
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Hint 
If you need to 
include an Access 
report in the 
document, perhaps 
because calculated 
totals are also 
required, export 
the report in .rtf 
format and insert 
thisintotheword­
processed 
document using the 
techniques shown 
in Section 10.1. 

Open thereportforTask ,;;;;;;rn~~=~~;~ llqin Design View. Click • , .,.. ,.~· ··11·· · .,., . .,. • ,. . , . _...._,.,...., 

the left mouse button on the r,..., .,.. - °""' ,.. 
Text Box containing the '·~~ 
calculation for the average , .... 
profit. If the Property Sheet :':"~":'- ::~,-~ 

~;,~: !~~:ev~:~!~1;~~1\~: fl~f=~S;;;i;J 11, :~"" 
control and sdect Properties :"'.:,_:';_ ~.-_'!E-._ 
from the drop-down menu. ~ ~- v• 

Select the All tab in the -.=.:-_Tr ...... ~-~---Property Sheet pane. - .-:- -~ 
Screenshot the window , .. ..,. __ _ 

using the <Prt Ser> key and 
paste this into a word-processed document. Crop the image so that the relevant 
sections can be seen. Enlarge the image so that the text can easily seen, like this. 

Repeat for the 

control for the ~~~~~~~~~"';;G;;;;:=:::--1 number of cars. Left ;'. , .,, , ,,,. , ... . , .... , .. -ctiontn>e: ,..,Bo:< 
click on the Text 
Box, take another 

screenshot and paste'!~~~~~~~ this into your • 
word-processed 
document. Again, 
crop and resize the 
image so that the 

:::i~~ss;;;ns can _,_.,.,,~rt--f~""".H 
Remember to add 
your name to the 
document before 
saving it. 

Activity I la 
Open the file saved in Activity 1 lk. 
Showevidenceoftheformatting used for the 
todisplaytheblackorblueitems. 

and rl fieldswithinthereport 

12.5 Combini ng your document and a database extract 

In the practical examinations you may need to take a database extract and place this 
into a word-processed document. Using an Access query rather than anAccess report 
is often the easiest method of combining this information. Copying the query and 
pasting it into the document (as described below) gives instant results. Be careful to 

format the new text to match the existing document, to ensure the table fits within 
the margin (or column) settings and to maintain consistency of line spacing with the 
original document. 
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Task llb 
Open the file MEMO.RTF and place only the , , , and 
fields of all the Ford cars that need valeting as a table after the text ' . that need to be 
cleaned:' . 

Open the database that you I :,i ,.. ..... ..... . ... 

saved in Task lle. Open the ru· 
query for the Ford cars and . 
valeting is Yes in Design View. 7 ~ 
In the Show: row ofthc que~ ~= 
remove the ncks from the fields -
that you do not need in the ::_• 
extract. ""'· 

click on the t_ick. boxes to I ;:; 

Save the changes to the ~ 'f'c"'-ec=;a:ia===aaa,aa:i;aa:,:a=a,aaa==aie 
query and close the query. In ,;_ E> ...... w, ... ,-.. , .... , "' , ,.... ... .. v- , 
the Navi~ation p~ne, right ,:;: !rl 0 !il ii M 00 
mouse chck on this query and ""'- -r_. "' 

use the drop-down menu to "" , ~ 
select Copy. -------~ 

in ~~;1~!~ dp=::~.~~c~!TF G!~ \ -----;j!D..;,;:i,i;.;..;~ 
cursor to the end of the text ' ... that 
need to be cleaned:' and click the 
right mouse button. Select Paste 
from the drop-down menu. 

.-- The document now koks like this 
Delete the top row from the table, 

and move the table so that it aligns 
with the left margin of the document. 
To do this, click in the table and 
adjust the mler settings for the table. 
Set the font style in the table so that it 
matches the text in the paragraphs. 
The document now looks like this. "'-

Memo 

b COfkd•""""'''"°"" "' "-

\ ·-"'.'"'™' "0111> ... 
' ~ I', ~-
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Activity l lb 
Use the file that you saved in Activity 11c. 
Extractalltheitemsthatareredandthediscountisyes,andshowallfieldsexcept PPrlc 
PlacethisextractintothefileLITTER.RTFafterthetext' ... redincolour.' 

12.6 Combining your document and a graph or chart 

In the practical examinations, you may need to insert a graph or chart into a word­
processed document. You should treat the graph or chart as an image and use the 
same methods, like copy and paste. Make sure that you have displayed all of the data 
and labels in full in your graph before copying it into the document. This will be 
shown in more detail in Chapter 14. 

12.7 Ensuring consistency of display 

It is very important that the finished integrated document looks like a single piece of 
work. Every part of a finished document should look the same in terms of font style, 
line and paragraph spacing, paragraph settings, margin settings and headers and 
footers. The headers and fcx:,ters should align with the margin settings of the page, 
not the default settings for your word processor. When you include tables or 
database extracts in your document these should have the same margin setting and 
font styles as the body text. All bulleted and numbered lists should also appear in the 
same style. In the practical examination, if you are not very careful about this you are 
likely to lose a large number of marks. 1l1is can be relevant in a question that is 
assessing your knowledge and understanding, if a question asks you to prepare a 
report, document or presentation on a topic; you are likely to be marked on both 
the subject content and on the quality of the doaunent that you produce. 

12.8 Precision framing 

Make sure that objects like tables and charts always fit precisely into the column or 
page margins, unless you are told in the question to do something different. 
Examiners are unlikely to allow more than 1 or 2 millimetres overlap if images or 
other objects fit outside the column width or margins. 

Activity llc 
Open each activity that you completed in Chapter 10. Check the consistency of presentation, 
page breaks and that all objects placed within a document fit precisely in the margins. 
This activity does not have model answers on the CD. 
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In this chapter you w ill learn how to: 
• use sequential numbering to save files 
• save files in different formats 
• print a draft copy of the final version of a document 
• print e-mails with a file attachment 
• print a table, query or report in a database 
• print a graph or chart. 

For this chapter you will need no additional materials. 

13.1 Saving d ocume nts 

Version numbering 

It is always wise to save each piece of work as you are producing it. You should save 
every 5 to 10 minutes, so that if there is a problem - a hardware fault or power cut 
for example - you only lose a few minutes' work. 

It is always sensible to name your files with sequential numbers. For example, as 
each chapter of this lxx:,k was being written, each was saved with a different version 
number so that different versions can be identified. \-Vhen producing your work, if 
you want to go back to something from an earlier version, it is always available. 

I 
\ 

OO· • K""".,..-' °''" 
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Saving a document in 

Doa1ments and data can be saved in 
different formats. In earlier chapters, " OP<• 'e;i::-------·· 

it:J :.:::. ...... _.~ -

different formats A ,.. 
~;e:1:; /i~;r;:,:1~~ ~::;; export Q '-rt 
using different data types inAccess. li:il - ~ =~:;:,:::;:.rtlllill!l"'Y 
Saving a document has already been 
covered in earlier chapters, but to ~ - 6< ' ~ _..,. 

save a document in a different file j ,~ 
fonnat, click on the Office butt~: - ' a'>, ~:::::.:- " 

~~~;;~o~?:n~::~ As and select ~ ~--
0

1 
~ ==~ MaNlo;ocztow,ct~oM 

This \vill open the Save As [::al s.n,ii ' """' '"""'""" 

window and you can choose the 
file type using the Save as type : 
drop-down list. This list may vary 
from the one shown, depending 
upon the configuration of your 
software. 

The most common fonnats 
that you may need to use are 
text fonnat (listed as Plain 
Text), and Rich Text Format. 
Select the one that you require 
and click on ~ 

13.2 Printing data a nd 
d ocuments 

For all of the ditlC:rent 
applications used for the practical 
examinations, you can use the 
Office button followed by Print 
and Print Preview to cl1eck that 
the object that you want to print 
is correct before sending it to the 
printer. Please note that all 
documents, data, graphs, charts, 
presentations, etc. must be clearly 
labelled with your name, centre 
number and candidate number in 
order for it to be marked. 

- '> ('-

·- ·H CII .., ._.. __ 
11, S..., <D 

¥ 11,_,_ 
·'itlau1.-., 

Printing any document created in colour on a black-and-white printer can cause 
problems. This lx:,ok has sections of coloured to.1: designed to outline key elements; 
for example, words in the glossary are shown in red, instrnctions are in blue and 



Hint 
Not all property 
windows have 
these settings. Each 
will depend upon 
the printer that you 
have installed. In 
thiscase,the 
Document 
Properties window 
can also used to 
change between 
Color and Black& 
Wh ite printing. 

Hint 
Always check that 
that the document 
that you are 
printing is free 
from errors before 
sending it to the 
printer. Use the 
Print Preview 
feature to help you. 

Output data 

fiddnames are in orange. If a page containing these three colours was printed on a 
black-and-white printer, each of the three colours would appear as a similar shade of 
grey. It would be impossible to identify which words were glossary tem1S, instmctions 
or fiddnames. TI1e use of colour in images is equally i.tnfX)rtant; some colours appear 
identical i.t1 grcyscale, particularly colours like red and green. You must be able to 
change the colour settings within your documents, diagrams and charts to enable the 
different sections to be disti.t1ctive when they are pri.t1ted in black and white. 

Printing a draft copy or final 
version of a document 

You have already practised many of the 
skills needed for this chapter. There is 
often no difference between a draft copy 
and a final copy of a document in terms 
of the way that it is laid out. In some 
cases, draft documents may be produced 
to a lower quality than final copies, so 
you do not waste expensive printer 
consumables. In the practical 
examinations, there will be no need to 

change your printer settings or include 
watermarks on your documents, unless 
you are asked to do so in the question 
paper. If the question paper asks you to 

show how to set a draft copy, click on 
the Office button followed by Print 
and select Print again from the new 
list to open the Print window. 
Click on Properties to show the 
Document Properties or Printing 
Preferences window. 

....................... _ ......... _ 

....... ---~ 

In the Document Properties 
window you can cl1ange the Quality 
Settings from the current value (in 
this case Nonnal) to Draft. --~ - -=~~-­
You may need to screenshot this 
process as evidence for the 
examination. 

Although this feature has been 
demonstrated using a document in 
the word processor, similar settings 
can be dunged in other packages. 
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Printing emails with a file attached 

Open your email browser !J 0<11 1..il!oolc ~s---
or editor. Enter the address Ille f dit 'l!iN - "'""' 1- .!<t""" 11<11> 

of the person that you are 

sendingthemessaget~ 1 .......... w.w .. ...,.,c .... ...., .• ~ r ....... 111'--- ·I 

:~~!~'.1~:~ ~~~:::~ Bee: ~ :c -::.-~-,----·--::-:..-• ------~ 
boxes. ~d thesubje~s.~, -~-"-~--~~~-------
~~;a~:' ~!:c:i;}:x ;~demail.~ , , !]n _1i_-..._,.doa ~19

ai 

Thedetailsofthefile Laii ,. ... ,,._ Iii! ._.. ;)· .,,.."""".,, . A ...... ,. •Jno· • 1 u 

attachment should be 
visible within the window, 
along with the other items 
entered. TI1e examiners 
will check very carefully 
that each of these items is 
correct. In this email the address, subject and attachment are all clearly visible. Check 
that there are no errors in the text of the email. If you need to send evidence of this 
as part of the practical examination, copy the screen using <Alt> and < Prt Ser>, 
before pasting this into a word-processed document. 

Printing from Microsoft Access 

You have already covered many of the skills required for this in 01apter 11. This 
section shows you how to produce printouts of each area inAccess. Do not forget 
that screenshots can be very useful as evidence, although documents containing a 
number of screenshots can be very large files and take a long time to print. 

One way to print a table or query is to open the table or query, and copy and 
paste the data into a word-processed document. This document can be edited (to 
add your name and other details), saved and printed. A table or query can be printed 
directly from Access by double clicking on the table name or query name in the 
Navigation pane to open it and dicking on the Office button followed by Print. 

Use a rqx,rt in Access if you need to show calculated controls and improved page 
layout. Printing a reix,rt uses the same method as printing tables and queries. The reix,rt 
can be opened and printed using the Office button followed by Print. Reports can be 
exported for inclusion in a word-processed document as outlined in Chapter 11. 

Printing a graph or chart from Microsoft Excel 

One way to print any graph or chart is to open the graph/d1art, and copy and paste 
the graph/chart into a word-processed document. You can add your name, candidate 
number and centre number and any otl1er text that you require before saving and 
printing. A graph or chart can be printed directly from E.,ccel by opening tl1e 
graph/chart and clicking on the Office button followed by Print. 
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I t his chapter you w ill learn how t o: 
create the layout for a spreadsheet model 
enter text and numeric data into a spreadsheet 
use editing functions such as cut, copy and paste 
enter formulae and simple functions into a spreadsheet 
replicate formulae and functions in the spreadsheet 
test the data model 
select subsets of data with in a spreadsheet 
sort the data within the spreadsheet 
change the display and format of cells with in a spreadsheet 
change the size of rows and columns within a spreadsheet 
adjust the page orientation 
save a spreadsheet 
print a spreadsheet displaying formulae or values 
create a graph or chart 
label a graph or chart 
extract segments from a pie chart 
add a secondary axis 
set axis scales 
change chart colours to print in black and white 
create, rename and delete files using an operating system 
access folders/directories within an operating system. 

or this chapter you will need these source files from the CD: 
• CLASSLIST.CSV • ROOMS.CSV 
• CLIENT.CSV • SALARY.CSV 
• CLUBS.CSV • SALES .CSV 
• COSTS.CSV • STAFF .CSV 
• EMPLOYEES.CSV • TASKS.CSV 
• ITEMS .CSV • TEACHERS.CSV 
• JOBS .CSV • TUCKSHOP.CSV 
• OPERATORS.CSV • TUTORS.CSV 
• PROJECT.CSV • WEBHITS.CSV 
• RAINFALL.CSV 

14.1 What is a data mode l? 
For data analysis, you will use a spreadsheet model to explore d ifferent possible 
answers. These mcx:lels are often financial, mathematical o r scientific. It is sometimes 
called using a 'what if scenario or 'what if modelling. It lets you change data in the 
spreadsheet to see what will happen to the results. In the practical examinations, you 
may be asked to build a simple spreadsheet model and change data within the 
model, or even change the mcx:lel itself, to produce different results . 
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Hint 
Remember that a 
column holds up 
the roof and you 
canseearowof 
houses. 

Spreadsheet basics 
You will use the spreadsheet Microsoft 
Excel to create your data model. A 
spreadsheet is a two-dimensional table 
split into rows and columns. It looks 
like this. 

_____.-:-: It is made up of a number of 
~ 1_ndividualcells, like this. This cell 

(with the darker outline) is tl1e cell 
that has the cursor within it. To help 
us to use individual cells in a 

spreadsheet, each cell has an address. In this example the cell witl1 the cursor in it is 
called cell E9 and the cell that has been coloured red is called cell C4. The red cell 
and all of the yellow cells are in column C, and the red cell and all of tl1e blue cells 
are in row 4. 

Task 14a 
Create a spreadsheet to multiply any two numbers together and display the result. 

Each cell in a spreadsheet can hold one of three things. It can contain: 
• a number 
• text, which is called a label 
• a formula , which always starts with an = sign. 

Move tl1e cursor into cell Al and click tl1e 
left mouse button. Type in the label 
'Multiplying two numbers'. Move the cursor 
down into cell A2 and enter a number. 
Repeat this for cell A3. In cell A4, enter the 
formula = A2 • A3 so tl1at the spreadsheet 
looks like this. ------~ 

You will see that the formula is not 
visible in the sheet and that the cell A4 only f 
contains the answer to the calculation witl1in : 
this cell. The formula for the cell containing ; 

th\~~~~rh:: ~~::~ ~~:~;:a:~:tb:;· -=L----~ 
shown, you should be able to change the 
contents of cells A2 and A3 to multiply any 

two numbers together. The changing of cells !E::_,~· ·~·;;:=~• ~~~~~;;~ 
to see the results is called modelling. lb; 



Hint 
If you do not show 
all of the contents 
ofthecellsinyour 
practical 
examinations you 
will lose a 
significant number 
of marks. 

If you enter large numbers 
into cells A2 and A3 the result 
in cell A4 may not appear as 
you expect it to. It may look 
like this. -----

This tells you that the 
number is too large to fit into 
the column. To expand the 
width of column, move the 
cursor to the end of the column 
heading for column A like this. 

Double click the left mouse 
button to expand the column 
width to fit the longest item 
stored in this column. The 
spreadsheet now looks like this. 
You can see how the label and 
all of the data are fully visible. 
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14.2 Creating a data model 

Task 14b 
Create a spreadsheet to display the times table for any number you choose to enter. Print 
your spreadsheet, showing values and formulae. 

For this task, you need to design and create the data 
model to calculate and display the times table for any 
number that you choose. You must therefore have a 
single cell that contains the number to use for all the 
calculations. In this model you can place a simple 
number like 2 in cell Al, so that you can easily tell if 
you have made a mistake with your formulae later on. 
Type the label 'Times Table' in cell Bl. 

You are going to create the times table in cells A3 to 

Bl2, with those cells in column A holding the number to 

multiply by and those cells in column B holding formulae 
to calculate the answer. MoYe the cursor into cell A3 and 
enter the number I. Move into cell A4 and enter the 
number 2. Rather than repeating this process another 
eight times for the numbers 3 to 10, highlight the cells 
A3 and A4, as shown here. Move the cursor to the drag 
handle in the bottom right comer of these cells. 
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Hint 
Make sure that 
yourname(and in 
the examination 
your candidate 
details)are 
included in either 
the header or 
footer. To do this 
use the Insert tab, 
in the Text area 
select the icon for 
Header and Footer 
and enter your 
details in the 
relevant section. 

Click and hold the left mouse bunon on the drag handle, dragging it down to the 
bottom right comer of cell Al 2. This replicates (copies) the cell contents. Excel 
realises that the numbers in cells A3 and A4 increase by 1, so uses this panem as it 
replicates the cells down. 

~ Miamo11Exc<'I - To,kl0 2~ 

f. • 

1• A 

'"""" . 
Move the cursor into cell B3 and enter the fonnula =A3'$A$ 1. The$ symbols in 
the reference to cell Al will be used by Excel to keep that cell reference the same 
when this cell is replicated into cells B4 to Bl2. Use the drag handle in cell B3 to 

replicate this fonnula into the cells down to Bl2. The results should look like this 
Without checking the fonnulae, you can sec that this has produced the correct results 

for the two times table. Change cell Al to another number to check that the formula 
works correctly. Print this values view of the spreadsheet using the Office button, 
followed by Print and then Print again. 

Displaying formulae 
To display (and then print) the formulae used 
in the spreadsheet, select the Formulas tab 
and find the Formula Auditing section. Click 
on the Show Formulas icon. The spreadsheet 
now looks more like this. 

absolute and relative referencing. In cell B3, the 
reference to cell Al (with the$ symbols) is an 
absolute reference and the reference to cell A3 
is a relative reference. You can see from this 
view that the reference in cell B3 to cell A3 has 
been changed as the cell has been replicated, as it 
uses relative rL-fercncing, but the reference to cell 
Al has not been changed during the replication, 
because absolute referencing has been used. 

To return to the view of the spreadsheet 
that shows the values, click on the Show 
Fonnulas icon again. 

" 

=A7"$AS1 

=A8'$AS1 

=A9'$AS1 

=A1o·SAs1 

=All'$A$1 

=A12'$A$1 

H • > .. ShooU 

Av«-11 couni:10 s.-110 iffiD 
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More editing tools 

O ther standard W indows editing tCXJ!s can be used in Excel, like cut, copy and paste. 
These can be used to copy the contents of one cell into another cell. An alternative 
method o f replicating cell B3 into cells B4 to Bl 2 is to enter the formula in cell B3, 
right mouse click on this cell and select Copy from the drop-down menu. H ighlight 
the cells B4 to Bl 2 and right mouse click, selecting Paste from the drop-down 
menu. This will pas te the fonnulac, adjusting the cell references fo r A3 as this is a 
relative reference but retaining the absolute reference. The result is identical. 

Accuracy of the data entry 

\Vhcn you are asked to 'create a data model that !CXJks like this', make sure that you 
copy the model in the question paper exactly as shown. Do not try to make 
improvements or add enhancem ents (like colour and formatting ) unless asked to do 
so. This is very important. Some students lCXJsc marks by trying to ' improve' the 
spreadsheet, for example by trying to left align a column containing numbers . Excel, 
quite correctly, should automatically right align numbers, so by left aligning this 
data it is now formatted incorrectly. Do not insert rows or columns, or remove rows 
o r columns containing blank spaces, unless instructed to do so . 

When you type data into a spreadsheet (or an y other form of document) you must 
make sure that the data that you have entered is identical to the original source 
document or examination question paper. A large number of marks can be lost by 
mshing the data entry and not cl1ecking that it has been entered with 100 per cent 
accuracy. Ths is even more important when working in a spreadsheet because one error, 
for example a mistyped number or decimal point in the wrong place, could cause all of 
the data in the spreadsheet to be incorrect. Care must also be taken when entering a 
formula, as one small error is likely to stop the spreadsheet working as it is expected to. 

Using formulae 
Simple mathematical o perators can be used to add, subtract, multiply, divide and 
calculate indices (powers) of a number. Eacl1 mathematical operator is placed in a 
formula, as you did in Tasks 14a and 14 b. For addition use the+ symbol, fo r 
subtractio n use the - symOO~ fo r multiplication use the • symOOI and for division 
use the / symbol. Indices arc calculated using the " symOO~ so the contents of cell 
A2 squared (x2) would be typed as = A2 " 2 . 

Task 14c 
Open the file OPERATORS.CSV. Place two numbers of your choice in cells 81 and 82. 
Calculate in cell : 

• 84, the sum of the two numbers 

• 85, the difference between the two numbers 

• 86, the product of the two numbers 

• 87, the contents of cell 81 d ivided by the contents of cell 82 

• 88. the contents of cell 81 to the power of the contents of cell 82 . 
Check that the formul ae have worked before print ing your spreadsheet showing the values 
andaga inshowingtheformulaeused. 
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Hint 
The~ symbol is 
often found using 
<5hift>and'6'. 

Open the file OPERATORS.CSV in Excel. Extend the I Nu mber X 14 
width of column A so that all the labels are fully visible (see . Number y . 2 
Task 14a). Move the cursor into cell Bland enter the 
number 4, then into cell B2 and enter the number 2. These X + Y 4 + 2 = 6 
numbers have been chosen so that you can easily check your X- Y 4 - 2 = 2 
calculations. It is wise to perform all calculations by hand X • Y 4 • 2 = 8 
before entering the fonnulae, to make sure that you XfY 4/2 = 2 
understand the formulae that you are using and to see the X" Y 4 " 2 = 16 
results of the calculation before the computer has 
shown you its results. TI1ese calculations may look like this. 
• Addition: Move the cursor into cell B4. The sum of the nvo numbers is needed 

in this cell, which means to add the contents of the two cells. There are two ways 
of doing this: one method uses the + operator and the second uses a function. 
You will be shown how to use the SUM function later in this chapter, but the 
formula needed to enter in this cell for the+ operator is = Bl + B2. This can be 
typed in followed by the <Enter> key, or you can type the = sign, click the 
cursor into cell Bl, type+ and click in cell B2 before pressing the <Enter> key. 

• Subtraction: Move the cursor into cell BS. The difference between two numbers 
is needed in this cell. Enter (using either of the methods described in the addition 
section aOOve) the formula = B l - 8 2 , followed by the <Enter> key. 

• Multiplication: Move the cursor into cell B6. The product of two numbers 
means to multiply the two numbers together and you need to enter the formula 
= BI ·· B2 ,followed by the <Enter> key. 

• Division: Move the cursor into cell B7. This cell needs a calculation to divide the 
contents of cell Bl by the contents of cell B2 using the fonnula = B l/B2, 
followed by the <Enter> key. 

• Indices: Move the cursor into cell B8. This cell needs to calculate the contents of 
cell Bl to the power of the contents of cell B2 using the formula = Bl " 82 , 
followed by the <Enter> key 

To check that the formulae have worked _1 First number· X 

correctly, compare your original paper- 2 second number· Y 

based calculations with the values in tl1e 3 

spreadsheet. --------n-; ~~f7e;:;::n~:weenXandY 
You will notice that tl1e values chosen 6 Prodl.lctofX and Y 

earlier in this task were carefully selected to 7 x divided by y 

~:r:J:~~1::1: J~:;~ :~t;:d?~~:~\nd ~ X to the power y 

indices. These numbers were selected so , ,..F"'-----=.==--n 
that the 4 divided by 2 gives an easy result 
and the 4 to the power of 2 is reasonably 
easy (4 ~4 ) . 

Print the values, making sure that your 

l Fir5tnumber · X 

2 Secondnumber ·Y 

name is fully visible on the printout. Select 5 Dif ference between x andY =81-82 

the Formulas tab, then click on the Show 6 Product of x and Y =81 • e2 

Formulas icon in tl1e Formula Auditing ..!_ XdlvidedbyY =81/82 

section to change tl1e display to show tl1; / 8 Xtothepower Y 

formulae, which should appear like tl1is./ --:9:: 
Save and print the spreadsheet. 
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Named cells and ranges 

\,Vhen an individual cell or an area of a spreadsheet is going to be used a number of 
times within the fonnulae of a spreadsheet, it is often a good idea to give it a name. 
This name should be short and meaningful. In the case of a large spreadsheet, it is 
easier to remember the name of a cell, for example VAT or AveMiles, rather than 
trying to remember the cell reference, for example AC456 or X232. Once a cell or a 
range of cells has been named, you use this name in all your fonnulae. 

Task 14d 
Open the file SALES.CSV. This spreadsheet will be used to calculate bonus payments to sales 
staff fora small company. 

Name cell 81 'Unit'. Name cells AS to C7 'Rate'. Name cells 811 to G18 'Sold'. 

Open the file and find cell B2. You must name this cell 'Unit'. Right click on the 
mouse in this cell to get the drop-down 
menu. Select the option to Name a 

! ::~~e~: ~h:~~ ; ~!~[e~~:~:vw~i3me :==---=,=,-- J 

;~~::~; ;,::es;:::~~1;:;~: ~: l::.t~~r Cg,wrent ~ e~h:~~ml~QIS!mer 
the practical examinations, ignore this 
suggestion (in this case the name tha/it 
suggests is too long to be used) and 
overtype it with the word Unit, as ar;t.rsto: ~tl!E$1 IJ51 
instrncted in the question. Add suitable ~ ~ 
text in the Comment OOx so that the 
window looks like this. To name the 
range click.on """ii"""". 

vVhen you move the cursor into cell 
Bl, you will see in the Name Box that it 

is now called Unit. ------~;:~==:t:::t.i;E:::= 

To create the named range for the rate, you must 
highlight the cells between AS and C7 Do this 
by clicking on cell AS and whilst holding down 
the left mouse button, dragging the cursor to cell @d•e: c'-~~-= -~ 1 
C7. Click the right mouse button within the ~: [w..- EJ 
highlighted range to get the drop-down menu. ~t 1~~~'"'"""""" °'"""~ ~.I 
Change the contents of the Name: OOxto Rate. 
Check that the New Name window looks like 

this before clicking on ~ . The name of the B<fffl"" l--wWSc$CP lAl!I 
range is only visible in the Name Box if only the ~ ~ 

cells in the range are highlighted. ----""tE:~==~=~=~ 
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Hint 
An alternative 
method is to enter 
: SUM( thendrag 
the cursor to 
highlightcellsB4to 
B8,thentype ) and 
press the enter key. 

~ TI1e final named range can be created in a 

1~=1~~~~~~~~similarway.HighlightcellsBl l toG18, 
11 fiame: then name this range Sold . Each of these 

~= named cells and ranges will be used in 
Cqm,cnt: Thorunbe<ofitansd:lt,y .r of ~ othcrtasks.Savcthis spreadshcetas 

l
pe-sonnel d..mg tho6 """'thpe-iod. 

Task_ l 4d as an £>::eel spreadsheet. 

&efl:rs to:~11l1Bll1'SG$111 rA, 

~~ 

Using functions 
A formula in.Excel starts with an= sign. It could be a simple fonnula using 
mathematical operators like = 8 1 + B2, a complex formula using nested statements 
(this will be explained later in this chapter) or a formula including functions. A 
function has a pre-defined name like SUM or AVERAGE that pcifonn a particular 
calculation. There are many of these functions in Excel, many of which are beyond 
the scope of this book, but each has a reserved function name. If a question asks you 
to chcosc your own name for a cell or range, try to avoid using these function 
names. This section docs not contain all of the fimctions available or all those that 
may be used in the examinations. 

SUM 

The SUM fimction adds nvo or more numbers together. In Task 14c, you used the 
mathematical+ operator and the formula = 81 + 82 to add the contents of two cells 
together. With only two cells to be added, this was the most efficient way of doing 
this. If there had been more figures to add, particularly if they were grouped together 
in the spreadsheet, using the SUM function would have been more efficient. 

Task 14e 
Copy this spreadsheet model and calculate: 

• the total number of hours worked by all of these five 
people 

• the average number of hours worked per person 
• the maximum number of hours worked by any of these five 

people 
• the minimum number of hours worked by any of these five 

people. 

Open a new sheet and copy the labels and values exactly as shown in the task. Select 
the Home tab and use tl1c (OOld) icon to embolden the cells shown. To find tl1c 
total number ofhours worked you will need to dick tl1e cursor into cell B9 and use 
SUM to add up the list of numbers. Enter the formula = SUM(84:B8). This should 
give the value 80. 
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I 
An alremative way to use this fimction without typing it into cell B9 is for you to use 
AutoSum. Move the cursor into cell B9, select the Home tab and find the Editing 
section. Click on the AutoSum icon. This will pbce the SUM fimction into cell B9 
and anempt to work out which cells you wish to add up (by looking at the la rout of 
your spreadsheet). It does not always get this range correct, so check carefolly. If the 
range is com:ct (as it is in this case) press the <Enter> key to accept the AutoSum. Ifit 
is not correct, rou can highlight the cells to be added before pressing the <Enter> key. 

There are many ways of using the SUM function, some of which are shown in 
Table 14.1. 

:SUM(B4:B8) :B4+B5+B6+B7+B8 

:SUM(D3,D8,D12) :D3+D8+D12 

:SUM(DS:D8,F2) :D5+D6+D7+D8+F2 

:SUM(MyRange) None 

Table 14.1 Ways of using the SUM function 

Addsupthecontentsofallthecellsintherange 
B4toB8 

Adds up the contents of the cells D3, D8 and D12 

Adds up the contents of the cells in the range DS 
to D8andthecontentsofcell F2 

Addsupthecontentsofallthecellswithina 
named range called MyRange; this can be used 
w ith any named range 

As you can see, the range of cells selected within these functions can include a number of 
individual cells, ranges of cells, named ranges, named cells or a combination of these. 
The average, maximum, minimum and count functions also work like this. 

AVERAGE 
To find the average number ofhours worked, click the cursor into cell BlO and use 
A VERA GE to calculate the mean (average) of a list of numbers. Enter the formula 
=A VERAGE(B4:B8).This should give the value 16. There are many ways of using 
the AVERAGE function, some of which are shown in Table 14.2 overleaf. 

II 
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Hint 
Settingacellasan 
integer value will 
truncate the 
contentsofacellto 
remove the 
decimal/fraction 
part of the number. 
Thisisnotthesame 
as formatting a cell 
toOdecimal places 
which stops the 
decimal/fraction 
part from being 
displayed but not 
from being used in 
a calculation. 

:AVERAGE(84:88) =(84+85+86+87+88)/5 

:AVERAGE(D3,D8,D12) =(D3+D8+D12)/3 

:AVERAGE(D5:D8,F2) =(D5+D6+D7+D8+F2)/5 

: AVERAGE(MyRange) None 

Table 14.2 Ways of using the AVERAGE function 

MAX 

Calculatesthemeanofthecellsinthe 
range84to88 

CalculatesthemeanofthecellsD3, 
DB and D12 

Calculatesthemeanofthecellsinthe 
rangeD5toD8andce11 F2 

Calculatesthemeanofthecellsina 
namedrangecalledMyRange 

To find the person who worked the most hours, click the cursor into cell Bll and use 
MAX to sdcct the brgest (maximum) figure within the list of numbers. Enter the 
fonnub =J\iAX(B4:B8).This should give the value 26. 

MIN 
To find the person who worked the least number of 
hours, click the cursor into cell Bl2 and use MIN to 

select the smallest (minimum) figure from the list. Enter 
the formub = MIN(B4:B8).This should giYe the value 4. fl 

The finished spreadsheet should look like this. Save this 1 

spreadsheet as Task_l4e. ------..,J{-
,o 

" 
Activity 14a 
Open the file TUCKSHOP.CSV. 
In cells 814 to 817, calculate the total number of days that all the students worked in the 
school shop, the average number of days worked, and the maximum and minimum values. 
Place your name on the spreadsheet. Print your spreadsheet showing the values. Print your 
spreadsheetshowingtheformulaeused. 

Task 14f 
John Reeves did an extra four hours' work. Change the spreadsheet that you created in Task 
14e to show the new figures. The manager wants to see the average number of hours 
worked displayed as: 

• anintegervalue 

• rounded to the nearest whole hour. 

Print two copies of the spreadsheet showing these values. 

Open the file Ch_l 4_Task_ l 4e. Change the contents of cell B6 to 21 to add the 
four extra hours that he worked. This gives an average value of 16.8 hours. Move 
the cursor into cell C9 and enter the text 'Integer', then move into cell D9 and enter 
the text 'Rounding'. To get the first value requested by the manager, we have to set 
cell B10 to hold an integer value. 
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INT 
In mathematics, an integer is the word used to describe a whole number (with no 
decimals or fractions). Within Excel, the INT function takes the whole number part 
of a number and ignores all digits after the decimal point. Move the cursor into cell 
ClO and enter the formula = INT(BlO).This should give the value 16. 

ROUN D 

Move the cursor into cell D 10 and enter 
theformula = ROU ND(Bl0,0 ).1bis -.'c+"'='~'°'=•~"~-+c=+--+-­
uses the ROUND function which takes 1-~+,=--+-= ~c+--+---
the content ofcell BlO and rounds the , DewJW.._, 211 
number to O decimal places: if the next 1f - Gtiiiim ~ - :io;+--+--

digit is five or more the number will be i~·;-;-i~i~'~'~i~i increased by one. For example, in cell 1 
s,i.,, 

4 

BIO the value is 16.8, so the content of : ~tal::1- - :! , ROlinCI 

Dl0 is 17, as it has rounded the value to 1--~!l.- A Ui 1' t 7 

the nearest whole number. The ~} ::::.:' 2: 
spreadsheet should look like this.------

Rounding can be used with a number of decimal places, for example using 
rounding for currencies with 2 decimal places can avoid calculation errors. Table 
14.3 shows more examples of how you can use the ROUND function, using cell Al 
which contains the number 62.5512. 

: ROUND(A1,2) 62.55 
Rounds the contents of A 1 to two decimal 
places 

Rounds the contents of A 1 to one decimal 
: ROUND(A1, 1) 62.6 place. Notethatthefigure5 inthe 62.S512 has 

forced the previous figure to be rounded up 

Rounds the contents of Al to no decimal places. 
: ROUND(A1,0) 63 Notethatthefigure5inthe 62.S51l hasforced 

the previous figure to be rounded up 

Rounds the contents of A 1 to the nearest 10. The 
: ROUND(Al ,-1) 60 negativevaluefordecimalplacesallowsthis 

functiontoroundnumbersintens.hundreds.etc. 

Rounds the contents of A 1 to the nearest 100. 
: ROUND(Al ,-2) 100 Notethatthefigure6hasforcedtheprevious 

figuretoberoundedupfromOto 1 

Table 14.3 Ways of using the ROUND function 

Save and print a copy of the spreadsheet showing the average number ofhours 
worked displayed as an integer value. Print a copy of the spreadsheet showing the 
average number of hours worked rounded to the nearest whole hour. 

Activity 14b 
Create a new spreadsheet model to calculate: 

• the whole number part of 375.56411 
• 375.56411 rounded to two decimal places 
• 375.56411 rounded to the nearest whole number 
• 375.56411 roundedtothenearestten 
• 375.56411roundedtothenearesthundred 
• 375.56411 rounded to the nearest thousand. 
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Task 14g 
Open the file PROJECT.CSV. This file lists some workers and below each worker is the 
number of jobs they have still to finish for a project. 
Place a formula in cell Al.2 to count the number of jobs that still have to be finished for the 
project. Place a formula in cell A24 to count the number of workers on the project. 

COUNT 

Fo r this task you will need to use functio ns that count different values. It is possible 
to count the number of numeric (number) values in a list using the COUNT 
function. Open the file, place the cursor in cell A22 and enter the formula 
= COUNT(A2:Al9). This will look at the range A2 to Al 9 (notice that you have 
not counted cell Al which contains the title, nor cell A20 that may be used for 
something else later) and count only the cells with numbers in them. It will not 
count any blank spaces and should give the value 7. 

COUNTA 
The CO UNT A function works in a similar way to the 
CO UNT functio n. Rather than counting just the 
number of numeric values, this function counts the 
number of numeric or text values displayed in the cells. 
It will not count any blank cells within the range. In 
&eel there is not a count function fo r just text values, so 
the COUNT A and COUNT functions will 00th be used 
to calculate the number of wo rkers on the project. Place 
the cu rsor in cell A24 and enter the formula 
= COUNTA(A2:Al9)-COUNT(A2:Al9). This will 
look at the range A2 to Al9 and count the cells with 
text or numbers in them, then subtract the number of 
cells with numbers in to leave only the cells with text in 
them, in other words the names of the employees. It 
should g ive the value 9 and look like this. 

Activity 14c 
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Open the file CLASSLIST.CSV. This spreadsheet lists all the students in a class. If a student has 
attendedanyclubsduringtheyear, the numberoftimestheyhaveattended is recorded in 
the cell below their name. Place a formula in cell A71 to count the number of students in the 
class. Place a formula in cell A74 to count the number of students who have attended extra dubs 
this year. 



Hint 
Note in examples 
one and three in 
Table 14.4thatthe 
range SBS3:SBS2 1 
hasbeensetasan 
absolute reference 
sothatthisrangeis 
always in the same 
placeiftheformula 
is replicated. Also 
note that examples 
three and four have 
cellA24setasa 
relative reference 
so that it will look 
for the next job 
title when the 
formula is 
replicated.Named 
ranges are absolute 
references,butyou 
must show 
screenshotevidence 
that you have 
named the range 
correctly in the 
practical 
examinations. 

Data analysis 

COUNTIF 

Task 14h 
Open the file STAFF.CW. This file lists some workers on another project and lists each 
worker's job. 
Place formulae in cells B24 to B28 to count how many of each type of worker are employed 
on the project. 
Place a formula that uses both absolute referencing in cell 831 to count the number of 
employeeswithlessthanfiveyears'experience. 
Place a formula that uses both absolute referencing in cell 832 to count the number of 
employees with ten or more years' experience. 

For this task, you need to count how many people have each type of job. Open the 
file and place the cursor in cell B24. The function needed for this task is 
COUNTIF, which looks at the cells within a given range and counts the number of 
cells in that range that meet a given condition. The condition is placed in the 
function and can be a nwnber, a string, an inequality or a cell reference. There are a 
number of ways the COUNTIF function can be used: any of the formulae given in 
Table 14.4 can be entered in cell B24 and will give the correct result. 

Replicate this formula into cells B25 to B28. As these cells are to be rc..'Plicated, 
methods three and four in Table 14.4 are the most efficient, as you do not have to 

edit each formula with a different name for each row. If an examination question asks 
you to show evidence of absolute and relative referencing, then method three would 
be the most appropriate. If named ranges are required or absolute and relative 
referencing arc not asked for in the question method four is the most efficient. 

:COUNTIF(SBS3:SBS21, "Director") 

:COUNTIF(Job, "Director") 

:COUNTIF(SBS3:SBS21,A24) 

:COUNTIF(Job,A24) 

Counts the number of cells in the range B3 to 821 
that contain the word 'Director' 

Counts the number of cells in the named range Job 
(83 to 821) that contain the word 'Director'. This only 
worksifcells83toB21 havebeennamed'Job' 

Counts the number of cells in the range B3 to 821 that 
contain the same text as the contents of cell A24 

Counts the number of cells in the named range Job 
(83to 821)thatcontainthesametextasthecontents 
of cell A24. This only works if cells B3 to 821 have 
beennamed'Job' 

Table 14.4 Alternative formulae using the COUNTIF function 

To count the number of employees with less than five years' experience, place the 
cursor in cell B31 and enter the formula =COUNTIF($C$3:$C$21,"<5").111is 
will look at the range C3 to C21 and count the cells with a number value of less than 
five. The speech marks around the <5 are needed to tell.Excel that it is dealing with 
another formula (in this case an inequality), rather than searching for the symbols 
<5. The spreadsheet should show the value 8. 

To count the number of employees with ten or more years' experience, place the 
cursor in cell B32 and enter the fonnula =COUNfl F($C$3:$C$2 l,"> = 10"). 
The value calculated should be 5. Save your spreadsheet as Ch_l4_Task_l4h. 
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Activity 14d 
Open the file that you saved in Activity 14c. This spreadsheet lists all the students in a class. 
Next to each student's name is the colour of the house that they are in. 
Place formulae in cells E2 to ES that use both absolute and relative referencing and count 
thenumberofstudentsineach house. 
Place a formula that uses in cell E7 to count the number of students with less than five clubs. 
Place a formula that uses in cell ES to count the number of students with 12 or more dubs. 

IF 
An IF function contains a pair of brackets and within the brackets three parts, each 
separated by a comma. An example ofan IF function is = IF (A l = 5 ,A2 "0 .0 5 ,"No 
discount''). The first part is a condition; in this example, it is testing to see if cell Al 
contains the number 5. The other two parts arc what to do if the condition is met, 
and what to do if it is not met. If the condition is met a number or label could be 
placed in the eel~ or a reference to another cell, or even a calculation that needs to be 
performed. The same range of options applies if a condition is not met. In this 
example, if the condition is met, the result of multiplying the contents of cell A2 by 
the figure 0.05 is displayed in this cell. If the condition is not met this cell will 
display the text 'No discount'. 

Task 14i 
Open the file that you saved in Task 14h. Add a new label 'Category' into cell D2. 
Place formulae in cells D3 to D21 to display Very experienced' for employees with ten or 
more years' experience and otherwise to display 'Not experienced'. 

Open the file and place the cursor in cell 
D2. Enter the label 'Category'. Place the 
cursor in cell D3 and enter the formula: 
= IF (C3 > = 10,'Very experienced","Not 
experienced"). The reason that C3> = 10 
is used rather than C3>9 (which in many 
ciraunstances would be a more efficient 
formula), is because one employee has 0.2 
years' experience. Ai; the data does not all 
contain whole numbers, there could be an 
employee with 9.5 years experience so this 
would not work for all data. Do not use 

, Project 153 

4 G,es.Mino , ...... ,, 
, ........... ""' 
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absolute referencing in this formula as the 11 _.,"'"'­

reference to cell C3 needs to change when 
you replicate the formula. Replicate this 

~;r~o:; ~~:e:~~:::~:~~~!! ;~milar t~

0

this. / 
Save rour spreadsheet as Ch_l4_Task_l4h. 

Activity 14e 
Open the file that you saved in Activity 14d. 
Add a new label 'New students' into cell Fl . 

-·­...... , 

-·­... ..,.,, 

-·­Prqr,mmor -­....... 

,-·-''"""'" 
, __ _ 
,--"·""'" 1ov..-y •.......,•nood ~=== 
nv..,.o•l*'•n«KI 1~=== '""'-"""'" n,,...._,_,.,..,.., 
'""'-""'""" 

Place formulae in cells F2 to F6 to display 'Add to this house' if the number of students in 
the house is fewer than six orto display 'Full' if the number is six or more. 



Hint 
Note that as the 
conditions are all 
'greaterthan',they 
have been placed in 
reverse order. For 
example,ifthevalue 
for experience w as 
40andthe condition 
<5 wasfirst,then 
>=5nextandthen 
>=10: the first 
condition<5would 
benottrue,soit 
would go to the 
next condition;>=5 
wouldbetrue,so 
the result displayed 
would be 
'Experienced'; it 
would never get as 
farasthetestfor 
>=10. 

Data ana lysis 

Nested formulae and functions 
A nested formula or function is having one formula or function inside another one. 
Sometimes nested formulae could contain several fo rmulae nested within each other. 
If the nested functions include a number o fIF statements, be careful to work in a 
logical order, either from smallest to largest or vice versa (depending upon the 
question ). Do not start with middle values, this will give incorrect results. 

Task 14j 
Open the file that you saved in Task 14i. 
Change the formulae in cells D3 to D21to display 'Not experienced' if they have less than 
five years' experience, 'Experienced' if they have five or more years' experience and 'Very 
experienced' for employees with ten or more years' experience. 

For this task, three conditions exist. If the value for experience is: 
• > = 10 then display 'Very experienced' 
• > = 5 then display 'Experienced' 
• < 5 then display 'Not experienced'. 

Place the cursor into cell D3 and change the fonnula so that it becomes: 
= I F ~ = 10,"Very experienced", IF(C3> = 5,"Experienced","Not 

experienced")) 

Notice how the second formula (highlighted in~ has been placed as a 'No' 
condition within the first formula. Be very careful to get the brackets correct, each 
condition has o ne o pen and one close bracket. \Vhen you work through this 
formula, it checks whether the value is greater than o r equal to ten first ; if so, it 
displays the correct text. Then ifit was not trne it would check if the value is greater 
than or equal to five next, if so it displays the correct text. AI, there are no other 
conditions that could occur, rather than having another nested statement the 
resulting text has been placed. 

Replicate this formula into cells D4 to D21. Your spreadsheet should look similar 
to this. Save your spreadsheet as Ch_ l4_Task_l4j. 

Activity 14f ~ ..._-~,.__ __ _,__ _ _,,___ _ __.,__. 

Open the file that you saved in , Project 153 
Activity14e. 
ChangetheformulaeincellsF2toF6 
todisplay'Addtothishouse'ifthe 
numberofstudentsinthishouseis 
fewerthansix,'ldealnumber'ifthere 
arebetweensixandtenstudentsand 
'Full'ifthenumberismorethanten. 
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Hint 
You could use 
named ranges 
rather than 
absolute 
referencing for cells 
B3toB21 andC3to 
C21 . 0ne 
alternative formula 
ince11B35 which 
uses the named 
range'Job'created 
earlier in the 
chapter is 
:SUMIF(Job,A35,$C 
S3 :SCS21). 

SUMIF 

Task 14k 
OpenthefilethatyousavedinTask 14j. 

Insert the label 'Total experience for :' in cell A34, the label 'Programmer' in cell A35 and 
'Engineer'incellA36. 

Insert a formula in cell B35 that uses both absolute and relative referencing to calculate the 
number of years' experience for the programmers. 

Insert a formula in cell B36 that uses both absolute and relative referencing to calculate the 
numberofyears'experiencefortheengineers. 

SUMIF works in a similar way to COUNTIF. It compares each value in a range of 
cells and if the value matches the given condition it adds another related cell to form 
a nmningtotal. 

Add the labels as required by the task into cells A34, A35 and A36. Move the 
cursor into cell B35 and enter the formula =SUMIF($B$3:$B$21,A35,$C$3: 
$C$2 l ). 111c total for this cell starts at zero. TI1is looks at the contents of each row 
in the range B3 to B21 and compares the value in each cell to the contents of cell 
A35 (which contains the text 'Programmer'). If these two items are identical it adds 
the value from the same row within the range C3 to C21 to the total. When all rows 
i1~ this ran?c h~vc been c_hcckcd the t~ta! is - ------,-.---.--=-----
displa~cd m this cell. This happens w1thm 34 Total experience for. 

a fraction of a second as you press the 35 Programmer 

<Enter> key or change any value within/ 36 Engineer 
these ranges. 37 

To total the hours for the engineers, 
place in cell B36 the formula =SUMIF($B$3:$B$2 l ,A36,$C$3 :$C$2 l). The 
results of these formulae should look like this. Save the spreadsheet as 
Ch_l4_Task_l4k. 

Activi t y 142 
Open the file CLUBS.CSV. 
Insert a formula in cell B37 that uses both absolute and relative referencing to calculate the 
number of clubs attended by students in red house. 
Replicate this formula in cells B38 to B40 for the other coloured houses. 

Using lookups 
The term 'look up', as used in the practical examinations, means to look up from a 
list. It docs not mean that you should use the LCX)KUP function, as there are three 
variations of the LOOKUP function that can be used within.fucel. TI1csc arc: 
LOOKUP, HLOOKUP and VLOOKUP. 

LOO KUP 

LOOKUP is used to look up information using data in the first row or the first 
column of a range of cells and rerurns a relative value. For the purpose of the 
practical examinations, this is probably the least useful of the three formulae. 



Hint 
Experiment with 
these settings. 
Change the value in 
cell B24to5.2See 
the result of this 
change. Now 
changetheexact 
match condition 
from False to True 
incellC24.Seethe 
result of this 
change. Try other 
numberslike5.9in 
B24toseewhat 
happens 

Data analysis 

HLOOKU P 

HLOOKUP is a function that performs a horizontal look-up of data. This should be 
used when the values that you wish to compare your data with are stored in a single 
row. The values to be looked up are stored in the rows below these cells. 

Task 141 
Open the file JOBS.CSV. 
Insert formulae in the Description column to look up and display the Job Title using the 
JobCodeasthelook-upvalue. 

Open the file JOBS.CSV and click the left mouse button to place the cursor in cell 
C6. Enter the formula =HLOOKUP(B6,$B$2:$H$3,2) into this cell. This 
formula will look up and compare the contents of cell B6 with the contents of each 
cell in the top (horizontal) row of the range B2 to H3. When it finds a matcl1, it will 
take the value or label stored in the second row which is directly under the matched 
cell. The two at the end of the formula tells Excel to look in the second row of the 
given range. Replicate this formula into cells C7 to C27. The results should look 
similar to this. Save the spreadsheet as Ch_ l4_Task_l41. \. 
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VLOOKUP 

VLOOKUP is a function that performs a vertical look-up of data. This should be 
used when the values that you wish to compare your data with are stored in a single 
column. The values to be looked up are stored in the columns to the right of these 
cells. The look-up data can be stored either in the same file or in a different file. 

Task 14m 
Open the file TASKS.CSV. 
Insert formulae in the CurrentTask column to look up the client, using the TaskCode for the 
look-up value and the file CLIENT.CSV. Make sure that you use both absolute and relative 
referencing within your function. 
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Open the file TASKS.CSV and click the left 
mouse bunon to place the cursor in cell C3. TI1e Ta.skCode Client 
Task instrncts you to use the file CLIENT.CSV !-e-+-,=="-f--="-----1 
for the lookup. Examine this file by opening it in 3 :z Cuattich9m 
a new spreadsheet. Look at the layout of this file l--'-+-3'---+-=="'o,'" • ....,---1 
to decide which type of look up formula to use. 4 Awlcotn 

CLIENT.CSV looks like this. ---;:~::;::;::-;~ l~·~•L=::(1•~•;"""""""~~==1 
Because it is stored with the look up data in 7 e LGY 

vertical columns, a VLOOKUP is the most >-8-+
7
---+-=-IC-T __ __. 

appropriate formula to use. Enter the fonnula 
= VLOOKU P (B3 , Client.csvl$A$2:$B$8 ,2 ,FALSE) into this cell. This formula 
will look up and compare the contents of cell B3 with the contents of each cell in the 
left (vertical) column of the range A2 to B8 within the file CLIENT.CSV. When 
entering this formula, you can add the yellow highlighted section of the formula by 
moving the cursor into this file and dragging it to highlight all of the cells in 00th 
columns, so it includes the look-up value and the result. The number 2 in the 
formula tells.E\'."eel to look in the second column of this range. 1l1e 'False' condition 
in the fonnula tells &eel to only 
display the match if it is an exact 
matcl1. If you set this to Trne it 
will find the nearest approximate 
matcl1. When it finds a match, it 
will take the value or label stored 

CurrentTask 

in the second column which is to 

the right of the matched cell. :~:~+~:".:.:=n"~1:;'=,~w~'~'5="~i~~M~~-;:,"::_~~~~f-'~L=G~Y~-;_~~-;;,~ 
Replicate this formula into cells 8 Seraio Gonzalez 

C4 ~e~!!~1lts should look simila/
1 "':,-+-~--+----+-Roo=.,-;oo-, ----< 

to this. Save the spreadsheet as 
Ch_l4_Task_l4m. 

Activity 14h 

11 HemiRamos RocklCT 

Open the file TUTORS.CSV. This lists a number of students and the initials for their personal 
tutor. 
Insert formulae in the Tutor Name column to look up the tutor's name using the file 
TEACHERS.CSV. Insert formulae in the Room Number column to look up the room number 
using the file ROOMS.CSV. Make sure that you use both absolute and relative referencing 
within all of your functions. Save your spreadsheet. 

14.3 Testi ng th e data model 
Designing a test plan and cl1oosing your test data are the most imi:ortant parts of 
testing the data model. Choose data that will test every part of a condition. Be 
careful to test each part of the spreadsheet with normal data that you would expect 
to work with your formulae, with extreme data to test the OOundaries and with 
abnormal data that you would not expect to be accepted. Carefully check that each 
formula and function works as you expect it to by using simple test data. 

For example, to test the look-up used in Task 14m: 
• make s1rrethat each number between 1 and 7 (normal data) is used in the Task.Code 
• use O and 8 and other abnormal data 
• use decimal values between 1 and 7. 
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Write down each number and the expected results, before trying each number in the 
T askCode column. Check that the acrual result matches the expected result for every 
entry. If not, change the fonnula before starting the whole test process again. A test 
plan for this formula would be similar to that shown in Table 14.5. 

Form ula in cell C:3 using .:!at.a from cell 6:3: 

Data11ntryln63 Datatyp11 

Quattlchem 

Table 14.5 Sample test plan for Task 14m 

Many marks are lost in practical examinations by careless use of ranges within formulae 
and functions. Check that everything works before using real data in your mo:lel. 

14.4 Selecting subsets of data 
This means getting Excel to search through data held in a spreadsheet to extract only 
rows where the data matches your search criteria. 

Searching using text filters 

Task 14n 
Open the file that you saved in Task 14m. 
Select from all the data only the employees who are currently working on jobs for 
Binnaccount. 
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Open the file that you saved in Task 14m and highlight cells A2 to 

C24. Select the Data tab and find the Sort & Filter section. Click 11 [Il f 
on the Filter icon to display an arrow in the top right comer of ~ - i,-., 

[

each column, like this. 
For this task, you need to use this arrow to select the people working on the 

Binnaccount task. When you click on the CurrentTask arrow, a small drop-down menu 
appears like this. I 
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8 

C 

Hint 
To remove the 
AutoFilter,either 
clickonthetickbox 
for (SelectAll ),or 
use select Clear 
Fil te r inthedrop­
downlist . 
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In the Text Filters section of the menu, click on the tick box for (Select All) to 
remove all of the ticks from every box. TI1en tick only the Binnaccount box, before 
clicking on LlL. This will display only the five sdected rows like this. 

The same method can be use to select more than one company from the list. By 
selecting different drop-down menu options, searches can be made using different 
criteria in different columns. Save the spreadsheet as Ch _ 14 _Task_ 14n. 

Searching using number filters 

Task 140 
Open the file that you saved in Task 14m. 
Select from all the data only the employees where the task code is between three and 
sixindusive. 



Hint 
The method shown 
here is an 
alternative to 
selecting only the 
boxes for three, 
four, five and six. 
Even though it may 
seem easier to click 
on the tick boxes 
for this question, 
you w ill need to 
use the Custom 
AutoFilter w indow 
w here a number of 
options are 
required. The 
Custom AutoFilter 
w indow also allows 
youtoselect isnot 
equal to and to 
perform w ildcard 
searches. 

Data analysis 

Open the file and set the Auto Filter arrows for cells A2 to C24 as in the previous 
task. This time the search will be performed on the TaskGxle column. Select the 
drop-down menu for this column using the arrow. Select Number Filters to get a 
sub-menu . Select Custom Filter . .. to get the Custom AutoFilter window. 

CustomAutoFilter 

USll!?torrpr6ffltany ~charactff 
Us@ •to~-tany~of charactft's 

This will allow you to set the search criteria to 

greater than or equal to 3. 

Custom AutoFilter 

AND 
less than or equ al to 6. 

~ .I, f ft., 

._., .. . , ., ., .. ., 

The drop-down options in each box of the Custom AutoFilter window can be 
used to select equ als to, not equal to, less than , or greater than , as well as the options 
shown. Save the spreadsheet as 0 1_14_Task_ l 4o. 

Searching using more than one criteria 

Task 14p 
Open the file that you saved in Task 14m. 
Select from all the data all the employees except John Mortlock and Sean O'Byrnewho are 
currently working on jobs for Quattichem or Hothouse Design. 
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Open the file and set the 
AutoFilter arrows for cells A2 to 
C24 as in the previous task. This 
time the search will be peifonned 
on both the Name and 
CurrcntTask columns. Select the 
drop-down arrow for the Name 
column, Text Filters and then u.e?tr:in:i:reoent.,y,s,giedwir-

select Does Not Equal from the u.e·11:1-t ... ,_otdwirllcil!n 

sub-menu. TI1is opens the Custom 

AutoFilter window, enter the ~==========~=!.I 
initial letter 'J' in the right box 
(this speeds up the search). When you click on the arrow for the drop-down list it 
will show you all the Names starting with 'J', so select 'John Mortlock' from the list. 
Select the AND operator and repeat the process for Sean O'Byme, selecting does 
not equal in the left box and typing 'S' to find Sean O'Byrne, selecting his name 
from the list in the right box. Click on JL. 

Select the search arrow for the 
CurrcntTask column. Select from 
this menu only the two tick OOxes 
for 'Hothouse Design' and 
'Quanichem', or select T ext 
Filters and set up the OR search 

likes:~;·th-, -,r-~-,a- ,h- ,-" - ~-------,~ ~·- ---~13~ .. ~ ::::-:-R 
Ch_ l 4_Task_ l 4p. TI1e results of :~:~:=::::":::1cr. 
this task should look like this. 

Activity 14i 
Open the file that you saved in Task 
14h. Selectfrom all the data: 
a) allthestudentswithatutorcalled 

Chris Scott 
2Quattlchem b) allthestudentswhowillbeusing 
3 Hothous.O.slgn rooms numbered between 22 and 74 

inclusive 

Searching using wildcards 

c) all the students except Kiah and 
HartatiwithatutorcalledKate 
Morrissey or Mike Arnott. 

A wildcard is a character that is used as a substitute for other characters. The • 
(asterisk) character is often used to show a number of characters (including 0 ) and 
the? (question mark) is often used to show a single character.Excel uses these 
wildcard characters, but AutoFilter also contains other feamres that simplify some of 
these searches. 

Task 14q 
OpenthefilethatyousavedinTask14m. 
Select from all the data only the employees who have a name that starts with the letter 'S'. 



Hint 
The method shown 
here is an 
alternative to 
selecting Text 
Fi lte rs. then Equals 
andentering S* 
before clicking on .---. 

Hint 
The method shown 
here is an 
alternative to 
selecting Text 
Fi lte rs. then Equals 
andentering *a 
before clicking on .---

Open the file and set the 
AuroFilter arrows for the cells A2 
to C24 as in the previou s task. 
This time the search will be 
performed on the Name column. 
Click on the drop-down arrow for 
this column and select Text 
Filters followed by Begins 
With .. . from the sub-menu. TI1is 

Data analysis 

I~ = 0 ~ H ~•----~ 
~l:l~~~~ 

opens the Custom AutoFilte ~ ~ 
window. Enter the initial S m the 
right box like this and click on ~ A e c 
~ - You should find these four ~ tcl1enthst 

rows. Save the spreadsheet as 2 IName------ . TaskC~CummtTask G 
Ch_ l4_Task_l4q. s Sri Paryantl 

Task 14r 
Open the file that you saved in Task 14m. 

8 SergloGonzalei 
17 SheluhO'Leary 
20 seanO'Byme 

5B1nnKC01Jnt 

l Rootralner 

3 Hothouse Design 

Select from all the data only the employees who have a name that ends with the letter 'a'. 

This is a similar process to the 
previous task. Use the same 
process, this time selecting the ~=when!: 
TextFilter s fromthemenu, then lenc11wilh r.i ~,----~ 
the Ends With ... option to 

:~~~it~;~;~t~: t::11~:::: i:::~e _ __/j- -iiiii"'iii""iiiiii_,,___-iiiiim[:k ____ ~ 
right box like this and click on 
~ . You should find this sit1gle 
row. Save the spreadsheet as 
Ch_l4_Task_l4r. 

Task 14s 
Open the file that you saved in Task 14m. 

U.ltorepr....,,t,ny!li',glodwKter 
u.,,•torepr-,t,ny-ofdwKters 

Select from all the data only the employees who have a name that contains the 
characters'O". 
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Hint 
The method shown 
here is an 
alternative to 
selecting Text 
Fil ters.then Equals 
andentering *O'* 
~re clicking on ..... 

Hint 
The method shown 
here is an 
alternative to 
selecting Text 
Fil ters.then Equals 
andentering ?ea* 
then ~ . 

Again., sdect the Text Filters from 
the drop-down menu in the Name 
column. 1l1is time select the 

(mni.. H ~-==;::::::::J=l.il __ go;~~l~::·d. iyp~~~l.,poeis~:pt: !::;e 
@ t,,d e a-

'-'""'"'""'""""""-.-"dl,<Nr«ll'I" u.,•1,, ___ afdw1Clef"1 

Task 14t 
Open the file that you saved in Task 14m. 

right box and click on ta. You 

should fmd these four ro\vs. Save~ 
the spreadsheet as Ch_l4_Task_l4s . 

' . ' 
-: :::-,-, .. .. ,-~,~ i.l 
., ,,._...._,,o'lM .. y ' """'"""-' 
,~ •••1-0.u""'•"t1" ,,.Ma<UIU<l< 
ZO S..1nO'Byme J11othou"'De>itn 

2l l<ianO'llti<co~ 3 11othou,~D<><iEn 

Select from all the data only the employees who have a first name that has the second and 
thirdlettersas 'ea'. 

Using the same methods as the 
previous searches, select the Text 
Filter from the drop-down menu 
in the Name column. This time 
select the Begins With ... option 
and add the characters ?ea to the 
right OOx before clicking on~­
This tells &eel that the first letter 
can contain any cl1aracter. Then 
there must be the letters 'ea' 
followed by any other cl1aracters. 

r~:e s~~l~~:~~~i:::::wo rows. ~._,,..-=c------c---r--c----r----c----,-

Ch_l4_Task_l4t. 

j
l Currenlclientl~t 

Name ~ T,ukcooElcurrenlTa~k . G 
SeanO'Byme 3 Hothou!i,!!Des1gn 
LeaC;ibusbusan 7Roclc 1CT 

Activity 14j 
Open the file that you saved in Task 14h. Select from all the data: 

a) allthestudentswithaforenamethatstartsorendswiththeletter'R' 
b) allthestudentswithaforenamethatcontainstheletters'eth' 
c) all the students with a forename that contains the letters 'Jam' and who have a tutor 

who uses room 60. 

14.5 Sorting data 
Before you try to sort any data, make sure that you select all of the data for each 
item to be sorted. One common error in practical examinations is to select and sort 
on a single column. If you were to do this, the integrity of the data would be lost. 



Hint 
You can sort into 
descending order 
rather than 
ascending order by 
selecting Zto A 
ratherthan Ato Z 
in the Order box. 

Data analysis 

Table 4.6 gives an example showing correct and incorrect sorting on the sn1dent's 
name for a spreadsheet containing their test results in Maths and English. TI1e 
yellow shaded cells show the areas selected for the sort. Note how the results for 
each person have been changed when sorting without highlighting all the data. 

Name Maths English 

Karla 72 75 

Marcos 64 34 Marcos 64 34 Marcos 64 34 

Vikram 61 Shelia 72 75 Shelia 61 44 

Karla 52 75 Vikram 61 44 Vikram 52 75 

Table 4.6 Correct and incorrect data selection for sorting 

Task 14u 
Open the file SALARY.CSV. 
Sort the data into ascending order of surname, then ascending order of forename. 

Open the file SALARY.CSV. Highlight all the cells in the 
range A2 to C43. Do not highlight row 1 or the column E AutoSum • Jir:. i9t\ 
headings would also be sorted within the employee I !ii Flll__:--r- 'LI 
~~::~~~~~~ ~0;1::;~;::;r:1:t:~ ~:~~;;:::·~ a,. ~~~,~ ;!7:d~ 
menu. Select Custom Editing 

Sort ... to open the Sort , ... 

window. In the Sort by lc1~=..,=~=",=, ~~=,.=.=".=~=-=,=.,,=!=[,]~7=~=-=.~-,-,-•• -~--~.11 
boxselcct Surname from ~ """" - ,_, I 

~~=~~;~:;~s~il' ~..,. ~~r ... , GI 
forthisrask.Makesure 
that the Order OOx 
contains A to Z to sort 

~:~!~ta into ascending ~ ~ 

To add the 
secondary sort to this 
data you need to add a 
second level to the ..._, "'"'"" 

Sort window. Click on ,_/~'l+ 1 r/:::- --__,-~i /::: ~Ill! 
E,1.!edd ,....s to add the . 
second sort level. In 
the Then by box select / 

Forename from the/ ~---------~~~~°' 
drop-down list. Again, ~ ~ 
make sure that the 
Order OOx contains A to Z to sort the data into ascending order. Click on ~ to 
perform the sort. 

1111 
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The data should look like this. ----__J 1 For:._ _M,!, 
Activity 14k 
Open the file that you saved in Activity14h. Sort the 
dataintodescendingorderoftutorname,then 
ascending order of forename. 

14.6 Using disp lay features 
Many of the fean1res described in this section can be 
applied to an individual cell, a range of cells, to one or 
more rows or columns, or to the entire spreadsheet. 
To apply the feamre to the entire spreadsheet, click in 
the top left-hand comer of the sheet. 

_;=::;::::~ = :rc::r. 

Frobish~ 

S cam.ron G«nhMn 

9Jake 

12 !8gk) 
U BIVn Guthri• 

l4Ullk Kaznla ..., 
16Kristy Kiili 

"" 

.... 
""" '""" -
-moo 

.... -
---fi--- - - ---!!L-To select a row or rows, click on the 

= 
number or numbers to the left of the 
row and it will select all the cells in 
that row. 

To select a column or columns, click on the column letter or letters to select all the 
cells in the column or columns. To select a single cell, click in that cell. To select a 
range of cells, drag the cursor to highlight a range of cells. If you need to select 
different cells or ranges from different parts of the sheet at the same time, hold down 
the <Ctrl> key whilst making your selections. 

Enhancing data 
To enhance data, first select the data to be enhanced. 
All of the enhancement feamres are located using the 
Home tab. The Font section contains icons to allow 
you to set the cell contents to underlined italic 
(sloping) or bold.---------~ 

The font size of a cell can be changed br either 
typing a new size in the point size box or using the 
drop-down menu to select a suitable size. 

Cells can also be enhanced using difl:Crent colours for 
the background of the cell. Again, highlight the area to be 
coloured and select the drop-down menu from the Fill 
Colar icon. The drop-down menu looks like this. There 
are a number of standard colours as well as colours selected 
by Excel for the current colour schemes. If the colour that 
you want is not there, click on the colour palette icon. 

If you are selecting colours, ensure that the 
foreground and background colours contrast and can be 
easily seen when printed. 1l1e foreground colour of a 
cell (the font colour) can be selected in the Font section. ~~----~ 
The Font Col o r icon is to the right of the Fill Col or icon. TI1e drop-down menu 
from this icon is the same as the menu for the background colour. 
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Activity 141 
Openthefilethatyousaved in Activity 14g. 
Set all the cells in rows 1 and 36 to bold and italic. Underline the cell containing your name. 
Set cells Al to Cl to have white text on a black background. Set the background colour for 
each of the cells in the range A37 to A40 to match the colour of each house. 

Formatting cells 
Formatting cells containing numbers changes the way a cell is displayed, but does 
not change the values held within it. 

Task 14v 
A Create a spreadsheet model that looks like this. Place 

a formula in cell C2 that multiplies the contents of cell 
A2 bythecontentsofcell 82. 

1 First second Product 

Format cell Al.as an integer. 

Create this spreadsheet as shown. In cell C2 enter 
the fonnula = A2 • B2. 1l1e spreadsheet will look 
like this.-----------

To format cell A2 as an integer, place the cursor 

1.2 

in this cell and select the Home tab. In the Number section, click on the arrow in 
the OOttom right corner to open the Format Cells window. 

\Vhen this window opens, it should have the Number tab selected. The Format 
Cells window will allow you to format cells in different currencies, into percentages 
or even as dates or times. 

Forth1s task,youneedtoformatth1scellas El-
a number Select the Number opnonm the _ -· .,.,- ;; ., ,_ 

~ a~e&:2'm~~t~~~e~ h~~~~!1~ ~ ~~:~ttmg ~
1 

~ I 

,h, fonnamng Thcsp~adshcct will now l= k ::- Ii ::;::-• 
hr; l ,,,.t sero~d "'°"~" ~ . i" L 2 1 s 6 ~:.-·-~----.... --
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If you compare the two views of the spreadsheet, you can see that cell A2 has 
changed. The contents still remain 1.2 but in the second view the answer for the 
product appears to be incorrect. To change the contents of cell A2 to a whole 
number, use the INT function. 

Original Fonnatted 

A C A C 

1 First Second Product 1 Fi rst Second Product 

1.2 5 6 

Task 14w 
Open the file COSTS.CSV. Format cells A 1, D1, D3 and G3 as a bold 14 point font. 
Format all numeric cells in row 2 into their respective currencies to 3 decimal places. 
Format all numeric cells in columns C and D into pounds sterling with 2 decimal places. 
Format the cells ES to E15 into Euros with 2 decimal places. 
Format the cells F5 to F15 into Japanese Yen with O decimal places. 
Format all cells between GS and G 15 into percentage values with no decimal places. 

Open the file COSfS.CSV. Click in cell A L Select the Home tab, find the Format 
section, then use the drop-down list to change the size of this cell to 14 point. 

Click the mouse on the Bold icon to set this cell to bold. 
Click on the Format Painter icon and click in cell DL Click on the Format 

Painter again and click in cell D3, then Format Painter again and cell G3. This 
process should copy the formatting from cell A l into these other three cells. 



Hint 
If the currency 
symbol that you are 
lookingfor(e.g. Y) 
may not appear in 
the drop-down list, 
there are a number 
of text options 
available. In this 
case you can select 
JPYwhichisthe 
international 
standard code for 
Japanese Yen. 

Hint 
An alternative to 
this for percentage 
valueswithno 
decimal places is to 
highlightthecell/s, 
select the Home tab 
and click the 
Percent Style icon 
in the Number 
section. 

Move the cursor into cell E2. In the 
Number section, click on the arrow in the 
bottom right comer to open the Format 
Cells window in the Number tab. In the 
Category: section, select Currency. 

Set the number of decimal places to 

three. Although this is not the correct 
number of decimal places for Euros, it 
was specified in the task. 

In the Symbol: section, select an 
appropriate Euro format from the list. 

Data analysis 

You may need to scroll down the list of ~ ~ 

available currencies to find it. TI1e Sample i~~~~~~~~~~f area will show you what the fonnatting of 
the cell will look like when you click on 
~ . When you have checked this 
formatting, click on ~ . 

Repeat this process for cell F2, but this 
time selecting Japanese Yen. Some 
currencies like Japanese Yen have no 
decimal places and so would nonnally 
need to be formatted to zero decimal 
places, but in this task you were told to 
set this cell to 3 decimal places. The 
Format Cells window should look like 

-··- _ .. ____ ..... __ ~ .... -
this. Click on J!:. 

To fonnat all the numeric cells in 
columns C and D, highlight all cells in the range C5 to D15. Then open the Format 
Cells window and set the Category: to Currency, the munbcr of Decimal places: to 

two and the Symbol : to pounds sterling (£ ). Repeat this process for cells E5 to El5, 
selecting Euros with 2 decimal places, and for cells F5 to Fl5 with Japanese Yen set to 
no decimal places (which are the appropriate fonnats for 00th of these currencies). 

To fonnat all cells between G5 and GlS into percentage values, highlight this 
range, then in the Format Cells window set the Category: to Percentage. Set the 
number of Decimal places: to 0. Resize columns as necessary. The finished 
spreadsheet should look like this. 

t Current jobs 

7Hothouse Oeslgn 

13 KOthouseOesign 
1-ol Blnl"IKCOUnt 

U KOthouseOe..ign 

Exchanae rurope Japan 

Job referen<:e Esti<Nle Cost Increase 
£urope ~Pill "lnaHse 

4023 0,'!40.00 £4,200.00 {A,634 ¥634,0'll 43" 

4122a,2.ooo.oo £240,ooo.oo C264,7'2l36,2lJ ,7tiO 

4123 o.oso.oo o.soo.oo cuss "1226,461 

£23,200.00 ~ .~97 ¥3>)~97 

4123 Dl.250.00 £17,500.00 09,308 11,642.00 

4129 0.400.00 £2,000.00 0.207 ¥30L94B 
4130 El0,800.00 £12,000.00 0 3,240 fLlll,YB 

£720.00 £720.00 CJ9,I U08,1tll 

U62.338 
0,000.00 0 ,~17 ¥754,SJtl 

~· .,. ... .,. ... 
, .. 
"' 
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Activity 14m 
Open the file that you saved in Activity 14g. 
lncellA41, place the label 'Total'. 
In cell 841,addthetotal numberofstudentsinall houses. 
In cell C36,addthelabel'Percent'. 
In cells 07 to C40, calculate, using absolute and relative referencing, the percentage of 
students in each house. Format these cells as a percentage with 1 decimal place. 

Activity 14n 
Open the file ITEMS.CSV. 
Format cells A4 and AS so that they are bold, italic and 20 points high. 
In cells O to F3, place current exchange rates for each currency shown. Use the internet (or 
exchange rates supplied by your teacher) to do this. Do not format these cells as currency. 
For each cell in the range C8 to F22, calculate the price of each item in the correct currency. 
FormateachofthecellsintherangeB8toF22intheappropriatecurrencywiththeappropriate 
numberofdecimalplaces. 

Adjusting rows and 
columns 

In Sectio n 4 .2, you learnt how to 
expand column widths using the drag 
handle to make sure that all data is 
visible in the spreadsheet. Row heights 
can be adjusted in exactly the same way. 

The settings for row heights can also 
be changed by right clicking the mouse 
button o n the row number on the left 
to o btain this drop-down menu. 

The row can be hidden from view 
by selecting the Hide option, or can 
have a different row height set using 
the Ro w H eig ht ... option. This o ption 
o pens the Row H eig ht window, where 
you can adjust the heig t settmg 
clicking on ~ . 

The column width can be hidden or 
adjusted in a similar way. To get the drop­
down menu click the right mouse button 
o n the column heading at the top of the 
column. 

Adjusting page orientation 

050.00 

20.00 

250.00 
,00.00 
80(),00 

20.00 

680.00 
.00 



Hint 
Thiswindowcanbe 
used as another 
way of changing 
the page 
orientation. 

Data ana lysis 

When preparing your spreadsheet for printing, you can adjust the layout of the 
spreadsheet on the printed page/s using Print Preview. To do this, select the Office 
button and then Print from the drop-down menu. Select the Print Preview option 
from the sub-menu. The print preview of the spreadsheet is shown. If you need to 
adjust how your spreadshti:t appears, you can click on the Page Setup icon in the 
Print Preview tab to open the Page Setup window. 

If you need to change the ~~~~~~~~IIIIIIIE====~ number of pages wide or tall in 
the printout use the Fit to: ,_.,...., 
radio button in the Scaling ~ ~ Ii" ... , .. ~ e L .......... 

section and select the number ""' 

ofpages. . ~'" ~ ........... ..., 
Ensurethat1fyouseta r,-...~ oi»: ~ --to, ~ .,. 

printout to a single page wide 
that all the formulae/ values and 
labels can be clearly seen. If 
the font size is so small that it is "-" '-~ ' ~ 
not clearly readable by an 
examiner, you may not be 
awarded the marks for that 
section. When you have 
cha~d the page settings click 
Oil !..!!_. 

14.7 Save and print data 
Save your work regularly. As recommended in Section 13.1, it is a good idea to save 
different versions, both in your work and in the practical examinations, each with a 
different version number. If you make a mistake and com1pt a file, you can always 
go back and redo a small part of the task without losing too much time. 

When printing your spreadsheets, make sure that you have adjusted all column 
widths and row heights to ensure that all printouts show all: 
• labels in full 
• fonnulaein full 
• data in full. 
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Remember that the examiner can only mark what can be seen. If you don't show 
that you have done, it will not get you any marks. Many candidates forge.."!: to submit 
printouts showing the formulae used - check that you have worked through how to 
display formulae in Section 14.2. You can use screenshots to show how you 
achieved your results. Make sure that all printouts contain your name, candidate and 
centre number. To print, select the Office button followed by Print. 

You may be required to export your spreadsheet data into different formats. In 
&eel, this is done by selecting the Office button followed by Save As. TI1is will 
allow you to export the data into common text formats like .txt (text format), .rtf 
(rich text format) and .csv (comma separated values). Although other export 
feamres exist, these should be sufficient for the practical examinations. 

14.8 Produce a graph or cha rt 

Hint 
Do not used 
stacked column 
charts or stacked 
bar charts for the 
practical 
examinations 

In the examination, you may be asked to select an appropriate chart for a puqx:,se. 
Which chart is the most appropriate is often very difficult to work out. For the practical 
examination, the choice will be between a pie chart, a bar chart and a line graph. 
• Pie charts: if you are asked to compare percentage values, a pie chart is often the 

most appropriate type because pie charts annpare parts of a whole. An example would 
be comparing the percentage of children who preferred ice cream, jelly or trifle. 

• Bar charts: these show the difference between different things. A bar chart is 
traditionally a graph with vertical bars, but is called a column graph in.Excel. TI1is 
is a little confusing but in the practical examinations to create a vertical bar chart 
you would need to use the 'column chart' and for a horizontal bar chart (with the 
bars going across the page) you would need to use the 'bar chart'. An example 
would be showing the number of items sold by five people in the same month. 

• Line graphs: these are used to plot trends between two variables. An example would 
be plotting the tempcramre of water as it was heated against time. You could then 
find any point in time on the graph and be able to read the corresponding 
tempcran1re, even if the temperamre had not been taken at that time. 

Creating a chart 

To create a chart, you have to highlight the data that you wish to use. This is 
highlighted in the same way as before. If all the data is together (contiguous data) 
this is easy. Sometimes in the practical examinations you will need to highlight data 
that is not kept together in the spreadsheet (non-contiguous data ). To do this, hold 
down the <Ctrl> key whilst making your selections. 

Task 14x 
Open the file EMPLOYEES.CSV. This shows the job types, the number of employees with that 
job type and the percentage of employees with that job type. 
Create an appropriate graph or chart to show the number of employees with that job type. 



Hint 
Keep your charts 
simple -do not use 
3Dchartsoradd 
features that are 
not a necessary part 
ofatask. Asimple 
chart is more 
effective. 

Data analysis 

Open the file and highlight only cells Al to BS. The highlighted data should look like 
this. TI1is highlighted area will be the cells used to produce the graph. Notice that 
the cells containing the column headings (Al and Bl ) have been included in this 
selection as these will be used as the labels in the chart (they can be changed later if 
the qrstion asks for different labels). 

l ' C 
I JobTitle Numberofst;iff Pertent;ige 

3 o.04838n 
l Engineer 
4 Ano1tyst 

6 Progr;immer 

,.! Clerfcal 

..!J 

Decide what type of cl1art you will need for this task. Look at the data and decide if 
it compares parts of a whole; shows trends between two variables; or shows the 
difli:rence. In this task, the data shows the different numbers of employees in each job 
type, so a bar chart is the most appropriate chart type and in this case you can use a 
vertical bar chart. 

Select the Insert tab and find the Charts section. Then select a vertical bar chart 
(labelled Column m Excel) and select a C lustered Column cl1art from the drop ~: ·::.-~::wr·· -::: .. ~ 

e!! ! _t ~ j ~···~~ 

Number of staff 
20 T-----~ 

:1 I. I • I. . I 
• Number of 

~la ff 
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Task 14y 
Open the file EMPLOYEES.CSV. Create an appropriate graph or chart to show the 
percentage of employees with that job type. 

Open the file and, using the <Ctrl> key 
and the mouse, highlight cells Al to AS and 
C l to CS. Do not highlight any other cells. 

Numberofstaff 

The highlighted spreadsheet should kok 3 Engineer 
like this. -------------, 4 Analyst 

Decide what type of chart you will need 5 Sales 

~~~!!si;::o~~};~~t: ;~:l;~d ~ ;::::;mmer 

shows trends between two variables; or : Clericiil 

shows the difference. ln this task, the data 

3 0.0483871 

compares parts of the whole, so a pie chart is the most appropriate chart type. Select 
the Insert tab and find the Charts section. Then select a Pie chart and the 2-D Pie. 

,---:.:.::~rr:~~'.i,, Ii.£ 
• An• l).'>l 

• Salo, 

• l>rognmmi:r 

• Tc'S!<r 

Task 14z 
Open the file RAINFALL.CSV. Create an appropriate graph or chart to show a comparison of 
the monthly data for towns A and B. 

Open the file and highlight cells Al to ClS. Decide what type of chart you will need 
for this task. Again, look at the data and decide if it compares parts of a whole; 
shows trends between two variables; or shows the difference. In this task, the data 
shows trends between the date and the total amount of rainfall that had fallen by 
that date. Because specific dates are used 
and the rainfall is cmnulative, a line graph 1:1 
is the most appropriate type. As there are , om 11.n1..... v-

::~;~\::~~~r::::;111~: :~:i~;i~th • :, l2 \) 
~~~::;

8
t:~~~~~\~:=~1: s~~1: a;~;~ ~:1~ht~e c- UM ~ ~ N:• ~ .. :!'::. 

2-D Line (the top left icon). 
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The finished line graph will lCXJk ~ like tl,s. Save this clmt foe btcc use. - ,~ ~ g: 
]~~ 

Modifying a chart 

Task 14aa 

11~ 11, m<U~< 

Tu"IIB 

Open the chart saved in Task 14x. Add a chart title 'Employees', category axis label 'Job type' 
and value axis label 'Number of staff' . Do not display a legend. 

You have to add a new axis label to the category axis. To do this select the Insert 
tab, then in the Text section select Text Box. Click the left mouse button on the 
chart near the category axis and type in 'Jo b type'. Resize the text OOx and change 
the font style, size, etc. to match the rest of the chart. Move the text OOx if necessary. 

It should l=k si~::,::e~,is j l ~~{;}~~:;E;:!£S~~{:.i:i:ht 

i I 
the to.1: OOx for 'Job type', copy and 

I I paste it, then edit and move it. This will I . ... save time forma_ui_ng the new text OOx 

I , , I ::r: t~7e t~:x~:~~~~1~~ !~~;~1 
,/ / ·~~/ ,.I .::::.. usiug tl,c gceeu h,udle. 

Employees 

After rotating the text, move the chart and 
place the value axis label to the left of the axis. To :: I 
remove the legend (the key), click the left mouse ': I I 
button o n the legend and then press the < Delete> I ', I key. Agaiu, editthcl,yout of the clmt so tl,at it i I I I 
lCXJks!ike this.-----------'+-

/// ~/ :,~ 
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Hint 
It is worth spending 
time browsing 
through each of 
these chart layouts 
to see what is 
available. 

A ctivity 140 
Open the file that you saved in Activity 14a. Use this data to produce a vertical bar chart 
comparing the number of days worked for each person, except Aminat and Sukrit. Add an 
appropriatetitleandlabelstothechart. Do not include a legend. 

Act ivity 14p 
Open thefileWEBHITS.CSV. This contains data about the number of members for an online 
book club and the average number of website hits each week over a nine year period . Create 
and label an appropriate graph or chart to show a comparison of these two sets of data. 

Task 14bb 
Open the chart saved in Task 14y. 
Display all segment labels and percentage values on the chart. Do not display a legend. 
Extractthesegmentforengineers. 

Open the chart saved in Task 14y, click o n the chart with_........,..; 
the left mouse button and select the Design tab. Select from ~ l~ l ~ _ 
the Chart Layouts one which displays the segm ent labels L!!!JL~ ~ L: J "" 
and percentage values. Other layouts d isplay the segment =="""""""""'-_. 
labels and values, some include a legend. Selecting the first 
option changes the ch art from this to this. 

"°"°""'' / ""' 

To extract the segment for engineers, click the left 
mouse button on the segment fo r engineers and 
then click again. Now click and hold the mouse 
button to drag the segment out from the pie in the 
direction o f the red arrow shown in the diagram 

~i~ : ~}l~~Jeur~:t: a! ef~;ra:::
1

: ::. ~ 

Activity I 4q 
OpenthefilethatyousavedinActivity14m. 

Percenbi,:e 

Percentage 

Create a pie chart showing the name of each house (the colours) and the percentage of the 
dass in that house. Add the title 'Percentage of students in each house' . Extract the segment 
for the Yellow house. 
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Using secondary axes 
Task 14cc 
Open the file RAINFALL.CSV. 
Create an appropriate graph or chart to show a comparison of the rainfall and average 
temperatures for each month in only t own A. Add a second value axis to the chart for the 
t emperature series and labeland scaletheseaxesappropriately. 

Open the file RAINFALL.CSV and highlight 
the dates and data for Town A; this is in cells 
Al to BlS and Dl to D15. Select the Insert 
tab and then in the Charts section select a Line 
graph. Use the top left option from those 
available (this will generally be the most 
frequently used choice). The line graph will 
look similar to this. -------~~ 

It is difficult to read the values forthc 
temperamre, so adding and scaling a ""' 

rea~t; fe)~t mouse button on the """ 
data series for the temperamres (the --- ''° - ~ .. .. - .... 

secondvalueaxiswillmakeiteasicrto = 
red data line in diis example), so that ' 00 

_ _ ,..__. 

it shows each of die points plotted like 50 
-...--, ..... • 

this. Right click the mouse button on • 

~:~1a1~~:i:1~
0

s~l:i~ ! ~n~:OK,ta a .j" 0~~ #' a ~~ .)~ 

Series .. .. 1liis opens the Format 
Data Series window. 

Select die Series Options section on the 
left (it may already be selected), and use the 
radio button to change die axis type from a 
Primary Axis to a Secondary Axis. Click on 

;~·--··-1-1:·· 
so 0 

O .5 - A,·cmg,, 

-- IXM>"''"" -a.w. "" '""'°" _,. e,._,._ 
~ ............. 

= 
The secondary axis is now visible. Excel has attempted to scale diese axes but you 

are now going to adjust them futther. You will change the primary axis so diat it is set 
between O and 240 and the secondary axis so that it is set between - 1 and 23. These 
values have been o..:racted from die original data: the total cumulative rainfall is 
240 millimc..'tres, and the temperature changes between -1 and 23 degrees. It would be 
acceptable to use values like -2 to 24 or even the -5 to 25 suggested by b::cel for diis. Ill 
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Tochmgctl,cprim,.-yaxis ~" 
values click on the axis labels like this. 10 

. . . , 
_ ........ - -. ·-·-·--~ 

lu.PF. Opto~s - ... - in - ... , ,::J 

::: ::: :::: ,:." 11 
;=M:...:-c,:- E:::J 
l'l ~ hoc.- ~~ -....... ~ 
LJil-dopa.,<nhw.lon<nl 

It is important to label these axes 
appropriately. Label the primary axis 

,i,:'.#';.~;;.,;.":%,,<>' 
Right mouse click within the axis 

labels to obtain the drop-down menu and 
select Format Axis ... to open the 
Format Axis window. In the Axis 
Options section, change the Maximum 
value to a Fixed value using the radio 
button. Change the value to 240.0 and 
click on ~ . 

Follow a similar proct"Clure for the 
secondary axis. Click the left mouse 
button on the axis, then right mouse click 
and select Format Axis ... to open the 
Fonnat Axis window. In the Axis 
Options section, cl1ange the Minimum 
value to a Fixed value of - 1 and the 
Maximum value to a Fixed value of 23. 

'Cumulative rainfall in millimetres' and -·--· 
the secondary axis 'Average ----1 
temperature'. 1l1ese changes should leave the chart looking like this. 

The legend has been moved so that all of the category axis labels are fully visible. 
In the earlier printout only every second label was visible. 1l1e category axis should 
also be labelled and the chart given a title before it is submitted for assessment. Save 
the file. 

Activity 14r 
Open the file that you saved in Activity 14p. 
Add a second value axis to the chart for the number of members and set the maximum 
value for this axis to 3200. 
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Formatting graphs and charts 

You have already learnt how to enhance a pie chart by extracting a segment or 
segments. Charts can also be enhanced using colour and/or shading. In some 
circumstances, the use of colour can be used to ensure that the person reading a 
document has their attention drawn to one specific part of a chart. 

Task 14dd 
Open the chart saved in Task 14bb. Change this chart so that the segments for 'Programmer' 
andfor'Engineer' attract a reader's attention. 

Open the chart saved in Task 14bb and click the ~ 

left mouse button on the segment for 'Programmer' 
and then click again, so that only that segment is 
selected. Select the Home tab and in the Font 
section click on the Fill icon. Select a bright colour, 
for example red, from the colour palette. Repeat 
this process for the 'Engineer' segment, this time 
selecting bright yellow (bright orange may be 
better if printing the chart). Now select other softer 
colours for the other segments. The chart should 
look similar to this. 

You can see that the brighter colours for the two 
segments stand out and the softer pastel colours are not as prominent. 

Activity 14s 
Open the file that you saved in Activity 14q. Change the segment colours to match the 
labels for each segment. 

Using colour to enhance your charts is useful if you have a colour printer, but 
printing a document created in colour on a black-and-white printer can cause 
problems. 111is book has sections of coloured text designed to outline key elements, 
like words in the glossary shown in red, instrnctions to follow in blue and field 
names in green. If a page containing these three colours was printed on a black-and­
white printer, each of the three colours would appear as a shade of grey. It would be 
impossible to identify which words were glossary terms, instructions or ficldnames. 
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With a black and white printer it is sometimes difficult to ensure that there is t,mugh 
contrast between ditlC:rent parts of a graph or chart, for example this chart, appears like 
this if it is printed in greyscale (black and white). 

:::: ~l::· : +--- t--
ProductB 

500 500 

0 

Sales 

Hint 
An alternative is to 
use gradient fills 
which are also in 
the Fi ll section of 
the Format Data 
Series window. 

2009 21ll0 

• • 

2009 2lllU 

In this case, choose more contrasting colours, like a very light and a dark colour, 
or use a patterned fill for one of the columns. To choose a patterned fill , dick the 
right mouse button on one of the bars, in this case the right-hand bar. From the 
drop-down menu, select Fonnat Data Series ... , then in the Format Data Series 
window select the F ill section. Select the radio button for Picture o r texture fill 
and choose a pattern from those available in the drop-down menu from the 
Textu re : box. Click on i:aii:i. 

Texture fills can also be applied to pie charts. Select a segment and right dick the 
mouse button, then select Format Data Point ... to edit the fill type. 

Activity 14t 
Open the file you saved in Activity 14s. Change the background fills so that each segment is 
distinctivewhenprintedinblackandwhite. 



Website authoring 

I this chapter you will learn how to: 
define and use HTML tags 
use a text editor to create a webpage 
display your webpages in a web browser 
format text using pre-defined styles 
align and enhance text 
create, edit and attach a cascading stylesheet 
create styles using specific and generic font fami lies 
set font sizes using absolute and relative values 
use classes within a stylesheet 
annotate your markup with comments 
create numbered, bulleted and nested lists 
use colour names and hexadecimal colour codes 
apply colour to text and backgrounds 
use anchors and hyperlinks within a webpage, to external pages and to 
send email 
open a webpage in a new window 
design and create page layout using tables 
create and format tables, including header, footer and body sections 
insert, place and manipulate an image within a webpage 
manipulate an image in a graphics package 
create a hyperlink from an image. 

or this chapter you will need these source files from the CD: 
• ALIGN.CSS • SUBSCRIPT.HTM 
• COLOUR_CODES.HTM • TURTLE.JPG 
• CLASS1.CSS • WEBPAGE1.HTM 
• HTMLTIPS.HTM • WEBPAGE2.HTM 
• PCTC.JPG • WEBPAGE3.HTM 

• REMORA.HTM • WEBPAGE4.HTM 
• REMORA.JPG • WEBPAGES.HTM 
• STYLE1.CSS • WEBPAGE6.HTM 

• STYLE2.CSS • WEBPAGE7.HTM 
• STYLE3.CSS 

15.1 Introduction 

What is a website? 
A website is a collection of individual but related webpages that are usually stored 
together and hosted by a web server. These can be programmed or created using 
different languages including HTJ\.1L, Sun Micn»ystems jaw, and Microsoft ASP. Each 
webpage can include a variety of different objects such as text, images (including 
moving images) and sound. You are going to develop your webpages in HfML. 
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What is HTML? 
HfML is an abbreviation for HyperText Markup Language. It is a text-based 
language used to develop websites, and is often used within an intranct or on the 
Internet. Files arc written in HfML using a simple text editor (or web-authoring 
package like Macromedin Drenmwem,er or Microsoft FrontPnge ). Files arc written in 
text format and arc usually saved with an .htm file extension. Tiicsc arc file formats 
that arc recognised as wcbpagcs by web browser s like Microsoft Interna Explorer or 
Mozilla Firefox. You arc going to develop your wcbpagcs using a simple text editor. 

Getting started 
A good technique for working on wcbpagcs is to tile three windows on the screen at 
the same time: this means to fit them side by side like tiles. \Vhcncvcr you do any 
work in HfML, it is recommended that you have a text editor, a web browser and a 
list o your ilcs in their storage older visible. Select the Start button, followed by 
Documents. This opens die Documents window, which will look similar to this. 

1>::::-­
-.1:.:.. ....... [il ---­
ra ... ----a---•--b--·-
,ti.- ... -. 

•·-
/ii ... ---­!),----

Place this window in the lower left 
of the screen and resize it to fill about 
a (jUartcrofthc screen. 

Create a new folder for your 
HfML work in your user area by 

'ill<•."·-·' 
fllo .1>.-., 

clicking the right mouse button on r.::;;::;;;:;:;:;;::==:;;:;::::;::::J.:::!;:!!;!!!~ 
the background for die file list on the 

right and selecting New followed by 1;":11"·~ .... IMl'"••••iiiiiii. 
Folder. Rename diis HTML. The [~ 
location of diis will depend on the 
strucrnrc of die system you arc using. 
Go into this folder and create new 
sub-folders for each task in diis 
chapter. Call these folders Task 15a •• =,...• 
to Task 15w. For each task in this • • a.,,...,o 

chapter you must save all die files for ; · • °"""'" 
that task in die correct folder. : : =~ 

Make sure you an: in the folder :•::=: 
Task 15a. This is where all the work · • ~, .. 

ll 

from die first part of diis chapter waJJ -;: e 1,.., 
be stored. The window should look/ Lo 
similar to this. ._-----~-- -----



Hint 
When using 
stylesheetslaterin 
this chapter you will 
have more than one 
copy of the text 
editor open and 
may need to tile 
these on the screen . 

Hint 
Notethatalltextin 
HTML tags should 
beinlowercaseso 
that if it is 
structured correctly 
itwouldneedlittle 
editing to become 
XHTML. 

Website authoring 

Open your text editor; in this case you are going to open Notepad. This can be 
opened by selecting the Start button, followed by All Programs, Accessories and 
selecting Notepad from the list of programs. Place this window in the top left of the 
screen and resize it so that it fills about a quarter of the screen. TI1e text editor will 
be where we write the HTML markup to create each webpage. 

Open your web browser and resize this window so that it fills the remaining half of 
your screen. Make sure that the windows fit together and do not overlap. The screen 
will look similar to this. 

·­·-
i§~ ~ 
·-· 

Although many people refer to HfML as a programming language, that is not 
strictly tme. It is a markup language that uses a set of markup tags to describe a 
webpage to the browser. HTML tags are shown using angle brackets around them 
like this: 

<html> 

The angle brackets tell the browser that this is a markup tag and not text to be 
placed on the webpage. The browser does not display the HfML tags, but uses the 
tags to display the content of the page. Most HfML commands have pairs of tags, 
one to open the command and one to close the command. Eacl1 tag has a pair of 
angle brackets around it. 

The first tag that will usually appear in any webpage will be < httnl > . This tag 
tells the browser that everything following this rag will be written in hypertext 
markup language. TI1e tag < /html > tells the browser that this is the end of the 
markup language. TI1e forward slash shows that it is a closing rag. All other HTML 
tags will appear bc..'tween these tags. 

Each webpage will have two clearly defined sections, the head and the body. The 
head section starts with < head > and closes with < /head > and objects between 
these tags are not usually displayed by the web browser. Only a few tags are 
universally accepted within the head section of a web page, these are: < base> , 
< link> , < m eta> , < title> , <sty le > and <script > . The body section starts with 
< body> and closes with <{bod y> and objects between these rags should be 
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Hint 
lfyoulookatother 
websites'HTML 
markupyoumay 
find a doctype 
definition before 
the<html>tag. 
This is normal but it 
is beyond the scope 
of this book. It will 
be needed if you 
wish to validate 
yourwebpages. 

displayed by the browser. The body 

section should always contain a titleJ <html> 
This is tl1e name displayed in the <head> 
browser toolbar. It is the page title if a r </~~! ~~e>Webpage name</ title> 
page is added to Favorites and is the <body> 
title displayed in search engine results. ~ 

;:;u~;s!~es:~~:u:c~:i;~
1
rh:::ra:~ :;~~i: 

Insert tags for tl1e head section here. 
Insert objects to be displayed by tl1e browser in tl1e body section here. 

15.2 Format text using pre-defined styles 

Hint 
It is essential that 
the text is typed 
exactly as shown 
here.One typing 
error may cause the 
webpagenotto 
function as 
expected. 

Hint 
It is acceptable to 
use capital letters in 
the text that is 
displayed on the 
page, but not in 
the tags. 

All text added to a webpage should have a tag telling the browser what the text style 
should look like. There arc a number of pre-defined styles available for use in a 
webpage. The normal paragraph style is obtained using <p> and ended with </p>. 
Likewise, six heading styles arc available and arc defined with tl1e style name.s < h l > 
to <h6> . 

Task 15a 
Create and save a new webpage showing paragraph and heading styles. 

Click tl1e cursor into the text editor. Type this markup into the editor, replacing MY 
NAM.E HERE witl1 your name. Remember to always add your name, centre 
number and candidate number to all of your printouts., 

<html > 
<head> 

<title>Ta sk 15a/ title> 
</head> 
<body> 

webpage by MY NAME HERE</p> 
style hl , the l argest heading style</hl> 
style h2 </h2> 
style h3 </h3 > 
style h4 </h4 > 
style h5</h5 > 
style h6, smallest heading style</h6> 

s t yle p, the par agraph style</p> 



Hint 
Some browser 
settings will make 
thisopeninanew 
brawserwindow, 
rather than the one 
that you have just 
opened. 

Website authoring 

When this has been entered and carefolly verified (by checking this original 
document with your typed copy), you must select File followed by Save As ... , 
which will open the Save As window. Click on Browse Folders to expand the 
window. The expanded window will lCXJk similar to this. I 

I .. .. 
'"""""'l••-r·"" ··-·- -~= ~ 

"..~~·-~-iliiii!~ii~~~~~~~ Click on the folder names ~ ~ 
until you find the Task 15a 
folder created earlier in this , l. 
chapter. ...... , ..,.. 

00·1• -,~ ... . ,,,,-

• M <"'f<all • 

:: ~~:~ [) 

.. ~- ~:::;:..: ....... =~= ~1:~:=-

appears if you forget to add the 
.htm extension to the filename. 

Select the file Task 15a from 
the Documents wind~w and drag 
this file (holding the left mouse 
button down) into the browser 
window. The screen should now 
ICXJk similar to the screen shown 
overleaf. The browser view now 
contains your first webpage. 
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-· ___ , ... 
:::? .sl 

Th i~ i~ ~fyle h 1, t he l:H"ge~t 
heading style 

15.3 Openi ng existi ng webpages and enhancing text 

Hint 
Editingiseasierif 
you ensure that the 
word wrap is 
selected in 
Notepad. To do this, 
use the Format 
menu and check 
that the Word Wrap 
option is ticked. 

To open an existing web page in 00th the text editor and the web browser you must 
first find the website in the Documents window. For all webpage files, including 
those given in the examination, it is advisable to copy the files into a sub-folder of 
your HfML directory before starting. 

Task 15b 

Open the file WEBPAGE1 .HTM and view this webpage in both the text editor and browser. 
Improve this webpage by emboldening the word 0bold', setting the word 'italic' to an italic 
font, setting the 3 in x3 as a superscripted character and setting the 2 in H20 as a 
subscripted character. 

Copy the file WEBPAGEl.HfM into your Task 15b folder. Drag this file from the 
Documents window into your text editor. Drag another copy of this file from 
the Documents window into your browser. The screen should look like this. 

..,_.._,,,,,._, ... 
Tntc101><,-...1,dlffer<ol w:,y1. Hert•rt ,...., ... ~ ........ ,, 



Hint 
If you prefer you 
can click the mouse 
on the browser 
window and then 
press the function 
key<f5>torefresh 
thebrowserview 
each time you have 
saved the file . 

Website authoring 

Move the cursor into the text editor window and make the following changes to 
the markup. 

Replace the word 
'first' with 'second' . <hea<l> 

N~[l:;E~ -= -·th--~<=U=U=e>='"="~ '=' ='<~n =" ='e~>~ I 

your name. 
Place the tags < b ~ 

and </b> around the 
word 'OO!d'. 

qi>My second webpaqe by Graham Brown<:/p> 
<h2>Text can be enhanced in <liUerent ways . 

some or those ways . </h2t 
<p>Textcanbema<le<b>bol<l</b></p> 

Place the tags < i > 
and </i> around 
word'italic'. J 
<s~~a: a\7; ~,:up > 
around the number '3'. 

:~:~::: ~~n~~ :<l~nJ ;~~~!~"~~/~:~~~> versions or html 

because it looks lil<e the text is a hyperlink</p> 
b p Jp t 1 J r <SUp>3</SUIJ></p> 

<p>Textcanbesubscripte<llikeH<:sub>2</sub></p> 
</bo<ly> 

Place the tags <sub > and < /sub >--------~ 
around the number '2'. 

vVhen you have made all these 
changes to the webpage, save the page 
by selecting the text editor, followed by 
File, Save As ... , selecting the T ask 15b ~ = -----'====~ 
folder and entering the filename 
T ask_l5b.htm before clicking on -

Test the webpage works by dragging 
this new filename from the Documents 
window into the browser window. The 
new browser view should look like this. 

Activity 15a 

T ext can be enhan ced in diD"erent 
w11y.s. lien: pre; ~omc of those ways. 

To.i""""bc-~JL,,l 

Open the file SUBSCRIPT.HTM and view this web page in both the text editor and bro.vser. 
Improve this website by emboldening the word ·emboldened' and setting the word 'italic' 
to an italic font . 
Set the 2 in 10 metres2 and the 3 in 500 cm1 as superscripted characters and set the 2 in C0

2 
as a subscripted character. 
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15.4 Working with styles 

Hint 
Remember to always 
add your name, 
centre number and 
candidate number to 
all of your printouts. 
Youwillnotgain 
any credit in the 
practical 
examinations if 
there is nothing to 
identify the 
candidate on the 
printout. 

Hint 
If you attach more 
thanonestylesheet 
toawebpageat 
the same time, 
those attached 
laterinthemarkup 
have priority over 
earlier ones. 

Hint 
Copy all HTML 
exactly as shown, 
including any 
spaces. 

Using styles in your webpages helps you to be consistent in the way the pages look. 
Using styles is much quicker and easier than applying individual settings, such as 
font face, font size, text alignment and font colours, to every piece of text in each 
webpage that you create. 

You have already met the heading styles h 1 to h6 and the paragraph style p 
earlier in the chapter. vVhen you used these styles the web browser did not find any 
of these style definitions in your HTML markup so used its own default settings. 
However, you can set your own definitions for each style and the web browser will 
attempt to apply these styles to the page. Styles are not only set for text, but can also 
be used to define page layout, colour schemes and default settings for other objects 
and links on the page. Using consistent styles is often important to give a 'corporate 
feel' to a website. Particular elements like colour schemes, logos and font faces are 
sometimes used to aid recognition of well-known companies or brands. 

Styles are always defined in the head section of a webpage. They may be defined 
in each webpage or defined in a stylesheet. If stylesheets are used, the styleshect is 
attached to the webpage in the head section of the markup. Although styles can be 
applied individually to each page, it is more efficient to write, edit and attach one or 
more common stylesheet/s to all the pages in a website. 

Using slylesheels 
You have already used different styles in your webpages, for example text set as a 
heading style (hl to h6) or paragraph style. These styles are often gathered together 
and held in a styleshect. This is a collection of styles saved in a different file in 
cascading stylesheet (.css) format. 

One or more of these cascading styleshects can be attached to a webpage, and the 
styles in the srylesheet will be applied to this page. vVhere more than one webpage is 
used, the styles only have to be defined once and attached to all webpages. This allows 
companies to develop different styleshet'ts for specific itelllS like corporate colour 
schemes, cmporate text styles and styles for a particular documt,1t or set of documents. 

Task 15c 
Open a copy of the webpage that you saved in Task 15a. 
Apply the stylesheet STYLEl .CSS to this page and save this webpage. 
Change the attached stylesheet to STYLE2.CSS and save this with a new filename . 

Select the folder called Task 15c in your Documents window. Copy the file 
Task_ l5a.htm into this folder. Rename this file as Task_lSc.htm. Open this file in 
your text editor and in your web browser. Copy the files STYLEl.CSS and 
S1YLE2.CSS into this folder. 

Change the title of the webpage to Task 15c. To apply the styles from the 
sryleshect STYLELCSS you must attach it to the webpage. Move the cursor to the 
text editor containing the HfML and add this line of text below the title tags in the 
head section of the markup. 



Hint 
The browser 
settings on your 
computer may 
show you different 
fonts to those 
shown here. 

Re minde r 
In this book: 

HTMLmarkupis in 
blue text. 

Astylesheetisin 
red text. 

Website authoring 

This defines the relationship of this link as a stylesheet, in cascading stylesheet 
format and searches for the file stylel .css and applies this to the page. Your finished 
markup should look like this. Save this webpage. View this webpage in your browser. 

<link rel = "stylesheet" tYt:e = "text/css" h r ef= "s t ylel . css " > 

<:title>Task 15c<:/title> 
n re = " stylesheet " type= "text / css " href="9tyl e 

<:body> 
<:p>My first we~age by MY NAME HERE<:/p> 
<: h l>This is style hl, the largest heading style<:/hl> 

<:h2>This i s style h2<:/h2> 
<:hJ>This i s style hJ<:/hJ> 
<: h 4>This is style h4<:/ h 4> 
<:hS>This i s style h5<:/h5> 
<: h 6>This i s style h 6, the smallest heading style<:/h6> 

is style p , the paragragh style<:/p> 

You will notice that your webpage has changed from this to thzs. 

D;,- • Q· D•• · ,,.. .• ,1:. i .. . . _ ..__._ 

T h i, ls d)'le hi , th ~ l11rge,,;f hull lngn~·le 

Thl< l•Uilehl 

This is style hi , the largest 
heac.ling style 

This i!i lltyle h2 

T hi~ i• •ty lt: hJ 

Thls iss~ la h4 

The page content has not changed but the ~O~~•=i~iiii~~, 
~?'J~re:ft:~it~~e!:ar:~;;;tv;a:, si~s, : : : ;:: ~ ~ · D• ii ·c>- ·O: .·. 
colours and aligmnent have all been ~Yf™-P•~~k>fCrah•"'B'"""' 

:;~::~ ~~:ep~~t~~~s: ~~~:~;'~: fhis is st~le hi. the lurgest heading 
many variations. If you change the stgJe 
markup to attach S1YLE2.CSS to the "fhfs f:; stgle h?. 

;~~:1:~;:rs~::~~ii!·~~, ~ ~~ ~ s~~ ~J 

This is the same webpage again, but n,;, '' • yle u 

with the slightly improved srylesheet 
S1YLE2.CSS, which has a background 
colour defined in the srylesheet. You will n. . .. ay1op, .,• r,orogro;,n•tflo 

discover how to create and amend these 
sryleshects in Section 15 .5. II 
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15.5 Creating a cascading stylesheet 

Hint 
Aseriffontisone 
whichhassmall 
lines or strokes 
(calledserifs)atthe 
ends of characters 

lik~h{erif_ 

A font that does 
not contain serifs is 
known as a sans 
serif font. 

Hint 
Any number of 
spaces can be 
placed between the 
style name and the 
opening bracket. 
This does not 
changehowthe 
browser interprets 
themarkup,but 
sometimes makes it 
easierforustoread 
themarkup. 

It is very easy to create a cascading stylesheet in your text editor. The srrucrure of a 
.css file has a few very simple mles. Stylesheets do not have tags in them as they are 
not a markup language. Each style has a style name which is called a selector. 111e 
selector is followed by curly brackets {}. Inside these curly brackets go the property 
for the style, followed by a colon and the property's value. For example, if you want 
to set the text in style hl to be eentre aligned it 
would appear like this. (Note the American - hl {text - align: center} 
spelling of 'center'.) 

Each style can have a number of properties and values. If there is more than one 
property then each property is followed by a 

::xn;\-1::~r~ i~:::;:e~t!~~i~=:\: ;:!se hl {~~~~ = :~~~~: 1~:~~er; 
high and bold it would appear like this.=-.---- font - weight' bold) 

If a value within a 
stylecontainsmorethan h2 {font - family : "Times New Roman • , serif) 

;::::

0

i~~~:~s::ks like this. ----------
Stylesheets are saved with a .css format (in a similar way to saving in .htm 

format ) from the text editor. 

Font families 
Individual fonts can be specified, but these are not always available in all browsers, 
so there are a number of generic fon t families, including serif and sans serif fonts, 
that can also be used. TI1ese include 'serif, 'sans-serif', 'cursive', 'fantasy' and 
'monospace', which has proportional spacing. The generic font family must always 
be listed after the other preferred font/s. The font-famil y property must contain a 
hyphen. In the example above, the font-famil y is set so that the browser will look at 
the list of fonts installed in the machine, and will rryto find Times New Roman first 
(it is in speech marks in the stylesheet because there are spaces in the font name); if 
it cannot find it, it will find any generic serif font that is available. 

Task 15d 
Open a copy of the webpage that you saved in Task 15c. Create a new stylesheet called 
SERIF.CSSthatsetsallthestylesasgenericseriffonts. Applythisstylesheettoyour 
webpage. View the webpage in your browser. 
Change the generic settings in the stylesheet to a different generic font style. Save the 
stylesheet with a new name. Try all the generic style settings to see what each one 
looks like. 

Select the folder called Task 15d in your Documents window. Copy the webpage you 
saved in Task 15c into this folder and rename the file asTask_l5d.hnn. Open this file 
in your text editor and in your web browser. Edit the title of the webpage so it 
becomes Task 15d. To attach the stylesheet to the webpage you must edit the tl1ird 
line of tl1e mark up so that it becomes: 

/ 
<link rel ="stylesheet" t ype= "text / css" href = "serif . css " > 



Hint 
This technique 
could save you time 
which can be 
invaluable in a 
practical 
examination. 

Website authoring 

Save the webpage. You are going to create the hl 

stylesheet by opening a second copy of the text h2 

editor. Enter the following style definitions into it.-"' h 3 

{font -fa mily : serif) 
{f ont - f a mily : serif) 

{f ont f a mily : serif) 

Carefully verify your stylesheet by checking h4 

this original document with your typed copy. 
Save the file using the filename SERIF.CSS. 
Refresh your browser so that you can see the 

{font f a mily : serif) 
{font f a mily : serit) 

{ f ont f a mily : serif) 

{ f ont f a mily : serif} 

eftC:cts that this has on the webpage. 

Grouping style definitions 

As all the styles have the same values for the font-family property, you can group all 
of the styles together and change the value only once. This stylesheet can be 

simf~~~~ :~d~:::tg~: ~~:~~hl,h2,h3,h4 , h5, h 6,p [font - family : serif} 

replaces the old version. 
Refresh the browser to check that it still works. 

Edit this stylesheet so that it sets the font-family to 'sans-serif'. Save this file using 
the filename SANS-SERIF.CSS. Change the markup in the HrML to link to this file 
and save this web page. Repeat this process for each of the other generic font families. 

Font size 
Font size can be specified by setting absolute values, by setting values relative to each 
other, or a mixrure of both. 

Absolute values can be used to set the number of points or picas or the number 
of pixels high for each character. If point sizes are used, there are 72 points to an 
inch, so a 28 point font will be about 1 centimetre tall. This will not be affected by 

~:es~:W ~; :r~1;:~::tf ~~~:1~:1~:;1~~e ~~t s1a:te!~:~e:~a:\
1
;;~t:~th 'pt' 

webpages are created using the measurement in picas, which is abbreviated as 'pc' 
and is the equivalent of 12 points, so a 2 pica font size would the same as a 24 point 
font. A pixel is one dot on a computer monitor. This means that pages will appear 
differently depending upon the size and resolution of the monitor used. For older 
style monitors, 1 pixel was often about the same size as 1 point, but full high 
definition (H D) monitors now mean that characters appear much smaller on these 
devices. The abbreviation for pixels is 'px'. Other absolute values include 'in' to show 
the measurement in inches, 'an' for centimetres or 'mm' for millimetres. 

Task 15e 
Open a copy of the webpage and stylesheet that you saved in Task 15d. Edit this stylesheet 
so that style hl is 36 points high, h2 is 24 points, h3 18 points, h4 16 points, h5 14 points, h6 
12 pointsandtheparagraphstyleis 12 points high. 
Change these settings to try and get similar results using the settings for pixels (the number 
will depend upon your monitor display settings), picas, inches, centimetres and millimetres. 
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Because all of the font settings are different in this case, it is more sensible to keep all 
of the settings for each style together. It is possible to produce a stylesheet that gives 

Although this works, 1t would be easier to edit 1f all ot the serungs for each style 

[

,h~, muks hk, ,h., 

Amend the markup for the 
hl h2 h3 h4 h5, h6 p ( font f a m1.ly ser1.f} webpage to link to the new 

dcfimnm,~mgcthcrhk,tlus J 
hl {font size 36pt) stylesheet (SIZE CSS) and save 

:~ )!::~ :~:: ~!~~( tlusmyourTask 15efolder 
h4 (font size 16pt} Savethenewstylesheetas 
h5 (font size 14pt) SIZE CSS m the same folder 
h6 {font size 12pt) Refreshyourbrowsersotl1at 
p {font size lOptJ youcanseetheeffecttl1atth1s 

has on tl1e webpage Use tnal 
and error to try and get s1m1lar 

hl {f ont fam1.ly ser1.f font size 36pt) resultsWJthtlieotherabsolute 

)!:::_:::~~: :::~:: !:~:=:~::: ~:::; siZl:settings. 
{font - family : ser"f; font - s · ze : 16pt) Relativevalues areoften 
{font- family : serif; 14pt ) baseduponpreviouslydefined 
{font- family : ser " f; font - s · ze : 12pt} valuesfortl1efonts,asdefined 
(font - family : ser " f; font - s·ze : lOpt) bytl1edefaultbrowsersettings. 

Two values are show using the 
abbreviations 'em' and 'ex'. 1 em is the same as the current font size, 2 em is twice 
the current font size, etc. This can be useful as this automatically selects the default 
fonts set by tl1e user in otl1er stylesheets or by the browser. 1 ex is alxmt half tl1e 
height of the current font size and is the measured height of tl1e letter 'x'. 

Task ISf 
Open a copy of the webpage and stylesheet that you saved in Task 15e. Edit the stylesheet 
so that the paragraph style is 16 points high. Set style h l so that it is 3 em, h2 is 2 em, h3 
1.Sem, h4 3ex,h52 ex and h6sothat it is 1.5ex. 

Open tl1e web page saved in Task lSe and edit this to attach the stylesheet 
SIZE2.CSS to it. Save this asTask_lSf.htm in tl1e folderTask_Sf. Open the 
stylesheet SIZE.CSS and edit it so tl1at it changes the font sizes like this. Save tl1is 
stylesheet as SIZE2.CSS. View the webpage witl1 this stylesheet attached. Notice the 
difference in the em and ex sizes. 

"""~,~- \ frequently used in cascading P (font - family : serif; 

stylesheets are percent~ge ~~ (font - family : serif; 
{f ont- family : serif; 

values, for example settmg the hJ {font- family : serif; 
font size to 200 per cent h4 (font - family : serif; 3ex) 

would force the font to be h5 (font - family : serif; 2ex) 

twice the size of tl1e current h6 (font - family : serif; 1 . 5ex) 

setting. Using percentage 
values allows you more flexibility in the relative sizes of tl1e fonts, which can be very 
useful if classes are used. You will meet tl1ese later in this section. There is also a set 
of pre-defined relative sizes that can be used. These are: 'xx-small', 'x-small' , 'small', 
'medium', 'large', 'x-large' and 'x:x-large' . Otl1er acceptable relative values are 'smaller' 
and 'larger', which can be very useful if defining different classes within a style. 



Hint 
For centre aligned 
text,notethe 
American spell ing 
forcenter. 

Hint 
Line breaks should 
notbeusedtosplit 
a paragraph into 
two. Each 
paragraph should 
have its own style 
definition. 

Website authoring 

Task ISe 
Open a copy of the webpage and stylesheet that you saved in Task 15f. Edit this stylesheet 
so that style h1 is xx-large, h2 is x-large, h3 is large, h4 is medium, h5 is small. h6 is x-small 
andtheparagraphstyleisxx-small. 

Open the webpage saved in Task 15f and edit this so that the stylesheet SIZE3.CSS 
is attached to it. Save this as Task 15g.hnn. Open the stylesheet SIZE.CSS and edit 

{font -family : eerif; 
{font - family : eerif; 

this so that it changes 
the font sizes like this. 
Save this srylesheetas 
SIZE3.CSS. View the 

{font - family : eerif; 
(font - family : serif; M 

webpage with this...........__ h5 

srylcsheet attached. .............. ;6 (font- family : eerif; 

{f ont- family : eerif; 

(font - family : serif; 

Aligning !ext 
A font style (or class within a style) can be 
aligned in one of four different ways. You can 
use the text-align property to format text so 
that it is left aligned, centre aligned, right 
aligned or fully justified, as shown in this 
samplcsrylesheet. 

Task 15h 

xx - large) 

x - large) 

large) 
medium} 

small) 

x - small) 

xx - small) 

{text - align : left) 

{text - align : center} 

{text - align: right) 
{t ext - align : justify) 

Open the file you saved in Task 15b. Add a new title 'Aligning text' in style h1 . Change the 
word'second'toread'third'. 

Set the heading style h1 to be centre aligned. Setstyleh2toberightaligned. Setstylepto 
be left aligned. Place a horizontal line below the title 'Aligning text' . 

Place additional blank lines before the title at the top of the page and after the horizontal 
line. 

Open the wcbpagc saved in Task 15b and edit this by attaching a new stylcshcct 
called ALIGN.CSS. Add the title 'Aligning text' in style hl. Change the word 
'second' in the paragraph style so that it becomes 'third'. Save this as Task_ l 5h.hnn 
in yourTask_lSh folder. 

Create a new stylcshcct like this called 
ALIGN.CSS. ----------

{text - a lign : center} 
{t ext - align : right) 

{text - a lign : left) 
Set hl to be centre aligned, h2 right 

aligned and p to be left aligned. Save this 
srylcshcet. Check that this works and that the 
styles have been applied correctly like this 

To place a horizontal line below the title 
you use the horizontal rnle rag. TI1is is one of 
the few single tags that arc used in HTML. It 
does not have an open tag and a close rag. 
The tag appears like this. ------ <hr> 

AUgnlo11tcx1 

l"trt caab..Hhoo•4 ill 4iffnn l "").._H•n•.-.,..,me 
0! 1~ ... ""J'· 
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Hint 
The carriage 
returns within the 
HTML have no 
effect on the layout 
ofthewebpage. 

Hint 
Although the 
underline 
command isno 
longer part of html, 
itcanstillbeused 
bysett ingitwithin 
astyleinthe 
stylesheet. 

To insert a blank line before the title, move to the correct position in the markup 
and insert a line break tag. Again this is a single tag and appears like this . .......... 

This tag must appear within a style, for example between the < h l > <br> 

and </hl> tags, or between the < p> and </ p > tags. Place another line 
break below the horizontal rule. Save the webpage again. TI1e markup and page 
should look like this. 

<titloTaakl5h<titl o 
<linkr.al- ' a tyl .aah .a .at ' 

typ<> . "t.axt/caa " hr .a t . "ali~.c•• " > 

</h.aad> 

<p><br>My t hircl "'"bpa~.a by Crall;,., Brcn,m</p> 

<h2>T.axt c a nl><a .anhanc.ad indiH.ar .ant way • . 

.ar .a a r.a a ono. otthoa .a waya . </112> 

<p>T.axtcanl><a riad<l <ll>OOld< / ll></p> 

<p>TQxtcanl><iriad<a<i>italic</i>< / p> 

Q •- --· <, x.., __ ,,. .... ___ _ 
Aligning text 

Tntron ltc<'ll hHr<d i • d iffumt lllly,. ll n<or< 
"'"'~oflh,...,,..!, 

<p>T.axt cannot l><a und.arlinnd. in lah v.ara ion , ,..,,_.,_. _ _ " '""'""- ' """ .. ., _ .. 

otht., l !}Qca u a.a it look s lik.a th.a t .axt ha 

H< • ull>2</ a ull></p> 

</body> 

Enhancing text within a stylesheet 
You are going to use some similar technigues to those used for Task 15b. 111is time 
the enhancements will apply to the whole style (or class of style as you will see later 
in this chapter). Each of the enhancements uses a different property setting. The 
default value for all three enhancements is normal. To get OOld text, set the font­
weight property to 'bold', like this.-----------~ 

i~ ::~~~~
1
=~~~c:!1;~0~~::~yle property to 'italic', lfe this. 

decoration property to 'underline', like E font -weight, bold; 

this.---------__::==:::::=:~~~=~t~!~~i:~derline} 

Task 15 i 
Create a new stylesheet called MYSTYLEl .CSS and attach this to the web page called 
WEBPAGE2.HTM. This stylesheetwill set style hl to a bold, italic, 18 point font . If 'TI mes New 
Roman' is available the browser will use that. otherwise it will choose 'TI mes', but if this is 
not available any other serif font will be used. Make this text centre aligned. 



Hint 
Notice that each 
property andits 
value/sareon a 
newline. This 
makes it easier to 
read and check for 
mistakes. 

Website authoring 

Copy the file WEBPAGE2.HTM into your Task lSi folder. Open this file in your 
web browser and text editor. Enter this markup to create a new stylesheet called 

:~~~:,C,S~i~:f~s:,::: fi/,1, in yomwcb browscc. 
New Roman " , Tim. es, serif.; 

font - size : 18pt; 
text - a lign : center; 

font - we:i.ght : bold; 

font - style : ita lic} 

Activity 15b 
Create a new stylesheet called MYSTYLE2.CSS and attach this to the webpage called 
WEBPAGE3.HTM. This stylesheet will set style: 

• hl as an italic, centre aligned, 24 point font. If 'Helvetica' is available the browser will 
use that, otherwise it will choose 'Arial Narrow' but if this is not available any other sans­
serif fontwill be used. 

• h2 asa bold, right aligned, 16 point font . If 'Courier Narrow' is available the browser will 
use that, otherwise it will choose 'Courier' but if this is not available any other 
proportional spaced font will be used. 

• h3 as an underlined, left aligned, 16 point font. If 'Courier Narrow' is available the 
browser will use that, otherwise it will choose 'Courier' but if this is not available any 
other proportional spaced font will be used. 

• pas a 14 point, leftaligned,seriffont. 

Print evidence of your stylesheet and the browser view of the webpage with the stylesheet 
attached. 

Using classes within a cascading stylesheet 
You can define different classes which are sub-types within an element in a 
stylesheet. You can define a class in the stylesheet by using the ( dot or full stop) 
symbol. These are very useful fo r adding to or chang ing styles without defining 
completely new styles. For example, this styleshect defines the style hl in the normal 
way. It also defines a class that can be used with any style to change the colour and 
alignment o f the style that it is applied to . 

{text - align : left} 

. right {c olor : blue; 

text - align : right ) 

Task 15j 
Open the stylesheet called CL.ASSl.CSS and add a new class within this stylesheet that changes 
the default style to be right aligned and blue. Open the webpage called WEBPAGE4.HTM and 
applythisclasstoeachlineoftextthatstartswiththeword'This'. 

Copy the files C LA.SSl.CSS and WEBPAGE4.HfM into your Task lSj folder and 
rename WEBPAGE4.HfM as Task_lS j.hnn. Open these files in your text editor 
and the file Task_lSj.hnn in your web browser. Add this markup to the 
stylcsheet and save this in cascading stylcshcct ( .css) format. 

~ . right{color : blue; 
text - a li \j'n : ri \j'ht ) 
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Enter the highlighted markup to the webpage to add a class sub-type to each line 
starting with the word 'lb.is' . It should look like th/is. 

<html > 

<hea d > 

< title>Ta sk 15j </title> 
< link rel> = "s t y lesheet" type= "text /css" href= " c l a ssl . c ss "> 

</hea d > 

<body> 
<hl >Ta sk 15 j </hl > 

<hl >Style hl is a sans serif , 2 0 point , c entre a ligned font . </ hl > 

<hl claaa=" r i hl"> his is the sub- type of hl c a lled . right</hl> 
< h 2>Style h 2 is a s a ns - serif , 14 p o int , left a ligned font . </h 2> 

<h2 class= " rig,ht " "'.;'['hi s i s the sub- type of h 2 c a lled 

< h 3>Style h 3 is a s a ns - serif , 1 2 p o int, left a ligned 

<h3 cla11s= " r1. ~ hi s is the sub- type of h 3 c a lled . right</h3 > 
< p >Sty le p is a serif , 10 point , left a ligned font . </p > 

. r ight</p > 

</html > 

The screen should now look similar to this."'-. 

1:,:,_.r: ,-m,1 

I ~-illr~ !!~\In . 
I
. Thla i.ine s ub--typeol 112c.aled .rlgllt 

SzyloAJll••Mo.nnl'.f~pc/ll<!of! :::..,~OOJ<- Jlllill 

You can see from this printout that the original style definitions ( except for the 
text aligmnent) have all been applied to the page. The text alignment and colour 
have been added to the styles using the class called 'right'. 
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Using comments in your markup 

Comments can be used to annotate your markup. Each comment appears within a 
single tag. The exclamation mark followed by two hyphens (dashes) opens the 
comment and two hyphens close the comment. An example of comments in the 
markup looks like this. -----------~ 

- This is a c omment . Comments a re not displ ayed in 

- Ma rkup c rea ted by Gra h a m Brown-- > 
- This section defines the hea der o f the webpa ge 

15.6 Working with lists 
You can include on a webpage either a numbered list, which is called an ordered 
list, or a bulleted list, which is called an unordered list. Bulleted (unordered) lists 
can also be nested (placed one inside the other) to give you more flexibility in the 
design ofyourwebpages. Items to be placed in a list start with the markup < Ii > 
and close with < /Ii > . These are used in the same way as the style definitions for 
headings (styles h l to h6) and paragraph styles. Each item in the list must have the 
list tags around it. An example of an item placed in a list would look like this. 

-----<li>This i s one item from a bulleted o r numbered list </ li> 

Numbered lists 
Numbered lists are called ordered lists in HMTL. Place the tag <ol> at the start of 
the numbered list and the tag < /o l> at the end. 

Task 15k 
Create a webpage containing the heading 'Fruit' and a numbered list for the following 
items: Apple, Orange, Pear, Banana and Lemon. 

Enter this markup into your text editor. Save the webpage, which should look like 

this in your browser. ~ 

Fruit 

' "'* i: ~· 
,-

& -...... .. H1 ... .-...i t1 ,,,,,. . 

<h t ml > 
< ! -- Ta sk 15k by y our n a me 

<title>T a sk 15k</ title> 
</hea d > 

<body> 
<hl >Friut</hl> 

<li> Apple </ li > 

<li> Or a nge </ li > 
<li> Pea r </ li > 
<li> Ba n a n a</li> 

<li> Lemon </ li > 
</ ol > 

</body> 
</html> 
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Bulleted lists 
Bulleted lists are called uno rdered lists in HMTI. Place the tag <ul > at the start of 
the numbered list and the tag < /ul> at the end. 

Task 151 
Create a webpage containing the heading 'Colours' and a bulleted list for the following 
items: Red, Yellow, Blue, Green and Cyan. 

Enter this markup into your text editor. Save the webpage, which should look like 
this in your browser. / ~ 

Colours I 

• Yellow .... 
CS, Rmricted,rte,; j Protected 'l. 100% 

Nested lists 

I 
- T a sk 151 by your name 

<title>T a sk 15k</ title> 
</ hea d > 
< body> 

<hl >Friut</hl> 

<li> Apple </ l i > 
<li> Ora nge </ li> 

<li> Pea r </ li > 
<li> Ba n a n a </ li> 
<li> Lemon </ li> 

</ u l> 

</ body> 
</ html> 

Bulleted lists can be nested, by having sub-lists. These are created by placing one 
unordered list within another list . 

Task 15m 
Create a webpage containing the names of two resorts as a bulleted list. These resorts are: 
Ellmau in Austria and Sharm El Sheikh in Egypt. For each resort, list the main activities 
available. 

Enter this markup into your web editor to create the primary list. 

- Ta sk 15m by our name 

< title>Ta sk 15km/ title> 
</hea d > 
<body> 

< li > Ellma u </ li > 

------
< li > Sha rm El Sheikh </ li > 

</ul> 

</body> 
</html > 
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After each resort, enter a new sub-list that contains the activities offered in each 
o f these places. Note that the sub-list fits between the list item name and the close 
tag for that item. The finished markup will look like this. -----~ 

Save the webpage, wh1c/h should l= k !;:,::·;~:·:::: b::::< s o me 

<t1.tle>T a sk 15m</ t1.tle> 

~~~~ </heo d , 
11
~ \Usns\Graham\Dowmc,,ts <body> 

00 Ill C:\ ~ \ G,aham\ C ~l•t IX l 
'tl · 

. Ellmau 
o Skiing 
o Snowboarding 
o Sledgillg 
o Mountaineering 

• Sharm El Sheikh 
o Scubadr.ing 
o Snorkdliog 

<li> Skiing </ li> 
<li> Snowboarding </ l i > 
<li > S ledging </ li > 
<li> Mounta ineering </ li > 

</ ul > 

<li> Scuba diving</ li > 
< l i > Sn orke l l ing</ li> 

</ul > 

</ul> 
</body> 

heill,.c,.,m='~='=''=''"="'aa"'=Mod=•= "-=l=OO='==.I </html> 

Activity 15c 
Create a newwebpage containing the heading 'Winter sports', a brief introduction and an 
unordered list of the following winter sports: skiing, tobogganing and snowboarding. For 
each winter sport, make a sub-list of the items of clothing required. Set these sub-lists as 
unordered lists. 
Print the webpage as viewed in your browser and as html. 
Change these sub-lists to ordered lists. Again, print the webpage as viewed in your browser and 
as html. 

15.7 Working with colour 
Colour in HfML can be defined in two ways. One method is to use colour names, 
like red, green and blue within the html code. There are currently only 16 colour 
names accepted as web standards in HTML, CSS and by the Wo rld Wide Web 
Consortium (known as W3C) . These are: aqua, black, blue, fuchsia, gray (note the 
American spelling), green , lime, maroon, navy, olive, purple, red, silver, teal, white 
and yellow. Other colour names are, however, accepted by the major browsers and a 
table showing these colours and their names is included on the CD. 1l1is can be 
found on the webpage called COLOURCODES. You can open this webpage and 
use these colours in your own stylesheets attached to your webpages. 

It is not always easy to remember the names of the colours, and many web 
designers prefer to use hexadecimal codes (often referred to as hex codes) to define 
the colour of text, backgrounds or objects. H exadecimal is a counting system where 
counting is done in 16s rather than in the 10s used in the decimal system. Because 
we do not have sixteen different characters for numbers, we use letters and numbers 
as shown in Table 15.1. Ill 
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Table 15.1 The hexadecimal counting system 

Hint 
Thistablewillhelp 
you work out which 
hex codes are 
useful in the 
practical 
examinations. 

The largest number that can be stored in a single byte of information is the decimal 
number 255, which is FF in hexadecimal. 

Each pixel ( dot) on a monitor or projected onto a screen is made up of three 
different colours. The primary colours when using light (which is very different 
from the primary colours used in painting) are red, green and blue. You will notice 
that the initial letters are RGB , hence RGB monitors. Each of these colours can be 
ofl~ partially on or fully on. In hexadecimal, if a colour is off it is set to 00 and if it is 
fully on it is set to FF. To create the colour for any pixel you must tell the computer 
how much red, green and blue light to show. 111is means that all colour codes have 
six characters, the first two being red, the next two green and the final two blue. 

~

This example is the hex code for red, as the red component is fully on (FF), the 
green component is off (00) and the blue component is also off (00). 

color = fFFOOOO 

All of the different combinations of red , green and blue allow more than 16 
million different colours to be used. You do ,wt need to learn the hex codes for the 
exam. Using a small number of values for each colour (like those shown in the table 
in the hint box) is more than enough. 

Fully on FF FFOOOO 

3/4on CD CDOOOO 

1f.2on 80 800000 

1/4on 40 400000 

off 00 000000 

1l1e webpage COLOURCODES contains the hex codes (as well as the names) for the 
most popular colours. It is interesting to note that, working with light, mixing red and 
green gives yellow, green and blue gives cyan and mixing red and blue gives magenta. 
If all three colours are folly on, the result is white and no colours on gives black. 
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Task 15n 
Create a new stylesheet called MYSTYLE3.CSS which sets the font styles: 

• hl to Times New Roman, or Times. or any serif font 

• hl to be 36 points high, black and centre aligned 

• h2 to Arial, or Helvetica, or any sans-serif font 

• h2 to be 24 points high, red and left aligned 

• h3 to Arial, or Helvetica, or any sans-serif font 

• h3 to be 18 points high, blue and right aligned 

• p and Ii to Arial. or Helvetica, or any sans-serif font 

• pandlitobe 14pointshigh, dark blue, left aligned. 
Open thewebpage called WEBPAGE5.HTM and attach this stylesheet to it. 

Copy the file WEBPAGES.HTM into your Task 15n folder. Open this file in your 
text editor and in your web browser. Create a new stylesheet in a second copy of 
your text editor. Fo r each style, add the font family, size and alignment as shown in 
previous sections. 

The colour for each style is added using the colo r p roperty and the value (note die 
American spelling of colour). For this example, the values will be in hexadecimal so 
that we can select from any of the 16 million available colours. You use the # symbol 
to tell the browser diat die following six characters are hexadecimal. For hl we will set 
the colour to black using # 000000, h2 to red with # FFOOOO, h3 to blue with 
# OOOOFF and dark blue for the paragraph style widi #000080. The final markup 
should look like di.is. 

",.. h, {font - family : " Times New Roman•, Times,serif; 
font - size; 36pt; 
text - align : center; 
color : fOOOOOO) 

{font - f a mily : Arial,Helvetica,sans seri f ; 
font - size; 24pt; 
text - align : left; 
color : fFFOOOO} 

(font - family : Arial,Helvetica,san s serif; 
font - size; lBpt; 
t ex t - a lign : right; 
color : tOOOOFF} 

p,li {font - family : Arial,Helvetica,ea ns serif; 
font - size; 14pt; 
text - align : lef t; 
color : f000080) 

Save this with the filename MYS1YLE3.CSS. Add di is markup 

Style h I is black Save your wcbpage and test it in your browser. The finished page 
to the head section of the webpage to attach your new styl~heet. 

Style h2 is red 

<title>Ta sk 15n< / title> 
\ < link rel = " stylesheet" type= "text / css " href 

= "mystyle3 . cse" > 

S'Y'"'""'~ _ I\ </oeod> 
should look like this. 
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Hint 
Even though you 
may choose your 
own class names in 
the practical 
examinations.try to 
make them short 
and meaningful. 
Try to avoid using 
wordsthatmean 
something in html, 
e .g. use'rd'rather 
than'red'. 

Task ISo 
Using the web page and stylesheet from Task 15n, add an extra stylesheet called MYSTYLE4.CSS 
that defines dasses to change the text colour to red, yellow or green and adds enhancements 
like black bold and blueitalic. Applythesestylesinthewebpage,sothateachofthebulleted 
itemshasthecorrectcoloursandenhancements. 
Set a khaki background to the webpage and make sure that all text is clearly visible. 

Copy all the file.s from your Task 15n folder into the Task 150 folder. From the 
Task 150 folder, open the file MYSTYLE3.CSS in your text editor and the webpage 
in both the text editor and your web browser. In another copy of your text editor, 
create a new stylesheet called MYSTYLE4.CSS. In this style.sheet you are going to 
add classes. Some will change the font colours and some will add enhancements to 

make text bold or italic. 
Like each style, each class is given a name. You will need to decide on the name 

for each class, which should be short but meaningful. In this example you can use 
the names <rd' for the red class, 'yllw' for yellow, 'gm' for green, ' ital' for italic and 
blue, and ' bid' for the bold and black class. Create each class in your stylesheet. 1l1e 
final markup should look like this. Save this with the filename MYS1YLE4.CSS. 

-----. rd I FFOOOO ) 
. y llw f FFFFO O) 

f OOFFO O) 
{fon t- Bt yl e : i t alic ; 
color : # DOOOFF J 

{font-weight : bold; 
color : 10000 00) 

Add this markup <title>Task 150</ title> 
to the head section <link rel ="stylesheet " type=text / css " 

of the webpage to <~: ~!=:~::~!;~~:~::~ • t ype=text /css" 

:;~~~~~:.l~/ he:~: f ="mys t yle4 .css "> 

Note that this 
stylesheet has been attached after the previous style.sheet, so if there were any clashes 
in style definitions, those in MYSTYLE4.CSS would take priority. These classes 
need adding to each style definition within the webpage. Edit the markup and save 
the webpage. The markup should look like this. 

"' = "rd" >red</ l i> 
= "y llw">yellow</li> 

<li cla s s • "!ijr n "~ /l i > 
<li>or left unchanged< / li> 

</ul> 
<p>In fact any other colour could be used to enhance previously 

defined t ext . Ot her enhancements could be added like having cl asses to 
make par t s of t he work enhanced and coloured like :</p> 

= "ita l ">blue and it alic</ li> 
= "bld">black and bold</ l i > 

<li>or left unchanged</ li> 
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•· ~·a· • · ~·• ·o- · · 

Style hl is black 

Th•i-,.grop!,lll)'l-i u l4poinldarU:lu.ofont 

Style h2 is red 

Styleh3 111 blue 

. ~· .... 
• ~rlel\ """"""li•d 

lnloc1onyctnercolourcculdb.nedto•n""r,c•Jnvic>J,ly 
d•t...,, 1•xtot...enh1n<•-cooldbelddedlike t--.g 
C1&11Htomt1<•p1ft1cnn•wonc • . .a1no.a1McCIOU!.a10te 

• l>/u.1~1ii:1ffe 
. block 1r>db~d 
. orleft""""""li.,; 

Ohrftdu,e~found,,..&,ui,h, d1•P1ercanl,.,addndi,• 
oimllarway 

Background colour can be added to many features of webpages, including the entire 
webpage, text on the page or, as you will see in Section 15.9, other objects like 
tables. In the original versions of HTML the colour was set in markup of the page 
rather than in a srylesheet, but many of the original commands have now been 
deprecated so all background colour settings are performed within the stylesheet. 

The background colour for a page is set in the lxxl.y style of the srylesheet. Edit 
the srylesheet MYS1YLE4.CSS to add the lxxly style setting for the khaki (hex code 
# FOE68C) background li?s. 

oody {background- col or : J FOE68C} 

to t~::i;;:~~~:;i::~:t~: extra enhancement to the text. Text can De turned: 

read the yellow text, so to make • red 
sure that all the text is fully 
visible, you are going to cha1~ge • green 
the background colour of the • or left unchanged 
yellow text to a contrasting 
colour. In fact any other colour could be used to enhance 
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1bis again is set in the stylesheet, by adding the background colour to the definition 
in the class )"llw', so the stylesheet looks like this.~ 

. rd #FFOOOO} 

.yllw IFFFFOO;ba.ckground- color : IOOOOBBJ 
IOOFFOO) 

{font - style : ita lic; color : #OOOOFFJ 
{ f ont - weight : bold; color : #000000) 

body {background- color : IFOE68CJ 

The background colour has been applied with the yellow font colour like this. 

extra enhancement to the text. Text can be turned: I . --------
• red 1 
• green 
• or le ft unchanged 

In fact an.Y other colour could be used to enhance 

Activity 15d 
Create a webpage with a pale blue background that is about using colour in websites. 
Attach a stylesheet that defines classes to change the text colour to red, yellow, green, dark 
green, blue, dark blue or magenta. Have three different styles for the dark blue text, one 
for left aligned, one for centre and one for right. Apply these styles in the webpage, so that 
eachcolourisusedappropriately. 

15.8 Using hyperlinks 
A hyperlink is a method of accessing another document or resource from your current 
application. H ypcrlinks do not just relate to wcbpages: other applications software can 
also use them. Hyperlinks are often used to create menu options widi webpages, using 
either text or images. When you select a hyperlink (usually by clicking the left mouse 
button), the hyperlink will perfonn an action. It may move your position within a 
page, open anodier page eidier locally or on the internet, or open your email editor so 
that you can send an email to a specified place or company. 

Anchors 
An anclmr is a point of reference within a webpage. It is similar to a lx>okmark 
when using word-processing or desktop publishing software. If you create a 
webpage that will not fit in a single window, it is useful to use one anchor for each 
section of die webpage (or document), so die user can move to any section widmut 
having to scroll through die whole document. An anchor starts widi an < a> tag 
and closes with a < / a > tag. One common use of an anchor is to define die top of a 
page. Tiiis anclmr is often called ' top' or 'start'. To create an anchor called ' top' enter 
this markup in the body section of die page. This anchor will work without any text 
bcnveen the open and close tags.-------... 

< body> 

<a name= " top " >Any c ontent c o uld a ppea r here</a> 
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Hyperlinks within a webpage 

Task 15p 
Open the web page WEBPAGE6.HTM and stylesheet STYLE3.CSS. Edit the w ebpage so that each 
new section contains an anchor. Use these anchors to create hyperlinks from the appropriate 
text in the first paragraph. Make the word 'top' in the last line a hyperlink to the top of the 
page. Make the w ords 'CIE website' a hyperlink to the website www.cie.org.uk and the words 
W3Cwebsite' a hyperlink to www.w3.org. 

Copy the files WEBPAGE6.HfM and SIYLE3.CSS into your Task 15p folder. 
O pen the webpage in your text editor and in your web browser. Each section needs 
an ancho r with a name. Each anchor name must be different. You should always 
choose short yet meaningful names for each anchor. For this webpage you will use 
the ancho r names top, 15a, 15b, 15c, 15d, 15e and 15f as these relate directly to the 
sections within the webpage. It is sensible to place all the anchor names into the 
document before creating the hyperlinks to these ancho r names . Each anchor name 
iscreatedlike this.\ 

<hl><a narne = " toP, " >< a>Cha pter 15</hl > 

You can see that the ancho r tags are inside the tags defining the style for the text. 
TI1e initial ancho r tag contains the ancho r name which is placed in speech marks. 
This name will be used in all hyperlinks to this point. Add the other anchors to the 

~=:up, one foe cad, section ofme dm ,mem like 7 
<h2 ><a narne=" l 5a•>< a:,,15 a Underst a nd wha t html is< / h2 > 
<p>Ma ny students sit the practica l examina tions without rea lly 

<hr> 
<h2 > a. n.a rne = "l5b "></a>l5b Problems with WYS I WYGs</h 2> 
<p >The re a re ma ny well desig ned WYSIWYG p ack a ges on the market, 

<h2 > a name= " l 5c•></a:,<l5 c Use the c orrect terms</h2 > 
<p > Over the p a st few yea rs , a s the pra ctical examina tions h a ve developed 

Add anchors for 15d, l 5e and l 5f with similar markup. In the final sentence, find 
the word ' top' . This will be used to create a hyperlink to the anchor with the name 
top that you created earlier. The hyperlink is also created using an anchor. TI1e two 
anchor tags are placed each side of the word top. The markup includes a hyperlink 
reference (the markup fo r this is href) and the name of the destination anchor. This 
anchor name is always inside speech marks and preceded by the # symbol like this. 

I 
<p >Ba ck t o the <a href .. "ftoUtop< a / p > 
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In the first paragraph find the text 'what is hnnl'. Edit the markup for this text so 
that it creates a hyperlink to the anchor named 15a. It will look like this. 

/ 
<h3>Here a re practica l tips for the exams, if you follow t hem you a re 
likel y to increase your marks . First you need 
know <ll ~fa"tl 5a"~t is html? </a> Once you h a ve a 
sound unders t a nding of html, it is wor t h 

You need to add similar markup to the text 'WYSIWYGs', 'use the right terms', 
'create and attach srylesheets', 'work with tables' and 'other resources'. The finished 
markup for this section should look like this. "' 

<hl>Hints and tips f or the practical examinations?</hl> 
<h3>Here are practical tips for the exams, if you follow t hem you are 
likely to increase your marks . First you need know <a href = " f15a">wha t 
is html. a> Once you have a sound unders t anding of html, it is worth 
considering t he use of <ll href,. "tlSb" >WYSIWYGs</a> and the potentia l 
problems o f using t hese packa ges . Ma ke sure t hat you a href = "f15c"> 
use the right terms</a:,; to describe what you have done, are doing 
or could be asked to do . Learn how to <a hre f •"l1 5d">creat e a nd 
a ttach s t ylesheetsc/a to your webpa ges. Ma ke sure that you c a n 

a href =" f1 5e">work with t a bles / a These provide a fundamental 
structure to webpa ges and seem to be replacing f r a mes in many areas . 
There a re other methods of formatting layout including the use of 
DIVs, but these a re currently beyond the scope of this book . Look for 
<I!. href ="flSf " oth er resou rces</ a> to help you prepa re for the 
pra ctical examina tions . </h3> 

Now that the hyperlinks have been created, each one needs testing. Save the 
webpage and refresh your browser, then try each hyperlink in tum and make sure 
that it directs you to the correct place in the webpage. If the name that you have 
used in the hyperlink reference does not exist, your browser will go to the top of the 
page and the browser does not show you that there is an error. 

Hyperlinks to other webpages 
Hyperlinks can be created to another webpage stored locally, usually in the same 
folder as the current webpage, or to an external website on the internet. TI1e markup 
for both of these links has the same syntax (strucn1re). TI1e only difference is the 
address of the webpage that the hyperlink is to go to. To complete task 15p, two 
hyperlinks need adding to external web addresses. These follow a similar format, 
with the URL for the web address appearing as the hyperlink. The markup for these 
two hyperlinks is shown overleaf. 



Hint 
Make sure that you 
do not put an 
absolute address in 
ahyperlink 
reference(for 
example,<ahref 
= "C:my 
documents/my 
folder/html/next_pa 
ge.htm" >)asthisis 
only likely to work 
on your computer. 
Other computers 
are unlikely to have 
the same folder 
structure and 
filename. 

Hint 
Although in these 
simple examples 
the target 
attributes open 
new w indows, they 
operate in new 
frames.Frames are 
beyond the scope 
of this book. Some 
recent browsers 
with multiple tabs 
(like Internet 
ExplorerlandB') 
over-ride these 
settings,asframes 
are not used. 

Website authoring 

<h2 ><a n a me = "15f"></a>15 f Other useful links</ h2 > 
. < p >There a re othe r pl a ce s tha t can be u sed t o g a in v a lua ble 

informatio n t h a t may help . Thes e inc lude the 
<a href,. "htt , www . c ie .o,:- .uk".;.CIE web s it / a )'. a nd the 
<a href= "h t tp, I /www .w3 .org- W3C websi t e </ . </p > 

< p >Back t o the <a h r ef = " #top " >top</a></p > 

Add these hyperlinks in to the last sectio n of your markup and save your webpage. 
Test the hyperlinks to make sure they work as you expected. 

References to pages stored in the same folder as your webpage just have an 
address without the U RL. To link to a local file called 'next_page.hnn', you would 
include a hyperlink reference like this 

\ 
<p > a name ="next__p,,.ge .htm"JoC lick here for the next p a g ~ . <p > 

Activity 15e 
Open thewebpage HTMLTIPS.HTM and stylesheet STYLE3.CSS. Replace the text 'YOUR 
NAME' with your name. 
Edit the webpage so that each new section contains an anchor. Use these anchors to create 
hyperlinks from the appropriate text in the first section. Make the word 'top' in the last line 
a hyperlinktothetopofthepage. 
Make the word 'CIE' a hyperlink to the website www.cie.org.uk, the words 'Hodder 
Education' a hyperlink to the website www.hoddereducation.co.uk and the text 'W3C a 
hyperlinktowww.w3 .org. 
Print the html view of this webpage. 

Opening a webpage in a new browser window 

\Vhen a webpage is o pened, it may open in the current window or it may open in a 
new window. This is set using the target attribute. An attribute is something that is 
added to one of the markup commands to g ive further infonnation/ instrnctions to 

the browser. This attribute is part of the anchor and tells the browser which window 
to use for the webpage that you are going to open. The target attribute can either 
be set as a default setting in the head section of the markup, o r as an individual 
setting for a hyperlink within the OOdy section. If the target attribute is not used, 
the browser will decide where to open a webpage. 

To set a targc..'t window fo r a single hyperlink, add the target attribute to the first 
anchor. Some target attributes have specific functions. If a target name of _ blank is 
applied, this will o pen in a new target window. If _self is applied it will o pen in the 
current window. Other target names such as _parent and _top are reserved and 
perfo rm different functio ns with frames , which are beyond the scope of this book. 
Any other target name that you use will open the specified webpage in a window 
with that target name if it exists, or open it in a new window with that target name. 

Task 15q 
Using the web page and stylesheet from Task 15p, make the hyperlink to the W3C website 
open in the same window and the hyperlink to the CIE website open in a new target 
windowcalled _cie. 
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Hint 
Body text could 
also be added by 
adding 
&body: The%20 
message%20here 
tothemarkup. 

Copy the file STYLE3.CSS and the wcbpage that you saved in Task l 5p from your 
Task 15p folder into your Task 15q folder. Open the webpage in your text editor 
and in your web browser. Edit the markup for the last two hyperlinks to include 
target windows like this. 

< p >There a re other ~ ac es tha t c an b e used t o g a in valua ble 
informatio n t h a t may help . The s e inc lude the <a 
href= " http: //www . c ie . org . uk" targ-• t • " _ei e " >eCIE website</a> a nd t he <a 
href= "http : //www . w3 . org " ta:rg-e t,. · _ .. l f" >W3C website</a> . </p > 

< p >Back t o the <a href = " l t o p ">t op</a></p > 

Save your website and test the hyperlinks to make sure that they work as you expected. 

Using a hyperlink to send an email message 

Hyperlinks from webpages, other applications packages or documents can be used 
to open an email editor and prepare a message to be sent to another person or 
company. This is very useful in a website where you can set up your email address 
and subject line within the markup and instrnct the browser to open the email editor 
and insert these details into a new message when the hyperlink is selected. 

The format for this is very similar to the hyperlinks shown earlier in this section. 
In place of the URL or path of a webpage that is placed within the hyperlink 
reference of the anchor, the mail to: instruction is used. This is followed by the email 
address of the recipient. To include the subject line for the message, this is included 
by specifying subject = followed by the text for the subject line. All the hyperlink 
reference is enclosed within speech marks. 

Task 15r 
Create a newwebpage that contains a hyperlink to prepare an email message to be sent to 
graham.a.brown@hotmail.co.uk with the subject line ' IGCSE Book'. 

For this task you need to prepare a new markup in your text editor that contains 
this line. 

< p ><a href = "ma ilto:gra harn . a . brown@h o tma il . c o . uk?subjec t =IGCS E%20 Book " > 
Cli c k here t o cont ac t us p a ge</a></p > 

Save this in your Task 15r folder and try it in your browser. When you click on 
the hyperlink it will open your email editor, place the address in the To : section and 
the text '!GCSE Book' in the Subject : line. Note how the space in the text ' !GCSE 
Book' has been replaced in the markup with '%20'. This is the hex value for the ascii 
character 32, which in the ascii code represents a space. There are no spaces inside 
the speecl1 marks for the hyperlink reference. 
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15.9 Using tables 

Hint 
In the practical 
examinations.this 
planning stage will 
often be given to 
you in the question. 

Hint 
In the practical 
examinations it will 
be much easier to 
use WYSIWYG 
software to create 
your tables. This 
section is designed 
to ensure that you 
understand how to 
create and edit 
tables. You will 
need to understand 
themarkupusedto 
define tables.even 
if you decide to use 
aWYSIWYG 
package to develop 
your tables. 

Tables are used to create the basic structure of many webpages. They are used to 

organise page layout and are often used in webpages even though they may not be 
visible. If you need to create a table within a webpage, it is always worth planning it 
on paper before starting to create the markup. 

Task 15s 
Create a newwebpage that looks like this and has the caption 'Colours': 

Red 36% 

Green 23% 

Blue 41 % 

Basic table structure 

Tables in HfML always start with a < table > 
tag and end with < /table > . Start by adding - Task 1 5 s by your n a me 

these rags in the body section of the mark up 
like this. Everything between these tags will be <title>Ta sk 15s</ title> 

included in the table, except for the captio~ : ~~a : > 

1bis is added using the <captio n > and ~ <t~ble> 

< /caption> rags and allows you to display a </ t a ble> 

caption (usually centre aligned) above the </body > 

table. If a caption is used it must be the first </h tml> 

hnnl tag after the < table > rag. 
Each table is split into rows. For this task., < body> 

the table you need to create has three table <capti on >Col o u rs</ca.ption> 

rows. TI1e tag fora table row is < tr > . Create </ t a ble> 

the three blank rows between the caption and </ body> 

the end of the table like this. </ html> 

Each table row will contain two cells of 
table data. Between each < tr > and < /tr > <body> 

tag place start table data < td > and end table < table> 

data ~ /td > ~gs like this. A table ~II can : ~=~ tion >Colo urs</ cap tion > 

contam text, images, other tables, hsts, ~ < td> 

paragraphs, fonns, horizontal rules, etc. </ t d> 

<body> 

<caption>Col o urs</caption> 

</ t r > 

</ t r > 

< td> 
</ t d> 

< tr> 
< td> 

< tr> 
< td> 

</ t a ble> 
</body> 
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Hint 
It is sometimes 
quicker to create 
one complete table 
raw first with the 
table data cells 
included and copy 
this raw a number 
oftimesusingcopy 
and paste. 

The data can now be added to each 
cell like this. ------~ 

Your table will look similar to this. <caption>Col ours</ca ption> 

Coioun,~ 

Red 36% 

Green23% 
Blue 41 % 

Table borders 

< t d >Red 
</ td> 

</ td> 
</ t r > 

< t d >Green 
</ td> 

</ td> 

1l1is table has been created but does not </ tr> 

have a visible border. To show the table 
gridlines you must add a border. 1l1is is 
added as an attribute within the table 
tag which should be changed like this. 

<body> / 

<ca ption>Co lours</ca p t ion> 

< t d>Blue 

</ td> 

</ td> 
</ tr> 

</ t a ble> 
</body> 

c.,.,., 
likes:~'.1g the bo rder to 1 sets a 1 IXJint lxmler width on the table ~P6% 

Setting the border to 6 IXJint:s looks like this. '-.,... ~[ii% 
Setting the border to O will hide the table bord~r, yet allow ~r,i"i"% 

the table to control the strucn1re of the page. 
Ccloo,s 

Headers and footers in tables 

!Red 136% 

~123% 
~141% 

Tables can have three sections: a header, a lxxlysection and a footer. These are 
defined using the < thead > , < tbody> and < tfoo t > tags, and closed with 
< /thead > , < /t body> and < /tfoot > respectively. 

Task ISt 
Create a new webpage that looks like this and has the caption 'Fruit 
sales'. The colour codes you will need are #328798 for the header, 
#92CDDC for the footer and #86DDE8 for the table body. 

Appler, $12.10: 

S7 SO!' 

S240I 
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To create this webpage you need to first create the open table and close table tags 
within the lxxly section of the markup. Place the caption tag between these in the 
same way that did when you completed Task 15s. The initial markup for this section 

o:btl:Y:ackup should look li/k, ,his. 

< t a ble border= " l" > 
<caption>F r uit s a les</caption> 

</ t a ble> 

</body> 

Before continuing with the markup it is worth planning the table using a hand­
drawn sketch similar to this. 1l1is will help you work out the stmcture needed for 
the markup. For this table, you will need three sections to the table. 

These three sections need creating next within the markup. The header section is 
created using the table head tags, with < thead > to start the section and < /thead> 
to finish the section. The footer section uses the tags < tfoot > and < / tfoot > and the 
lxxly is defined with < tbody> and < / tbody> . In HTML you must define the table 
header, footer and then body (in that order) if all three sections are to be included. 
Create the three sections within the table of your markup like this. 

<body> 

« ::a ption>Fruit s a les</capt i on> 

< thea d > 

:::::;:> ~ 
</ tfoot > 

< tbody> 
</ tbody> 

</ t a ble> 

</body> 

Within eacl1 section add the correct number of table rows, using the notes you 
made on your sketcl1 to help you. 

You can add the table data sections to the footer and lxxly of the table using the 
tags < td > and < /td > . Do not use these tags in the table header. At each stage, save 
your webpage and cl1eck that the markup that you have written gives you the results 
that you expected. 

In the table header, create heading cells (which are bold and centre aligned) using 
the tags < th > and < /th > rather than the table data tags. These will set the column 
headings in heading style. Heading cells can be used inside the table lxxly and table 
footer sections and are useful in the left column of a table if row headings are required. 

Ill 
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Place the contents (in this case text) of 
the header section in the header cells and 
place the contents of the body and footer 

- Ta sk 15t by your n a me 

sections in the relevant cells. The finished <title>Ta sk 15t< / title> 

;;:~~.a1_,d_=_u1t_,,_,g_"_b1_, _,h_m_ua_1_=_k~ : ~~f:e border = "l " > 

Table styles using a 
stylesheet 
You have created the table, but it does not 
yet look like the table shown in Task 15t. To 
format the sections of the header you will 
attach a stylesheet and add the formatting 
within the srylesht"et. Add the stylesheet link 
to the head section of the markup like this. 

< title>Ta sk 15t</title> 

< link rel = "stylesheet " 
type= " text /c ss " 
href= "mystyle5 . css" > 

</hea d> 

< c a ption>Fruit s a les</caption> 
< t hea d > 

< th>Fruit< / th> 
< th>Price</ th> 

</ tr> 
</ thea d > 

<td>Tota l </ td> 

< td>$ 65 6 0< / td> 
</ tr> 

</ tfoot > 
< t body> 

< td>Apple</ td> 
<td>$ 1230< / td> 

</ t r > 

< td>Ora nge< / t d > 
< td>$78 0</ td> 

</ tr> 

< td> Pea r </ td> 
< td>$ 24.0</ td> 

</ tr> 

<td>Ba n a n a < / t d > 

< td>$ 4.235</ td> 
</ t r > 

< td>Lemon</ td> 

< td>$ 75</ td> 
</ tr> 

You will now create a new stylesheet </ tbody> 

called MYS1YLES.CSS. This sryleshcet </ t a ble> 

::!~ta;:b1;ea:~:lld:::~:~~:J:;, ~:ter ;;~ : 

and lxxly sections. As rou are going to 

define some of the table attributes in the srylesheet it will be sensible to move the 
table borcler details into the srylesheet. Remove the border= "! " attribute from the 
table tag in the markup. In your stylesheet, set the table attributes so that the 
border-color is black, the border -sty le is a solid line and the border -wid th is set to 

1 pixel.-------------------

{border - c olor : #00 0000; border- s t yle : solid; border-width : lpx} 
{background- c o lor : 132 8798) 

[

tfoot {ba ckground- c olor : 1 9 2 CDOC ; c olor : I FFOO OO} 

tbody {background- c olor : I B6DDE8J 

Set the background-color for each section of the table and the text col o r within 
the footer to red. 
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When this has been saved and is applied to the webpage the Fruit sales 

table will look like this. ---------

Formatting columns --------­
The prices and heading in the right column need to be right 
aligned to match those in the question for the task, and the text 
in the left column needs to be left aligned (to override the 
centre align within the heading setting). You can set this in the 
markup for the page rather than the stylesheet. All of the cells in 
a column will be grouped together and have a style attribute set. 
In the case of the left column, this will be the aligmnent set to left and in the second 
column the alignment set to right. 

These are set with tags for <colgroup > and </colgroup > . The colgroup tags 
always appear immediately after the caption but before the table header < thead > 
tag if it is used. The markup for this section looks like this. TI1e table should then 

l=klikcthis. / j 
< t a ble> Fruits.ales 

Formatting cells 

TI1is table still docs not look exactly the same as that shown in 
the task. TI1e rnlcd lines between the cells are not visible. To 
tum these on add to the table tag the 

:~~:: :1~~1~:~d~~: ;o:a!~to;f~:
1
::~l~ <~ > le rules = "all "> 

Although this sets the rnlcd <caption>Fruit s a l e s </caption> 

gridlines within the table, they have not 
appeared the same as the OOrder. This 
is beyond the scope of this book as the practical examinations are likely to require 
you to set the rnles attribute to 'all' or 'none', although it is worth knowing that they 
could also be used to rnle in 'rows', 'cols' or 'groups'. Try each 
of these settings and see how the table appears for each value. 

Cell padding and cell spacing are used to improve the 
layout of a table. Cell padding is the amount of space between 

~~: :~~:e~~:;~te1~~ y~~ : 1~ ::et~:t~:~ :h~:s!:~~e~ 

around the to.1: so the table looks crowded. 
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Hint 
Valuesfortable 
borders,cell 
padding and cell 
spacing can beset 
in pixels(px)or 
points(pt). 

~ 
By adding cell padding of 4 pixels to the table, you can make 

appear like the one in the original task. To add cell padding 
sert this markup as a second attribute to the table tag. This 

as the effect of adding 4 pixels of whitcspace between the text 
1d the ruled gridlines of the cell like this.-------

body> 

< t a ble rules= " a ll " cellpa dding = " 4px " > 
<cap t ion>Fruit s a le s</caption> 

Save both your webpage and stylesheet. 

Task ISu 
Create a newwebpagewith a table that looks like this and has the caption 'Sales team'. Set 
the border to 5 points, the cell spacing to 5 points and the cell padding to 10 points. - -

Trnel Sl62.20 SlM.75 S150.00 

Betel $240.00 S18l.40 S322.00 

F... S146.50 SIOl.10 S104.50 

The background colour code that you will need is #548DD4. The image that you require is 
calledTURTlE.JPG . 

Plan the table using a hand-drawn sketch similar to this. 

~ 2 ~0.l::'eru-J,,)s t..i"L.tk 't co~, 

,.,__,..,. ........ ,.......,~._.'-i;:,~ ~Tf~~~c~ Ctll:. 



Hint 
When creating a 
newtablelikethis, 
itiswisetoadda 
single character as 
contents of the cell 
when you create it. 
lnthiscaseasingle 
letter'A'hasbeen 
added to the top 
leftcell.theletter 
'B'tothenextcell 
and soon. This is 
because some 
browsers, including 
Internet Explorer 
do not display a 
table cell without 
contents. By adding 
these single letters 
it allows you to test 
the table as you are 
creating it. 
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Create the basic markup as you did with < body> 

Task l 5t, starting with the table tags, the 
caption, the two sections of the table and 
then inserting the table rows. The markup 
so far will look like this. -__ 

The top row of the table header has 
only two cells. The first of these is a cell 
that covers two rows. For this you use a 
rowspan attribute to tell the browser this 
cell is going to span the two rows. TI1e 

[mackup_';;;~is section will l=k like mis. 

< td rowspa n = " 2 " >A</ td> 

< c a ption>Sa.les tea m</caption> 

< thea d > 

</ tr> 

</ tr> 

</ tr> 

</ tr> 
</ tbody> 

< th colspa n = " 3" > B</ th> 

</ tr> 
</ t able> 

</ body> 

The second cell in the top row is a cell that 
covers three columns. For this you use the 
colsp:m attribute to tell the browser that this 
cell is going to span three columns. This cell 
was identified in your sketch as a being a 
heading cell, so the colspan attribute is used 
within the table heading tag. 

Using the sketch to work from, add the 
cells to each row of the table. In the body of 
the table, set the first cell of each row as a table 
heading and the next three cells as table data. 

< th colspan= " 3 " > B</ th> 
</ tr> 

< th>C</ th> 
< th> D</ th> 
< th>E</ th> 

</ tr> 

</ thea.d > 
< tbody> 

1l1is section of the table will look like this. -

< th> F</ th> 
< t d >G</ td> 
< td>H</ td> 
< td> I </ td> 

</ tr> 

In the table tag near the top of the 
markup, add the attributes for the lxm::ler, 
rnles and cellpadding . Also, include the 
cellspacing attribute, which increases the 
spacing between each cell in the table. The 
markup for the rabletag~his. 

<body> 
< table border= " 5 " rules = "a.11 " 

c ellpa dding = " 1 Opx " 

The background colour cannot be added 
to the table tag so create a new srylesheet 
called MYS1YLE6.CSS and include 

< th>J </ t h > 

< td> K</ td> 
< td> L</ td> 
< td>M</ td> 

</ tr> 

< th>N</ t h > 
< td>O</ td> 

< td> P</ td> 
< td>Q</ td> 

</ tr> 
</ tbody> 

</ t able> 
</body> 
</html > 

the style definition like this. Save this table {background-color : #548DD4} 

~:t::~~l~~~ 
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Enter all the text and currency values into the 
correct cells in the table. The webpage should look 
like this. This task is continued in the next section. 

15.10 Using im ages 
Images are frequently used on webpages, sometime 
as a picture and sometimes in the fonn of icons that 
can be used for hyperlinks. 

Inserting an image 

_J_J_J_J 
_J_J_J_J 
_J_J_J_J 
_J_J_J_J 

To complete the webpage for Task 15u, you need to replace tl1eletter 'A' in the top left 
celloftl1etablewitl1 the image1URllE.JPG. To do this you have to tell the web 
browser tl1e name of the image source, which should be stored in tl1e same folder as 
your webpage. Make sure that you have copied the file 1UR 11.E.JPG into your Task 
l 5u folder. Add the following: to tl1e markup. As some browsers do not supJX)rt 
graphics, you can tell the browser to replace the image with alternative text. Ths usually 
describes the image so tl1at the user can still understand what is being shown, even 
though they cannot see the image. The mark.up will look like this. 

<tr> I 
< td rowspa n = " 2" ><l.mg src = "TURTLE . JPG" alt = " Compa ny Logo" ></ td> 
< th colspa n = " 3 " >Expenses</ th> 

</ t r > 

Where to store an image 

Images must be stored in the same folder as the webpage. This is called the current 
folder. Notice in the markup shown above how the filename TURllE.JPG is given as 
the image source. This does not contain any reference to which folder the image is 
stored. Because there is no absolute reference to a folder, tl1e browser automatically 
looks in tl1e current folder for tl1e image. 1l1is means tl1at if tl1is webpage is opened on 
another computer, as long as the image is stored in tl1e same folder as tl1e webpage it 
will work properly. If an absolute reference had been used for a file, for example: 

< img src = : \ webs ites \ My ictures TURTLE.JPG " 

alt = " Company Logo ">< / td> 

this would prevent the file being found unless the 
folders in all the computers were strucrured in this 
way. If tl1e file TURLE.JPG is not in the current 
folder, the webpage will look like tl1is. The image 
has been replaced by the text 'Company Logo' to 
tell the user what the missing image should be. 



Hint 
A common mistake 
made by candidates 
in the practical 
examinations is to 
use absolute 
pathways for files, 
like images, 
stylesheets,etc. 

Hint 
The attributes to 
align elements 
within the table 
can be applied to 
thetagsforatable, 
columns, rO'NS, 
table headings and 
table data . 
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If the image file is stored in the current 
folder, this will be displayed. 

Placing an image 

Images are usually placed within tables. H ow an 
object (often an image or text) is viewed within 
a table cell will depend upon the alignment of 
the cells. The horizontal alignment has been 
covered earlier in the chapter using the align 
attribute, which can be applied to columns (as 
seen earlier), rows (to format all cells in that 
row), or individual cells in the table heading or table data tags. 

Task 15v 
Open theWEBPAGE7.HTM. In the top row, align the images in the second column to the top 
left of the cell, the third column to be centre aligned both vertically and horizontally, and 
the last column to be placed in the bottom right corner of the cell. 

Copy the files WEBPAGE7.HfM, TURTLE.JPG and REMORA.JPG into your 
Task 15v folder. View the wcbpagc in your browser. 

You will edit the markup in the table data tags for the three images of a turtle in 
WEEP AGE7.HIM, adding new attributes to these tags to change the alignment in 
these cells. To align the image (or any other object) to the top of a cell of table data, use 
the valign attribute with the value set to top. 

You can use the values of 'middle' or 'bottom' for this - <td v a lign= " top " > 

attribute to obtain these positions within the cell. The 
horizontal alignment is set using the align attribute, as seen 
in Task lSu. 

For this task, apply the vertical alignment attributes to the table data tag as you 
did in Task l St. Save the completed markup, which should look like that shown on 
the next page. 

The finished wcbp,gc will l= k like this.~ 

...... ._.., m_ ,,. rui.., • .,..,.., 
,..-,..,. ... ·-~ 

·- ·· · 
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- Ta sk 15v by y our n a me 

< title>Ta sk 15v</title> 
</hea d > 
<body> 

< t a ble width = "1001" border= "lOpx " rules = "all " cellpa dding ="lOpx " 

c ellspacing= "lOpx" > 
< tbody> 

< td r o wspa n = " 3" >< img src = " REMORA . J PG" a lt = " Remora " ></ td> 
< td colspa n = "3 " ><hl> Ima ge a lignment</ hl ></ td> 

</ tr> 

< td valign= " top " a lign= " left " ><img src = "TURTLE . JPG" 
a lt = " Logo" ></ td> 

< td valign= "middle" align= " cente " >< img src = "TURTLE . JPG" 

a lt = " Logo" ></ td> 
< td a lilj"n= "bottom" a lign= "right ><img src = "TURTLE . J PG" 

a lt = " Logo "></ td> 
</ tr> 

< td>< h 3>This ima ge is left a ligned a nd a ligned t o the t o p o f the 
t a ble c ell . </ h 3></ td> 

< td>< h 3>This ima ge is c entre a ligned both horizonta lly a nd 

vertica lly. </ h 3></ td> 
< td>< h 3>This ima ge is right a ligned a nd a ligned to the bottom of 

the t a ble c ell . </h 3></ td> 

</ tr> 
</ tbody> 

</ t a ble> 
</body> 

</html > 

Resizing an image 
Images can be resized using two methods : 
• The first method is to change the size of the displayed image in the markup. 1bis 

is the easier o f the two methods, but often uses large image files, which are 
slower to upload and can delay the display of a completed webpage. 

• The second method is to physically resize the image in a graphics package and 
then save the new image. This method has the advantage of being able to reduce 
the file size of an image so that a webpage will be displayed more quickly . It has 
the d isadvantage of using low resolution images, which can appear pixelated, 
particularly if you wish to enlarge them. 

Task 15w 
Open the webpage that you saved in Task 15v. Resize the image REMORA.JPG to a width of 
80 pixels and maintain the aspect ratio. Use both methods to resize this image and compare 
the relative file sizes of the two images. Save both versions of yourwebpage. Make this 
image a hyperlink to the webpage REMORA.HTM. 
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Resizing an image in the markup 

Copy the wcbpagc and supporting files from Task 15v into your Task 15w folder. 
Also copy the file REMORA.HTM into your Task 15w folder. 

To change the size of an image in the markup use either the width or height 
attributes within the image tag. For this question the width needs setting to 80 pixels. 
If you change the width of the image to 80 pixds and do not specify a height for the 
image, it will maintain its aspect ratio. This means that it will keep the same 
proportions. Sometimes you may be asked to distort an image to give a difli:rcnt effect 
within a wcbpagc. This is done by specifying both width and height but not keeping 
the aspect ratio of die original image. Find die markup for the image REMORA.JPG 

which looks like d:i:~>~ 

< t d rowspan= "3"><img- src = "REMORA . JPG ' alt = 'Rernora ' ></ t d> 
< t d colspan= " 3 "><hl>Image a lignmen t </hl ></ td> 

Add a new attribute to the image rag to specify the new width of die image, like diis. 

I 
< t d rowspan= '3'><irrg src= "REMORA . JPG" alt = 'Remora ' width=' BOpx ' </ t d > 
< t d colspa n = '3'><hl>Image a lignrnent</hl></ t d> 

Although die vertical alignment of all 
three turtle images has not been changed in 
the markup, the effect is to make die images 
appear to have the same vertical alignment. 
This is because the row height has been 
reduced to fit with the new row height for 
the image of the rcmora. 

Resizing an image in an external 
package 

Open the image REMORA.JPG in your 
graphics manipulation package. InAdobe 
Photos/Jop images arc resized using the Image 
menu, followed by the Image Size ... option. 
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This opens the Image Siz.e 
window. To set the image width to 
80 pixels, change the value in the 
Width: box. 

The image will maintain its aspect 
ratio as long as there is a tick in the 
Constrain Proportions box. To 
intentionally distort an image you 
would remove this tick and enter a 
height as well as a width for the 
image. Click on iJL, This will alter 

- Ooam,ont>Oe 

::::::7 ~ ]1 
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new filename before clicking 
on ~ . As this image will be 
saved in JPEG fonnat, you are 
given options on the image 
quality that you require. These 
can be selected by typing a 
number between 1 and 12, using 
the slide bar, or selecting from 
the drop-down menu. 1 is the 
smallest file size that you can 
have, also gives the poorest 
quality images. 12 is the highest 
quality but results in large file 
sizes, which are mucl1 slower to 
download over the internet. 
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Resampling an image 

T, ~ .. 
" • 
~ 

This process of changing the image quality is called resampling. Images can be 
downsampled., meaning fewer pixels are used for the image, as you have just done by 
reducing the image quality. Images can also be upsamplcd by adding more pixels. 
Downsampling reduces the file size and therefore makes the webpage load more 
quickly. A good teclmique is to have a small, low resolution image (called a 
thumbnail) on a webpage. If the user wants to see more detail they can click on the 



Website authoring 

image and a new window will open containing a high resolution version of the same 
image. The webpage needs amending so that the width attribute is no longer 
present, and the source attribute within the image tag points to the new filename. 

< td rowspa n = " 3 " ><1.tng ere="REMORAl . JPG" a lt = " Remora"></ td> 

< td colspa n = " 3 " ><hl > I mage a ligrunent</hl></ td> 

Save your amended webpage \\-':ith a new filename. Now open the Documents 
window and navigate to the Task 15w folder. This folder contains the files saved during 
this task and shows you the 

diff"erenceinfilesizes betweet:i~~~~~~~~! :;!~~ 
thetwomc..·t:hc:xl.s. Your image ~ .. " "-" , , ... , ,-,,. · "Ii: 
sizesmayvaryfromthis, 
depending U(X)n the resolution 111 
you selected whet1 you saved : ::'.:' ~- :.:~ ::: 
the file. As can be seet1 here, in ,,,..,,,.. _ , , 
this case the ne\\' image should • " '-' "" --• ,a 
loadinlessthan60percentof ; :: : ~ ::::;..., ,,,..,,......, ..... ..._ , .. 
the time the original will take. · 1 , - II .... : 

Hyperlinks from images 

Images can be used as hyperlinks in the same way as text. To create a hyperlink to 
the webpage REMORA HTM, add this hyperlink reference to an anchor 
surrounding the image tab. / 

<tr> 

< td r o wspa n = "3 " > 
<a href= EMORA . H™ " irrq src= " REMORAl.JPG" a l t= "Remora " >< /a></ td> 

< td c olspan= " 3 " ><hl > Ima ge a lignment</hl></ td> 

This hyper link will open the partially constmcted webpage called REMORA HTM. 

File types for images 
TI1ere are three common file types for images used in websites. TI1ese are JPEG 
files, GIF files or PNG files. You can use a graphics package lik.eAdobePlmtos/Jop to 
change images from one format to another by opening them and using Save As 
change the file format for the new image. 
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Printing webpages 
You will be required to print different views of your webpages for the practical 
examinations. You must ensure that your name is included on the wcbpage before it 
is sent to the printer, in whicl1evcr view is specified. Printing the HTML view is 
frequently required, and even if you are using a WYSIWYG package you will need 
to open the wcbpage in a text editor to print the html. Browsers will often do this 
for you. In Microsoft Intern a F.xplorer this is opened using Page and View Source. 

It is worth noting that the image above would not gain any credit in the practical 
examinations as there is nothing to identify the candidate on the printout. Browser 
views like this are acceptable, but you must ensure that, if you chCXJsc to use a 
WYSI\VYG package, you test the wcbpagc in a browser and not just within the 
package. Some products will display what appears to be the browser view, but is 
only a development tCXJ! and docs not necessarily display the page as it should. 
Taking scrcenshots of your pages; using the <Print Screen> button on your 
keyOOard to copy the screen contents into the clipboard, then pasting the clipOOard 
into another package (usually a word processor) is a useful method of providing 
evidence of your work. If you have used sryleshccts in your webpage make sure that 
you print evidence of these as well. It is more difficult to include your name in a 
sryleshcc..'t, so copying and pasting the sryleshcct into a word-processed document 
containing your details is a good method of producing this evidence. 

Activity ISf 
Create a new webpage with a table that looks like this and has the caption 'Last week'. Set 
theborder,cellspacingandcell paddingto4pixels. 

E::i:prnsrs PltTm_!. r--~-~--~-----, 

$182.20 $185.75 $260.00 $322.00 

$80.00 $62.40 $54.00 $40.00 

$420.00 $382.10 $104.50 $260.00 

The background colour code that you will need is #FFFFOO. The image that you require is 
called PCTC.JPG. Print yourwebpage as html and as it is viewed in your browser. 
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In this chapter you w ill learn how to: 
• use a master slide to set up a presentat ion 
• create presentation slides 
• add and edit text 
• insert an image 
• create and add a chart to a slide 
• insert other graphical featu res to a slide 
• use transitions between slides 
• animate objects on a slide 
• save and print a presentation . 

For this chapter you will need these source files from the CD: 
• HTML. RTF 
• POWERPOINT.RTF 
• SLOGAN. JPG 
• WEBSITE.JPG 

16.1 What is a presentation? 
A presentation is a series of slides used to give information to an audience. A presentation 
can be used in many difl:i:rent ways : to teach o r inform as a visual aid in a lecture, or as a 
constant on -screen carousel giving information or advertising, for example in a shopping 
centre or mall. The media for delivery and type of presentation developed will dtp:nd 
upon the purpose of the presentation and the target audience. Fo r example, you would 
design a presentation on road safety to a class o f fi ve-year-old children to be short (for a 
short attention span), have only a few simple words (as they ca1mot read fluently) and 
contain bright colomful moving images (to keep tl1eir attention ). TI1e medium for tl1e 
ddivery of tl1is p resentation would be using a multimedia projecto r and large screen. 

It is important to understand all o f this information before starting to design and 
develop the presentation , as different media will require different screen/page si7..es. 
M ost p resentations will require a consistent colour scheme and consistently applied 
styles to all slides . In the practical examination, you will be g iven details o f these 
colour sch emes and styles . 

16.2 Using the maste r slide 

Task 16a 
You are going to create and save a short presentation for IGCSE students telling them how to use 
Microsoft PowerPoint. The medium for delivery will be a multimedia 

proJector LU 
Create a master shdew1th a pale yellow background on the right hand 
s1de(about1/4ofthew1dth)w1thonevert1caldarkbluestripeasa 
border for the yellow background and two horizontal dark blue stripes 
Eachstripeshouldbe4pomtsw1de ltshouldlookhketh1s ~ 
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A master slide allows you to design the layout of your slides before you start adding 
objects (like text or images) to the slides. It holds the information on colours, fonts, 
effects and the fOSitioning of objects on the slides. 

Open PowerPoint and select the View tab. Find the Presentation Views section 
and click on the Slide Master icon. 

Click to edit Master title style 

O>ek!o!OditMut~r,ubtitlestyle 

The display will change to this. The layout of a presentation will depend on the 
medium for its delivery. In this task, you are told that the medium for delivery will 
be a multimedia projector. To change the medium for delivery you must select the 
Slide Master tab and find the Page Setup section. Click on the Page Setup icon, 
which will open the Page Setup window. 

Use the Slides sized for : drop-down list to select an On-Screen Show. You can 
also change the orientation of slides and handouts/notes pages in this window. When 
you have selected the settings, click on o,; • 

---•IG 

Delivery of a presentation with a multimedia projector may include the use of 
audience notes and/or presenter notes. Audience notes are paper copies of the 
slides of a presentation that are given to the audience so that they can take them 
away and refer to them after the presentation. TI1ese can be in different formats, 
with several slides on a page, or just one slide with space for the person to add their 
own notes. Presenter notes are a single printed copy of the slides from a 
presentation, with prompts and/or key facts that need to be told to the audience by 
the person delivering the presentation. These notes are not usually given to the 
audience. More information will be given on these later in this chapter. 



\Vhen you look at the presentation, 
you will see a list of master slides will 
appear down the left side of the screen. 
You must select the Office Theme 
Slide Master at the top of the list. 

Working in this master slide will 
affect all of the other master slides for 
each different style of page you may 
decide to use later. The master slide now 
appears like this. 

Presentation authoring 

ClicktoeditMaster titlestyle 

For this task., the master slide has to contain a number of lines and one filled area. 
You should start with the filled area. 1l1is will be created by placing a filled rectangle 
in the right place. However, this rectangle will cover some of the objects already on 
the slide, so these objects need resizing or moving out of the way first. 

Select the title text box and use the drag handle to resize the text box. 
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Repeat this for the body text box on the master slide. This OOx has also been 
made less deep using the lower drag handle, in order to create space to move the 
slide numbering. 

The text OOx containing the slide numbering is t small to resize, so this will 
need to be moved from the right-hand side. Drag the entire text box into the space 
created below the body text box. 

The page layout should now look like this. 

Select the Insert tab and find the Illustrations section. Click on the Shapes icon 
and select the Rectangle option from the drop-down menu. 

Use the drag tool to drag a new rectangle that fills about a quarter of the slide. 
Make sure that this rectangle fits to the top, bottom and right edges of the slide and 
leaves no white space. 

Hint 

Many,~~!:~ke :h
1

e rect:n:~~:~n a:~e found in the Drawing section of the Home tab. 

i~~IJ~:"~~~::::.-. Q=• · 



Hint 
Holding down the 
<Shift>keywhilst 
placing the line 
forces it to be 
either vertical, 
horizontal orat45 
degrees. 

Hint 
You may find it 
easier to copy the 
firstlineandpaste 
ittwice,rotatethe 
two new copies and 
resize and place 
them as required by 
the task. 

Presentation authoring 

You now need to edit the appearance of the rectangle. Select the Home tab and 
find the Drawing section. Use the Shape Fill icon to select the fill colour and click 
on the Shape Outline icon, followed by Weight from the sub-menu. Select the 
More Lines ... option to remove the borcler from the rectangle. This can be done 
by setting the width of the line to 0. The master slide should look like this. 

You will notice that all the other master slides (down the left-hand side of the 
window) now show the yellow background. 

line~::\r:usl:~:.d ;:i;~~;~~:: ~~~~ ~ ~" { ?: ~ -~ .~. ~ ;-·;: • • • • • 

then in the Drawing section select the I 
Shapes icon and click on the Line 
option from the drop-down menu. Use ~ r tit le 
the drag tool to draw a vertical line on -
the border between the yellow and 
white areas. 

Use the Shape Outline icon to ~ .. -- - - "'-

Shape Outline icon can also be used to , ., --

change the line thickness. Select Weight ::;: == 
and from the sub-menu select the line ,., --
weight. For this task, the line weight ~ _ 
should be 4 JXlints. This option is not 
available from this menu so select the 

change the line colour to dark blue. The;t :: ~ 

nearest weight avaibble, in this case 4 1/2. l;'-;;;;;;c-;:::"""""""""""":"':=-1..,.'"l 
Right mouse click on the line and select 

Format Shape .. . from the drop-down menu. 
From the Format Shape window adjust the line 
W idth : to 4 points . Click on ~ 

Repeat this process to add the two horizontal 
lines to the master slide, in the positions shown 
in the task. Save the presentation with the 
filename Ch_l 6 _Task_l6a. 

= 
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Task 16b 
Open the presentation that you saved in Task 16a. lndude the heading 'Using PowerPoint', 
left aligned in a dark blue, 60 point serif font above the blue line at the top of the master 
slide. Include an automated slide number in the bottom left of the footer. 

Enter your name, centre aligned in the white area, at the bottom of the master slide. Use a 
black, 14point, italic, serif font . 

Place a clipart image of a computer or peripheral in the right-hand area. Crop and/or resize 
the image so that it fits within the yellow area and will not overlay the dark blue lines. Do 
not distort the image. Make sure that the image fills more than 50 per cent of the available 
space. Save your presentation . 

r;,.'.E r;;:::::;'.::C~=2""'~=:--::e~~ To include the heading, add a 
new text box in the top left 
section of the slide. This text 
box will replace the title text 
box, so move the title text box 
down the slide to below the 
blue line. Go to the Insert tab 
and click on the Text Box icon 
in the Text section. Drag out a 
new text 00.x, select the Home 
tab and find the Font section. 
Set the font size to 60 points 
and select a serif font, e.g. 

[!~~~~ii=:iiiii!c::il~ Times New Roman. 

Enter the text 'Using PowerPo int' into this text box. The window should now 
kx:,k like this. Highlight the text and set the font colour to d ark blue, using the Font 
Colar icon. 

As the text is already left aligned , do not adjust the alignment. Notice how the 
text box has been aligned with the other objects on the slide so that the examiner can 
check that the text is left aligned. 

The automated slide number is in the o bject moved fro m the right side of the 
footer. The task asks for this to be placed on the left in the footer. Resize this object 
(as shown previously) and change its al ignment to left aligned by clicking on the 
Align Text Left icon in the Paragraph section under the Home tab. Drag the box 
into the bottom left com er. As the date is not required on all pages, this o bject can 
be deleted before moving the automated slide number. 

Enlarge the automated fCXJter so that it fill s the width of the white space, as 
shown. Make sure that you enlarge the fCXJter so that it overlaps the slide number, 
which will ensure that the examiner can sec that the o bject is centre aligned. Change 
the text and the slide number to a black, 14 point, serif font, as described above. The 
finished footer area should look like this. 

'~--
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Although you have set the footer are~---
ofthe master slide, you have not yet li.............. uiieiJ I 
added y~ur nan:ie to the footer, nor told ;;':. _:."": 
PowerPomttodisplaythepagenumbers. ~ ~ 
To dothis,selectthe Insert tab, then in ~~ 
the Text area click on the Header and ., ,.... ====::i ::;:~ ::~!.is opens the Header and 11 ~;:_ ~ I 
IY,}~~:; ~::; ~~! ~i~~e

1

~~1: : ;:1:::dti~e !al=··='-.. ·=·=·=======:.!· 
text OOx for Footer and type in your 
name. To set this on all slides, dick on ~ . 

Restore the full height of the lxxly text OOx on the master slide using the drag 
handle. Now move down into each of the other master slides and resize all text 
boxes to ensure that they fit within the white space, for example from this to this. 

Using PowerPoint 

ClicktoeditMastertitle ylel" 

/ I 

Using PowcrPoi nt 

ClidtoeditMastertitle ' 

"'' 

If the task required particular font styles or sizes for each of these objects, these 
can also be set in these master slides as described earlier. 

Clipart images 
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e11t!:~:~~:~~: ; ~~t~:t e:~~:t::
1 
~~!1~d

0

~:c~o:p~ ~(see 
Section 10.5 for further details on clip art options.) 

This searches the clip art library and finds pictures that may 
match what you are searching for. Look through the images to 

~:~;::;:a;:::~ ~s:l!~: !:;:~~:~l~:~:: ~i;:ti:.b;!::r , , ,,,,,as.=s.,=;-,a I 
you have chosen the image, dick the left mouse button on it to 
select it. This places this clip art image onto the master slide. 
Move and resize it so that it fits into the correct area. To crop 
the image, select the image and click on the Format tab. In the 
Size section, click on the Crop icon . 

. ~ 
[I] Htight: 7.74cm : 

With the crop tool selected use the drag handles of the image to crop the edges so 
that it changes from this to this. 

\Vhen the master slide is complete, select the View tab and in the Presentation 
Views section click on the icon for Normal page layout. Save your presentation. 

16.3 Creating slides 
There are two methods of creating presentation slides. The first method is to import 
the page contents from a text file. The text file could be stored in .txt or .rtffom1at. 
The method for creating these slides is the same. With rich text format, the styles 
saved within the document apply to the presentation, whereas with text format there 
are no styles saved within the document, so these need adding after the slides have 
been created. 

Task 16c 
Open the presentation that you saved in Task 16b. Import the file POWERPOINT.RTF, placing 
the text as slides in your presentation software. Save the presentation. 
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O pen the presentation. Select the Home tab and in the Slides section select the drop­
down menu from the New Slide option. Select Slides from Outline .. . near the 
bottom of this menu. Browse through your files until you locate the file 
POWERPOINT.R TF; click on this filename followed by ~ . This leaves the 
o rig inal title slide but adds five extra slides to tl1e presentation. Save the presentation. 

The second metlmd used to create presentation slides is by inserting a new slide 
into an existing presentation. 

Task 16d 
Open the presentation that you saved in Task 16c. Insert a new slide between slides 4 and 5. 
This slide will contain the heading 'Ease of use', a chart and a bulleted list: 

• 86% of students found it easy to use 
e 120studentsinthesample 

Use this data to create a chart: Easy - 103, Difficult - 12, No response - 5. Show the 
percentageofstudentsineachcategory. 

On slide 1, add the heading 'Hints and tips' and add the subheading 'for IGCSE students'. 

Set the following styles of text throughout the entire presentation: 

• heading: darkblue,serif, leftaligned,40 point 
• sub-heading: blue,sansserif,centrealigned, 30 point 
• bulletedlist: black,sansserif, leftaligned,24point. 

Save the presentation. 

Open the presentation. Move into tl1e left pane and select the Slides tab (if it is 
not already visible). Click the cursor between slides 4 and 5 so tl1at it flashes as a 
horizontal line like this.-----------~ 

Select tl1e Home tab and in the Slides section select the drop­
down menu for New Slide. Look at the different slide layouts 
available from this menu and select tl1e layout tl1at matches tl1e slide 
you are going to produce. This slide needs a small bulleted list and a ~·-.~~~~~·~···'···r 
u _., ...... .._ ,;, ---
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Although the option for 'Content with Caption' looks correct, it is more difficult to 
manipulate the caption OOx. Click once on this icon to get the new slide. 

Delete 00th of the text OOxes that say 'Click to add text'. These are not needed in 
this slide. To do this click on the line for the text box and press the < Backspace> or 
<Delete> key. Use the drag handles to edit the two larger objects below them to 

make them fit the available space. Move the title text box down, so it sits below tl1e 
blue line. The slide will change from this to this. 

Click in tl1e title text box and add tl1e heading 'Ease of use'. Select the left object 
below the title. Click on tl1e bulletecl text 'Click to add text'. This will change tl1is 
object into a text box. Type in the text '86% of students found it easy to use', 
<Ren1m>, ' 120 students in tl1e sample', so tliat it looks similar to this. 

It is sensible to complete all the text parts 
oftl1is task together and then add tl1e chart ==- --==·'=- -=-­
at the end. Move onto slide 1. Add the 



Hint 
You may find it 
easier to define all 
the styles in the 
master slides before 
adding the 
contents to any of 
the slides. The 
instructions given 
inthistask(andthe 
practical 
examinations)may 
not be in the 
easiestorderwithin 
PowerPoint. It is 
sensible to read 
through the task 
before starting. For 
example,setting 
the styles first may 
save you a lot of 
time later. 
Remember that the 
practical 
examinations are 
created for all 
platforms and 
manytypesof 
software. 

Select the View tab followed by Slide 
M aster and select the Office Them e 
Slide M aster (the top master slide). 
Highlight all the text in the heading 
(title) style and dick the right mouse 
button to obtain a drop-down menu and 
minian1re toolbar to allow you to edit 
the text style. 

The heading style needs to be a dark 
blue, left aligned serif font; so select a 
serif font like Times New Roman, using 
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the font list. Use the Text Colar icon to ___ ,. 

selectadarkbluecolourand use the ~ 
Alig n Text Left icon to change the text Calilm '*° • K 11: ~ • iz · ::J 
alignment. Use the drop-down list for B I II: ~ . !,_ flt;:: . 
the font size to change it to 40 points. 
The text box should now look like this. 

Use a similar method to set the first 
level of the bulleted list, to a black sans 
serif, left aligned font (no changes 
needed for these parts), 24 points high. 
Adjust the font sizes for the other levels 
of bullet points so that they are smaller 
relative to this one. 

The sub-heading style is not visible in 
this master slide, so you need to move 
into the master slide for the Title Slide 
Layout (the first master slide down). 

In the master slide for the Title Slide 
Layout, highlight the text for the Master 
subtitle style and set this to a blue, sans 
serif, centre aligned, 30 point font. Use 
tl1e same metl1od as you did for tl1e 
Master title style. 

Move tl1rough each slide master in 
rum and edit any of tl1e styles on other 
page layouts that need to be set. 

Select the View tab and the Normal 
icon. Check each slide carefully to ensure 
that tl1e styles that you have changed 
have been applied to each slide of the 
presentation. If tl1ey have not been 
applied, you can right mouse dick on the slide background (not on an object) and 
select R eset Slide from tl1e drop-down menu to ensure tl1at each slide matches tl1e 
expected styles. You should not need to do tl1is very often, but in this example, 
because you imported pre-defined styles into the presentation, added a new page and 
then set the styles, it may be necessary. 

It is very important to make sure that all slides are consistent. A significant number of 
marks are lost in the practical examinations by srudcnts who assume that tl1e software 
will fonnat tl1cir slides correctly and do not check each slide carefolly themselves. 

This task is continued in the next section. 
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16.4 Creatin g a cha rt 
Move into slide 5. In the task you were instructed to 'use this data to create a chart: 
Easy- 103, Difficult- 12, No response - 5. Show the percentage of smdents in each 
category.' There are two ways of doing this: to create the chart within PowerPrint; or m=~-~-~--~-~-~~~-
Creating a chart in PowerPoint 

Click on the chart icon in the unused object on this slide. This opens the 
Insert Chart window. 

-~ 

You must decide which type of chart is the most appropriate for the task. In this 
case, you are told to show the percentage of students in each category and there is a 
clue to the need for percentage 
values in the bullet points on 
the left of the slide. Because the 
chart needs to show percentage 
values (parts of a whole), a pie 
chart is the most appropriate 
type of chart. Select a simple 
pie chart from the available 
chart types and click on ~ . 
1bis opens a default pie chart, 
but does not use the correct 
data. TI1e slide should now look 



Hint 
Charts maybe 
created from 
contiguousornon­
contiguousdataand 
can have features 
liketitles,legends, 
and labels for axes 
and segments.All 
the features that 
you studied in 
Chapter14canbe 
applied to a graph 
orchartbeforeitis 
cut and pasted into 
the slide. 

A5 you can see, the chart does not 
relate to the data for this task. Instead, it 
is about quarterly sales in a company. It 
may also open an Excel spreadsheet like 
this that contains the data. If this does 
not appear, select the Design tab under 
Chart Tools, find the Data section and 
click on the Edit data icon. 

Move into cell El and replace the 
label 'Sales' with the word 'Students'. In 
cell A2, enter the text 'Easy' so that it 
replaces the existing text, in A3 type 
'Diflicult' and inA4 'No response'. 
Replace the sales figures in B2 with 103, 
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in B3 with 12 and in B4 with 5. Delete the contents of cells AS and B5. Drag the 
blue range marker using the drag handle so that it includes cells Al to B4 only. It 
should now look like this. 

The slide now contains the correct chart. Close the spreadsheet containing the data. 

Inserting a chart into PowerPoint 
TI1e second way of placing a chart into the slide is to create a chart in Excel and then 
insert this chart into the slide. This method is usually more flexible than the first 
method, as it allows you to create and edit the chart before adding it to the slide. 
Open Excel and enter the data into cells Al to B3. 

i=i:;~==i:~ ......---------no"!..._,...=""""'...,.... __ """l 
1 Ea IOJ 
2 Difficult J2 
3 Nores 5 

Select the Insert tab, and in the Charts 
section click on Pie Chart. Manipulate and 
label thecl1an as shown in Section 14.8. 
Copy the cl1art and paste it into the slide. 
For this task you can paste it into slide 6. 
Resize both the chart and the text 
containing the bullet point so that they do 

~~; ::~lap. TI1e completed slide will look --i;!oa.aialiio- ... ------11 
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Activity 16a 
You are going to create a short presentation for IGCSE students giving them hints on 
website authoring . The medium for delivery will be a multimedia projector. 
Create a master slide with a green background at the top (about ~ of the height) and at the 
bottomofeachslide(about X. oftheheight)withadarkgreen horizontal line as a border 
between the white and green backgrounds. Add two vertical dark green lines to the left of 
the slide. Eachlineshouldbesixpointswide. ltshouldlooklikethis. 
lndudetheheading'HTML',rightalignedinablack40pointsansserif L 
font at the top of the master slide (as shown above). Include an 
automated slide number in the green area to the left of the two vertical 
lines. Make this a 14pointblacksansseriffont. lncludeyournameright 
alignedinthefooterinthesamestyleasthepagenumbering. 
Set the following styles of text throughout the entire presentation: 

• heading: black, sans serif, left aligned, 40 point, within the green 'header' section 
• subheading: red,serif,centrealigned,40 point 
• bulletedlist: darkgreen,serif, left aligned, 32point 
e level2bulletedlist: darkgreen,serif,leftaligned,24point. 

Place a very small clipart image of a computer or peripheral in the bottom right corner of 
the white space. Crop and/or resize the image so that it fits. Do not distort the image. 
Import the file HTML.RTF, placing the text as slides in your presentation software. On slide 1, 
addtheheading'Hintsandtips' andaddthesubheading'forlGCSEand Leve12students'. 
Use this data to create a chart: Text editor - 42, FrontPage - 37, Dreamweaver - 31 . Show 
thepercentageofstudentsineachcategory. lnsertthischart intoslide5withtheheading 
'Percentageofusersfromthesurvey'. 

16.5 Add ing presenter notes 

Hint 
Take great care 
when entering 
presenter notes. A 
large number of 
marks are lost in 
the practical 
examinations each 
year through 
carelessdataentry 
in presenter notes. 
Take great care 
with the use of 
capital letters and 
punctuation. 

Task 16e 
Open the presentation that you saved in Task 16d. Add the following presenter notes to the 
slides: 

Slide 1: Welcome to this presentation giving you useful hints and tips on using Microsoft 
Power Point for your IGCSE practical examinations. 

Slide 2: The presentation that you are watching is made using PowerPoint. 

Slide 4: Hyperlinks can be used to give different paths orto open external websites or 
documents. 

Slide5:Graphsandchartscan beaddedtoenhancea presentation. 

O pen the presentation that you 
saved in Task 16d . ful you o pen 
the presentation in Nanna! view, 
it looks like this. 

Move the cursor to the Notes 
area of the screen . Click the 
cursor into this box and type the 
presenter notes fo r slide 1. Use 
the Slides tab to select the next 
slide and continue with this 
process until all o f the presenter 
notes have been entered . Not all 

Using PowerPoint 

; ~: ~~~: ::Tie1fo;:;~::,1~~:es . ..,..,;.;;.., _ _ ___ ____ _ 

the slides when the presentation is nm. You will learn how to print these so that the 
presenter can read from them in Section 16.9 . Save the presentation . 
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16.6 Using images 

Hint 
It is easier 
manipulate these 
objects if the ruler 
is showing. To 
select the ruler, 
select the View tab, 
find the Show/Hide 
section and click on 
the tick box for 
Rule r. 

Task 16( 
Open the presentation that you saved in Task 16e. Add the image SLOGAN.JPG to the 
bottom of the final slide, above the blue line. Crop the image so that the red line and all 
contents below it are removed. Resize the image so that it fits about 1 centimetre from the 
left edge of the slide, 1 centimetre above the lower blue line and 1 centimetre to the left of 
the vertical blue line, maintaining its aspect ratio. Adjust the brightness and contrast of the 
image so that the background colour (pale yellow) is not visible. 

In Task 16b, you inserted a new image from clip art into the master slide. For this 
task, you are going to insert an image given to you as a file. 

Open the presentation saved in Task 16e and use the Slides tab to open slide 7. 
Select the Insert tab and then click on the P icture icon. This opens the Insert 
Picture window. Search through the files until you locate SLOGAN.JPG, select the 
file and click on to insert the image into the slide. Click the left mouse button on 

'.~ ~: ' ,nd fro~_,h: Fornun ,b : ~:i~-on tl,c Crnp mol iwn 1 :==- --- .. ,.-CIQ l;:;l .=iCI ==- • ._.-oc_e;---------~ 

Worklni wllb PowerPolnl 
Is tun 

Drag the lower handle up the screen above the red line, but below the red text, 
to crop the image. 



II 

Information and Communication Technology 

Click the left mouse button off the image then back on it and drag the image 
down so that the left and bottom edges are in the correct place on the slide. 

Grab the top right drag handle and drag this to resize the image to the correct 
position to the left of the vertical blue line. Th::cs7cmS ~ 

Wtl'lllt WIii POWerPtlll ;m -
ls tun 

To remove the pale yellow background colour 
from this image, you need to adjust the image 
brightness and contrast. Click the right mouse ... _ 
button on the image and select Format Picture. .. - = [__jJ: : 
from the drop-down menu. This opens the Format --1 :=. ~ 
Picture window. Select the Picture option from the ~ 
left side of the window. Move the sliders for the -
Brightness: and Contrast:, so that the pale yellow 
background disappears but the other colours remain 
unaffected. These figures are found using trial and 
error: both settings change from 0% to a brighmess 
of around 35% and a contrast of around 75%. vVhen 
you have completed this, click on ~ . = 
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The slide should now look 

Iik,,:'~~;,,-h
0
_w_,-h,- ,-,a-,-

0
-
10
-"'- +- Using PowerPoint 

in the text has changed from its 
o rig inal dark red colour (see 
the previous page) to this shade 
of red. Save the presentation . 

Task 16g 
Open the presentation that you saved in Task 16f. Add : 

• an arrow to slide 5 pointing from the first bullet point to the largest segment of the pie 
chart 

• a callout box to slide 6 telling the reader that the image of a computer is placed on the 
master slide 

• the text 'C Microsoft' to the end of the first bullet point on slide 7 in a in a black, 12 point 
sans serif font 

• a 6 point horizontal red line to slide 7, above the image you inserted in Task 16f. 

Open the presentatio n and select slide 5 using the Slides tab . Select the Insert tab 
and click on the Shapes icon. 1bis drop-down menu o f available shapes will appear. 
Select an arrow to be included on the slide. Click the left ---.. ===--= 
mouse button where you want the arrow to start and 
drag the point of the arrow to the position that you 
want it to finish . 

The finished slide should look like this. 

Using PowerPoint 
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To place the callout box on slide 6, select slide 6 and again select the Insert tab 
and Shapes icon. This time select a callout box from the Callouts section of the 
drop-down menu. Click on the slide and drag the callout box to draw it. It is easier 
if you make the box too large and reduce the size later. \Vhen you have placed the 
box, grab and drag the yellow handle to move the pomt of the call out box so that 1t 
pomts to the image 

OU1t 

Type the to.1: that you require into the callout OOx (you cannot see the cursor as 
you can with a text OOx) and then resize the callout OOx using the drag handles. It 
may look similar to this. 

Select slide 7. To insert the copyright symbol, click the left mouse button to place the 
cursor after the 't' at the end of the first bullet ix,int. Select the Insert tab and click on 
the Symbol icon. This opens the Symbol window. Scroll through the available list of 
symOOls until you find the O symbol. Click on this symbol and then click on -
followed by ~ Add the text 'Microsoft' after the symOOl and highlight both the 
symOOl and the new text. Set this to a black, 12 ix,int sans serif font using the methods 
learned earlier in the chapter. 
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To insert the red line, select the Insert tab, then click on the Shapes icon and 
select a line. Drag the line horizontally across the page. Click the right mouse button 
on the line to open the Format Shape window. Use the Line color and Line style 
sections to change the colour and thickness of the line. The completed slide should 
look similar to this. Save the presentation. 

Using PowerPoint 

Worklnl! Wllh PowerPolnl 
) )un 

16.7 Tra nsitions between slides 

Hint 
For the practical 
examinations, 
always use the same 
transition effect 
between slides and 
the same animation 
effect throughout 
the whole 
presentation . 
Consistency in these 
areasisjustas 
important as using 
consistent styles and 
colour schemes. 

Task 16h 
Open the presentation that you saved in Task 16g. Apply transitions between all slides in 
your presentation. In slide 3 animate all the bullets so that they appear one at a time. 

The transitions betwet,1 the slides are the methods used to introduce a new slide. This 
can be simply replacing die existing slide with a new slide or using a number of 
different fean1res to change from one to another. All transitions are located in die tab. 

Open the presentation. Select the Animations tab and find the Transition to 
This Slide section. H old the mouse over each of the slide transitions to see die 
effect diat it uses. Tiiere are more transitions available; you can use the scroll bar to 

s~tl,csc. ' ~ 

.,._ .. ff.,_. 

Click on the icon to select the transition that you wish to use and then click on 
the Apply To All icon to apply die same transition to all slides. This task is 
continued in the next section. 
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16.8 Animation effects 

Select slide 3 and highlight only the bulleted list . 
Select the Animations tab and find the 
Animations section on the left. Select the drop­
down list next to the Animate: icon, which will 
look like this. 1l1e task instrncted you to 'animate 
all the bullets so that they appear one at a time', 
so select Fade, Wipe or Fly In with By 1st Level 
Paragraphs. This sets the animation. 

It is a good idea to have the Custom 
Animation pane open, so that when you need to 
show evidence of your animation effects these can 
be seen. To do this, still in the Animations tab, 
click on the Custom Animation icon. The 
button at the bottom of the Custom Animation 
pane allows you to test your animatio n and see if 
it works as you intended. Each individual 
animation can be edited in the Custom Animation pane by clicking on the item in 
the pane and clicking the right mouse button to obtain the options. The order o f 
animation can also be changed by dragging the items up or down in the Custom 
Animation pane list. Save the presentation. 

16.9 Savin g a nd printin g a presentatio n 

As with all your work, make sure that you save your presentations regularly using 
the Office button and Save. To print evidence of your work, you must identify what 
types of printouts are required . Sometimes you will be expected to print only the 
slides, but more often you will need to print audience or presenter notes; for these 
printouts you will need to select the Office butto n and Print. To print evidence o f 
the transitions and animations, screenshot evidence is the best method . 

Task 16i 
Open the presentation that you saved in Task 16h. Print your presentation showing: 

• onlytheslides 
• presenter notes 
• audience notes with three slides per page and space for the audience to make notes 
• evidenceofthetransitionsbetweenslides 
• evidenceoftheanimationsusedonslide3 . 



Presentation authoring 

Printing slides 

Select the Office button and Print, to open the Print window. In the Print what: 
drop-down list, select Slides. This will print only the slide/ s content with no 
additional notes or space. 

l"'.J """"to!t<>4>" c,-u:;,;a,,,ol<b 
~ ... ,,,.,,,,;c. ~ tio;i, ,....it, 

c-'"""'"""""""rt~ 
[::;;;:::] ~ 

Printing presenter notes 

In the Print what: section, select Notes Pages. This will print the content of the 
slides and the presenter notes that you typed in the Notes section for each slide. 

Printing audience notes 

In the Print what: section, select ~==========~~ 
Handouts. This will give you 
several options to select from. 
The task asks for three slides per 
page, so in the Slides per page 
section, select the number 3 from 
the drop-down list. The small 
image to die right shows you 
what the printed pages will look 
like. In this case, the three slides 
arc to the left and space to make 
notes on the right. This matches 
the requircments of the task. 

You can click on to 

check die printout is as you 
intended before printing or click 
on cii:" to print. 

:!f/\'Al"'tllio'tf'De,ale! MX'./M1C,&12C/ .•• 1 ... ;1 1 ::r"""lio> I 
:!"o..u.,"40C,M,c,Mx:,M,r; 1~'"'"'···1 

l!"l ""nlt<> lle 



II 

Information and Communication Technology 

Printing evidence of slide transitions 

Select the View tab and click on the icon for Slide Sorter view. Use the <Print 
Screen> key on your keyboard to copy this into the clipboard and paste the image 
into a word-processed document so that you can add your name and other details 
before sending it to the printer. 

You can see from the Slide Sorter view the evidence that transitions have been 
added to each slide. 

Printing evidence of animations 

Select the View tab and click on the Normal icon to rerum to the Normal view of 
the slides. Select slide 3. Make sure that the Custom Animation pane is visible to 
the right of the slide. If it is not visible, open it using the Animations tab followed 
by the Custom Animation icon. Use the <Print Screen> key on your keyboard to 

copy this into the clipboard and paste the image into a word-processed document so 
that you can add your name and other details before sending it to the printer. 

The numbering next to eacl1 bullet point shows that eacl1 bullet is animated 
separately from the others. Further detail about the animation of bullet point 1 can 
be seen in the Custom Animation pane. If the individual bullets are not visible, 
click on the icon in the Custom Animation pane to pull down the list. 



Activity 16b 
Open the presentation that you saved in Activity 16a. 
Add the following presenter notes to the slides: 

Presentation authoring 

• Slide 1: Welcome to my presentation giving tips about website authoring using html . 
• Slide 4: An intranet is internal within an organisation and is managed. The internet is 

global and is not managed. 
• Slide 6: There are many other websites that can offer you help. 
Place the image WEBSITE.JPG on the right side of slide 6. Crop this image so that only the 
crestandnamearevisiblelikethis. 

Add a red arrow, 3 points wide, from the text 'CIE website' to point to this image. 
Apply transitions between all the slides in your presentation. 
In slide 3 animate all the bullets so that they appear one at a time, in the order that they are 
in the list. 
Print the presentation showing: 

• presenter notes 
• audience notes with six slides per page 
• evidence of the transitions between slides 
• evidence of the animations used on slide 3. 
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abnonnal data 98 
Acce!l"seedatabases 
accessing data 29 
access points, \VLANs 40 
acn1ators 26 
advanced search options 116 
alignment 147-8 

tables 145-7 
text wrapping 127-8 

alphanumeric data 53, 151 
analogue data 57-8 
analogue to digital converters (ADCs) 18, 19, 

58, 82 
analysis stage, system analysis 94-5 
anchors 250 
AND operator 51-2 
animations 73 

in presentations 288, 290 
anti-virus software 60 
applications servers 37 
applications software 2 
asymmc.."tric digital subscriber line (ADSL) 

modems 42 
attachments, email 112 
audience notes, presentations 270, 289 
authentication techniques 47 
automated teller machines (ATMs) 9, 89 
automatic stock control systems 86-8 
AVERAGE function 195-6 

background colour, webpages 249-50 
backing storage devices 29-36 
backing up data 28-9, 60 
back problems 69 
banking 

automated teller machines (ATMs) 89 
chip and PIN 90 
online 62-3 

barcharts 219 
barcodes 15, 86-8, 91 
batch processing 80 

applications 86 
Bee: box, email 108 
billing systems, batch processing 86 
BIOS (basic input/output system) 3 

biogs (web logs) 67 
bluetooth 41 
blu-ray disks 34-5 
body section, webpages 229-30 
bold text 139 
booking systems, online 88 
Boolean fields 152 
Boolean (logical) data 50-3 
bootfile 3 
bridges 42 
broadband modems 42, 45 
bulleted lists 140-1 

webpages 244 
bus networks 38-9 
buzzers 27 

cable modems 42, 45 
callout boxes 286 
camera images 123-4 
cascading srylesheets 236-42 

aligning text 239 
classes 241-2 
enhancing text 24-041 
font-families 236-7 
font size 237-9 

cathode ray rube (CRT) monitors 21 
Cc: box, email 108-9 
CDs 32-3 
cell padding 259-60 
cells 

spreadsheets 188 
tables 145-7 

HTML 259-61 
cell spacing 261 
central processing unit (CPU) 3 
centre aligned text 147-8 
changeover methods 98-100 
cliaracterchecks 97 
cliarts 218--21 

colour and shading 225-6 
insertion into word-processed documents 182 
modification 221-2 
in presentations 280-81 
printing 186 
secondary axes 223-4 



check digits 87, 97 
chemical processes, control 84 
chip and PIN system 9, 14, 90 
classes, cascading stylesheets 241-2 
clipart 122, 275-6 
club records, databases 76 
CMOS (complementary metal oxide 

semiconductor) 3 
CODEC 48 
colour 

in documents 139 
in graphs and charts 225-6 
printing 184-5 
in spreadsheets 212 
in webpages 245-50 

COLOURCODES webpage 245, 246 
column breaks 134 
columns 

in spreadsheets 188, 216 
in tables 143, 144, 146 

HTML 259 
of text 135-6 

command line interfaces (CLis) 4 
comma separated values ( .csv) files 117 
communication methods 48-9, 71-3 

satellite and mobile network technology 73-5 
complementary metal oxide semiconductor 

(CMOS) 3 
computer aided design (CAD), graphics tablets 20 
computer name, URLs 44 
computer systems, main comJX>nents 2-3 
computer rypes 5-7 
concept keyOOards 9 
consistency checks 97 
contacts, email 107, 110 
control applications 

nmle graphics 81 
use of sensors 82-4 

control devices 26-7 
control systems 58 
cookies 67 
copy, paste and delete 121 
copyright rnles, software 59-60 
COUNTA function 198 
COUNT function 198 
COUNTIF function 199 
country codes 44 
cropping images 129 
current folders, webpages 262 
cut and paste 121 

data 
access methods 29 
analogue and digital 57-8 
testing 98 

data backups 28-9 
databases 54, 151 
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combination with word-processed documents 
179-80 

creation from existing files 153--6 
data entry 156-7 
evidence for examinations 179-80 
field types 151-2 
label production 169-71 
printing 186 
queries 158-61 

using formulae 171-3 
reasons for use 54-5 
relational 55-7 
reJX)rts 161--6 

exporting data 166-7 
hiding data 167-9 
using formulae 173-6 

sorting data 176-7 
data entry 

databases 156-7 
spreadsheets 190 

data handling applications 
club and society records 76 
surveys 75 
tuck shop records 76 

data models 187, 189-91 
see also spreadsheets 

data protection act 76-7 
data strnctures 54 
data types 50-3 
date data 53 
design stage, systems analysis 95-7 
desktop computers (PCs) 5 
development of systems 97-8 
dial-up modems 42, 45 
digital cameras 17-18 
digital data 5 7 
digital media sharing websites 68 
digital subscriber line (DSL) internet access 44--5 
digital to analogue converters (DACs) 25 , 58, 82 
directaccess 29 
direct changeover 99, 100 
doa1mentation of systems 100-1 
doa1ments 

columns 135-6 
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documents (continued) 
data entry from existing files 118- 19 
editing text 120-1 
emphasising text 139-40 
error correction 150 
font styles and sizes 137-8 
formatting pages 130-1 
headers and footers 131-3 
images 

cropping 129 
importing 122-4 
resizing 125-6 
text wrapping 126-9 

keying in text 120 
line spacing 148-9 
lists 140-2 
page, section and column breaks 134-5 
tables 143-7 
text alignment 147-8 
windows and orphans 133-4 

domain name and type, URL.s 44 
dongles 35 
dot matrix printers 24 
double entry verification cht-cks 95 
draft copies 185 
drag and drop 121 
DVDs 32-4 

echo cancellation software 48 
editing text 120-1 
electrically erasable programmable read only 

memory (EEPROM) 36 
electrocution risk 70 
electronic fund transfer (EFT) 90 
electronic point of sale (EPOS) terminals 9, 86 
electrostatic plotters 25 
email 44, 48, 104 

accounts 110 
attachments 112 
etiguene 106 
hyperlinks 254 
opening your mailbox 104-5 
organising mail 105-6 
phishing 66 
receivingmail 112 
screenshots 186 
sending mail 107-8 
spam 66 

email addresses 44 
embedded objects 118 
embedded web technology (EWT) 74 

employment, impact of ICT 61-2 
encryption 46-7, 61 
enhancing data 

charts 225-6 
spreadsheets 212 

enhancing text 139-40 
webpages 240-1 

environmental monitoring 83 
ergonomic keyboards 8 
error correction 

databases 157 
documents 150 

evaluation of systems 101 
Excel see spreadsheets 
expert systems 92-3 
extreme data 98 
eyestrain 69 

Facebook 68 
fact finding 95, 96 
fax (facsimile ) 48 
feasibility studies 94-5 
fields 54, 151 

changing field types and properties 155-6 
field types, databases 151-3 
filenames, URLs 44 
files 

databases 151 
email attachments 112 
strucn1re 54 
version numbering 183 

file servers 37 
fire risk 70 
firewalls 61 
fixed hard disk drives 30 
flash memory 35-6 
flat file structure 54, 56 
Flickr 68 
floppy disk drives 31 
flyers 72 
folksonomies 68 
font-families 236-7 
fonts 137-81 
font size, webpages 237-9 
footers 

database reports 163 
documents 131, 132-3 
HTML tables 256-8 
presentations 274-5 

format checks 97 
format painter 140 



fonnatting cells, spreadsheets 213-15 
fonnatting pages 130- 1 
fonnulae 

in database queries 171-3 
in database reports 173-6 
spreadsheets 188, 190, 191-2 

nesting 201 
fully justified alignment 147-8 
functions 194--200 

LOOKUP functions 202-4 
nested 201 
SUMIF 202 

generic file types 117 
global i:ositioning satellite (GPS) systems 

(sat navs) 74--5 
grammar checks 150 
graphical user interfaces (GUis) 4--5 
graphics tablets 20 
graph plotters 25 
graphs see charts 
greenhouses, environmental control 83-4 
groups, email contacts 110 

hacking 60-1 
hard disk drives 3, 30 
hardware 2 

safety considerations 70 
headaches 69 
headers 

database reports 163 
documents 131-2 
HfML tables 256-8 

head section, webpages 229-30 
health and safety issues 68-70 
heaters 27 
height of fonts 137 
hexadecimal counting system 245-6 
hiding data, database reports 167-9 
HLOOKUP function 203 
hospitals, use of sensors 82 
host name, emails 44 
household devices, microprocessor-controlled 64-5 
HfML (H yperText Markup Language) 228-30 

adding comments 243 
colour 245-50 
enhancing text 233 
images 262-7 
lists 243-5 
opening existing webpages 232 

saving files 231 
styles 234 
stylesheets 234-42 
tables 255-62 
text fonnatting 230, 233 
see also webpages 

HTTI' proxy servers 43 
hubs 39, 42 
humidity sensors 19 
hyperlinks 44, 250 

from images 267 
to other webpages 252-3 
to send email messages 254 
within webpages 251-2 

H yperT ext Mark up Language see HfML 

IF function 200 
images 

cropping 129 
file types 267 
in HI"ML 262-6 
hyperlinks from 267 
importing 122-4 
in presentations 283-7 
resampling 266-7 
resizing 125-6, 264-6 
text wrapping 126-9 

implementation of systems 98-100 
importing objects 122-4, 178-9 
indents 

lists 141 
paragraph settings 149 

induction loop sensors 78 
inference engines/ inference rules 93 
infonnation reliability, internet 65 
infrared, use in \VLANs 40 
inkjet plotters 25 
inkjet printers 23-4 
input devices 2, 8-21 
inserting images 124 
integer fields 152 
integrated documents 178-82 
internet 43, 113 

access 44--5 
control 63-4 
cookies 67 
reliability of infonnation 65 
search engines 114-16 
security issues 66-7 
URLs 113 

Index 
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websites 43-4 
undesirable 65 

see nlso HTML (H yper Text Markup Language); 
web pages 

internet developments 67-8 
internet service providers (ISPs) 44 
interviewing, fact finding % 
INT function 197 
intranets 45-6 
italics 139 

job queues 80 
joysticks 12 

keyOOards 8-9 
key field 54 
knowledge base 93 

labels 
production from databases 171 
spreadsheets 188 

laptop (notebook) computers 6 
monitors 22 

laser pointers 25 
laser printers 22-3 

ozone irritation 69 
left aligned text 147-8 
length checks 97 
library systems 91 
light pens 20-1 
lights 27 
light sensors 19 
limitchecks 97 
line graphs 218, 220-21 
line spacing 148 
lists 140-2 

on webpages 243-5 
local area networks (LANs) 37-9 

bridges 42 
logical (Boolean) data 50-3 
LOGO 81 
LOOKUP functions 202-4 

magnetic ink character recognition (MICR) 17 
magnetic stripe readers 13 
magnetic tapes 29, 31-2 
mainframe computers 7 
master slides 269-75 
MAX function 196 
media access control (MAC) addresses 42 

memory 3 
memory sticks 35-6 
mice 9-10 
microphones 18--19 
microprocessor-controlled devices 64-5 
microprocessors 3 
MIN function 196 
mobile phone networks 73-4 
modelling applications 77-80 
mOOems 41-2 
moisture sensors 19 
monitoring applications 82-3 
monitors 21-2 
morphing 73 
motors 26 
multimedia presentations 72 
multimedia projectors 25-6 
music production 73 
Myspace 68 

neck problems 69 
nested formulae and functions 201 
nested lists, webpages 244--5 
netbooks 6 
network devices 41-3 
network hubs 39, 42 
networks 37 

bluetooth 41 
communication methods 48-9 
intranets 45-6 
local area networks (LANs) 37-9 
mobile phone technology 73-4 
wide area networks (WANs) 41 
WiFi 40-1 
wireless LANs (WLANs) 40 
seenlsointemet 

network security 46-7 
normal data 98 
numbered lists 140, 142 

webpages 243 
number filters 206-7 
numeric data 53 
numeric fields 151-2 
numeric keypads 9 

obsen'ation, fact finding 96 
online lxx,king systems 88 
online processing 80 
online shopping and banking 62-3 
operating systems 3-4 



optical character recognition (OCR) 16, 75 
optical mark recognition (OMR) 16, 75 
optical mice 10 
optical storage media 32-5 
ordered lists, webpages 243 
OR operator 52-3 
orphans 133-4, 150 
output devices 2, 21-6 
oxygen level monitoring, rivers 83 
ozone irritation 69 

page breaks 134 
page layout 130-1, 216-17 
page numbers, automated 132 
paper-based presentations 72 
paperwork, fact finding 96 
paragraph setting 141 , 148-9 
parallel running 99,100 
passwords 46, 61 
paths, URLs 44 
payrolls, batch processing 86 
PCs/desktop computers 5 
pen drives 35--6 
pen plotters 25 
personal digital assistants (PDAs) 6-7 
pharming 66 
phased implementation 99, 100 
phishing 49, 66 
photography, digital cameras 17- 18 
pH sensors 19 
picture checks 97 
pie charts 218,220 
pilot implementation 99, 100 
piracy, software 60 
pixels 22 
plotters 25 
points, font sizes 137 
policing of the internet 63-4 
portable hard disk drives 30 
posters 72 
PowerPoint see presentations 
presence checks 97 
presentations 72, 269 

animation effects 288 
charts 280-81 
creating slides 276-8 
evidence for examinations 290 
images 283-7 

clipart 275--6 
master slides 269-75 

presenter notes 282 
saving and printing 288-90 
transitions between slides 287 

presenter notes 282, 289 
pressure sensors 19 
primary key 54 
printers 22-4 
printerservers 37 
printing 184-6 
processing types 80-1 
programming, robots 85 
proofreading 150 
protocols, URLs 44 
prototypes, 3D ink.jet printers 23 
proxy servers 37 

queries, databases 158--61, 162 
using fonnulae 171-3 

questionnaires 75 
fact finding 96 

QWERTY keyboards 8 

radio buttons 47 
random access memory (RAM) 3 

DVD-RAMs 33-4 
range checks 97 
read only memory (ROM) 3 

CD-ROM and DVD-ROM 32 
real-time process control 80-1, 82-4 
real-time (transaction) processing 80, 81 
record keeping 77 
records 151 
relational databases 55-7 
remote controls 11 
repetitive strain injury (RSI) 69 
replying to email 111 
reports 161, 177 

databases 162-5 
exporting data 166-7 
hiding data 167-9 
using formulae 173--6 

resampling images 266-7 
resizing images 125--6, 264-6 
rich text format (.rtf) files 117 
right aligned text 147-8 
ring networks 38 
rivers, oxygen level monitoring 83 
robotics 85 
robust passwords 61 
ROUND function 197 
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routers 42-3 
rows 

spreadsheets 216 
tables 143, 144 

rnles base 93 

safi .. "t)' issues 70 
sans serif fonts 137,236 
satellite communication, GPS systems (sat navs) 

74-5 
saving documents 

formats 184 
version numbering 183 

scanners 14-15 
scanning images 123 
screenshots 179-80, 185 

webpages 268 
search engines 114-16 

information overload 65 
searching databases 158-61 
secondary axes 223-4 
secondary storage devices 2 
section breaks 134, 135 
security 

ATMs 89 
databases 55 
data protection 76-7 
encryption 46-7, 6 1 
internet 66-7 

online shopping and banking 63 
networks 46-7 
software protection 35, 60 
VOIP 49 

selectors 236 
sensors 19-20, 58 

applications 82-4 
in robotics 85 

serial access 29, 31 
serif fonts 137,236 
servers 37 
shopping, online 62-3 
simulations 77-80 
site addresses 44 
slides, creation 276-8 
slide transitions 287, 290 
smart cards 13- 14 
social networking sites 68 
society, impactoflCT 61-5 
society records, databases 76 
software 2 

copyright rules 59-60 

solid state backing store 35-6 
sorting data 176-7 

spreadsheets 210-12 
sound sensors 19 
spam 49, 66 
speakers 25 
spell checks 150 
spreadsheets 187-8 

display feamres 212-17 
formulae 190, 191-2 
functions 194-200 
named cells and ranges 193-4 
nested formulae and fimctions 201 
saving and printing 217-18 
searching 

using more than one criteria 207-8 
using number filters 206-7 
using text filters 205-6 
using wildcards 208-10 

sorting data 210-12 
testing data models 204-5 
tuck shop model 76, 77-8 
seen/so data models 

spread spectrum technology 40 
spyware 67 
star networks 39 
stock control systems 86-8 
stylesheets 234-3 

table styles 258-9 
SUM function 194-5 
SUM.IF function 202 
surveys 75 
switches 39, 42 
systems analysis 94-5 
systems design 95 
systems development 97-8 
systems documentation 100-1 
systems evaluation 101 
systems implementation 98-100 
systems software 2 
systems testing 98 

tables 118- 19, 143-7 
in HI"ML 255-62 

placing images 263-4 
in relational databases 53-4 

tag clouds 68 
tagging 68 
target attributes 253 
technical documentation 100- 1 
temperamre sensors 19 



testing systems 98 
text alignment 147-8 

webpages 239 
text data 53 
text fields 151 
text filters 205-6 
text (.txt) files 117 
text wrapping 126-9 
thin film transistor (TFI) monitors 22 
tomography 23 
touchpads 10 
touch screens 5, 12 
trackerballs 11 
traffic, data collection 78 
traffic light simulation 78-9 
transaction (real-time) processing 80 
tree networks 39 
trip hazard 70 
tuck shop model, spreadsheets 76, 77-8 
h1rtle graphics 81 
tweening 73 
type checks 97 

underscoring 140 
universal serial bus (USB) connectors 17 
uniform resource locations (URLs) 44, 113 
user documentation 100 
user IDs 46, 6 1 
user interfaces 4-5 

systems development 98 
user name, emails 44 

validation 95, 97 
verification 95 
video conferencing 49-50 
vim1almice 25 

viruses 28-9, 60 
in email attachments 11 2 
pharming 66 

visual verification checks 95, 157 
VLCX)KUP function 203-4 
voice over internet protocol (VOIP) 49 
voice recognition software 19 

wardriving 41 
Web 2.0 67 
web browsers 43 
welxams 18 
webpages 43 

evidence for examinations 268 

Index 

see also HTML (H yperText Markup Language) 
websites 43-4, 227 

importing objects 178-9 
undesirable 63, 65 
use in communication 72-3 

'what if scenario ('what if modelling) 187 
wide area networks (WANs) 41 
WiFi 40-1 
Wikipedia 68 
wikis 68 
wildcard searches 

databases 160-1 
spreadsheets 208-10 

widows 133-4, 150 
windows icons menu and pointing device 

(WIMP) 4 
wireless local area networks (WLANs) 40 
wireless personal area networking (WPAN) 41 
world wide web (WWW/web) 43 

YouTubc 68 
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